Send Us Your Comments

Preface

1 Introduction to the Oracle Application Management Pack for Oracle E-Business Suite
   Overview......................................................................................................................................... 1-1

2 Installing and Upgrading the Oracle Application Management Pack for Oracle E-Business Suite
   Introduction...................................................................................................................................... 2-1
   Supported Versions....................................................................................................................... 2-2
   Prerequisites.................................................................................................................................... 2-2
   Downloading the Plug-In............................................................................................................... 2-2
   Deploying the Plug-In................................................................................................................... 2-2
   Installing a Management Agent.................................................................................................... 2-3
   Discovering Targets....................................................................................................................... 2-3
   Metrics Collected by the Plug-In.................................................................................................... 2-3
   Upgrading the Plug-In.................................................................................................................... 2-3
   Undeploying the Plug-In................................................................................................................ 2-4

3 Getting Started with the Oracle Application Management Pack for Oracle E-Business Suite
   Getting Started ............................................................................................................................. 3-1
   Oracle E-Business Suite Management Page................................................................................... 3-1
4 Discovering Oracle E-Business Suite

Preparatory Steps for Discovery .............................................................................. 4-1
Using the Discovery Wizard ..................................................................................... 4-2
Additional Features of Discovery ............................................................................. 4-7
Command-Line Discovery for Oracle E-Business Suite ............................................ 4-13
Rediscovering an Oracle E-Business Suite Instance ................................................. 4-14
Deleting an Oracle E-Business Suite Instance ......................................................... 4-14

5 Setting Credentials

Overview of Credentials ........................................................................................... 5-1
Preferred Credentials ............................................................................................... 5-1
Named Credentials .................................................................................................... 5-2
Preferred Credentials for Oracle E-Business Suite Application Login ................. 5-2
Preferred Credentials for Oracle E-Business Suite Database Login .................... 5-5
Preferred Credentials for Oracle E-Business Suite Node ....................................... 5-8
Preferred Credentials for Oracle WebLogic Server .............................................. 5-13
Preferred Credentials for Host .................................................................................. 5-15

6 Preferences

Setting Preferences ...................................................................................................... 6-1

7 Security

Privileges and Roles for Managing Oracle E-Business Suite .................................. 7-1
Change Management Privileges .............................................................................. 7-5
Specific Privileges for Features ................................................................................ 7-6

8 Monitoring Oracle E-Business Suite

Navigation and Overview .......................................................................................... 8-2
Home Page of an Oracle E-Business Suite System Instance ................................. 8-3
Incidents and Problems for an Oracle E-Business Suite Target ............................. 8-7
Embedded RUEI Region on the Oracle E-Business Suite Summary Page ............ 8-7
Patch Recommendations for Oracle E-Business Suite and Technology Stack .... 8-9
Compliance Standards for Oracle E-Business Suite .............................................. 8-19
Monitoring Online Patching to Detect Cutover ..................................................... 8-23
Monitoring Current Activity .................................................................................... 8-24
Monitoring User Sessions ....................................................................................... 8-25
Monitoring JVM Usage ........................................................................................... 8-27
Monitoring Templates for Oracle E-Business Suite ............................................ 8-29
Enabling Service Tests and Beacons Link ........................................................................... 8-35
Drilling Down to Oracle Applications Manager ................................................................. 8-37
Services .............................................................................................................................. 8-38
Concurrent Processing Dashboard ....................................................................................... 8-41
Oracle E-Business Suite Summary on the Exalogic Dashboard ........................................... 8-53
End-To-End Performance Monitoring with RUEI and JVMD ............................................... 8-54
Setting up End-to-End Monitoring ...................................................................................... 8-55
Analyzing a Performance Issue ......................................................................................... 8-60
Drilling Down from RUEI to the Plug-In ............................................................................... 8-65
Custom Metrics .................................................................................................................. 8-66
Custom Compliance Rules ................................................................................................. 8-67
Purging of Metrics .............................................................................................................. 8-67

9 Configuration Management

Configuration Details of Oracle E-Business Suite Technology Stack ................................... 9-1

10 Administering Oracle E-Business Suite

Starting and Stopping Services ......................................................................................... 10-1
Manual Synchronization of Editions ................................................................................... 10-10
Privilege Propagation With Administration Groups ........................................................ 10-10
Instance Administration .................................................................................................... 10-12

11 Monitoring Settings

Settings to Monitor Oracle E-Business Suite ...................................................................... 11-1
Configuring Monitoring of HTTPS/SSL Targets ............................................................... 11-4

12 Diagnosing Issues

Diagnosing Issues Using Pack Diagnostics ...................................................................... 12-1
Diagnostic Tests for AMP: Cloning ................................................................................... 12-3
Diagnostic Tests for Patch Manager .................................................................................. 12-10
Diagnostic Tests for Customization Manager .................................................................. 12-13
Diagnostic Tests for User Monitoring .............................................................................. 12-16

13 Cloning an Oracle E-Business Suite System

Overview of Cloning an Oracle E-Business Suite System ................................................. 13-1
Smart Clone for Releases 12 and 12.2.x: Requirements, Setup, Prerequisites .................. 13-6
Running a Smart Clone Procedure for Releases 12 and 12.2.x .......................................... 13-8
Adding Custom Steps to a Smart Clone Deployment Procedure ....................................... 13-21
Smart Clone for Release 12 - Application Tier Only: Requirements, Setup, Prerequisites
14 Managing Oracle E-Business Suite Instances on Oracle Cloud Infrastructure

Recommended Procedure if Enterprise Manager is Deployed On-Premises

Installing a Hybrid Cloud Gateway Agent

Installing Hybrid Cloud Agents on All Oracle E-Business Suite Nodes

Adding an Oracle E-Business Suite Database Target

Recommended Procedure if Enterprise Manager is Deployed on Oracle Cloud Infrastructure

Taking Inventory of Port Numbers

Creating Ingress Rules in Oracle Cloud Infrastructure to Open Required Ports from Oracle E-Business Suite Nodes to OMS Host

Creating Firewall Rules on the OMS Host to Allow Communication from Oracle E-Business Suite Nodes

Creating Ingress Rules in Oracle Cloud Infrastructure to Open Required Ports from OMS to the Oracle E-Business Suite Nodes

Adding Firewall Rules on Oracle E-Business Suite Nodes

Ensuring the Fully Qualified Domain Name is Resolvable

Creating Required Named Credentials to Connect Oracle E-Business Suite Nodes

Manually Installing Management Agents on All Oracle E-Business Suite Nodes

Adding an Oracle E-Business Suite Database Target

Common Tasks

15 Introduction to Change Management

Introduction

Approval Process for Change Management

Preferred Credentials for Change Management

Notifications Setup

Diagnostic Tests

16 Patch Manager

Introduction

Patch Manager Home

Creating a Patch Run for Oracle E-Business Suite Release 12.1 and Earlier

Creating a Patch Deployment Procedure for Oracle E-Business Suite Release 12.2

Extending Patch Manager Deployment

Patching an Oracle E-Business Suite Release 12.2 Instance using EM CLI

Patching an Oracle E-Business Suite Release 12.1 or Earlier Instance using EM CLI
17 **Customization Manager**

**Introduction** ............................................................................................................. 17-1
**Major Definitions** ...................................................................................................... 17-2
**Setup Steps** ............................................................................................................... 17-4
**Security** .................................................................................................................... 17-4
**Diagnosing Issues** ..................................................................................................... 17-4
**Overview of the User Interface** ................................................................................ 17-4
**Managing Custom Applications** .............................................................................. 17-5
**Managing Custom Packages** ................................................................................... 17-16
    - Developing Custom Code ...................................................................................... 17-16
    - Creating Custom Packages .................................................................................. 17-20
    - EM CLI Commands for Custom Package Creation .............................................. 17-48
**Maintaining the File Metadata Repository** ................................................................ 17-51
**Reporting** .................................................................................................................. 17-54
**Customization Discovery** ......................................................................................... 17-60

**A Target Types**

**Target Types** ............................................................................................................ A-1

**B Prevalidation for Discovery**

**Prevalidation Checks for Discovery** ........................................................................ B-1

**C Supported File Types in Customization Manager**

**Supported File Types** .............................................................................................. C-1
**Recommended Locations for Common File Types** ................................................ C-13
**Execution Sequence of SQL File Types** .................................................................. C-14

**D Customization Manager Coding Standards Validation**

**Customization Manager Coding Standards Validation for Files** .............................. D-1
**Customization Manager Coding Standards Validation for Database Objects** .......... D-11

**E Validation of Custom Applications: Examples**

**Validation of Custom Applications: Examples** ......................................................... E-1

**F Character Set Mapping for Custom Patches**

**Character Set Mapping for Custom Patches** ............................................................ F-1
G  XML Schema Using EM CLI
   Sample XML Input File to Discover Oracle E-Business Suite Instances Using EM CLI........G-8
   Sample XML Schema to Start and Stop Oracle E-Business Suite Using EM CLI................G-11
   Sample Input XML File to Start or Stop Using EM CLI...........................................G-12
   Sample XML Schema to Start and Stop Component/Node Using EM CLI..........................G-13
   Sample Input XML File to Start and Stop Component/Node Using EM CLI......................G-15

H  Known Product Limitations
   Known Product Limitations..........................................................................................H-1

Index
Send Us Your Comments

Part No. F32518-01

Oracle welcomes customers’ comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience

This book is intended for database administrators and system administrators who are responsible for performing the tasks associated with maintaining an Oracle E-Business Suite system using the Oracle Application Management Pack for Oracle E-Business Suite.

See Related Information Sources on page xii for more Oracle E-Business Suite product information.

Documentation Accessibility
For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Structure
1 Introduction to the Oracle Application Management Pack for Oracle E-Business Suite
2 Installing and Upgrading the Oracle Application Management Pack for Oracle E-Business Suite
3 Getting Started with the Oracle Application Management Pack for Oracle E-Business Suite
Related Information Sources


This book lists the target metrics for Oracle E-Business Suite that Oracle Enterprise Manager monitors.

Oracle E-Business Suite System Administrator's Guide Documentation Set


Oracle Enterprise Manager Cloud Control Introduction

This manual introduces Oracle Enterprise Manager. It provides a brief overview of the
system architecture and describes the key features of the product. The manual also
details new features in this release.

**Oracle Enterprise Manager Cloud Control Basic Installation Guide**

This guide enables you to begin the installation of a new Enterprise Manager system.

**Oracle Enterprise Manager Cloud Control Advanced Installation and Configuration Guide**

*Oracle Enterprise Manager Cloud Control Advanced Installation and Configuration Guide* is
an extension to *Oracle Enterprise Manager Cloud Control Basic Installation Guide*. While the
*Oracle Enterprise Manager Cloud Control Basic Installation Guide* covers basic installation
procedures that help you get started with Enterprise Manager Cloud Control, the *Oracle
Enterprise Manager Cloud Control Advanced Installation and Configuration Guide* covers
advanced installation procedures that help you install and configure the Enterprise
Manager Cloud Control components in more complex environments.

**Oracle Enterprise Manager Cloud Control Upgrade Guide**

This guide describes how you can upgrade from an existing Oracle Enterprise Manager
12c to Oracle Enterprise Manager Cloud Control 13c.

**Oracle Enterprise Manager Cloud Control Administrator’s Guide**

This guide describes how to set up a Private Cloud, manage and deploy virtualization
targets with Oracle Enterprise Manager 13c.

**Oracle Enterprise Manager Cloud Administration Guide**

This guide describes how to set up a Private Cloud, manage and deploy virtualization
targets with Oracle Enterprise Manager 13c.

**Oracle Enterprise Manager Lifecycle Management Administrator’s Guide**

The Lifecycle Management Guide introduces you to the lifecycle management solutions
offered by Oracle Enterprise Manager Cloud Control (Cloud Control) and describes in
detail how you can use the discovery, provisioning, patching, and configuration and
compliance management features to manage your data center.

---

**Do Not Use Database Tools to Modify Oracle E-Business Suite Data**

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an
Oracle E-Business Suite form can update many tables at once. But when you modify
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Introduction to the Oracle Application Management Pack for Oracle E-Business Suite

This chapter covers the following topics:

- Overview

Overview

The Oracle Application Management Pack for Oracle E-Business Suite is built on top of the Oracle Enterprise Manager 13c Cloud Control platform to deliver monitoring capabilities and to manage Oracle E-Business Suite systems more effectively.

The Oracle Application Management Pack for Oracle E-Business Suite is also known as Oracle E-Business Suite plug-in.

Oracle Enterprise Manager Cloud Control provides a complete view of your enterprise so that you can manage all of your Oracle E-Business Suite systems from a single console. This pack provides new pages within Cloud Control that help you monitor the performance, availability, and configuration changes of your Oracle E-Business Suite system and also help you provision your Oracle E-Business Suite applications. You can take advantage of advanced Cloud Control features such as the provisioning framework.

**Note:** Refer to My Oracle Support Knowledge Document 2676355.1, *Getting Started with Oracle Application Management Pack (AMP) for Oracle E-Business Suite, Release 13.4.1.0.0*, for additional patches required for your system.

**Information About the Oracle Application Management Pack for Oracle E-Business Suite Deployment**

Installing and Upgrading the Oracle Application Management Pack for Oracle E-Business Suite

This chapter covers the following topics:

- Introduction
- Supported Versions
- Prerequisites
- Downloading the Plug-In
- Deploying the Plug-In
- Installing a Management Agent
- Discovering Targets
- Metrics Collected by the Plug-In
- Upgrading the Plug-In
- Undeploying the Plug-In

Introduction

The Oracle Application Management Pack for Oracle E-Business Suite extends Oracle Enterprise Manager 13c Cloud Control to help monitor and manage Oracle E-Business Suite systems more effectively. This plug-in integrates Oracle Applications Manager with Cloud Control to provide a consolidated, end-to-end Oracle E-Business Suite management solution. The plug-in can be used to manage Oracle E-Business Suite Release 12 systems.
Supported Versions
For a list of supported versions, see My Oracle Support Knowledge Document 2676355.1, Getting Started with Oracle Application Management Pack for Oracle E-Business Suite, Release 13.4.1.0.0.

Prerequisites
For a list of prerequisites, see My Oracle Support Knowledge Document 2676355.1, Getting Started with Oracle Application Management Pack for Oracle E-Business Suite, Release 13.4.1.0.0.

Additional Instructions
Ensure that the following OS/User Group requirement has been met: It is recommended that the Oracle E-Business Suite OS user and the Enterprise Manager Agent OS user are the same. If they are different, then they must belong to the same OS group.

Downloading the Plug-In
You can download plug-ins in online or offline mode. Online mode refers to an environment where you have Internet connectivity and can download the plug-in directly through Enterprise Manager from My Oracle Support. Offline mode refers to an environment where you do not have Internet connectivity or where the plug-in is not available from My Oracle Support.


The following details of the Oracle E-Business Suite plug-in can be used for searching in the Self Update feature of the Enterprise Manager console:

Plug-in Name: Oracle E-Business Suite
Description: Enterprise Manager for Oracle E-Business Suite consists of System Management and Change Management Feature Sets
Version: 13.4.1.0.0

Deploying the Plug-In
You can deploy the plug-in to an Oracle Management Service instance using the Enterprise Manager Cloud Control console, or using the EM Command Line Interface (EM CLI). While the console enables you to deploy one plug-in at a time, the command line interface mode enables you to deploy multiple plug-ins at a time, thus saving plug-in deployment time and downtime, if applicable.

**Installing a Management Agent**

A Management Agent must be present on all hosts containing targets that will be monitored/managed by the plug-in.

This step is required only if a Management Agent is not already present on a host containing targets to be managed.

See "Installing Oracle Management Agents [https://docs.oracle.com/en/enterprise-manager/cloud-control/enterprise-manager-cloud-control/13.4/embsc/installing-oracle-management-agents.html#GUID-D08C7C37-7BCD-4E32-A74B-7C5FD266D151]" in the Oracle Enterprise Manager Cloud Control Basic Installation Guide for instructions on deploying a Management Agent to a host machine:

To monitor and manage Oracle E-Business Suite instances running on Oracle Cloud, you must deploy Hybrid Cloud Agents onto the Oracle Cloud virtual hosts.

For more information on Hybrid Cloud Management and for instructions to enable the feature, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

**Discovering Targets**

After the plug-in is deployed, targets that will be managed/monitored by the plug-in must be "discovered" by Enterprise Manager.

For information on discovery, see the chapter Discovering Oracle E-Business Suite with Cloud Control, page 4-1.

**Metrics Collected by the Plug-In**


**Upgrading the Plug-In**

For instructions on how to upgrade the plug-in, see My Oracle Support Knowledge Document 2676355.1, Getting Started with Oracle Application Management Pack for Oracle E-Business Suite, Release 13.4.1.0.0.

**Considerations for Cloning and Upgrades**

Only Smart Clone procedures are supported in this release. As a prerequisite to running
a Smart Clone procedure, the target Oracle E-Business Suite database must be cloned and discovered in the Enterprise Manager.

Clone transaction data created in previous releases will not be usable in this release. After you upgrade from an earlier release, the old cloning transactions will not be available.

**Undeploying the Plug-In**

Getting Started with the Oracle Application Management Pack for Oracle E-Business Suite

This chapter covers the following topics:

- Getting Started
- Oracle E-Business Suite Management Page

Getting Started

Once the Oracle Application Management Pack for Oracle E-Business Suite, or plug-in, has successful deployed on the OMS, you can go to the landing page (called the Oracle E-Business Suite Management page henceforth) of the plug-in. To do this, select Oracle E-Business Suite from the Targets menu.

Oracle E-Business Suite Management Page

The Oracle E-Business Suite Management page gives you a bird’s eye view of all the Oracle E-Business Suite instances that are being monitored. This view includes status, incidents, compliance, and so on. The page has the following sections:
**Status of Oracle E-Business Suite Targets**

This section shows the status summary of Oracle E-Business Suite targets being monitored. The pie charts show how many are up, down, or in unknown status.

**Incidents and Problems**

This section has the summary of incidents reported from all the Oracle E-Business Suite targets being monitored. The incidents are grouped based on category and severity.

**Oracle E-Business Suite Instances**

This section lists the Oracle E-Business Suite instances that are already discovered. The status column tells you if the instance is up or down. You can perform the following actions:

- Go to the home page of an Oracle E-Business Suite instance by clicking on the name of the instance.
- Discover a new Oracle E-Business Suite instance by clicking Add.
- Delete an Oracle E-Business Suite instance which is already discovered by clicking Delete.
- Configure how an Oracle E-Business Suite instance is being monitored by clicking Configure.

**Tip:** Use the Detach button to view the table in a separate page. This feature is useful if your table has more rows than can be shown in the default display.

**Compliance Summary**

This section lists the compliance standards that are shipped by the Oracle E-Business Suite plug-in along with the evaluations performed and violations reported. The Average Compliance score is an indication on how much compliant all the Oracle E-Business Suite instances are to each specific standard.

Oracle Enterprise Manager Compliance Management provides the ability to evaluate the compliance of targets and systems as they relate to business best practices for configuration, security, and storage. This is accomplished by defining, customizing, and managing compliance frameworks, compliance standards, and compliance standard rules. In addition, Compliance Management provides advice of how to change configuration to bring your targets and systems into compliance. Oracle Application Management Pack for Oracle E-Business Suite includes the Oracle E-Business Suite
Framework for use with Compliance Management. For more information on Compliance Management, refer to the Oracle Enterprise Manager Lifecycle Management Administrator’s Guide.

Least Compliant Targets

This section lists the Oracle E-Business Suite targets that are least compliant across all standards. The default Target Type shown is Host. The Average Compliance score is an indicator of how compliant the specific Oracle E-Business Suite instances are to standards.

Navigating from the Oracle E-Business Suite Management Page

You can navigate to the following pages from the Oracle E-Business Suite Management page through the Administer menu.

- Change Management
- Preferences
- Discovery Wizard
- Pack Diagnostics
- Cloning
- Instance Administration
Discovering Oracle E-Business Suite

This chapter covers the following topics:

• Preparatory Steps for Discovery
• Using the Discovery Wizard
• Additional Features of Discovery
• Command-Line Discovery for Oracle E-Business Suite
• Rediscovering an Oracle E-Business Suite Instance
• Deleting an Oracle E-Business Suite Instance

Preparatory Steps for Discovery

Privileges Needed to Perform Discovery

To discover an Oracle E-Business Suite instance, a user must have the "Add Any Target" target type privilege.

Prerequisites to Perform Discovery

• The Oracle E-Business Suite database must be discovered in Enterprise Manager Cloud Control.

• The hosts on which the Oracle E-Business Suite is deployed must be discovered in Enterprise Manager Cloud Control.

• AutoConfig must be enabled and updated on all nodes in order for Oracle E-Business Suite systems to be properly recognized by Oracle Application Management Pack for Oracle E-Business Suite. Refer to the applicable documentation:
• My Oracle Support Knowledge Document 387859.1, *Using AutoConfig to Manage System Configurations in Oracle E-Business Suite Release 12*


**Note:** Starting with Release 13.1.1.1.0, Oracle Application Management Pack for Oracle E-Business Suite is bringing up all patch edition WebLogic Servers prior to performing discovery. All patch edition WebLogic Servers will be brought down after discovery is completed.

To bring up/down the patch edition WebLogic Server, the plug-in requires the Normal Host Preferred credentials on all nodes. If the user does not set this credential for all nodes, the plug-in uses Normal Host credentials defined for the Admin host.

**Using the Discovery Wizard**

An Oracle E-Business Suite instance is discovered using the Discovery Wizard. The Discovery Wizard allows you to validate, track, plan, log, and customize the Oracle E-Business Suite discovery processes.

To access the Discovery Wizard, on the Oracle E-Business Suite Management page select **Discovery Wizard** from the **Administer** menu.

**Setting Credentials for Discovery:**

Starting with Release 12.1.0.4.0, the Discovery Wizard requires named credentials to perform discovery. You can choose an existing named credential or you can create a new one during the discovery process. If you create a new named credential, you must first save it before it can be used.

**Discovering an Oracle E-Business Suite Database:**

The Oracle E-Business Suite database should be discovered before you proceed with discovery. Refer to the *Oracle Enterprise Manager Cloud Control Administrator’s Guide* for information on discovering the Oracle E-Business Suite database. The database target name will be used as a prefix to the target name of all the member targets of the Oracle E-Business Suite target. The database target name can contain alphanumeric characters and periods (.). Other characters are not usually allowed, although starting with Release 13.1.1.1.0, the underscore (_) and hyphen (-) can be used as well.

For Oracle E-Business Suite deployments using Oracle Database 19c or later, while discovering the database target in Enterprise Manager, the Oracle E-Business Suite database PDB SID should be used for "Database SID". This workaround is required to successfully discover Oracle E-Business Suite instances.
When the Oracle E-Business Suite database is a pluggable database, use the following workarounds:

- If the database is single-instance database, the database target should be discovered as "Database Instance" target and the Oracle E-Business Suite database PDB SID should be used for the "Database SID".

- If the database is running on Oracle RAC, after discovering the "Cluster" target, while configuring/adding the "Cluster Database" target, the Oracle E-Business Suite database PDB SID should be used for "Service Name". While configuring/adding the "Cluster Database Instance" targets, the Oracle E-Business Suite database PDB SID should be used for "Database SID".

**Adding an Oracle E-Business Suite Database to the Discovery Wizard:**

When adding the database to the Discovery Wizard, if the database is an Oracle RAC database, choose the target with the type "rac_database."

**Note:** You should not add an individual node in the Oracle RAC which is of target type "oracle_database."

1. On the Oracle E-Business Suite Management page, navigate to the **Discovery Wizard** from the **Administer** menu.

2. Click **Add**.

3. From the list of available database targets, select the Oracle E-Business Suite database target.

   **Note:** If the database is a RAC database, choose the target with the database target type "rac_database." You should not add an individual node in the RAC with the database target type "oracle_database."

4. Once added, the database target shows up in the Discovery Wizard. You can now proceed to discover the Oracle E-Business Suite instance.
**Prevalidating Discovery:**

Prevalidation allows you to analyze the Oracle E-Business Suite instance and Enterprise Manager Cloud Control to ensure successful discovery. These validation checks include verifying the following:

- Context files
- Context variables
- Agent installation
- OS user privileges

For more information on these checks, see: Prevalidation Checks for Discovery, page B-1.

1. To prevalidate discovery, go to the Discovery Wizard.

2. Select the Oracle E-Business Suite database target and click **Prevalidate**.

3. Select the default monitoring named credential from the drop-down list. Click **Set** so that it becomes the default for all Oracle E-Business Suite instances.

   **Note:** If needed, this can be overridden at the individual instance level.

4. Click **Next**.

5. **Note:** If you have selected an Oracle E-Business Suite instance that features online patching, follow the remaining steps. If you have not selected an Oracle E-Business Suite instance, you will go on to the Review section.

   Select the default WebLogic admin named credentials. Click **Set** so that it becomes the default for all Oracle E-Business Suite instances.
6. Select the named default normal host credentials of the host where the patch edition administration server is running. This is necessary to check if the patch edition admin server is down.

If this host has an alias name in the Oracle E-Business Suite context files, you may have to perform host aliasing prior to starting the discovery. See Mapping an Aliased Host, page 4-11.

Click Set so that it becomes the default for all Oracle E-Business Suite instances.

*Note:* If needed, this can be overridden at the individual instance level.

7. Click Next to go to the Review section.

8. Review the details to ensure they are correct. A separate section is displayed for Oracle E-Business Suite instances that feature online patching.

9. Click Submit and a job will be submitted to prevalidate the discovery.

The Diagnostics Status column in the Discovery Wizard shows the status of prevalidation as a link. You can drill down to get the details. A detailed report will be generated that can be used to resolve any issues.

**Discovering Oracle E-Business Suite:**

1. Navigate to the Discovery Wizard.

2. Select the Oracle E-Business Suite database target and click Discover.

3. Choose the default "Monitoring Credential Name." Click Set so that it becomes the default for all Oracle E-Business Suite instances.

*Note:* If needed, this can be overridden at the individual instance level.

4. Click Next. The following steps will appear only if you have selected an Oracle E-Business Suite instance that features online patching. Otherwise, the wizard will proceed to the Review section.

5. Select the default "WebLogic Named Credential" for the WebLogic Administration Server. Click Set so that it becomes the default for all Oracle E-Business Suite instances.

*Note:* If needed, this can be overridden at the individual instance level.
6. Select the "Host Named Credential." This is to set the default normal host preferred credentials of the hosts where application nodes are running. It is assumed that the credential is the same for all hosts. If not, you must set it separately using the credential screens in Oracle Enterprise Manager.

   - The admin server and all managed servers must be up in both run and patch file systems during discovery. If any one is down, it will be brought up during discovery, and then brought down once the discovery is complete. The host preferred credentials are also needed for this same reason.

   - If this host has an alias name in the Oracle E-Business Suite context files, then you may have to perform host aliasing before starting the discovery. See: Mapping an Aliased Host, page 4-11.

7. Click Set so that it becomes the default for all Oracle E-Business Suite instances.

   **Note:** If needed, this can be overridden at the individual instance level.

8. Click Next to go to the Review page.

9. Review the details to ensure they are correct. A separate section is displayed for Oracle E-Business Suite instances that feature online patching.

10. Click Submit. A job will be submitted per Oracle E-Business Suite instance to perform the discovery.

    **Note:** For an Oracle E-Business Suite instance that features online patching, both run and patch edition targets will be discovered, but only run edition targets will be shown in the UI. Patch edition targets will be blacked out immediately after discovery to prevent false incidents from being raised.

**Tracking the Discovery Job:**

The **Discovery Job Status** column in the Discovery Wizard will show the status of discovery as a link. Click on the link to drill down to see more details. If the discovery fails, the **Error Log** column will provide you the details of the error.
Additional Features of Discovery

Discovering Oracle E-Business Suite as the EM_MONITOR User (Recommended)

Oracle E-Business Suite can be discovered and monitored by an EM_MONITOR user which has read-only access to Oracle E-Business Suite tables required for monitoring. By default, the EM_MONITOR user is locked. A user would have to unlock it explicitly to use it.

Connect to the database through SQL*Plus as the SYSTEM user and issue the following command:

```
alter user em_monitor account unlock;
```

Reset the password using the following command:

```
alter user em_monitor identified by <new password>
```

Discovering Oracle E-Business Suite as Any Database User (such as DBSNMP)

Oracle E-Business Suite can be discovered and monitored using any database user, provided the user has been granted the EM_OAM_MONITOR_ROLE. This role is provided with read-only access to Oracle E-Business Suite tables required for monitoring.

Additional Steps for Oracle Database 12.1.0.2 and Later

Aside from the grant mentioned above, if the Oracle E-Business Suite database is 12.1.0.2 or later, additional steps are required. In addition to the grant mentioned above run the following command:

```
GRANT INHERIT PRIVILEGES ON USER DBSNMP TO APPS;
```

Troubleshooting Discovery

If anything goes wrong with the discovery, you must check the discovery log to troubleshoot. It is available at:

```
$<MIDDLEWARE_HOME>/sysman/log/ebsDiscovery_<database_target_name>_<rac_database/oracle_database>.log
```

Restrictions for Discovery

- If you are using Oracle E-Business Suite’s Online Patching feature and you have an active patching cycle in progress, you must wait until it completes before attempting to discover an Oracle E-Business Suite instance.

- If you are using Oracle E-Business Suite’s Online Patching feature and if a node is abandoned, you cannot perform a discovery. You must customize the discovery
Customizing Discovery

It is possible to customize the discovery. You can exclude the discovery of certain targets and services. To customize the discovery of an Oracle E-Business Suite instance, select the instance and click **Configure** in the Discovery Wizard.

You will be prompted to enter the monitoring schema named credentials for the database. Either choose an existing named credential or create a new one. Click **Next**.

Customization at the Instance Level

The following table explains the different options available for customizing discovery.

<table>
<thead>
<tr>
<th>Options for Customizing Discovery</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
<tr>
<td>Customer Group Name</td>
</tr>
<tr>
<td>Customer Instance Group Name</td>
</tr>
<tr>
<td>Discover Workflow Service</td>
</tr>
<tr>
<td>Discover Workflow Service</td>
</tr>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Discover Forms Service</td>
</tr>
<tr>
<td>Discover SSA Service</td>
</tr>
<tr>
<td>Discover Patching Information</td>
</tr>
<tr>
<td>Discover Custom Objects</td>
</tr>
<tr>
<td>Discover All Concurrent Managers</td>
</tr>
<tr>
<td>Delete Removed Targets</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Excluding Nodes from Getting Discovered**

The Configuration of Oracle E-Business Suite: Discovery Parameters page lists all the nodes in the section Context Discovery. You can exclude a node from being discovered by deselecting the check box corresponding to the node in the Enable column. At least one applications node must be selected for successful discovery. Discovery can happen even if you do not select a database node.

For Oracle E-Business Suite Release 12.2, you cannot exclude a node if the WebLogic Administration Server is running on that node.
Note: If the Oracle E-Business Suite features Online Patching, it is possible that a few nodes can be in an abandoned state. If the system detects an abandoned node, an additional column will appear in the above section named "Abandoned." You must exclude that node before discovery.

Customization at the Node Level

You can also configure the targets that are discovered in each node. Select the node in the Context Discovery section and click Configure.

In the pop-up window that appears, you can customize the configuration.
Customization at the Application Node Level

You can exclude Forms, Mobile Web Applications, and the Apps JVM from being discovered in Oracle E-Business Suite Release 12.

**Note:** If the Oracle E-Business Suite instance features Online Patching, make sure that the Oracle E-Business Suite host where the WebLogic admin server is running can be pinged from the OMS host.

Mapping an Aliased Host

A host which is uniquely identified by an IP address can have different alias names in the network. It is possible that the Oracle E-Business Suite context file has one host name while it has been discovered in Cloud Control with a different alias name. In such a situation, the system will try to find the mapping by itself using the host metrics. If conflicts should occur, you must map the host name available in the context file to the corresponding host name with which it has been discovered. This can be done by configuring the discovery for each node.

The Map Aliased Host section in the Configure Context pop-up window serves this purpose where you can provide the overriding host name. A list of values is shown from which you can select the appropriate host which can be mapped to the host in which this node is running.
Resetting the Customization

From the Configure Discovery page, you can reset your customization to the default or you can reset it to the last configuration with which discovery was completed successfully.

Deleting the Customization

You may need to delete the customization in the event that you delete an Oracle E-
Business Suite instance and run discovery again. If you do not delete the customization, the customized instance will be discovered instead of the default.

In the Discovery Wizard, delete a customization by selecting the customization row you would like to remove and click **Delete**.

**Command-Line Discovery for Oracle E-Business Suite**

Oracle Application Management Pack for Oracle E-Business Suite provides a command-line interface for the batch discovery of multiple Oracle E-Business Suite systems. This feature uses Enterprise Manager Command Line Interface (EM CLI). See *Enterprise Manager Center Command Line Interface* to understand more about EM CLI.

**Prerequisites**

- EM CLI must be installed. See "Downloading and Deploying the EM CLI Client for Standard EM CLI" in *Enterprise Manager Command Line Interface*.
- Set up EM CLI. See "Getting Started with EM CLI" in *Enterprise Manager Command Line Interface*.
- Log in to your Oracle Management Server (OMS).
- Synchronize the EM CLI client with OMS.

**Discovering Oracle E-Business Suite Instances**

The EM CLI verb **discover_ebs** must be used to discover Oracle E-Business Suite instances. Details of these instances should be provided as an XML file. See XML Schema to Discover Oracle E-Business Suite Using EM CLI, page G-2 for the schema with which the XML must be built and sample XML with comments included about each element.

You can provide default discovery parameters which will be applied for all Oracle E-Business Suite instances or you can provide parameters at individual instance levels which will also be given precedence.

**Note:** You can generate the XML from the schema using any IDE. Choose a depth of 8 or more, if you do so.

Execute the following command to perform the discovery:

```bash
./emcli discover_ebs -input_file=ebs_discovery_file:<fully qualified path of ebs_discovery_file.xml> -log_file=<fully qualified path of log file>
```

The **log_file** parameter is optional. If it is not provided, the system will generate its own and the path will be printed in the console. The log file contains separate sections.
for Oracle E-Business Suite instances where a job was submitted successfully and for those where the job was not submitted due to some error. You can track the successful submissions from the Enterprise Manager UI to monitor jobs using the Job IDs found in the log file.

Rediscovering an Oracle E-Business Suite Instance

If the Oracle E-Business Suite configuration has changed after discovery, then you must rediscover the Oracle E-Business Suite instance so that such changes are reflected in Enterprise Manager. Examples of changes to the configuration are:

• A new node has been added

• A service, such as a concurrent processing service, has been enabled in a node

The steps for rediscovery are the same:

1. Navigate to the Discovery Wizard.

2. Select the Oracle E-Business Suite database.

3. Click Discover.

Deleting an Oracle E-Business Suite Instance

If you no longer want to monitor and manage an Oracle E-Business Suite instance, you can delete it. The steps are:


2. Select the Oracle E-Business Suite instance from the section Oracle E-Business Suite Instances.

3. Click Delete.

By default, the system deletes application server targets (like the HTTP server, OC4J, and so on) when deleting the parent Oracle E-Business Suite target. If you do not want all the application server targets deleted, change the preference. For information on updating preferences, see: Setting Preferences, page 6-1.
Setting Credentials

This chapter covers the following topics:

- Overview of Credentials
- Preferred Credentials for Oracle E-Business Suite Application Login
- Preferred Credentials for Oracle E-Business Suite Database Login
- Preferred Credentials for Oracle E-Business Suite Node
- Preferred Credentials for Oracle WebLogic Server
- Preferred Credentials for Host

Overview of Credentials

The Enterprise Manager credential subsystem enables Enterprise Manager administrators to store credentials, in a secure manner, as preferences or operation credentials. The credentials can then be used to perform different system management activities, such as real-time monitoring, patching, provisioning, and other target administrative operations.

Preferred Credentials

Preferred credentials are used to simplify access to managed targets by storing target login credentials in the Management Repository. With a preferred credentials set, users can carry out administrative operations using the job system without being prompted to log in to the target. Preferred credentials are set on a per user basis, thus ensuring the security of the managed enterprise environment.

Default Preferred Credentials

Default preferred credentials can be set for a particular target type and will be available for all the targets of the target type. It will be overridden by target preferred credentials.
Target Preferred Credentials

Target credentials are preferred credentials set for a particular target.

Named Credentials

To set a preferred credential, you must first create a named credential. Credentials are stored within Enterprise Manager as "named" entities. Administrators can define and store credentials within Enterprise Manager and refer to the credential by a credential name.

If only the senior DBAs have knowledge of higher privileged credentials like `sys` credentials for a database, they can store these credentials in a named credential and share the name with the junior administrators. Junior administrators can perform their jobs using the named credentials without knowing what the actual credentials are.

If the administrators have the same credentials for targets, they can create one named credential containing those credentials and share the name with appropriate personnel. This simplifies credential maintenance (changing passwords, for example) by eliminating the need to create several copies of named credentials containing the same credentials.

Preferred Credentials for Oracle E-Business Suite Application Login

Create named credential for Oracle E-Business Suite Application Login:


2. On the Named Credentials page, click Create.

3. Provide an appropriate name and description.

4. Select Oracle E-Business Suite from the Authenticating Target Type drop-down list.

5. Select E-Business Suite Applications Login Credential from the Credential Type drop-down list.

6. Select the scope.

   • If you choose Global, this named credential will be applicable for all Oracle E-Business Suite targets.

   • If you choose Target:

      • Select Oracle E-Business Suite as the target type.
• Select the Oracle E-Business Suite for which this named credential is applicable.

7. Enter the applications login user name and password in the credential properties.

8. You can test and save the credentials.
Set Preferred Credential for Oracle E-Business Suite Application Login:
1. Navigate to Setup menu > Security > Preferred Credentials.

2. Search for and select the Target Type "Oracle E-Business Suite."

3. Click Manage Preferred Credentials.

Set Default Preferred Credentials for Oracle E-Business Suite Application Login:
If you want to set a preferred credential for Oracle E-Business Suite Application Login which is applicable for all Oracle E-Business Suite targets, go to the Default Preferred Credentials section.
1. Select **AppsUserCredsSet** as the Credential Set.

2. Click **Set**.

3. Choose the named credentials. Only those named credentials with scope as "global" will appear in the list.

4. You can test and save the credentials.

**Set Target Preferred Credentials for Oracle E-Business Suite Application Login:**
If you want to set a preferred credential for Oracle E-Business Suite Application Login applicable only to a specific Oracle E-Business Suite target, go to the Target Preferred Credential section.

1. Select the Oracle E-Business Suite instance.

2. Select **AppsUserCredsSet** as Credential Set.

3. Click **Set**.

4. Choose the named credentials.

5. You can test and save the credentials.

**Preferred Credentials for Oracle E-Business Suite Database Login**
Preferred credentials for database login are needed if you are using Customization Manager or Patch Manager. You must set the preferred credentials for the APPS, APPLSYS, and SYSTEM schemas.

**Create named credential for Oracle E-Business Suite Database Login:**
1. Navigate to Setup menu >Security >Named Credentials and click Create.

2. Provide an appropriate name and description.

3. Select "Oracle E-Business Suite" from the Authenticating Target Type drop-down list.

4. Select "E-Business Database Credentials" from the Credential Type drop-down list.

5. Select the scope.
   - If you choose Global, this named credential will be applicable for all Oracle E-Business Suite targets.
• If you choose Target:
  • Select Oracle E-Business Suite as the target type.
  • Select the Oracle E-Business Suite for which this named credential is applicable.

6. Enter the schema name and password in credential properties.

7. You can test and save the credentials.

**Note:** You must create three named credentials here: one for the APPS schema, one for the APPLSYS schema, and one for the SYSTEM schema.
Set preferred credential for Oracle E-Business Suite Database Login:
1. Navigate to Setup menu > Security > Preferred Credentials.
3. Click Manage Preferred Credentials.

Credential Sets for Oracle E-Business Suite Database Login:
The following table lists the credential sets and the schemas they access:
**Credential Sets and Schemas for Oracle E-Business Suite Database Login**

<table>
<thead>
<tr>
<th>Name</th>
<th>Schema</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppsDBCredsSet</td>
<td>To access the APPS schema</td>
</tr>
<tr>
<td>AppsSysDBCredsSet</td>
<td>To access the SYSTEM schema</td>
</tr>
<tr>
<td>ApplsysDBCredsSet</td>
<td>To access the APPLSYS schema</td>
</tr>
</tbody>
</table>

**Set Default Preferred Credentials for Oracle E-Business Suite Database Login:**

If you want to set a preferred credential for the Oracle E-Business Suite Application Database which is applicable for all Oracle E-Business Suite targets, go to the Default Preferred Credentials section.

1. Select the Credential Set for the corresponding schema.
2. Click on **Set**.
3. Choose the named credentials and save. Only those named credentials with scope as “global” will appear in the list.

**Set Target Preferred Credentials for Oracle E-Business Suite Database Login:**

If you want to set a preferred credential for Oracle E-Business Suite Database Login applicable only to a specific Oracle E-Business Suite target, go to the Target Preferred Credential section.

1. Select the Oracle E-Business Suite instance.
2. Select Credential Set for the corresponding schema.
3. Click **Set**.
4. Choose the named credentials.
5. You can test and save the credentials.

**Preferred Credentials for Oracle E-Business Suite Node**

Preferred credentials for nodes are needed if you are using Customization Manager or Patch Manager. You must set them for both the applications node and database node. If
the Oracle E-Business Suite instance features online patching, then credentials must be set for targets in both the run and patch file systems.

Create Named Credentials for Oracle E-Business Suite Node Using Host Credentials:

1. Navigate to Setup menu > Security > Named Credentials and click Create.

2. Provide an appropriate name and description.

3. Select Host from the Authenticating Target Type drop-down list.

4. Select Host Credentials from the Credential Type drop-down list.

5. Select the scope:
   - If you choose Global, this named credential will be applicable for all Oracle E-Business Suite Nodes.
   - If you choose Target:
     - Select Oracle E-Business Suite Node as the target type.
     - Select the Oracle E-Business Suite Node for which this named credential is applicable.

6. Enter the user name and password in the credential properties.

7. You can test and save the credentials.
Create Named Credentials for Oracle E-Business Suite Node Using SSH Key Credentials:

1. Provide an appropriate name and description.

2. Select **Host** from the Authenticating Target Type drop-down list.

3. Select **SSH Key Credentials** from the Credential Type drop-down list.

4. Select the scope.
   - If you choose Global, this named credential will be applicable for all Oracle E-Business Suite Nodes.
   - If you choose Target:
     - Select Oracle E-Business Suite Node as the target type.
• Select the Oracle E-Business Suite Node for which this named credential is applicable.

5. Enter the user name and upload private and public keys.

6. You can test and save the credentials.
Set preferred credential for Oracle E-Business Suite Node:
1. Navigate to Setup menu > Security > Preferred Credentials.
3. Click Manage Preferred Credentials.

Set Default Preferred Credentials for Oracle E-Business Suite Node:
If you want to set a preferred credential for Oracle E-Business Suite Node which is applicable for all Oracle E-Business Suite nodes, go to the Default Preferred Credentials.
section.

1. Select **OS Credentials** as Credential Set.

2. Click **Set**.

3. Choose the named credentials. Only those named credentials with scope as "Global" will appear in the list.

4. You can test and save the credentials.

**Set Target Preferred Credentials for Oracle E-Business Suite Node:**
If you want to set a preferred credential for Oracle E-Business Suite Node applicable only to a specific Oracle E-Business Suite Node, go to the Target Preferred Credential section.


2. Select **OS Credentials** for Credential Set.

3. Click **Set**.

4. Choose the named credentials.

5. You can test and save the credentials.

**Preferred Credentials for Oracle WebLogic Server**
A preferred credential for Oracle WebLogic Server is needed if you are using Patch Manager. You must set it for the Admin server.

In addition, the WebLogic Administrator credentials must be set before you register a custom application on the patch edition in Oracle E-Business Suite Release 12.2.

**Create named credential for Oracle WebLogic Server:**

1. Navigate to **Setup menu >Security >Named Credentials** and click on the **Create** button.

2. Provide an appropriate name and description.

3. Select **Oracle WebLogic Server** from the Authenticating Target Type drop-down list.

4. Select **Oracle WebLogic Credentials** from the Credential Type drop-down list.

5. Select the scope.
• If you choose Global, then this named credential will be applicable for all WLS Servers.

• If you choose Target:
  • Select **Oracle WebLogic Server** as the target type.
  • Select the Oracle WebLogic Admin Server for which this named credential is applicable.

6. Enter the user name and password in the credential properties.

7. You can test and save the credentials.

---

**Set preferred credential for Oracle WebLogic Server:**

1. Navigate to **Setup** menu > **Security** > **Preferred Credentials**.

2. Select Oracle WebLogic Server.
3. Click on Manage Preferred Credentials.

**Set Default Preferred Credentials for Oracle WebLogic Server:**
If you want to set a preferred credential for Oracle WebLogic Server which is applicable for all Oracle E-Business Suite instances, go to the Default Preferred Credentials section.

1. Select **Oracle WebLogic Administration Credentials** for Credential Set.

2. Click **Set**.

3. Choose the named credentials. Only those named credentials with scope as "Global" will appear in the list.

4. You can test and save the credentials.

**Set Target Preferred Credentials for Oracle WebLogic Server:**
If you want to set a preferred credential for Oracle WebLogic Server of a specific Oracle E-Business Suite target, go to the Target Preferred Credential section.


2. Select **Oracle WebLogic Administration Credentials** as Credential Set.

3. Click **Set**.

4. Choose the named credentials.

5. You can test and save the credentials.

**Preferred Credentials for Host**
Host Preferred credentials must be set for the host from where files will be checked out by Customization Manager. This is the same host which is referenced in file source mapping. You must set the **Normal Username** and **Normal Password** for the host. Navigate to **Setup menu >Security >Preferred Credentials**. On the Preferred Credentials page, select **Host** and click **Manage Preferred Credentials**. On the Host Preferred Credentials page, set the operating system credentials of the host.
This chapter covers the following topics:

- Setting Preferences

### Setting Preferences

Use Preferences in Enterprise Manager to configure some of the features in Oracle Application Management Pack for Oracle E-Business Suite.

Navigate to the Preferences page from the Oracle E-Business Suite Management page through the **Administer** menu.
The following preferences can be set:

**For Patch Manager**
- Enforce Patch Promotion Policies
- Default Blackout Minutes in Patch Manager
- Default Blackout Hours in Patch Manager
- Target Patch Directory Location
• Connect to My Oracle Support for Patches (MOSEnabled)

• OMS Patch Stage Directory Location (required)
  This preference specifies the patch stage directory location. This preference is used in conjunction with the preference "MOSEnabled". If "MOSEnabled" is unchecked, then Patch Manager will use the "OMS Patch Stage Directory Location" in searching for patches.

• Target Stage Directory Location

**For Discovery and Monitoring**
• Maximum Number of Email Addresses for User (required)

• Sampling Interval for User Monitoring (required)

• Delete Application Server targets while deleting EBS Target - By default, the system deletes application server targets (like the HTTP server, OC4J, and so on) when deleting the parent Oracle E-Business Suite target. If you do not want all the application server targets deleted, deselect this check box.

• Number of Rows in Tables of User Monitoring (required)

**For Customization Manager**
• Stage Directory (required)
  This preference specifies the OMS stage directory for package creation.

**For Cloning**
• Number of threads to be used to zip, transfer, and unzip files under APPL_TOP of Apps Tier (Maximum value is 16)

• Number of threads to be used to zip, transfer, and unzip files under COMMON_TOP of Apps Tier (Maximum value is 4)

• Number of threads to be used to zip, transfer, and unzip files under Web home of Apps Tier (Maximum value is 4)

• Number of threads to be used to zip, transfer, and unzip files under Tools home of Apps Tier (Maximum value is 8)
This chapter covers the following topics:

- Privileges and Roles for Managing Oracle E-Business Suite
- Change Management Privileges
- Specific Privileges for Features

Privileges and Roles for Managing Oracle E-Business Suite

Oracle Application Management Pack for Oracle E-Business Suite uses the native Enterprise Manager functionality of privileges and roles for security.

User privileges provide a basic level of security in Oracle Enterprise Manager. They are designed to control user access to data and to limit the kinds of SQL statements that users can execute. When creating a user, you grant privileges to enable the user to connect to the database, to run queries and make updates, to create schema objects, and more.

A role is a collection of Oracle Enterprise Manager resource privileges, or target privileges, or both, which you can grant to administrators or to other roles. Resource privileges allow a user to perform operations which are not dependent on a specific target type. Target privileges allow an administrator to perform operations on a target. This management pack includes target-instance level privileges, which are for a particular target instance, and target-type level privileges, which are for all target instances of that type. An example of a resource privilege is the "Edit Global Preferences" resource privilege, which enables a user to edit global preferences for Oracle Application Management Pack for Oracle E-Business Suite. An example of a target-instance level privilege is the "Start and Stop Services" which enables a user to start and stop services using the Administration menu for a given instance.

Privileges and roles are managed through the functions available from Setup menu > Security in the Cloud Control console. For more information, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

Ready-to-use privileges shipped with the management pack are listed in the tables.
below. Please note the following in regard to privileges:

- The user SYSMAN has all the listed privileges by default.

- The use of privileges on a system is enabled by default, which means that a user will not be able to perform an action unless the appropriate privilege(s) are granted to that user.

- All target privileges are given against the target "Oracle E-Business Suite."

- Each privilege listed in the tables below does not include any other privilege. For example, the "Approve release package request" privilege does not include the privilege "Create release package request".

The table below lists ready-to-use resource privileges in Oracle Application Management Pack for Oracle E-Business Suite. These resource privileges are to be granted while creating or updating users in the "EM Resource Privileges" screen under the resource type "Oracle E-Business Suite Plug-in".

**Resource Privileges**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create release package request</td>
<td>This privilege is required to access any Customization Manager page.</td>
</tr>
<tr>
<td></td>
<td>Specifically, this privilege is used to create a request to release a package.</td>
</tr>
<tr>
<td>Approve release package request</td>
<td>Used to approve the release of a package.</td>
</tr>
<tr>
<td>Create/edit approval hierarchy</td>
<td>Used to create or edit approval hierarchies for the approval process of change requests.</td>
</tr>
<tr>
<td>Raise Customization Discovery Request</td>
<td>Used to create a request to discover customizations.</td>
</tr>
</tbody>
</table>

The following table lists ready-to-use target instance level privileges. With these privileges, a user can perform the specified action against only the given target.
### Target Privileges

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create splice request</td>
<td>• To create a request to register a new custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to validate an existing custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to auto-correct an existing invalid custom application</td>
</tr>
<tr>
<td>Approve splice request</td>
<td>• To approve a request to splice an application</td>
</tr>
<tr>
<td></td>
<td>• To hide and unhide custom applications</td>
</tr>
<tr>
<td>Create Patch Manager request</td>
<td>To create a Patch Manager request</td>
</tr>
<tr>
<td>Approve Patch Manager request</td>
<td>To approve a Patch Manager request</td>
</tr>
<tr>
<td>Start and Stop Services</td>
<td>To start and stop services using the Administration Dashboard</td>
</tr>
</tbody>
</table>

The following table lists ready-to-use target type level privileges. With these privileges, a user can perform the described action against any eligible target.

### Target Type Level Privileges

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create splice request</td>
<td>• To create a request to register a new custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to validate an existing custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to auto-correct an existing invalid custom application</td>
</tr>
</tbody>
</table>
Approve splice request

- To approve a request to splice an application
- To hide and unhide custom applications

Create Patch Manager request
To create a Patch Manager request

Approve Patch Manager request
To approve a Patch Manager request

Use advanced options in Oracle E-Business Suite Patching
To use advanced options while patching, such as HotPatch Mode

Start and Stop Services
To start and stop services using the Administration Dashboard

The following table lists ready-to-use roles:

<table>
<thead>
<tr>
<th>Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>EBS_SUPER_USER</td>
</tr>
<tr>
<td>Code</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>EBS_ACP_SUPER_USER</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Change Management Privileges**

Change Management for Oracle E-Business Suite provides a centralized view to monitor and orchestrate changes (both functional and technical) across multiple Oracle E-Business Suite systems. Change Management offers the capabilities to manage changes introduced by customizations, patches, and functional setups during implementation or maintenance activities. For more information, see: Introduction to Change Management, page 15-1.

The Change Approval process helps ensure that all changes done using any of the products in Change Management go through a change approval mechanism. This change control mechanism is a multilevel approval process for any change that results in a configuration or code change of an Oracle E-Business Suite instance. The Change Approval process uses privileges and roles to enforce the approval process.

**Required Privileges and Roles**

The seeded "Change Management Super User" role (code EBS_ACP_SUPER_USER) has privileges to submit and approve all Change Management requests.

For more information on these privileges, see: Privileges and Roles for Managing Oracle E-Business Suite, page 7-1.

A user must have the "Operator any Target" privilege in order to submit a patch run in
Patch Manager, create a package in Customization Manager, or register a custom application. This privilege is described as:

- Name - Operator any Target
- Description - Ability to perform administrative operations on all managed targets
- Included Privileges - View any Target
- Applicable Target Types - All Target Types

In addition to the above Target Type privilege, a user must have the "Job System" resource privilege, as described below:

- Name - Job System
- Description - Job is a schedulable unit of work that administrator defines to automate the commonly run tasks
- Privilege Grants Applicable to all Resources - Create

**Note:** You must also assign the resource type privilege of "Create" to the user using the "Manage Privilege Grants" feature, available from Setup menu > Security > Administrators. For more information on managing privilege grants, see the Oracle Enterprise Manager Cloud Control documentation.

**Note:** To view development procedures submitted by other users in Patch Manager, the user should also have the "Edit Any Procedure Configuration" resource privilege under "Job System."

### Specific Privileges for Features

The default roles EBS_SUPER_USER and EBS_ACP_SUPER_USER provide privileges on all targets. If these roles are provided to a particular user, there is no need to provide any specific privileges to that user. If you want to provide specific privileges to a user, follow the instructions in this section, which describe specific privileges for Cloning, Patch Manager, and Customization Manager.

There are two types of required privileges: Target Privileges and Resource Privileges.

#### Target Privileges

1. Common privileges
• Module: Customization Manager/Patch Manager
  • View any Target
  • Execute Command Anywhere
  • Execute Command as any Agent

• Module: Cloning
  • View any Target
  • Execute Command Anywhere
  • Execute Command as any Agent
  • Operator any Target
  • Add any Target

2. Application Change Management (ACMP) specific privileges
• Module: Customization Manager
  • Requestor: Create splice request
  • Approver: Approve splice request
  • Super User: Both

• Module: Patch Manager
  • Requestor: Create Patch Manager request
  • Approver: Approve Patch Manager request
  • Super User: Both

3. Oracle E-Business Suite Patching privileges
• Use of advanced patching options

All above privileges can be provided either as "Common to All Targets" or "Specific to Target" by adding a target at the bottom of the Target Privilege screen and editing the target-specific privilege.

Note: The following privileges are not present as part of Target Specific
Privileges but they are included under "Operator":

- View Any Target
- Execute Command Anywhere
- Execute Command as any Agent
- Operator any Target

### Resource Privileges

To grant Resource Privileges, click Edit for each Resource Privilege and select the sub-privileges.

1. **Common Privileges:**
   - Module: ALL
     
     Edit the following Resource Types in the Resource Privileges screen and select the privileges.
     - Job System
     - Deployment Procedure
     - Oracle E-Business Suite Plug-in

2. **Change Management-Specific Privileges**
   - Module: Customization Manager, Patch Manager
     
     Edit the Resource Type "Oracle E-Business Suite Plug-in" in the Resource Privileges screen and select the following privileges.
     - Requestor: Create release package request
     - Approver: Approve release package request
     - Super User: All
     - Edit global preferences
     - Create/edit approval hierarchy

All above privileges can be provided either "Common to All Targets" or "Specific to Target" by adding a target on the Resource Privilege page and selecting the applicable targets.
Monitoring Oracle E-Business Suite

This chapter covers the following topics:

- Navigation and Overview
- Home Page of an Oracle E-Business Suite System Instance
- Incidents and Problems for an Oracle E-Business Suite Target
- Embedded RUEI Region on the Oracle E-Business Suite Summary Page
- Patch Recommendations for Oracle E-Business Suite and Technology Stack
- Compliance Standards for Oracle E-Business Suite
- Monitoring Online Patching to Detect Cutover
- Monitoring Current Activity
- Monitoring User Sessions
- Monitoring JVM Usage
- Monitoring Templates for Oracle E-Business Suite
- Enabling Service Tests and Beacons Link
- Drilling Down to Oracle Applications Manager
- Services
- Concurrent Processing Dashboard
- Oracle E-Business Suite Summary on the Exalogic Dashboard
- End-To-End Performance Monitoring with RUEI and JVMD
- Setting up End-to-End Monitoring
- Analyzing a Performance Issue
- Drilling Down from RUEI to the Plug-In
- Custom Metrics
- Custom Compliance Rules
• Purging of Metrics

Navigation and Overview

Once discovered, an Oracle E-Business Suite instance will appear in the Oracle E-Business Suite Instances section on the Oracle E-Business Suite Management page. Click on the name of the instance to go to the home page of that instance.

Oracle E-Business Suite System

Oracle E-Business Suite is discovered as a system. The members of the system include all nodes and targets that run on each node. To see the members, click on the instance target menu (labeled "Oracle E-Business Suite") and select Members > Show All.

Topology of the Oracle E-Business Suite System

The Configuration Topology Viewer provides a visual layout of the Oracle E-Business Suite system with its child targets. To access the Configuration Topology Viewer, select Members > Topology from the Oracle E-Business Suite instance target menu.

Upon service failure, the potential causes of failure as identified by root cause analysis, are highlighted in the topology view. You can view dependent relationships between services and systems from the Topology tab.

Using the topology view, you can:

• Determine the source of a target's health problems

• Analyze the impact of a target on other targets

• Determine the system's structure by viewing the members of a system and their interrelationships

Metrics

Once discovered, metrics are collected for an Oracle E-Business Suite system as well as its individual members. To see the metrics collected for any target, select Monitoring > All Metrics from the Oracle E-Business Suite instance target menu.


Setting Thresholds for Metrics

Metrics collected can be compared to predefined values to check if they are exceeding a critical threshold or a warning threshold. Incidents are generated once the threshold is exceeded. To see the thresholds defined for metrics of any target, select Monitoring > Metric and Collection Settings from the instance target menu. Here you can set the
Critical/Warning thresholds used to generate incidents. You can also change the collection schedule of the metrics here.

For more information on incidents, see: Incidents for an Oracle E-Business Suite Target, page 8-7.

**Home Page of an Oracle E-Business Suite System Instance**

The home page of an Oracle E-Business Suite instance provides you with the following regions: Overview, Services, Targets Running on Nodes, Incidents and Problems, Oracle E-Business Suite Patch Recommendation, and Compliance Summary. Information about each region is provided below and in more detail in the remainder of this chapter.

**Overview Region**

The Overview region provides general information and statuses of the Oracle E-Business Suite instance.

**General Section**

Details about the Oracle E-Business Suite instance in the General section are shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configured Components</td>
<td>The count of member targets that fall into the status categories of Up, Down, or Other. You can drill down on a status category to view the targets that currently fall into that category.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System Name</td>
<td>The name of the Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Version</td>
<td>The version of the Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Products Licensed</td>
<td>The number of products licensed on the Oracle E-Business Suite system.</td>
</tr>
<tr>
<td>New Internal System Alerts</td>
<td>The number of new System Alerts generated in the Oracle E-Business Suite instance. Note that these System Alerts originate from the alerting infrastructure of Oracle E-Business Suite. These are complementary to the Oracle Enterprise Manager incidents.</td>
</tr>
<tr>
<td>Patches Applied</td>
<td>The number of patches applied to the system in the last 24 hours.</td>
</tr>
<tr>
<td>Site Level Profile Options</td>
<td>The number of site level profile options that have changed on the system in the last 24 hours.</td>
</tr>
<tr>
<td>Context Files Edited</td>
<td>The number of AutoConfig context files that was changed on the system in the last 24 hours.</td>
</tr>
<tr>
<td>Monitoring Host</td>
<td>The host of the agent which is monitoring the Oracle E-Business Suite system. This will be the host where the database is running.</td>
</tr>
</tbody>
</table>

**Note:** The New Internal System Alerts, Patches Applied, Site Level Profile Options Changed, and Context Files Edited metrics are based on information periodically summarized in the Oracle E-Business Suite database by the Oracle Applications Manager Dashboard Collection concurrent program. This program is controlled through the Preferences global link in Oracle Applications Manager. If this program has been disabled in the Oracle E-Business Suite system for any reason, then these metrics will not be updated.
Availability Status Charts
This portion of the Overview region is made up of three charts which depict the following:

- Status of the Configured Components.
- Historic information about the availability status of the Oracle E-Business Suite instance. You can choose to view data from the last day, week, or month.
- Status of the services.

Services Region
Oracle E-Business Suite and its member targets provide four major services to its customers. They are:

- Concurrent Processing
- Forms
- Self-Service Pages
- Workflow

All these services are registered with Cloud Control once the successful discovery of the Oracle E-Business Suite target is completed. The Services section on the home page of the Oracle E-Business Suite instance has the details of services.

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Performance Incidents</th>
<th>Usage Incidents</th>
<th>System</th>
<th>Key Components Status</th>
<th>Key Components Incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROD_Oracle Applications Service</td>
<td><img src="Green" alt="Green" /></td>
<td>0</td>
<td>0</td>
<td>PROD_Oracle E-Business Suite</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>PROD_Concurrent Processing Service</td>
<td><img src="Green" alt="Green" /></td>
<td>0</td>
<td>0</td>
<td>PROD_Oracle E-Business Suite</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>PROD_Forms Applications Service</td>
<td><img src="Green" alt="Green" /></td>
<td>0</td>
<td>0</td>
<td>PROD_Oracle E-Business Suite</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>PROD_Self-Service Applications Service</td>
<td><img src="Green" alt="Green" /></td>
<td>0</td>
<td>0</td>
<td>PROD_Oracle E-Business Suite</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

Each service has a set of critical components without which the service cannot be provided. The following table lists the critical component of each service.
### Critical Components of Services

<table>
<thead>
<tr>
<th>Service</th>
<th>Critical components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent Processing</td>
<td>• Internal Concurrent Manager</td>
</tr>
<tr>
<td></td>
<td>• Concurrent Manager</td>
</tr>
<tr>
<td></td>
<td>• Database</td>
</tr>
<tr>
<td></td>
<td>• Apps Listener</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>• Concurrent Processing Service</td>
</tr>
<tr>
<td></td>
<td>• Oracle Workflow Background Engine</td>
</tr>
<tr>
<td></td>
<td>• Oracle Workflow Agent Listener</td>
</tr>
<tr>
<td></td>
<td>• Oracle Workflow Notification Mailer</td>
</tr>
<tr>
<td>Forms Applications Service</td>
<td>• Forms server (OC4J/WLS)</td>
</tr>
<tr>
<td></td>
<td>• HTTP Server</td>
</tr>
<tr>
<td></td>
<td>• Database</td>
</tr>
<tr>
<td>Self-Service Applications Service</td>
<td>• OACORE Server (OC4J/WLS)</td>
</tr>
<tr>
<td></td>
<td>• HTTP Server</td>
</tr>
<tr>
<td></td>
<td>• Database</td>
</tr>
</tbody>
</table>

More information on services is provided later in this chapter.

### Targets Running on Nodes

This section shows the targets running on each node in which the Oracle E-Business Suite is deployed. The data is shown in a hierarchical way with the host as the topmost parent. The nodes running on that host appear as the immediate children. The individual targets running on each node will appear as the child of each node. If the Oracle E-Business Suite instance features Online Patching, only run edition targets will be shown.
Tip: Click **Detach** to view the table on a separate page. This feature is useful if your table has more rows than can be shown in the default display.

Incidents and Problems for an Oracle E-Business Suite Target

Incidents and problems will be raised if any member of the Oracle E-Business Suite system is down or if any metric has exceeded its threshold. The Incidents and Problems region on the Oracle E-Business Suite instance home page gives an overview of the incidents raised for that instance. You can get the number of incidents grouped by severity. In addition, you can filter incidents based on the type of incident, such as availability, performance, security, and so on. You can drill down to the details of each issue by clicking on the Summary column which takes you to the Incident Manager. The Incident Manager page is where you can view more details of the event. You can track and manage the incident from here as well.

Embedded RUEI Region on the Oracle E-Business Suite Summary Page

Real User Experience Insight, or RUEI, is a powerful, web-based utility used to report on real-user traffic requested by and generated from your network. RUEI regions can now be embedded within the Oracle E-Business Suite Summary page.

The following RUEI regions are embedded in the Summary page:

- Key performance indicators

- Top Users
• **Top User and Application Violations**

![Top User and Application Violations](image)

- **Violation Metrics**
  - Application Violation Page Views: 1
  - User Violation Page Views: 0
  - Web SSO Error Page Views: 0
  - Server Error Page Views: 0
  - Network Error Page Views: 0
  - Content Error Page Views: 0

• **Top User Flows**

![Top User Flows](image)

- **User Flow Name: defaultFlow**
  - Failed: 0
  - Completed: 0
  - Stopped: 0
  - Stop with Highest % Stopped: No Criteria to Display

• **Top User Requests**

![Top User Requests](image)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ebs_02/Show</td>
<td>3</td>
<td>7.4</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>100</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ebs_02/Select</td>
<td>3</td>
<td>2.1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

The Key Performance Indicators region is shown by default. You can activate other regions using personalization features.
For more details and information on how to configure RUEI with Oracle E-Business Suite, refer to the *Oracle Real User Experience Insight Installation Guide*.

**Patch Recommendations for Oracle E-Business Suite and Technology Stack**

Oracle E-Business Suite customers must ensure Oracle recommended patches are applied to their Oracle E-Business Suite environments. These recommended patches are made available through My Oracle Support.

Patch Recommendations are provided for Oracle E-Business Suite and Technology Stack. Patches are recommended for three different components:

- Oracle E-Business Suite
- Oracle Database
- Oracle Application Tier Technology

The Patch Recommendation functionality works as follows:

- By default, a background collection job is run daily to collect a list of recommended patches for Oracle E-Business Suite and the Technology Stack.
  - The pre-defined background job named "REFRESH EBS PATCH UPDATES.1" of job type "Refresh Oracle E-Business Suite Patch Recommendation" downloads patch information from My Oracle Support to the OMS Patch Stage Directory location.
  - This job is scheduled to run every day, although Administrators can reschedule it according to their needs.

- Applied patch information is collected from the respective Oracle E-Business Suite environments.

- A list of recommended patches are compared with already applied patches. Recommended patches which have not yet been applied are displayed.

Oracle Application Management Pack for Oracle E-Business Suite Release 13.1 includes 2 major enhancements:

- In the case of multi-node instances, patch recommendations are performed for all nodes of the Oracle E-Business Suite for both the run and patch file systems for Application Tier Technology. For RAC databases, patch recommendations are performed for all instances within the RAC database.

- Patches recommended for Oracle WebLogic Server and Oracle Database can now be applied from the E-Business Suite Patch Recommendation Details page.
Oracle recommends that customers enable My Oracle Support to use the Patch Recommendations functionality. However, for those customers who have security restrictions and do not prefer to enable My Oracle Support, see the section Settings in Oracle E-Business Suite, page 8-10 for an alternate option.

If you are enabling a My Oracle Support connection, follow the instructions in the section Settings to Enable Patch Recommendations, page 8-10.

**Settings to Enable Patch Recommendations**

The following settings must be set in order to enable the Patch Recommendation feature:

**Required Privileges**

The user must have the following privileges on the respective target to utilize Patch Recommendation functionality.

**To View Patch Recommendations**

The user must have:

- Operator privileges on the Oracle E-Business Suite target
- View privileges on the Oracle WebLogic domain for Oracle E-Business Suite and view privileges on the Oracle home targets of Oracle Forms and Reports, Oracle Web Tier and Oracle Fusion Middleware common

**To Create or Apply an Oracle Enterprise Manager Patch Plan**

In addition to the above "view patch" privileges, to create or apply an Oracle Enterprise Manager patch plan the user should also have the following privileges:

- Operator privileges on the Oracle WebLogic Server and Oracle Database
- Create Oracle Enterprise Manager patch plan privileges

**Settings in the OMS**

- Set the My Oracle Support credentials.
- For information on setting preferred credentials, see Setting Credentials, page 5-1.

**Settings in Oracle E-Business Suite**

The following settings should be set in the Patch Manager section of the Preferences page:

- Set the OMS patch stage directory to a location where patches and patch
recommendation information can be downloaded and searched. The directory must be accessible from OMS.

- To allow automatic downloading of Patch Recommendation information, ensure "Connect to My Oracle Support for Patches" is enabled.

If "Connect to My Oracle Support for Patches" is disabled due to some reason such as the connection to My Oracle Support being unavailable on the OMS instance, the Patch Recommendation feature can still be used by following the steps below:

1. Disable "Connect to My Oracle Support for Patches" from Oracle E-Business Suite Preferences.
3. Download patch 17353079 from My Oracle Support.
4. Copy the zip files to the OMS Patch Stage Directory Location.
5. Click on the Refresh button in the Oracle E-Business Suite & Technology Stack Patch Recommendation region. This will collect a list of recommended patches from the OMS staging directory that need to be applied to the instance.

Oracle E-Business Suite & Technology Stack Patch Recommendation Region

By default, you can find the Oracle E-Business Suite & Technology Stack Patch Recommendations region on the Oracle E-Business Suite instance target home page.

The bar graph in this region shows a summary of recommended patches to be applied on the specific Oracle E-Business Suite instance. Hover over each bar to see the number of recommended patches for a particular product. Click on any bar in the bar graph to drill down to the next section which provides details on the individual patches for each technology component of the Oracle E-Business Suite Technology stack.

Oracle E-Business Suite & Technology Stack Patch Recommendation Region
**Note:** For Release 12.1 instances, the name of this region is "Oracle E-Business Suite Patch Recommendation."

Descriptions of the elements in this region are as follows:

- **Patch Data Collection Job Status** link - This link takes you to a detailed status page of the patch data collection job status. Enter text in the search field and click Go to display your search results, which provides you with procedure activity details.

- **Last Refreshed Date** - This time stamp reflects the date and time when the list of recommended patch data was collected from My Oracle Support.

- **Refresh** button - It is generally not required to refresh the results as the data is collected each day. However, if the "Last Refreshed Date" is very old or if you want to ensure the data collection happens again, then you can click Refresh to collect the latest list of recommended patches.

**Note:** Oracle E-Business Suite Application Patch Recommendations are available for Release 12.1.3 and later.

Oracle E-Business Suite Technology Stack Patch Recommendations including Database and Application Tier Patch Recommendations are available only for Oracle E-Business Suite Release 12.2 or later.

**Patch Recommendation Details**

As mentioned previously, clicking on any bar in the graph in the Oracle E-Business Suite & Technology Stack Patch Recommendation region shows you the details of the patches to be applied on Oracle E-Business Suite and each technology component of the Oracle E-Business Suite Technology stack.

**Oracle E-Business Suite Application Patch Recommendations**

The E-Business Suite tab drills down into the Oracle E-Business Suite recommended patch details.
Elements in this region are as follows:

- **Patch Information Bundle Creation Date** - The date/time stamp when Oracle created the patch information bundle. As data collection from My Oracle Support takes place on a daily basis, this date also indicates the date on which the data was last collected from My Oracle Support.

- **Unapplied Patches** - The number of recommended patches that need to be applied to this specific Oracle E-Business Suite instance.

- **Last Refreshed Date** - This time stamp reflects the date and time when the list of recommended patch data was collected.

- **Applied Patch Data Collection Date** - The date and time in which the patches applied data was collected from the Oracle E-Business Suite instance. This collection job is run by the OMS agent on the Oracle E-Business Suite targets to collect applied patch information.

- **Search** - Use the drop-down list and text field to search for recommended patches for a particular product, product short name, or patch number.

- **View** drop-down - Provides table viewing options.

- **Patch Deployment Procedure** - This drop-down list of values allows you to select the right patch deployment procedure specific to the Oracle E-Business Suite release. If you have any custom deployment procedures, that value will also be displayed in the list of values.

- **Apply Patches** button - When clicked, this button will direct you to the patch interview pages of the appropriate patch interview process.

- **Export** - Use to export a list of recommended patches to an Excel file.

- **Detach** - Detach the table into a fullscreen window.
• **Product Short Name** column - Select the check box beside the column name to select all patches.

• **Product Name** column

• **Patch Count** column

• **Patch Number** column

• **Readme** column - Displays a link to view the patch readme file from My Oracle Support. If MOS credentials are not set, then a "No Readme Available" message will be displayed.

• **Description** column

---

**Oracle E-Business Suite Application Tier Technology Patch Recommendations**

**Note:** This section is relevant for Oracle E-Business Suite Release 12.2 and later.

The **Application Tier Technology** tab includes sub-tabs detailing the recommended patches for the following Oracle E-Business Suite application tier technology components:

• Forms & Reports

• Oracle WebLogic Server

• WebTier

• Oracle FMW Common
Elements in these regions are as follows:

- **Patch Recommendation Information Creation Date** - The date/time stamp when Oracle created the patch recommendation information.

- **Last Refreshed Date** - This time stamp reflects the date and time when the list of recommended patch data was collected.

- **Distinct Unapplied Patches** - The number of recommended patches that need to be applied to this specific Oracle E-Business Suite instance.

- **Online Patching Cycle Status** - The status of the online patching cycle on the Oracle E-Business Suite instance. If the cycle has not started, click the “Start Online Patching Cycle” link to initiate an interview process to create Online Patching Cycle.
in the environment.

- **View** drop-down - Provides table viewing options.

- **Refresh** button - Clicking on the Refresh button will display a listing of Oracle homes which can be used to fetch applied patch information of the target. This also displays the date/time in which applied patch information was last collected from the target.

- **Export** button

- **Detach** button

- **Patch Number** column - Lists the recommended patches for a particular file system on a host in a tree structure. Clicking on the patch number opens the readme of the patch. Clicking on "run" or "patch" displays the host, date/time of last applied patch information collection date, and Oracle home information of the target.

- **Patch Version** column - Displays the version of the patch that is recommended

- **Footnote** column - Provides special instructions which must be followed when applying the patch

- **Description** column - Displays the patch readme file from My Oracle Support. If MOS credentials are not set, then a "No Readme Available" message will be displayed.

Under the **Oracle WebLogic Server** sub-tab, you can find the following additional elements:

- **Create EM Patch Plan** button - Creates an Enterprise Manager patch plan which is used to deploy selected patches to your environment. In a multi-node instance, even if a patch is selected from only one node, it will be applied to all nodes in a domain.

- **Add to Existing EM Patch Plan** button - Adds additional patches to an existing Enterprise Management patch plan.

- **Schedule EM Patch Plan** button - Shows a list of Enterprise Manager patch plans created for the target.

**Note:** Oracle Database and Oracle Application Tier Technology patches may be listed, despite already being applied. This may be due to the fact that some patches have bug fixes spawning to other patches. Apply all patches, in sequence, as listed in the table and then click the Refresh link to recollect the applied patch metrics from the target to view the correct patch recommendations.
**Note:** For Oracle WebLogic Server, it is highly recommended to apply patches on the patch file system. Applying a patch on the run file system returns a warning message recommending that you apply the patch on the patch file system.

**Patches Recommended for Oracle Database**

**Note:** This section is relevant for Oracle E-Business Suite Release 12.2 and later.

The **Database** tab displays Oracle E-Business Suite database patch recommendation details. In the case of RAC instances, it displays patch recommendations for all nodes of the database.

Elements in this region are as follows:

- **Patch Recommendation Information Creation Date** - The date/time stamp when Oracle created the patch recommendation information. As data collection from My Oracle Support takes places on a daily basis, this date also indicates the date on which the data was last collected from My Oracle Support.

- **Last Refreshed Date** - This time stamp reflects the date and time when the list of recommended patch data was collected.

- **Distinct Unapplied Patches** - Number of recommended database patches that need to be applied to this specific Oracle E-Business Suite instance.

- **View** drop-down menu - Provides table viewing options.

- **Create EM Patch Plan** button - Creates an Enterprise Manager patch plan which is used to deploy selected patches to your environment. On a RAC instance, even if a patch is selected from one node, it will be applied to all the nodes in the cluster.

- **Add to Existing EM Patch Plan** button - Adds additional patches to an existing Enterprise Management patch plan.
• **Schedule EM Patch Plan** button - Shows a list of Enterprise Manager patch plans created for the target.

• **Refresh** button - Clicking on the Refresh button will display a listing of Oracle homes which can be used to fetch applied patch information of the target. This also displays the date/time in which applied patch information was last collected from the target.

• **Export** - Use to export a list of recommended patches to an Excel file.

• **Detach** - Detach the table into a fullscreen window.

• **Patch Number** column - Lists the recommended patches.

• **Patch Version** column - Displays the version of the patch that is recommended.

• **Footnote** column - Provides special instructions which must be followed when applying the patch.

• **Description** column - Provides a description of the patch.

When applying Oracle Database patches from Oracle Enterprise Manager, you should be aware of the different modes of patching available.

**Note:** Currently, the Patch Recommendation feature for Oracle Database is not available for in-memory databases.

There are two modes of patching which Oracle Enterprise Manager supports for database patching: "In Place" and "Out of Place".

• When the In Place mode is selected, the Oracle home is patched.

• When Out of Place is selected, then the database Oracle home is cloned and the cloned home is patched. Then, Oracle Enterprise Manager will establish the cloned home as the new Oracle home.

For Oracle E-Business Suite, the Out of Place patching mode does not work as the database home of Oracle E-Business Suite is customized and is not the same as an Oracle Database home. If patches are applied in this mode, the patch deployment will fail. Therefore, the In Place patching mode should be used while patching Oracle E-Business Suite database from Oracle Enterprise Manager.

For more details on applying database patches from Oracle Enterprise Manager, see the *Oracle Enterprise Manager Lifecycle Management Administrator’s Guide*.

**EM CLI Verbs for Listing Recommended Database Patches**

To list all the patches which are recommended for Oracle Database, use the following command after logging in to EM CLI:
emcli ebs_patch_list -component="database" -target_name="Oracle E-Business Suite target name"

An example run of the command and output is as follows:
emcli ebs_patch_list -component="database" -target_name="orcl_Oracle E-Business Suite"
#Target Name,Host,Instance,Patch Number,Patch Version
orcl_Oracle E-Business Suite,***.***.***.***,orcl,20887355,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,2153266,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,2223463,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,19908836,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,21321429,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,21843138,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,21864513,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,21904072,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,21967332,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,22098146,12.1.0.2.0
orcl_Oracle E-Business Suite,***.***.***.***,orcl,22496904,12.1.0.2.0

EM CLI Verbs for Applying Recommended Patches
To apply Oracle E-Business Suite recommended patches to Oracle Database, use the following command after logging in to EM CLI:
emcli patch_ebs_db -ebs_db_patch_file="<fully qualified path of properties file>"
The input properties file is described in the verb itself which can be shown by using the following command:
emcli help patch_ebs_db
An example run of the command and output is as follows:
emcli patch_ebs_db -ebs_db_patch_file=/tmp/patch.properties

Note: Patching Oracle Database with the *emcli* verb 'patch_ebs_db' requires preferred credentials for the Oracle home target associated with the Oracle Database target to be set.

Compliance Standards for Oracle E-Business Suite
Compliance evaluation generates a score for a target which indicates how much the
target is compliant with the standard. Violation of a standard can be classified as Critical, Warning or Minor Warning.

The management pack includes a set of compliance standards for Oracle E-Business Suite security which will be associated to every Oracle E-Business Suite instance once it is discovered. Evaluation will happen periodically, which will ensure that the Oracle E-Business Suite is configured in a secure way.

The following table lists details of the compliance standards shipped along with the compliance rules associated with them.

### Compliance Standards

<table>
<thead>
<tr>
<th>Compliance Standard</th>
<th>Rules Mapped to the Standard</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checks for profile validations in Oracle E-Business Suite</td>
<td>Checks for profile errors in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Checks for profile validations in Oracle E-Business Suite</td>
<td>Checks for profile warnings in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Checks for profile validations in Oracle E-Business Suite</td>
<td>Checks for profiles, missing in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 11gR2 Database</td>
<td>Checks for default Database password users in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 11gR2 Database</td>
<td>Checks the Database will be completely compatible with the software version 11gR2</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 11gR2 Database</td>
<td>Checks if parallel execution and Oracle RAC parameter set to recommended value for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 12cR1</td>
<td>Checks if parallel execution and Oracle RAC parameter set to recommended value for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 12cR1</td>
<td>Checks the Database will be completely compatible with the software version 12cR1</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 12cR1</td>
<td>Checks if optimizer parameters used to turn off automatic statistics is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance Standard</td>
<td>Rules Mapped to the Standard</td>
<td>Severity</td>
</tr>
<tr>
<td>------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite 12cR1</td>
<td>Checks for default Database password users in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Checks for default APPL password users in Oracle E-Business Suite</td>
<td>Checks for default application password users in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>APPLSYS PUB unnecessary privileges check for Oracle E-Business Suite</td>
<td>APPLSYS PUB unnecessary privileges check for Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Server security check for Oracle E-Business Suite</td>
<td>Server security check for Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Checks for hashed passwords in Oracle E-Business Suite</td>
<td>Checks for hashed passwords in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Checks if SSL (HTTPS) is enabled in Oracle E-Business Suite</td>
<td>Check if SSL (HTTPS) is enabled in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Checks for mod security in Oracle E-Business Suite</td>
<td>Checks for mod security in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Credit card encryption check in Oracle E-Business Suite</td>
<td>Credit card encryption check in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Credit card encryption check in Oracle E-Business Suite</td>
<td>Supplement credit card encryption check in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Credit card encryption check in Oracle E-Business Suite</td>
<td>Enhanced hashing in Oracle E-Business Suite</td>
<td>Warning</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the parameter work area size policy is set to the default recommendation</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the use of bitmap plans optimizer parameter is set to the default recommendation</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance Standard</td>
<td>Rules Mapped to the Standard</td>
<td>Severity</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if NLS date default format is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if block size for Oracle E-Business Suite is 8K</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the create columns semantics is using byte by default for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the total size of the SGA is configured set to the default recommendation for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if version 7 dictionary accessibility support for Oracle E-Business Suite is set to False</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the Cost Based Optimizer is set to FALSE for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the treat LIKE predicate with bind as an equality predicate optimizer parameter is set to suggested value</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the index fast full scan configuration set to the default recommendation</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks for cursor sharing mode in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the system management undo parameter is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the cost ratio for sort elimination optimizer parameter is set to suggested value for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
</tbody>
</table>
### Compliance Standard

<table>
<thead>
<tr>
<th>Compliance Standard</th>
<th>Rules Mapped to the Standard</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if optimizer parameters used to turn off automatic statistics is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the database system triggers has been enabled for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance for Oracle E-Business Suite Database Configuration Standards</td>
<td>Checks if the Real Application Clusters parameter is set to TRUE startup in cluster</td>
<td>Critical</td>
</tr>
</tbody>
</table>

The Compliance Standards region on the home page of the Oracle E-Business Suite instance provides details of the evaluations performed on that instance and how many violations there are. You can click on each standard to view further details of evaluations per rule. Each standard comes with a recommendation on how to fix the violations for that standard.

**Note:** Compliance standards will not be set for Oracle E-Business Suite instances discovered using the previous releases of the management pack. You must rediscover an instance to attach compliance standards to it.

---

### Monitoring Online Patching to Detect Cutover

If the Oracle E-Business Suite target features online patching, false incidents will be raised for the patch edition targets being down or the whole Oracle E-Business Suite being down during cutover. To prevent this, the system keeps checking the patching activities to see if any cutover is in progress. Corrective actions are triggered once a cutover is detected. If there is any cutover in progress, the whole Oracle E-Business Suite target will be blacked out. This is true if the patching is done either from Patch Manager or Oracle E-Business Suite console. Once the cutover is complete (success or failure) the corrective actions will end the blackout of the Oracle E-Business Suite target and black out the correct patch edition.

### Important Points to Note

- The system should detect the cutover within 15 minutes, although there may be a delay depending on the load on the OMS and Agent.
- Blackout is an asynchronous activity. Incidents may be raised even before blackout
comes into effect. It is safe to ignore those incidents.

- You will not be able to perform any management activities like cloning or package creation while corrective actions are in progress.

- If the corrective actions fail to sync up the editions, you can do so manually. See: Administration of Oracle E-Business Suite, page 10-1.

- If you upgraded the management pack from Release 12.1.0.2.0, you must rediscover your Oracle E-Business Suite Release 12.2 targets after your upgrade to attach the corrective actions.

**Abandoned Nodes**

During online patching, it is possible that a few nodes can get abandoned in the run edition. An incident will be raised if the system detects an abandoned node. An error message will be displayed on the home page of the corresponding Oracle E-Business Suite instance. You must either fix the node on the Oracle E-Business Suite side and perform a rediscovery or exclude the node using discovery customization and rediscover.

**Monitoring Current Activity**

Activity metrics are collected for the Oracle E-Business Suite target. These metrics provide details of current activities going on the Oracle E-Business Suite instance. Select Monitoring > All Metrics from the instance target menu. Expand the metric named Activity. You can see the trends for service processes, concurrent processing, and Forms.
Monitoring User Sessions

When a user logs in to Oracle E-Business Suite, the system creates sessions in the database identified by a unique session ID, or SID. All of these user sessions are created using the APPS schema credential. Each database session is associated with an Oracle E-Business Suite application user. This feature enables linking the database session with the corresponding application user for monitoring and troubleshooting purposes. You will be able to pinpoint how the Oracle E-Business Suite user opened a database session and whether it is with a concurrent processing, Forms, or Self-Service application.

For information on diagnostic tests for this feature, see: Diagnostic Tests for User Monitoring, page 12-16.

Mandatory Settings

The following settings are mandatory:

Settings on the OMS

Set the preferred credentials of the "Oracle E-Business Suite" target type for the credential set AppsUserCredsSet. You must provide the Oracle E-Business Suite user login credentials.

For information on setting preferred credentials, see: Set Preferred Credential for Oracle E-Business Suite Application Login, page 5-4.

Settings on the Oracle E-Business Suite Instance

- For the above Oracle E-Business Suite user, assign "LCM_EM_CLIENT" responsibility.

- Form sessions can be monitored only when the site-level profile Sign-On:Audit Level is set to 'FORM'. The internal name for this profile is 'SIGNONAUDIT: LEVEL'.

Top Sessions

The Top Sessions page will show four bar charts of database sessions triggered by the APPS database user.

- Top waiting sessions: sessions waiting for a database event to trigger to proceed further.

- Top running SQL statements.

- Top CPU consuming sessions.
• Top memory intense sessions.

To navigate to the Top Sessions page, select **User Monitoring >Top Sessions** from the instance target menu.

The level of detail shown in the bar graphs is controlled by properties set on the Preferences page. See: Setting Preferences, page 6-1.

• Sampling Interval for User Monitoring. The sample interval default is 60 minutes (which is also the maximum interval allowed).

• Number of Rows in tables of User Monitoring.

You can drill down from the legend to see the details of the session. If the Oracle E-Business Suite user information is available, the Oracle E-Business Suite session details is shown with further drilling down available to the database session details. If the Oracle E-Business Suite user information is not available (that is, the database sessions were triggered by a background process and not by a user), you can drill down to the
Searching for User Sessions

You can search for Oracle E-Business Suite user sessions using:

- **Database Session ID** - Provide the database sessions ID and if a match is found with a concurrent program, Form, or Oracle Application Framework page, the details will be shown with a drill-down facility to the database session details.

- **Oracle E-Business Suite user name** - This search shows all active concurrent programs, Forms, and Oracle Application Framework pages accessed by the user. It will also show the associated database session ID with drill down capability.

To navigate to user sessions search, select **User Monitoring > Search E-Business Suite User** from the instance target menu.

Impact of the July 2017 Critical Patch Update for Oracle E-Business Suite

A critical bug fix was applied to the REST services deployed on Oracle E-Business Suite which are invoked by the User Monitoring feature. This fix is available as part of the July 2017 Critical Patch Update (CPU) for Oracle E-Business Suite. There is an impact of this feature due to that fix. If you have applied the CPU, refer to the readme to understand the requirements to activate this feature.

For Oracle E-Business Suite Release 12.1.3 customers: If you have not applied the CPU, but have applied Bundle Patch 1 (BP 1) on top of Oracle Application Management Pack 13.1.1.1.0, you must apply the following Oracle E-Business Suite patches to utilize the User Monitoring feature:

- 20677714:R12.FND.B

- 26043228:R12.OAM.B

Monitoring JVM Usage

You can monitor JVM usage parameters specific to Oracle E-Business Suite Release 12.1. You can review the following parameters for each of the oacore J2EE containers in which a given Oracle E-Business Suite instance is deployed.

- **Application Module pool** - Provides information about all active and leaked application modules.

- **Locked AOLJ Connections** - Provides information about all locked and leaked AOL/J connections utilized by applications.

- **Cache Components** - Provides information about the cache component utilization
Note: The feature allowing you to monitor JVM usage is only available for Oracle E-Business Suite Release 12.1. Users wanting to monitor Oracle E-Business Suite Release 12.2 and later should consider using the Oracle WebLogic Server Management Pack Enterprise Edition, which provides JVM monitoring and JVMD.

**Setup Steps**

For Release 12 systems, ensure that you have set up the monitoring configuration for each "oacore" OC4J target as follows:

1. In the Targets Running on Nodes section in the Oracle E-Business Suite instance home page, click on the "oacore" OC4J target. This will take you to the home page of the target.

2. On the home page of the oacore OC4J target, select **Target Setup > Monitoring Configuration** in the instance target menu.

3. Enter the OC4J administrator username and password for the "oacore" OC4J in the "Username for Basic authorization" and the "Password for Basic authorization" fields, respectively.

   **Note:** The OC4J administrator username by default is "oc4jadmin" and is specified in the `system-jazn-data.xml` file under the `$INST_TOP/ora/10.1.3/j2ee/oacore/config` directory. The oc4jadmin password by default is set to a randomized value during installation and will need to be reset as in the following example:

   In the `$INST_TOP/ora/10.1.3/j2ee/oacore/config/system-jazn-data.xml` file, set the value of the "credentials" element for oc4jadmin user to your chosen password preceded by a ! character. For example:

   ```xml
   <user>
     <name>oc4jadmin</name>
     <display-name>OC4J Administrator</display-name>
     <description>OC4J Administrator</description>
     <credentials>![new password]</credentials>
   </user>
   
   After saving `system-jazn-data.xml`, restart the oacore OC4J.
   This step encrypts the updated password in `system-jazn-data.xml`.

4. Click **OK** to save the information.
Ensure that the Application Server passwords are also set for Oracle E-Business Suite Release 12, as Oracle Enterprise Manager expects these passwords to be set for metrics collection for the JVM targets.

**Command to Enable the Metric Collection**

```
./emcli modify_collection_schedule -force
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="LockedAOLJConn"
-collectionStatus="Enabled" -preview=N -freqType="Minute"
-freqValue="1"
./emcli modify_collection_schedule -force
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="AMPoolCount"
-collectionStatus="Enabled" -preview=N -freqType="Minute"
-freqValue="1"
./emcli modify_collection_schedule -force
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="CachedObjects"
-collectionStatus="Enabled" -preview=N -freqType="Minute"
-freqValue="1"
```

**Command to Disable the Metric Collection**

```
emcli modify_collection_schedule
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="LockedAOLJConn"
-collectionStatus="Disabled" -preview=N emcli modify_collection_schedule
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="AMPoolCount"
-collectionStatus="Disabled" -preview=N emcli modify_collection_schedule
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="CachedObjects"
-collectionStatus="Disabled" -preview=N
```

To find out the oracle_apps_jvm target names associated with an Oracle E-Business Suite instance, go to the All Targets page and search for `<ebs_instance_name>% oacore_jvm_1_apps`.

**Note:** It is important to set the oc4j admin username and password at the EBS as per the mandatory setups mentioned above. If you enable this metric without doing that, it can result in the flooding of metric collection errors at the OMS repository.

**Monitoring Templates for Oracle E-Business Suite**

Monitoring templates let you standardize monitoring settings across your Oracle E-Business Suite environments by allowing you to specify the monitoring settings once and apply those to your monitored targets. You can save, edit, and apply these
templates across one or more targets. A monitoring template is specified for a particular target type and can only be applied to targets of the same type. For example, you can define one monitoring template for Oracle E-Business Suite test instances and another monitoring template for Oracle E-Business Suite production instances. For more descriptions of Oracle Certified Templates and Oracle Provided Templates please see the latest *Oracle Enterprise Manager Cloud Control Administrator’s Guide*.

**Note:** Currently, Oracle delivered templates may not have many out-of-box metric values. However, you can set these metric values by observing the trend in your own environment over a period of time. You can view some of the trend information by examining Average value, Low value, and High value statistics for each metric that you are monitoring using the template.

**Managing Out-of-Box Monitoring Templates for Targets for Oracle E-Business Suite**

Navigate to monitoring templates using the path **Enterprise menu > Monitoring > Monitoring Templates**.

Users must have the required privilege(s) to manage monitoring templates. The privilege(s) for the view/edit/create like/delete functions for managing out-of-box monitoring templates for the management pack are the same as that for all out-of-box monitoring templates. See: *Oracle Enterprise Manager Cloud Control Administrator’s Guide* for more information.

**Viewing Out-of-Box Monitoring Templates**

To view out-of-box monitoring templates, select the "Display Oracle Certified Templates" check box and search for templates. All Oracle-certified templates are displayed.

**Default Listing of the Monitoring Templates**

Out-of-box monitoring templates are called 'Oracle Certified Templates.' By default, the Oracle Certified Templates are not displayed.
Find Out-of-Box Monitoring Templates for Oracle Application Management Pack for Oracle E-Business Suite

Search for out-of-box monitoring templates for management pack targets by selecting the “Display Oracle Certified Templates” check box and selecting the Target Type in the drop-down list. Alternatively, you can simply search for the target name.

Currently, out-of-box monitoring templates are supported for the following targets:

- Oracle E-Business Suite
- Oracle Concurrent Manager
- Concurrent Processing Service
- Oracle Workflow Agent Listener
- Oracle Workflow Background Engine
- Oracle Workflow Notification Mailer
- Workflow Service
- Oracle Applications JVM Usage
- Self Service Application Service
- Forms Based Applications Service

Note: This is only applicable for 12.1.x. Since the Forms service targets metrics that are promoted in 12.2 are different, monitoring templates shipped in this release are not applicable for 12.2.
Editing Out-of-Box Monitoring Templates

Editing an out-of-box monitoring template is not permitted in all Enterprise Manager versions. Please check Oracle Enterprise Manager Cloud Control Administrator’s Guide for more information.

In addition, the Edit option is enabled only if the user has the required privilege to edit a monitoring template through Enterprise Manager. Management pack templates follow the same restrictions as all out-of-box monitoring templates.

The Monitoring Templates home page lists all viewable templates. To display out-of-box templates, search using the criterion ‘Oracle Certified Templates’.

To edit a template:

1. From the Enterprise menu, select Monitoring, and then Monitoring Templates.
2. Choose the desired out-of-box monitoring template from the table.
3. Click Edit.
4. Once you have finished making changes, click OK.

Copying an Out-of-Box Monitoring Template

To create a template based on an existing template, select the template, go to Actions, and select Create Like.
Enter the inputs for 'General', 'Metric Thresholds', and 'Other Collected Items' and click OK.

Deleting an Out-of-Box Monitoring Templates
Out-of-box monitoring templates cannot be deleted.

Applying a Monitoring Template to an Oracle E-Business Suite Target
An out-of-box monitoring template can be applied to a management pack target based on the target type. To apply a template, you must have at least Manage Target Metrics.
target privileges on the destination target(s).

1. From the Enterprise menu, select Monitoring and then Monitoring Templates.

2. Select the desired template from the table.

3. Click Apply.

4. Select the desired apply options and the target(s) to which you want the templates applied. See Oracle Enterprise Manager Cloud Control Administrator’s Guide for more information.

5. Click OK.

Other Features of Monitoring Templates

All other features of out-of-box monitoring templates such as 'Compare Settings' and 'View Past Apply Operations' are valid for out-of-box monitoring templates in the management pack.

Defining or Modifying the Threshold Values in the Out-of-Box Monitoring Templates

Currently, Oracle Application Management Pack for Oracle E-Business Suite supplies the out-of-box monitoring templates with default values. To define the threshold values in out-of-box monitoring templates, the following steps are involved:

1. Observe the trend of the metrics for the targets.

2. Determine the threshold values based on observation.
3. Modify the threshold values by editing the template.
4. Apply the modified template to the target.

To check the trend of the metrics for the target, on the target’s home page target menu (labeled “Oracle Concurrent Manager”), navigate to Monitoring > All Metrics. Select any metric, and check 'Metric Value History'. Change the 'View Data' period based on the time of analysis.

Enabling Service Tests and Beacons Link

Administrators can define service tests for Oracle E-Business Suite services and can also define their own ATS transactions to determine the health of an application (for example, whether the application is rendering the correct pages and functional flows are intact). All Oracle E-Business Suite service targets support the Service Test Types of ATS and HTTPPING. For more information on service tests, service test types, beacons, and Oracle Application Test Suite (OATS), see the section "Configuring and Using Services" in the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

The following services have the 'Service Tests and Beacons' link enabled:

- oracle_apps_svc_cp (Concurrent Processing Service)
- oracle_apps_svc_ebs (Oracle Applications Service)
- oracle_apps_svc_forms (Forms Based Applications Service)
- oracle_apps_svc_ssa (Self-Service Applications Service)
oracle_apps_svc_wf (Workflow Service)

The basic steps to create such a test are as follows:

1. Navigate to the Service target home page.
2. Select the Service link.
3. Click on the Monitoring Configurations tab.
4. Select the Service Tests and Beacons link.
5. Select 'Test Type' as 'ATS Transaction' and click Add.
6. Enter an appropriate name.
7. Click the Upload button and select the OATS script zip file.
8. Add a Beacon to monitor the Service Test. The Enterprise Manager Management Beacon default is available.
9. Enable the Service Test.
10. Click OK.

For more detailed information, see the "Creating an ATS Service Test" section of theOracle Enterprise Manager Cloud Control Administrator’s Guide.

Seeded ATS Test Transaction for Self-Service Applications Service

A sample ATS test script is shipped out of the box for a login/logout test against Oracle E-Business Suite 12.1.x instances. This script will only work if the 12.1.x instance is not SSL configured. This ATS test transaction is configured during the discovery time of the 12.1.3 Oracle E-Business Suite instance against 'Self-Service Applications Service.' An end user needs to enable the ATS transaction and edit it with a correct Oracle E-Business Suite username and password.

1. Click on the Monitoring Configuration tab from the Self-Service Applications Service home page.
2. Click on the "Service Tests and Beacons" link.

3. The default ATS service test is disabled. First mark the default beacon, 'EM Management Beacon' as 'Key Beacon' in the Beacons region. Then click on the **Enable** button for the Service Test.

4. Click on **Edit**.

5. Enter the Oracle E-Business Suite applications username and password under Variables, Sensitive Values. Click **OK**.

6. Again, click the **OK** button from the Service Tests and Beacons home page to ensure that the changes are saved.

7. You can verify the service test as follows:
   - Click the **Verify Service Test** button in the Service Tests region.
   - Click the **Perform Test** button.
   - Execution results are displayed in the results table.

8. You need to mark this service as 'Key Service Test' so that it starts contributing to the availability.
   - Select the **Key Service Test** check box and click the **Change Key Tests** button.

For more details see the chapter "Configuring and Using Services" in the *Oracle Enterprise Manager Cloud Control Administrator’s Guide*.

### Drilling Down to Oracle Applications Manager

You can drill down to the Oracle Application Manager of each Oracle E-Business Suite instance from Oracle E-Business Suite plug-in. Select **Oracle Applications Manager** from the instance target menu.

You can access the following sections and its subsections in Oracle Applications
Manager:

- Database
- Concurrent Processing
- Forms
- Workflow
- Configuration of all hosts
- Configuration of all nodes
- Applications Usage
- Others

Services

Performance of Services

The metrics collected from a service’s critical components are used to evaluate the performance of each service. The following table lists the performance metrics for each service.

### Performance Metrics for Services

<table>
<thead>
<tr>
<th>Service</th>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent Processing</td>
<td>Concurrent Requests Success Rate</td>
<td>Successfully completed requests per hour</td>
</tr>
<tr>
<td>Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Concurrent Processing</td>
<td>Concurrent Requests Error Rate</td>
<td>Failed requests per hour</td>
</tr>
<tr>
<td>Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forms Service</td>
<td>Forms Response Time</td>
<td>Average response time of forms in milliseconds</td>
</tr>
<tr>
<td>Forms Service</td>
<td>Forms Requests per Second per Second</td>
<td>Average of number of requests processed by the Forms server per second</td>
</tr>
</tbody>
</table>
### Usage by Services

The metrics collected from a service's critical components are used to evaluate the resources used by each service. The following table lists the usage metrics for each service.

#### Usage Metrics for Services

<table>
<thead>
<tr>
<th>Service</th>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent Processing Service</td>
<td>Running Requests per Hour</td>
<td>Number of requests running per hour</td>
</tr>
<tr>
<td>Concurrent Processing Service</td>
<td>Active Service Processes</td>
<td>Number of active services running per hour</td>
</tr>
<tr>
<td>Forms Service</td>
<td>Forms server CPU usage</td>
<td>Percentage of CPU used by the Forms server</td>
</tr>
</tbody>
</table>
## Service Metric Description

<table>
<thead>
<tr>
<th>Service</th>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms Service</td>
<td>HTTP server CPU usage</td>
<td>Percentage of CPU used by the HTTP server</td>
</tr>
<tr>
<td>Forms Service (Socket Mode)</td>
<td>Total Memory Utilization</td>
<td>Percentage of the total memory used by the Forms process</td>
</tr>
<tr>
<td>Forms Service (Socket Mode)</td>
<td>Total CPU Utilization</td>
<td>Percentage of CPU used by the Forms process</td>
</tr>
<tr>
<td>Forms Service (Socket Mode)</td>
<td>Number of Forms Processes</td>
<td>Total number of Forms processes that are running</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>Background Engine Deferred Items</td>
<td>Number of items deferred by the background engine yet to be processed</td>
</tr>
<tr>
<td>Self-Service Applications Service</td>
<td>OACore CPU usage</td>
<td>Percentage of CPU used by the oacore server</td>
</tr>
<tr>
<td>Self-Service Applications Service</td>
<td>HTTP server CPU usage</td>
<td>Percentage of CPU used by the HTTP server</td>
</tr>
</tbody>
</table>

### Charts for Services

To see charts based on the above performance and usage metrics, go to the home page of each service and click on the **Charts** tab.

### Incidents for Services

You can set thresholds for tracking the performance and usage of services. Incidents are generated once the metrics exceed the threshold. To set the threshold, go to the home page of the service and click on the tab **Monitoring Configuration**. Click on the link "Performance Metrics" or "Usage Metrics". You can set the warning and critical threshold for performance and usage metrics on the respective pages.

The Services section on the Oracle E-Business Suite home page provides the details described in the following table:
### Services Status Information on the Home Page

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>The Oracle E-Business Suite system whose members are providing the service.</td>
</tr>
<tr>
<td>Performance Incidents</td>
<td>Number of performance incidents which are classified as Critical or Warning. You can drill down from here to get the details of the incidents by clicking on the number.</td>
</tr>
<tr>
<td>Usage Incidents</td>
<td>Number of usage incidents which are classified as Critical or Warning. You can drill down from here to get the details of the incidents by clicking on the number.</td>
</tr>
<tr>
<td>Key Components Status</td>
<td>The status of the key components. The service will be shown as &quot;down&quot; if any of the key components is down. You can drill down from here by clicking on the number.</td>
</tr>
<tr>
<td>Key Components Incidents</td>
<td>Incidents (Critical and Warning) raised against key components of the service. You can drill down from here by clicking on the number.</td>
</tr>
</tbody>
</table>

### Services Dashboard

Extending the service dashboard feature provided by Cloud Control, Oracle E-Business Suite also has a dashboard which provides a brief summary of all service-related information. You can access it by selecting Service Level Reports > Oracle Application Services from the instance target menu.

### Concurrent Processing Dashboard

The Concurrent Processing Dashboard provides you with details in concurrent processing in your Oracle E-Business Suite system. The dashboard gives you a complete picture of concurrent processing on your system, both current activities as well as usage statistics.

To navigate to the Concurrent Processing Dashboard, select E-Business Suite Dashboard > CP Dashboard from the instance target menu.

### Discovery of Concurrent Processing Targets

When you discover an Oracle E-Business Suite instance, the concurrent processing-related targets are discovered. This includes the Apps Listener, Internal Concurrent
Manager, Output Post Processor, Internal Monitor, Service Manager, and Conflict Resolution Manager. The Oracle Application Management Pack for Oracle E-Business Suite supports the monitoring of parallel concurrent processing.

There is a provision to discover all concurrent managers during discovery of the Oracle E-Business Suite instance, although it is disabled by default. If needed, you can enable it by customizing the discovery. See the section Customization at the Instance Level in Customizing Discovery, page 4-8.

**Note:** Discovery of core managers and all concurrent managers are new features introduced in Release 12.1.0.4.0. This feature will not work if the agent is not at the same release level as the OMS.

---

### Overview Tab

The **Overview** tab provides a summary of the concurrent processing infrastructure. The General region includes details on the status of the concurrent processing service:

- **Status** - The status is linked to the Concurrent Processing Service home page.
- **Active Service Processes** - Number of active service processes.
- **User-Defined Concurrent Program Targets** - Shows the total number of user-defined programs that are being monitored.
- **Configured Concurrent Managers** - The number of configured concurrent managers.
• User Defined Concurrent Manager Targets - Shows the total number of user-defined managers that are being monitored.

The Hourly Completed Requests region shows a pie chart for requests by status (Successful, Warning, and Errored).

The Activity Summary graph illustrates active requests in the following statuses:
• Pending Normal
• Pending Standby
• Running

The Components region lists components of the Concurrent Processing service. The table shows the following for each component:
• Name
• Type
• Status
• Incidents
• Host

<table>
<thead>
<tr>
<th>Components</th>
<th>Type</th>
<th>Status</th>
<th>Incidents</th>
<th>Host</th>
</tr>
</thead>
<tbody>
<tr>
<td>dbcsb_InternalMonitor</td>
<td>Oracle E-Business Suite Internal Monitor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>dbcsb_ConflictResolutionManager</td>
<td>Oracle E-Business Suite Conflict Resolution Manager</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>dbcsb_ConcurrentManager</td>
<td>Internal Concurrent Manager</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>dbcsb_ServiceManager</td>
<td>Oracle E-Business Suite Service Manager</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Incidents region lists any incidents that were triggered recently, with the following information for each:
• Severity
• Metric
• Target Name
• Target Type
• Incident Triggered
• Last Value
• Last Checked
Current Activity Tab

The **Current Activity** tab gives details of the concurrent processing that is taking place at any point in time.

<table>
<thead>
<tr>
<th>Concurrent Requests by Status</th>
<th>Hourly Completed Requests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending Normal</td>
<td>Successful</td>
</tr>
<tr>
<td>Pending (Standby)</td>
<td>Warning</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Error</td>
</tr>
<tr>
<td>Inactive (No Manager)</td>
<td>Successful Requests Rate (%)</td>
</tr>
<tr>
<td>On Hold</td>
<td>Requests Warning Rate (%)</td>
</tr>
<tr>
<td>Running</td>
<td></td>
</tr>
</tbody>
</table>

The Concurrent Requests by Status region lists the number of requests for each status:

- Pending Normal
- Pending (Standby)
- Scheduled
- Inactive (No Manager)
- On Hold
- Running

Click on the number for a status to find out more about the metric trend.

The Hourly Completed Requests region lists statistics for requests that have completed in the past hour, including:

- Successful
- Warning
- Error
- Successful Requests Rate (%)
- Requests Warning Rate (%)
• Requests Error Rate (%)

Click on the number for each statistic to find out more details.

The Concurrent Managers by Requests lists all concurrent managers, in order of the number of requests it has in the specified status, either Running or Pending.

With “Running” selected, the following is shown for each concurrent manager:

• Service Name
• Service Short Name
• Application Name
• Status
• Running Requests
• Service Handle
• Service Target Processes
• Service Actual Processes

With "Pending" selected, the following is shown for each concurrent manager:

• Service Name
• Service Short Name
• Application Name
• Status
• Normal Pending Requests
• Standby Pending Requests
• Service Handle
• Service Target Processes
• Service Actual Processes

The Top Concurrent Requests region shows the top ten (10) requests for the specified status of Running, Pending, or Scheduled.

• Running - These are sorted by running time in descending order.
• Pending - These are sorted by running time in descending order.
• Scheduled - These are sorted by their scheduled start time.

The Top Applications region lists the top ten (10) applications for running requests or pending requests, as specified.

The Top Users region lists the top ten (10) users by number of running or pending requests, as specified.

Usage Tab

The Usage tab provides a summary of how the concurrent programs and managers have been utilized over a period of time.

The top ten (10) concurrent requests for the following categories are listed:

• Number of executions - For this category, the total number of executions, the percentage (%) of successful executions, and the percentage (%) of errored executions are shown.

• Number of failed executions - The number of executions, percentage (%) of failed executions, and percentage (%) of errored executions are shown.

• Average run time in minutes - The number of executions, average running time (minutes), and total running time (minutes) are shown.

• Total run time in minutes - The top ten (10) programs with the highest maximum running time are shown. For each program listed, the number of executions, total running time (minutes) and percentage (%) of successful executions are shown.
The top ten (10) applications for the following categories are listed:

- Number of Executions
- Number of Failed Executions

The top ten (10) users by total number of requests are also listed, in descending order of number of requests.

**User Defined Targets Tab**

The **User Defined Targets** tab displays the details of the concurrent programs and managers being monitored. Use this tab to get information about the added concurrent programs and managers as well as to add more custom targets.

![User Defined Targets Tab](image)

**Adding a Concurrent Program Target**

You can add a concurrent program custom target so that the system will collect metrics on activity and usage for the concurrent program.

1. To add a concurrent program custom target, navigate to the Concurrent Processing Dashboard, select the **User Defined Targets** tab, and click Add CP under Concurrent Programs.

2. For your new target, define the following:
   - Target Name Prefix - This value is determined by the system based on the instance name and cannot be updated.
   - Target Name - Enter in a target name "suffix". The actual target name will be composed of the Target Name Prefix (above) and the value of this field.
   - Target Type - The system automatically provides the value "Custom Oracle"
Concurrent Program”.

- Concurrent Program Short Name - Use the LOV icon to search for and select the program short name. In searching for the program name you can search by concurrent program short name, concurrent program name, or application.

- Monitoring Host

For the Basic Properties region, values for the following should default in. These values are used as credentials by the target for metrics collection:

- SID
- Machine
- Port
- (Database) User name
- (Database) Password
- ConnectString

3. When you are done, click Add to add the target.

**Adding a Concurrent Manager Target**

If you have decided not to discover all concurrent managers during discovery, you can add an individual concurrent manager custom target so that the system will collect metrics on activity and usage for requests run by the concurrent manager.

1. To add a concurrent manager custom target, navigate from the Concurrent Processing Dashboard to the **User Defined Targets** tab and click Add CM under Concurrent Manager.
2. For your new target, define the following:
   - **Target Name Prefix** - This value is determined by the system based on the instance name and cannot be updated.
   - **Target Name** - Enter in a target name "suffix". The actual target name will be composed of the Target Name Prefix (above) and the value of this field.
   - **Target Type** - The system automatically provides the value "Custom Oracle Concurrent Manager".
   - **Concurrent Manager Short Name** - Use the LOV icon to search for and select the concurrent manager short name. In searching for the manager name you can search by concurrent manager short name, concurrent manager name, or application.
   - **Monitoring Host**

   For the Basic Properties region, values for the following should default in. These values are used as credentials by the target for metrics collection:
   - **SID**
   - **Machine**
   - **Port**
   - **(Database) User name**
   - **(Database) Password**
   - **ConnectionString**

3. When you are done, click Add to add the target.
Configuration of Concurrent Processing

To view the concurrent processing configuration, go to the Concurrent Processing Dashboard. From the “Oracle Concurrent Processing” target menu, select Configuration > Last Collected.

Configuration data collected includes:

- General settings
- Specialization rules for concurrent managers
- Work shift for concurrent managers
- Profile options

Monitoring Concurrent Processing

Metrics are collected to monitor the concurrent processing. These metrics are collected at three levels:

- The first level is on all concurrent processing in the instance, which covers all concurrent managers and programs.
- The second level is at the individual concurrent manager level.
- The third level is at the individual program level.

To see metrics for all concurrent processing in your instance, choose Monitoring > All Metrics from the instance target menu in the Concurrent Processing Dashboard.

To see metrics for a concurrent manager or concurrent program, go to the User Defined tab and click on the name of the target to go to its home page. From the target menu on the home page, choose Monitoring > All Metrics.

Monitoring Capacity Utilization of Concurrent Managers

Every concurrent manager has a maximum number of processes that can be active at a given point of time. The metric Capacity Utilization of Concurrent Managers tracks this. It collects the utilized capacity as a percentage of maximum allowed. You can set an alert if the usage falls below a certain percentage. The metric is available for all concurrent processing in your instance and for individual managers.

Monitoring Running Requests Based on Time

The Running Requests metric, known as Long Running Requests in previous releases, is available for all concurrent processing, an individual concurrent manager and individual concurrent program and allows you to monitor requests that are running at a given time. You can set a threshold to receive alerts if the running time exceeds a
Monitoring Oracle E-Business Suite

Monitoring Long Running Requests as a Percentage of Average Runtime
You can raise an alert if the running time exceeds a certain percentage of the average running time of previous requests. The metric Tolerance Level For Long Running Request can be used to set this alert. The metric is available for all concurrent processing, the individual concurrent manager, and individual concurrent program.

Monitoring Pending Requests Based on Time
Requests that are pending can be monitored based on time. In former releases of the management pack, these metrics were referred to as Long Pending Requests. In 12.1.0.4.0, these metrics are called Pending Requests, categorized as either Normal or Standby. You can set alerts if the pending time exceeds a predefined threshold. The metric is available for all concurrent processing, the individual concurrent manager, and individual concurrent program.

Monitoring the Number of In-Progress Requests by Status
The metric No. of Incomplete Requests by Status, formerly Concurrent Requests by Status in previous releases, can be used to set an alert if the number of inactive or pending requests exceeds a predefined limit. The metric is available for all concurrent processing and the individual concurrent program.

Monitoring the Number of Completed Requests by Status
Formerly known as Hourly Completed Requests in previous releases, the metric No. of Hourly Completed Requests by Status can be used to monitor and raise an alert if the number of requests completed (absolute and percentage) with warning or error exceeds a predefined limit. You can also raise an alert if the success rate falls below a predefined percentage. The metric is available for all concurrent processing and the individual concurrent program.

Monitoring Blocked Concurrent Requests by Time
You can raise an alert if a concurrent request is in blocked state due to a database lock. The metric Concurrent Requests in Blocked State can be used to set up this alert. The metric is available for all concurrent processing, the individual concurrent manager, and individual concurrent program.

Monitoring the Number of Blocked Requests
You can raise an alert if the number of requests in blocked state due to database locks exceeds a predefined number. The metric No. of Concurrent Requests in Blocked State can be used to set this alert. The metric is available for all concurrent processing, the individual concurrent manager, and individual concurrent program.
**Note:** In Release 13.1.1.1.0, this metric is disabled. See the Known Product Limitations, page H-1 appendix for more information.

**Monitoring Specialization Rules**
Specialization Rules can be defined for concurrent managers to define what kind of requests a manager can process. Both inclusion and exclusion rules can be defined. There have been cases where the number of such rules defined were large and caused performance issues. The metric No. of Include and Exclude Specialization Rules allows you to raise alerts if the number of such rules exceeds a predefined limit. This metric is available only for the concurrent manager target.

**Monitoring Schedule of Requests**
If a concurrent program is not scheduled as a best practice recommendation, you can raise an alert. The metric Monitor Schedule for Requests can be used to raise this alert. You can specify the expected interval in days, months, hours or minutes. When specifying the interval, only one unit of measurement can be used at a time (for example, you cannot specify a combination of hours and minutes). This metric is available only for the concurrent program target.

**Monitoring Unscheduled Requests**
If it is mandatory for a concurrent program to be scheduled periodically and if it is not scheduled, you can raise an alert. The metric Unscheduled Requests can be used to raise this alert. This metric is available only for the concurrent program target. You must enter the value as 0 for the alert to be raised. You must provide the recommended schedule value and recommended schedule unit by editing the monitoring configuration of the concurrent processing target. The allowed values for unit are DAYS/MINUTES/HOURS/MONTHS. If the recommended value and unit is not provided, the behavior will be to raise an alert if concurrent processing is not scheduled at all.

**Monitoring Request Sets**
The option to monitor requests set metrics is available only for concurrent processing in your instance.

**Monitoring Running Request Sets**
You can raise an alert if a request set is running for more than a predefined time. The metric Running Request Sets can be used to set this alert.

**Monitoring a Request Set for Failure**
You can raise an alert if a specific request set fails. The metric Failed Request Sets can be used to raise this alert.
Monitoring Request Sets That Have Not Started
You can raise an alert if a request set does not start as expected. The metric Not Started Request Sets can be used to set this alert.

Monitoring Request Sets That Are Not Scheduled
You can raise an alert if a request set is not scheduled. The metric Unscheduled Request Sets can be used to raise this alert.

Monitoring Conflict Resolution Manager
Metrics are collected to check the health of the Conflict Resolution Manager (CRM). You can raise an alert if:

- CRM is in an inactive state for a certain period of time
- CRM is in a blocked state for a certain period of time

You can go to the home page of the Conflict Resolution Manager target by clicking on its name from the Components region in the Overview tab of the Concurrent Processing Dashboard.

Monitoring Output Post Processor
Metrics are collected to check the health of the output post processor. Alerts will be raised if:

- Output post processor hangs
- If any request gets no response error
- If any request times out

You can go to the home page of the Output Post Processor target by clicking on its name from the Components region in the Overview tab of the Concurrent Processing Dashboard.

Oracle E-Business Suite Summary on the Exalogic Dashboard
You can add an Oracle E-Business Suite Summary region for instances running on Exalogic machines to enable monitoring for these instances.

This region contains:

- A pie graph for consolidated status of Oracle E-Business Suite targets.
- A summary table that shows name of the Oracle E-Business Suite instance, status, incidents, configured components, service, compliance violations.
To add an Oracle E-Business Suite summary region on the Exalogic dashboard, perform the following steps:

1. Click on the global menu **Targets > Exalogic**. The landing page with all the discovered Exalogic instances should be displayed.

2. Click on any instance. The Exalogic dashboard should be displayed.

3. Click on the personalization page icon. The page should become editable.

4. Click on the **Add Content** button for a list of available regions. Click the Add icon for Oracle E-Business Suite Instances to add the region.

5. Click **Close** to exit the editable page.

To remove the Oracle E-Business Suite summary region from the Exalogic dashboard, click on the personalization page icon and the page should become editable. Click on the cross icon (X) on the top right side of the region to remove the Oracle E-Business Suite summary region.

To change the location of the Oracle E-Business Suite summary region, click on the View Action Menu icon on the top right side of the region and click Move Up/Move Down to rearrange the region on the Exalogic dashboard.

### End-To-End Performance Monitoring with RUEI and JVMD

The management pack now integrates seamlessly with Real User Experience Insight (RUEI) and Java Virtual Machine Diagnostics (JVMD) for monitoring performance of transactions. RUEI understands how users are interacting with your product. Using the measurements that RUEI collects, you can assess the effectiveness of user interface design, the responsiveness of web servers and the internet, and the success of user operations. JVMD looks at the finest details of code execution and to identify problems like race conditions, blocked threads, and memory leaks. To learn more about RUEI and JVMD, see Part VI - Monitoring Application Performance of *Oracle Enterprise Manager Cloud Control Getting Started with Oracle Fusion Middleware Management Plug-in*.

### Supported Oracle E-Business Suite Versions

This feature works only for Oracle E-Business Suite Release 12.2 and above, where the middle tier is deployed on the WebLogic Server.

### Prerequisites

- **Discover the Oracle E-Business Suite instance** - To perform end-to-end monitoring first discover the Oracle E-Business Suite instance in the management pack

- **Install Java Virtual Machine Diagnostics** - Deploy the JVMD Manager (JVM
Diagnostics Engine) in Enterprise Manager. For information, see "Installing JVM Diagnostics" in Oracle Enterprise Manager Cloud Control Basic Installation Guide.

- **Deploy JVMD Agent on the WLS server of the Oracle E-Business Suite instance** - For information, see "Installing JVM Diagnostics" in Oracle Enterprise Manager Cloud Control Basic Installation Guide.

- **Register the Oracle E-Business Suite Database with JVMD** - After the JVMD agent is deployed on the respective Oracle E-Business Suite application server, and once it is ready to diagnose JVM issues, then you need to register the database of the relevant Oracle E-Business Suite with the JVMD engine. This step is required in order to navigate to the database diagnostics page from JVMD pages.
  - Navigate to **Setup >Middleware Management >Setup**.
  - Select the row **JVM Diagnostics Engines** and click **Configure**.
  - Select the **Register Databases** tab.
  - Click on **Add Database Instance**, select the respective Oracle E-Business Suite database instance, and click **Select**.

- **Install Real User Experience Insight** - For information, see the Oracle Real User Experience Insight Installation Guide.

### Setting up End-to-End Monitoring

**Configure Oracle E-Business Suite in RUEI:**
Real User Experience Insight can be configured to support drilling down to JVM Diagnostics. For example, if a page is taking too much time to load, RUEI will detect it. You can then drill down from RUEI to JVMD and find out the root cause of why the page is hanging.

1. Log in to RUEI.

2. Navigate to **Configuration >Applications >Suites**.
3. Click on **New Suite**. A "New Suite" window opens.

4. Enter a suite name. This is the name that can be used to uniquely identify an Oracle E-Business Suite in RUEI. Provide any name that uniquely defines the Oracle E-Business Suite instance being configured.

5. Provide the domain name and port of the Oracle E-Business Suite applications URL in the Find Domain and Find Port fields. For instance, if http://domain.example.com:8080/AppsLogin is your Oracle E-Business Suite applications URL, "domain.example.com" will be the domain field value and 8080 will be the port field value.

6. Enter "*" in the Find in URL field. This entry means that any request to the Oracle E-Business Suite applications URL will be monitored. Alternatively, you can provide some patterns so that only those URLs that match the given pattern will be monitored. Click Next.
7. Enter "E-Business Suite" as the Suite Type and click Finish. The newly-created suite appears on the page.

8. Click on the created suite name.

9. Click on the Advanced tab.

10. Click on the Enterprise Manager subtab.

11. Click on 'n/a' for Enterprise name. In the name field, provide the name of the Oracle E-Business Suite instance that is discovered in Enterprise Manager where you want to drill down to JVMD or the Oracle E-Business Suite search user sessions pages. For example, "tst123_Oracle E-Business Suite".

Configure Protocols:
2. Based on the Oracle E-Business Suite instance protocol (http/https), click on the respective protocol and provide/add the respective port on which Oracle E-Business Suite is up and running. You can also provide the port on which forms are running in the respective protocols.

**Configure Link for RUEI to EM:**
In diagnosing an issue in RUEI, it is possible to drill down to JVM Diagnostics in Enterprise Manager, if the EM instance is linked to RUEI. Use these steps to link RUEI to EM:

1. Click on Configuration > General > Advanced Settings > Clickout Settings. Click on Add new clickout setting.
2. Select the version of Enterprise Manager in the clickout tool list.

3. Provide host and port values of the Enterprise Manager instance.

4. Click on Advanced. Provide the protocol (http/https).
5. Click on Save.

6. After linking, you should be able to see the link "Inspect in Enterprise Manager" when right-mouse-clicking on any session activity in the Browse data tab.

Analyzing a Performance Issue

1. Log in to RUEI screen and click on Browse data tab.
2. Select the date on the left hand side to filter the data accordingly. Select E-Business (Forms) from the drop-down list below Applications tab.

3. Click on the Session Diagnostics tab below the list mentioned in the above step.

4. Select the EBS suite name configured in section "Configure Oracle E-Business Suite in RUEI" from the Application drop down. If you are trying to search for sessions of a specific user ID, EBS responsibility ID, or ECID, select the values accordingly from the respective drop down fields. Not all values need to be selected for each drop-down list to perform the search.

5. Click on Search.
6. Click on a session link.
7. Multiple session activities are displayed. Check the Info column. A red-colored icon identifies that the session activity ended with some error or is hanging.
8. Right click on that session activity, click on **Inspect in EM 12C > Trace JVM request.**
Drilling Down from RUEI to the Plug-In

You can drill down to the Oracle E-Business Suite Plug-in from RUEI to monitor user sessions.

Configure link for RUEI to drill down to the plug-in:
1. Navigate to Configuration > General > Advanced Settings > Clickout Settings.
2. Click on Add New Clickout Setting.
4. Provide host and port values of the Enterprise Manager instance.
5. Click on Advanced and provide the protocol (http/https).
6. Click on Save.
7. After creating this link, you should be able to see the link "Inspect in EBS Diagnostics" when you right-click any session activity in the Browse data tab.
Monitoring User Sessions by drilling down from RUEI:
Once the "Inspect in EBS Diagnostics" link is available, select the child menu User Search to drill down to the management pack. You will see the active sessions of the Oracle E-Business Suite user like Concurrent Processing (CP), Forms, and Oracle Application Framework (OAF) sessions. You can drill down to each session to get the details.

Custom Metrics
You can create custom metrics in case it is not covered by the metrics shipped out of the box.
1. Navigate to Enterprise > Monitoring > Metric Extensions.
2. Click Create > Metric Extension.
3. Select Applicable to as Oracle E-Business Suite.
4. Select Adapter as SQL.
5. Define the query. Define columns in next step.
6. Add any target and test. Query will hit this EBS target.
7. Submit.
8. Select the metric you created, Actions >Save As Deployable Draft.

9. Select the metric you created, Actions >Publish Metric Extension.

10. Select the metric you created, Actions >Deploy to Targets.

11. Select any target and deploy.

For more details, see "Using Metric Extensions" in Oracle Enterprise Manager Cloud Control Administrator’s Guide.

**Custom Compliance Rules**

Follow these steps to create custom compliance rules.

1. Navigate to Enterprise >Compliance >Library.

2. Create >Repository Rule.


4. Define Query, violation condition, and other details.

5. Make sure that query has target_guid as the first column.

6. Click Test and Submit.

7. Now you can map this rule to a custom standard and then the custom standard to a custom framework.

   Please note that System defined compliance objects are non-editable. You cannot map any compliance object to any System defined compliance object. However, you can use Create Like to create a copy of a System defined object and then edit that.

8. You can always edit a custom compliance object and map rule to standard, standard to framework.

For more details, see "Managing Compliance" in Oracle Enterprise Manager Lifecycle Management Administrator’s Guide.

**Purging of Metrics**

All metrics collected by the plug-in will be purged, as per the default Management Repository Data Retention Policies. However, the metric, "Requests Completed Successfully" for the target type "Custom Oracle Concurrent Program", is not restricted by the above mentioned policy. The metric is disabled by default. If you should enable it, manually purge the data from the table EBS_AMP_CP_REQ_COM_SUCC.
Configuration Management

This chapter covers the following topics:

• Configuration Details of Oracle E-Business Suite Technology Stack

Configuration Details of Oracle E-Business Suite Technology Stack

Application Management Pack collects Oracle E-Business Suite technology stack configuration information at regular intervals. Customers can modify the collection frequency. Customers can view the configuration and compare the configurations using time-based configuration snapshots or compare configurations between multiple Oracle E-Business Suite instances.

You can get the details of how the Oracle E-Business Suite instance is configured by looking at the configuration metrics collected for the Oracle E-Business Suite target. Select Configuration > Latest from the Oracle E-Business Suite instance target menu.

Configuration of All Members

To see the configuration of each member target of Oracle E-Business Suite, you would have to go to the home page of each target and follow the navigation path mentioned above. As this would be inconvenient, the Configuration of All Members page simplifies this task. You will get a link to see configuration of all members in one place. Select Configuration of All Members from the Oracle E-Business Suite target menu.

Here you can see the links to see the last collected configuration of all member targets grouped as nodes, host, services, and so on. You can search for any context variable by clicking Search Context Variable. You can also search for patches applied and patch set information.

Comparing Configurations

Comparing configurations is very important while managing Oracle E-Business Suite targets. You may be able to spot configuration differences between two Oracle E-
Business Suite instances that are supposed to be identical or you may be able to find differences in configuration caused by human error or patching activities. You can compare the configuration of one or more Oracle E-Business Suite instances. You can also compare configuration snapshots taken on different dates and times. By comparing configurations, you can ensure consistency across all of your Oracle E-Business Suite systems, troubleshoot issues, or keep track of configurations for tracking and auditing purposes.

To compare configurations select **Configuration > Compare** from the Oracle E-Business Suite instance target menu.

**Configuration Comparison Templates**

In Enterprise Manager, a comparison template is an example for fine-tuning a comparison of like configurations. A template is associated with a specific target type, which determines the configuration item types, items, and properties to be compared. A set of default templates ships ready-to-use to support certain target types. A template enables you to establish specific settings to take into account when comparing configurations of the given target type; for example, which property differences to ignore and which property differences trigger an alert. For more information on comparison templates, see the Oracle Enterprise Manager Lifecycle Management Administrator’s Guide.

The Oracle E-Business Suite plug-in includes a set of comparison templates for the following target types:

- Oracle E-Business Suite
- Oracle E-Business Suite Node
- Oracle Concurrent Manager
- Oracle E-Business Suite Custom Objects
- Oracle E-Business Suite Patch Information
- Oracle E-Business Suite Workflow

These templates will be available once the Oracle E-Business Suite plug-in is deployed. You can use these templates to compare the configurations of similar target types without creating new comparison templates.

You can use these templates as-is, or as a guideline. For example, you might decide that an existing comparison template, with just a few changes, can meet your requirements. Perhaps a shipped template ignores property differences that you are concerned about. In this case, you can use the "Create Like" feature to make the adjustments to the existing template and save the new template under a different name.
Using a Configuration Comparison Template

Click on Enterprise > Configuration > Comparison & Drift Management.

In the Search region, select one of the above target types in the Target Type List. Click on the Search button.

Select the configuration against which other configurations will be compared. Click Next.

Click Add Configuration to select a single or multiple configurations to compare with the first. Click Next.

Select the template with the same name as the target type. In the same page you can view the template settings and member settings of the comparison template.

Click Submit.

Check the comparison result. The comparison report should adhere to the selected template rules. That is, if there are any ignored members or properties present from comparison, the same properties/members should not be present in the result report.

Creating a Copy of an Existing Comparison Template

Click on Enterprise > Configuration > Comparison Templates. Select an existing template's row and click Create Like. Give the new template a name and edit the copy of the template.

Configuration Management During Online Patching

Tracking Configuration Changes in the Run Edition During Online Patching

Once you initiate a patching cycle by starting the prepare phase, you need to keep track of the configuration changes that are happening in the run edition. These changes will not be present in the new run edition once the cutover is performed. Doing this tracking manually is error prone. Configuration comparison is there for the rescue. You must follow the steps as follows:

Refresh the Configuration of Oracle E-Business Suite Before Initiating the Prepare Phase

Go to the home page of the Oracle E-Business Suite instance and refresh the configuration data to the latest value. See the section Viewing Configuration Data in the Enterprise Manager Lifecycle Management Administrator’s Guide.

Save the Latest Configuration

Go to the home page of the Oracle E-Business Suite instance and save the latest configuration. Give an appropriate name. This will be used to compare with the configuration which will be collected after patching is complete. See the section Working with Saved Configurations in the Enterprise Manager Lifecycle Management
Refresh and Save the Configuration Again Before Initiating the Cutover

Once the patching is over, before starting the cutover, refresh and save the latest configuration of the Oracle E-Business Suite instance.

Compare the Two Configurations

Now that you have the configurations collected before and after the patching cycle, compare it with the template by the name Detect run edition configuration changes to get the details of the changes which were implemented.

This template compares the configurations of the following targets in an Oracle E-Business Suite instance:

- Oracle E-Business Suite
- Oracle E-Business Suite node
- Forms WebLogic server
- Self-service Applications WebLogic server
- Oracle HTTP server

You can download the differences as a spreadsheet. See the section Understanding the Comparison Wizard in the Enterprise Manager Lifecycle Management Administrator's Guide.

**Important:** In an Oracle E-Business Suite instance featuring online patching, all patch edition targets are blacked out except for the node target. This is to prevent false alerts as the patch edition is supposed to be down. The node target is not blacked out because that target is used to collect metrics to detect a cutover and trigger corrective actions. See the section Monitoring Online Patching to Detect Cutover, page 8-23.

So, while comparing the configuration, the configuration of the patch edition node target will also show up as it is not blacked out. You must ignore it. In the Mapping compartment of the configuration comparison wizard, search for the target Oracle E-Business Suite Node. Check the box in the Ignore column for patch edition nodes and node system. You must also ignore the database nodes and node system because there is no run and patch editions.

Tracking Configuration Changes Introduced by a Patch

Configuration comparison capabilities of Enterprise Manager can help you get the
details of configuration changes introduced by patching. Follow the steps below:

1. Refresh and save the configuration.
   First, you must refresh and save the configuration before initiating the patching cycle, as mentioned in the above section. Once the patching cycle is complete, refresh and save the configuration again.

2. Compare the configurations.
   Compare with the template Compare Run and Patch Edition Configurations. Here, we are comparing only the node target because that is the only target that is not blacked out in the patch edition.

   When you perform the comparison between configurations collected for an Oracle E-Business Suite instance at different intervals, by default, the configuration of same targets are compared. In this case, the default mapping is to compare configurations of run edition node, which was collected before initiating the patching cycle, with the one collected before initiating the cutover. Since we want to know the changes that took place in the patch edition due to the patching cycle, we have to create the mapping to compare between the run and patch editions and ignore the default.

   In the mapping compartment of the comparison wizard, use the Create Mapping button and link the run edition node target to the patch edition node target.

   You must ignore the following mappings:
   • Between run to run App nodes
   • Between database nodes

   **Note:** When the comparison report is shown, it will show all targets. You must filter the search to show only those targets where differences were found in the configuration.
Administering Oracle E-Business Suite

This chapter covers the following topics:

• Starting and Stopping Services
• Manual Synchronization of Editions
• Privilege Propagation With Administration Groups
• Instance Administration

Starting and Stopping Services

There are two ways to start and stop the services running on each instance node: by selecting the options in the Administration menu or by using command line verbs.

Using the Administration Menu to Start and Stop Services

You can start and stop the components running on each node using the Administration menu. Select Administration > Start and Stop Services from the instance target menu (labeled "Oracle E-Business Suite"). All application nodes are shown with the targets running in them. You can select individual target or a node (which means you are selecting all targets running on that node) and start or stop it. ICM does not show up under a specific node because we can start and stop it from any node where it is enabled. If the Oracle E-Business Suite instance features Online Patching, only run editions targets are shown.

Jobs are submitted to start and stop services. The details and status of these jobs can be tracked through standard Enterprise Manager Job screens.

Note: For Oracle E-Business Suite Release 12.2, you cannot perform any action if a cutover is detected.
Privileges Need to Start and Stop Services Using the Administration Menu

An administrator must have the EM_ALL_ADMINISTRATOR role to run the jobs to start and stop components. In addition, an administrator must have the "Start and Stop Services" privilege to start and stop services.

For more information on privileges and roles, see: Privileges and Roles for Managing Oracle E-Business Suite, page 7-1.

Credentials Needed to Start and Stop Services Using the Administration Menu

- The preferred credential must be set for Oracle E-Business Suite node for the credential set **OS Credentials**.

- The preferred credential must be set for Oracle E-Business Suite for the credential set **AppsDBCredsSet**.

For more information on preferred credentials, see: Setting Oracle E-Business Suite Preferred Credentials, page 5-1.

Using Command Line Verbs to Start and Stop Services

Oracle Application Management Pack for Oracle E-Business Suite provides a command-line interface for the batch execution of start/stop multiple Oracle E-Business Suite services. This feature uses Enterprise Manager Command Line Interface (EM CLI). See **Enterprise Manager Command Line Interface** to understand more about EM CLI.

The EM CLI verbs allow you to start and stop on-premises Oracle E-Business Suite instances. These verbs also generate a health check report which describes the status of certain target types (if certain services are accessible).

The health check is generated before stopping and after starting Oracle E-Business Suite. You can use these reports to validate or check any discrepancies that might occur between the stop and start of Oracle E-Business Suite.

Prerequisites

- EM CLI must be installed. See "Downloading and Deploying the EM CLI Client for Standard EM CLI" in **Oracle Enterprise Manager Command Line Interface**.

- Set up EM CLI. See "Getting Started with EM CLI" in **Oracle Enterprise Manager Command Line Interface**.

- Log in to your Oracle Management Server (OMS).

- Synchronize the EM CLI client with OMS.

- The following are mandatory credentials that must be set:
The preferred credential must be set for Oracle E-Business Suite node for the credential set **OS Credentials**.

The preferred credential must be set for Oracle E-Business Suite for the credential set **AppsUserCredsSet**.

The preferred credential must be set for Host for the credential set **Normal Host Credentials** (for all application node hosts).

**Stopping Services on the Oracle E-Business Suite Instance**

Use the EM CLI verb `stop_ebs` to stop services on the Oracle E-Business Suite instance with details of the instance provided as an XML file. Schema requirements and sample XML with comments are found in the appendix XML Schema Using EM CLI, page G-2.

You can provide the following named credentials in the input XML file:

- "E-Business Suite Database credentials" type for Oracle E-Business Suite target type set for the APPS schema.

- "Oracle Weblogic credentials" type for Oracle WebLogic Server target type.

The required APPS schema database credentials and WebLogic Server administration credentials are chosen in the following order:

1. Preferred credentials set for:
   - "AppsDBCredsSet" credential set for Oracle E-Business Suite
   - "Oracle Weblogic Administration credentials" credential set of Oracle WebLogic Server target type

2. Named credentials provided at the individual Oracle E-Business Suite instance level

3. Global named credentials

   **Note:** You can generate the XML from the schema using any IDE. Choose a depth of 8 or more, if you do so.

Execute the following command to stop services on the Oracle E-Business Suite instance:

```
./emcli stop_ebs -input_file=stop_file:<fully qualified path of stop_ebs_file.xml> -oms_url=<em url> [-log_file=<fully qualified path of log file>] [-emcli_pwd=<password>]
```

The `log_file` parameter is optional. If it is not provided, the system generates its own,
and the path is then displayed in the console. The log file contains the debug statements, job IDs of various jobs which are submitted in the process of stopping Oracle E-Business Suite. You may be prompted for the `emcli_pwd` parameter if it is not passed.

The following is the sequence of actions that occurs while stopping Oracle E-Business Suite:

1. A job is submitted to stop the Oracle E-Business Suite instance.

2. A health check report is generated and the path of the report is displayed in the console.

3. A blackout is performed on the Oracle E-Business Suite instance. This is to avoid receiving alerts that the instance is down.

4. Application node components are stopped.
   - **Selection of application nodes**
     - Either all or only selected application nodes are stopped, based on the attribute `StartAndStopOnAllNodes` value of the `EBSInstancesList/GlobalSettings/AppsTier` tag.

   - All application nodes are stopped if this value is `true`.

   - If this value is `false`, only the application nodes mentioned in the `EBSInstancesList/EBSInstances/EBSInstance/AppNodes/ContextName` tag are stopped.

   - Multiple `ContextName` tags could be provided to mention multiple application context names.

   - For Oracle E-Business Suite Release 12.2, only application nodes of run edition type are stopped.

   - **Components to be stopped**
     - Using the `EBSInstancesList/GlobalSettings/AppsTier/Component` tag, you can specify the component that has to be stopped. To do this, provide one of the following options:

       - All
       - ICM
       - APPS_LISTENER
       - HTTP_SERVER
• OAFM_OC4J
• OACORE_OC4J
• FORMS_OC4J
• ADMIN_SERVER_WEBLOGIC
• FORMS_WEBLOGIC
• OACORE_WEBLOGIC
• FORMS_LISTENER

• Selection of database nodes
  • Either all or only selected database nodes are stopped based on the attribute StartAndStopOnAllNodes value of the EBSInstancesList/GlobalSettings/DBTier tag.

  All database nodes are stopped if this value is true.

  If this value is false, only the database nodes mentioned in the EBSInstancesList/EBSInstances/EBSInstance/DBNodes/ContextName tag are stopped.

  Multiple ContextName tags could be provided to mention multiple DB context names.

• Components to be stopped
  • Using the EBSInstancesList/GlobalSettings/DBTier/Component tag, you can specify the component that has to be stopped. To do this, provide one of the following options:
    • ALL
    • LISTENER
    • DATABASE

5. Database node components are stopped.
  • Either all database nodes or only selected database nodes would be stopped based on the attribute "StartAndStopOnAllNodes" value of EBSInstancesList/GlobalSettings/DBTier tag. All database nodes are stopped if
this value is true. If this value is false, only database nodes mentioned in the EBSInstancesList/EBSInstances/EBSInstance/DBNodes/ContextName tag are stopped.

- Multiple ContextName tags could be provided to mention multiple DB context names.

- Using the EBSInstancesList/GlobalSettings/DBTier/Component tag, you can specify the component to be stopped. The following is a list of options:
  - ALL
  - LISTENER
  - DATABASE

You can review the job summary to view the execution report of all Oracle E-Business Suite instances.

**Starting Services on the Oracle E-Business Suite Instance**

Use the EM CLI verb `start_ebs` to start services on the Oracle E-Business Suite instance with details of the instance provided as an XML file. Schema requirements and sample XML with comments are found in the appendix XML Schema Using EM CLI, page G-2.

You can provide the following named credentials in the input XML file:

- "E-Business Suite Database credentials" type for Oracle E-Business Suite target type set for the APPS schema.

- "Oracle Weblogic credentials" type for Oracle WebLogic Server target type.

The required APPS schema database credentials and WebLogic Server administration credentials are chosen in the following order of precedence:

1. Preferred credentials set for:
   - "AppsDBCredsSet" credential set for Oracle E-Business Suite
   - "Oracle Weblogic Administration credentials" credential set of Oracle WebLogic Server target type

2. Named credentials provided at the individual Oracle E-Business Suite instance level

3. Global named credentials
Note: You can generate the XML from the schema using any IDE. Choose a depth of 8 or more, if you do so.

Execute the following command to stop the Oracle E-Business Suite instance:

```
./emcli start_ebs -input_file=start_file:<fully qualified path of
start_ebs_file.xml> -oms_url=<em_url> [-log_file=<fully qualified
path of log file>] [-emcli_pwd=<password>]
```

The `log_file` parameter is optional. If it is not provided, the system generates its own and the path will be displayed in the console. The log file contains the debug statements, job IDs of various jobs which are submitted in the process of starting Oracle E-Business Suite. You may be prompted for the `emcli_pwd` parameter if it is not passed.

The following is the sequence of actions that occurs while starting Oracle E-Business Suite.

1. A job is submitted to start the Oracle E-Business Suite instance.
2. The Oracle E-Business Suite database components are started.
   - **Selection of application nodes**
     - Either all or only selected application nodes are started based on the attribute `StartAndStopOnAllNodes` value of the `EBSInstancesList/GlobalSettings/AppsTier` tag.
     - All application nodes are started if this value is true.
     - If this value is false, only those application nodes mentioned in the `EBSInstancesList/EBSInstances/EBSInstance/AppNodes/ContextName` tag are started.
     - Multiple `ContextName` tags could be provided to mention multiple application context names.
     - For Oracle E-Business Suite Release 12.2, only application nodes of run edition type are started.
   - **Components to be started**
     - Using the `EBSInstancesList/GlobalSettings/AppsTier/Component` tag, you can specify the component that has to be started. To do so, provide one of the following options:
       - ALL
       - ICM
• APPS_LISTENER
• HTTP_SERVER
• OAFM_OC4J
• OACORE_OC4J
• FORMS_OC4J
• ADMIN_SERVER_WEBLOGIC
• FORMS_WEBLOGIC
• OACORE_WEBLOGIC
• FORMS_LISTENER

• Selection of database nodes
  • Either all or only selected database nodes are started based on the attribute StartAndStopOnAllNodes value of the EBSInstancesList/GlobalSettings/DBTier tag.
  • All database nodes are started if this value is true.
  • If this value is false, only database nodes mentioned in the EBSInstancesList/EBSInstances/EBSInstance/DBNodes/ContextName tag are started.
  • Multiple ContextName tags could be provided to mention multiple DB context names.

• Components to be started
  • Using the EBSInstancesList/GlobalSettings/DBTier/Component tag, you can specify the component that has to be started. To do so, provide one of the following options:
    • ALL
    • LISTENER
    • DATABASE

3. The blackout is removed on the Oracle E-Business Suite instance.
4. The health check report is generated and the path of the report is displayed in on the console.

You can review the job summary to view the execution report of all Oracle E-Business Suite instances.

**Health Check Report**

As part of the Health Check Report, the following tests are executed on Oracle E-Business Suite. The name of the test and its results are displayed in a table in HTML format.

**Health Check Report Tests**

<table>
<thead>
<tr>
<th>Serial No.</th>
<th>Test Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that maintenance mode is disabled</td>
</tr>
<tr>
<td>2</td>
<td>Verify Service Manager concurrent manager on each node</td>
</tr>
<tr>
<td>3</td>
<td>Verify if AppsLocalLogin.jsp is accessible</td>
</tr>
<tr>
<td>4</td>
<td>Verify database in Archive Mode</td>
</tr>
<tr>
<td>5</td>
<td>Verify Forms server is up and running</td>
</tr>
<tr>
<td>6</td>
<td>Verify OPMN processes are up and running</td>
</tr>
<tr>
<td>7</td>
<td>Verify JTF Login as sysadmin</td>
</tr>
<tr>
<td>8</td>
<td>Verify MWA server</td>
</tr>
<tr>
<td>9</td>
<td>Verify responsibilities assigned to SYSADMIN</td>
</tr>
<tr>
<td>10</td>
<td>Show number of JVMs configured</td>
</tr>
<tr>
<td>11</td>
<td>Verify Workflow Notification Mailer</td>
</tr>
<tr>
<td>12</td>
<td>Compare the Workflow Components status</td>
</tr>
<tr>
<td>13</td>
<td>Compare invalid database objects</td>
</tr>
<tr>
<td>Serial No.</td>
<td>Test Name</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>14</td>
<td>Verify duplicate rows in FND_OAMCONTEXT_FILES</td>
</tr>
<tr>
<td>15</td>
<td>Run &quot;Prints environment variable values&quot; CP</td>
</tr>
</tbody>
</table>

**Manual Synchronization of Editions**

When monitoring an Oracle E-Business Suite instance that features Online Patching, the plug-in ensures that only the run edition targets are monitored after a cutover. This is achieved through a corrective actions job which will black out the patch edition targets. The corrective actions are triggered based on the metrics collected about the patching activity. In case if they fail to trigger, the plug-in will end up monitoring the wrong file system. Corrective actions will not be triggered until the next cutover. Therefore, if the user observes that the plug-in is monitoring the wrong file system, with the Operator privilege the user must manually trigger the corrective actions job.

Navigate to Administration > Synchronize Edition Details in the instance target menu.

By synchronizing the edition details, this will ensure that the plug-in monitors the run edition only. This job will exit gracefully if the correct file system is being monitored. The same UI will also show the details of previous submissions for the same purpose.

**Privilege Propagation With Administration Groups**

An administration group in Enterprise Manager is a special kind of group wherein the target members can be added automatically based on certain target properties of the members. When target properties match with administrative group specifications, then the target is automatically added to that administration group. A privilege defined for an administrative group is also set for all the member targets. A target must have the ability to accept privilege propagation to be part of administration group, otherwise the privileges cannot be set for the members of that target. All Oracle E-Business Suite targets can be part of administration groups and allow privilege propagation.

For more information on administration groups in Enterprise Manager, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

**Important:** To use this functionality, an administrator must have both Full Any Target and Create Privilege Propagating Group target privileges to be able to create an Administration Group.
How to Create an Administration Group in Enterprise Manager

1. From the Enterprise Manager console, click the Targets drop-down menu > Groups.
2. On this screen, click on the Create drop-down.
3. Select Administration Group from the list.
4. Define the Administration Group’s target properties. Choose one or more target properties by clicking on Add in Hierarchy Levels table.
5. Specify the target property value(s) by adding in the Hierarchy Nodes table.
6. Click Create to save your work and create the group.

How to Add Targets as Members of an Administration Group

Once an administration group is created, members can be added by specifying member properties as that are of the group. For an Oracle E-Business Suite instance, the following steps are used to set the target properties.

1. Navigate to Targets > Oracle E-Business Suite from the Oracle Enterprise Manager console.
2. Select an instance by clicking on it.
3. From the Oracle E-Business Suite instance target menu, select Target Setup > Properties.
4. Set the target property value to one of the values specified in the Administration Group page by clicking on the Edit button.
5. To save, click OK.
6. To view the Administration group members, go back to Targets and then Groups.

You can now see the Oracle E-Business Suite instance and members added to the administration group created earlier and also in the corresponding subgroup based on the value of target property chosen.

Example

For example, you can create an administration group with two subgroups corresponding to Production and Development lifecycle statuses.

Set the Lifecycle Status of an Oracle E-Business Suite instance by selecting Production in the drop-down listing.
Now, the Oracle E-Business Suite target members should be added to the group automatically and to the Production level.

Instance Administration

Brief Description

The Oracle E-Business Suite Instance Administration feature provides the option to modify the existing Oracle E-Business Suite instance in the following ways:

- Add/Remove application tier nodes
- Enable/Disable service groups in each application node
- Create/Delete managed servers in each application node (For Oracle E-Business Suite Release 12 only)

Required Setup

Oracle E-Business Suite Instance Administration requires Perl 5.005 or later on the Oracle Enterprise Manager agent. The user who starts the agent processes must set the PERL5LIB environment variable to point to the Perl 5.005 (or later) libraries. Also, the Perl executable 5.005 must be used.

All virtual internet protocol (VIP) addresses configured in the Oracle Cluster Ready Services (CRS) of the target nodes identified for the created RAC instance must be up
and running.

The OS utilities make, ld, cc, and ar must be in the environment PATH variable in all host targets. If not, please update the PATH variable accordingly and restart the agent in the same terminal.

**Prerequisites**

Before starting Oracle E-Business Suite Instance Administration, please make sure the following prerequisites are met:

**Oracle E-Business Suite Instance Prerequisites**

- The Oracle E-Business Suite instance to be modified must be up and healthy.

- The instance should have been discovered in Enterprise Manager and the status must not be pending.

- The instance should have had AutoConfig run successfully. It is mandatory that AutoConfig was successfully run on the source applications tier and source database tier.


- At the time of running the Oracle E-Business Suite instance, the `etc/oraInst.loc` must point to the correct `oraInventory`.

  **Note:** On some platforms such as Solaris, the variable is `/var/opt/oracle/oraInst.loc`.

**Oracle Application Management Pack for Oracle E-Business Suite Prerequisites**

- All database hosts and application tier hosts should have "Oracle E-Business Suite Plug-in" deployed before starting Oracle E-Business Suite Instance Administration.

**User Privileges**

- User privileges for the Cloning module are also applicable to Oracle E-Business Suite instance administration.

**Navigation to Oracle E-Business Suite Instance Administration**

Oracle E-Business Suite Instance Administration can be accessed through the Oracle E-Business Suite home page or from the Procedure Library.
From the Oracle E-Business Suite Home Page

Go to the Oracle E-Business Suite Management page and expand the Administer menu. Then, select Instance Administration.

From the Procedure Library

Navigate to the Procedure Library from the Enterprise menu > Provisioning and Patching > Procedure Library.

Search for and select the "Instance Administration for R12, 12.2.x" procedure radio button. Then, click Go.

How to Submit an Oracle E-Business Suite Instance Administration Procedure

From the Oracle E-Business Suite Instance Administration start page, follow the steps below to submit an Oracle E-Business Suite Instance Administration procedure:

1. Select the Oracle E-Business Suite instance by clicking on the Search icon. Selecting an instance will display the application and database node information.

2. Verify the current Oracle E-Business Suite details.

Then, enter the following data:

- Job name: Name of the current job to be submitted
- Database Apps Credential
- Database Apps Credential
- For Oracle E-Business Suite Release 12.2 only: WebLogic password
3. Manage the application nodes.

To add application nodes:

1. In the Application Nodes section, click Add. The Select Host(s) window will appear.
2. Select one or more hosts to be added, then click OK.

For Release 12.2 only: To add an application node as a shared file system node:

1. In the Select Host(s) window, select the Shared Application Node radio button. Choose the node to be added in the Select APPL_TOP drop-down.
2. Then, select one or more hosts to be added. Click OK.

To delete application nodes:

1. Select one or more rows in the Application Nodes table.
2. In the Application Nodes panel, click Delete, which pops up a list of hosts.

To update the service groups of each application node:

1. The user will be able to update the following service groups for each node:
   - Web Entry Point Service Group: To enable following services in the current node:
     - OHS, OPMN
   - Web Application Service Group: To enable following services in the current
node:
- oacore, forms, oafm, tns_apps
- For Release 12.2 only: forms-c4ws, oaea

- Batch Processing Service Group: To enable following services in the current node:
  - Concurrent Manager, ICSM, JTFF

- Other Services: To enable following services in the current node:
  - forms_server, met_cl, met_srv, mwa_srv

- For Release 12.2 only: Admin - To enable WebLogic Admin Server in the current node.

- For Releases earlier than 12.2.x only: Root Service Group - To enable Node Manager in the current node.

  Note: For Release 12.2, the node manager will automatically be enabled if the Web Application Service Group is enabled.

For Release 12.2 only: Updating managed servers:
- When a user selects "Web Application Services," default managed servers will automatically be populated.

- Users can delete/add managed servers with the options found in the Managed Servers column. Click Add to add a managed server. Click the red X icon to delete it.

4. Modify the stage directory details.
   If the user has added at least one new node, this option will appear.

Manual copy: If a user wants to copy files manually / file system on the new application node is already present.

Automatic copy: This option allows users to automatically copy files from the Admin node to the new application nodes. Users can choose from one of the copy methods described below:
- Remote file transfer: When in the Admin node, new application nodes do not have any shared storage mounted.
- Shared file system storage: When in the Admin node, new application nodes
are on different hosts and have a common storage location mounted across.

Enter the stage directory path.

Enter the absolute path for the Admin Host stage directory.

Also, enter the absolute path of the stage directories for new application host(s).

**Note:** Make sure this directory has write permissions. Also, the stage directory has sufficient space to hold a complete course file system (Approximately 15GB - 20GB or more free space is required, depending on the source application file system).

The following screenshot shows an example of when the user had added 2 new nodes to the existing Oracle E-Business Suite instance:

![Oracle E-Business Suite Management Screenshot](image)

5. The following host credentials need to be defined:
   - Database node credentials: This table lists all the database nodes.
   - Application node credentials: This table contains all the application node hosts.

**Note:** It is recommended that you verify your entries and click on the **Test** button before proceeding to the next step.
6. The last step displays the data which was entered by the user. Review and click on the Finish button to submit the clone.

**Viewing the Status of a Submitted Instance Administration Procedure**

1. Open the Procedure Activity page by navigating to the Enterprise menu > Provisioning and Patching > Procedure Activity.

2. Enter the Job Name that was provided when the procedure was submitted into the Search Text Fields field and click Go.

3. In the Procedure Steps section, select the corresponding check box to choose a procedure to view its details.
4. If any of the procedure step statuses are marked as failed, select the step to view it in the procedure view and choose one of the following options:

- Ignore - Ignore the current failed step and proceed to the next step.
- Retry - Retry the failed step.
- Update and Retry - Update the job parameters and retry the failed step.

Note that in the Instance Administration deployment procedure for Release 12.2.x, as AutoConfig on the database tier will update the sqlnet.ora there will be a manual step just before the target Oracle E-Business Suite discovery step to enable the OMS host(s) to connect to the target Oracle E-Business Suite database. You need to verify and update the OMS host(s) entry for tcp.invited_nodes if tcp_validnode_checking is set to yes.
Update opnetora file to enable OMS connectivity

Please make sure all the instructions are completed before you confirm.

Instructions:
1. Change the path to point to the Target ODS database
2. Update the file in the TARGET_0DS/opnetora file by appending OMS server to the "http://operated" entry. (End)

Note:
This chapter covers the following topics:

- Settings to Monitor Oracle E-Business Suite
- Configuring Monitoring of HTTPS/SSL Targets

### Settings to Monitor Oracle E-Business Suite

You can change the configuration with which each Oracle E-Business Suite instance is monitored. You can do two things:

- Change monitoring schema
- Change the availability definition of the Oracle E-Business Suite instance

To configure monitoring, go to the Oracle E-Business Suite Management page by clicking on the global Targets menu > **Oracle E-Business Suite**. In the Oracle E-Business Suite Instances section, select the Oracle E-Business Suite instance by highlighting the chosen row and click **Configure**.

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBSSFSEE31_Oracle E-Business Suite</td>
<td><img src="up" alt="Down" /></td>
</tr>
<tr>
<td>allqa-Oracle E-Business Suite</td>
<td><img src="up" alt="Down" /></td>
</tr>
<tr>
<td>ebs1228_Oracle E-Business Suite</td>
<td><img src="up" alt="Up" /></td>
</tr>
<tr>
<td>sc1226_Oracle E-Business Suite</td>
<td><img src="down" alt="Up" /></td>
</tr>
</tbody>
</table>
Changing the Monitoring Schema

After clicking the Configure button, you can change the details of the monitoring schema. You can either change the user name or password here and click Next or directly proceed to change the availability computation by clicking Next.

![Configure ebs1226_Oracle E-Business Suite : Parameters](image)

Extending the Oracle E-Business Suite Target Model

The status of the Oracle E-Business Suite target is determined by the status of its member targets. It uses AND logic, which means all the members must be up for the Oracle E-Business Suite target to be up. Customers can add more targets or remove existing targets.

*Note:* Starting with Release 12.1.0.3.0, the management pack availability computation matches the Enterprise Manager computation so that the same status is shown across all pages. The "Partially Up" status is retired now.

Viewing the Existing Availability Definition

Navigate to global Targets menu >Oracle E-Business Suite. From the Oracle E-Business Suite Management page, select an instance and click Configure. After specifying parameters, click Next to go to the Availability Definition page.

You can see all the targets being used to evaluate the status.
You can select a specific target type as well as search for a target name.

**Changing the Availability Definition**

In the above UI, check the targets you wish to include in the availability computation. Deselect a target if you want to exclude it. Click on **Add Target** to add any other target which is not part of the Oracle E-Business Suite hierarchy, such as SSO, LDAP, Load Balancer, and so on. Then click **Next**. Review the availability computation summary and click **Submit** to save your changes.
If the Oracle E-Business Suite instance features Online Patching, only run edition targets are shown in the UI. If you remove the current run edition target from the availability computation, the corresponding patch edition target will also be removed so that it works seamlessly once a cutover happens. The summary page where you can review the availability computation shows the details of the run edition and patch edition targets that are affected.

Adding or Removing an Oracle E-Business Suite Node

If you add or remove a node as part of availability definition, all of its child members will also be added or removed.

Targets That Cannot be Removed as Part of Availability Configuration

You cannot remove the database, database node, or the WLS Administration Server from availability definition.

Configuring Monitoring of HTTPS/SSL Targets

To configure Cloud Control to monitor Oracle E-Business Suite application tiers that are running in SSL, each Management Agent must be able to authenticate the application tier's SSL certificate against its Certificate Authority (CA).
Assumed Prerequisites

- The HTTP Server that ships with Oracle E-Business Suite is already configured and verified to be running in SSL mode.
- Basic knowledge of SSL certificates and their configuration.

Obtaining the CA Certificate(s)

1. In Microsoft Internet Explorer, connect to the HTTPS URL of the Web site you are attempting to monitor.
2. Double-click the lock icon at the bottom of the browser screen which indicates that you have connected to a secure Web site. The browser displays the Certificate dialog box, which describes the certificate used for this Web site. Other browsers offer a similar mechanism to view the certificate details of a Web site.
3. Click the **Certificate Path** tab and select the first entry in the list of certificates.
4. Click **View Certificate** to display a second Certificate dialog box.
5. Click the **Details** tab on the Certificate window.
6. Click **Copy to File** to display the Certificate Manager Export wizard.
7. In the Certificate Manager Export wizard, select Base64 encoded X.509 (.CER) as the format you want to export and save the certificate to a text file with an easily identifiable name, such as beacon_certificate.cer.
8. Open the certificate file using a text editor.

Add the Certificate to the Management Agent(s)

Each Management Agent that monitors an Oracle E-Business Suite application tier must have the CA certificate added to it as follows:

1. Locate the `b64InternetCertificate.txt` file in the following directory of Agent Home of the Beacon host: `$AGENT_ORACLE_HOME/sysman/config` (This file contains a list of Base64 Certificates).
2. Edit the `b64InternetCertificate.txt` file and add the contents of the certificate file you just exported to the end of the file, making sure to include all the Base64 text of the certificate including the BEGIN and END lines.
3. Repeat for each Management Agent.
Restart Each Management Agent

Each Management Agent should be restarted:

> $AGENT_ORACLE_HOME/bin/emctl stop agent
> $AGENT_ORACLE_HOME/bin/emctl start agent

Cloud Control may not immediately pick up the change. You may want to give it a few minutes for the agent to run a metrics collection and upload them to the Oracle Management Server (OMS). You can click on the Refresh icon in the upper right of the Oracle E-Business Suite home page (by the Page Refreshed time stamp) in the Cloud Control console to get updated information.

Importing an Oracle E-Business Suite SSL Certificate to the OMS

Oracle Application Management Pack for Oracle E-Business Suite invokes REST services deployed on Oracle E-Business Suite using java.net.HttpURLConnection. The User Monitoring and Diagnostics features use REST services. If the Oracle E-Business Suite instance is SSL-enabled, the SSL certificate must be exported from Oracle E-Business Suite and imported to the trust keystore of the Oracle WebLogic Server (WLS) that runs the OMS. Below are the steps to do this action:

1. Find out the trust keystore of WebLogic Server.

2. Open the WebLogic Server Administration Console by using the following steps.
   1. Go to the All Targets page of Enterprise Manager Grid Control.
   2. Select the target type Oracle WebLogic Server.
   3. Select the WebLogic Server instance that runs the OMS.
   4. The target home page will contain the link to open the Administration Console.

3. From the Administration Console, select Servers.

4. Select the server that runs the OMS.

5. Click on the subtab Keystores under Configuration.

6. Look for the Java Standard Trust Keystore which points to the location of the keystore.

7. Run the command to import the certificate using the keytool utility. Use the JDK that comes with WebLogic Server.

   JDK_HOME/bin/keytool -importcert -alias oracle_ebs_<ebs instance name> -trustcacerts -file <location of EBS SSL certificate> -keystore <location of key store>
Refer to the Java SE documentation on the command `keytool` for information on passwords.

8. Restart the OMS.

For more information on configuring identity and trust for WebLogic Server, see the Oracle Fusion Middleware manual *Securing Oracle WebLogic Server*.

**Re-Configuring SSL for Oracle E-Business Suite**

If you have implemented SSL or deactivated SSL after the initial discovery of that Oracle E-Business Suite instance in Cloud Control, you will have to re-configure Cloud Control to monitor the new URL with the new protocol. There are two ways to do this:

- The Easy Way: If you don’t care about the metrics data that has been collected for the instance, you can simply remove the instance from Cloud Control and rediscover it.

- The Hard Way: If metrics history is important, then each HTTP Server Target has to be re-configured to point to the new URL, port, and protocol.

**Re-Configuring Release 12 Application Servers**

1. Navigate to the home page of the Oracle E-Business suite instance. Select **Members > Show All** from the instance target menu.

2. Search for the target type "Oracle Application Server".

3. From the results listing, select the HTTP Server for Oracle Applications Server target to go to its home page.

4. In the target menu, select **Change Application URL**.

5. Edit the "URL to measure application response" as appropriate.

6. Click **OK**.

**References**

- My Oracle Support Knowledge Document 376700.1, *Enabling SSL in Oracle Applications Release 12*


- *Oracle Enterprise Manager Cloud Control Administrator’s Guide*
This chapter covers the following topics:

- Diagnosing Issues Using Pack Diagnostics
- Diagnostic Tests for AMP: Cloning
- Diagnostic Tests for Patch Manager
- Diagnostic Tests for Customization Manager
- Diagnostic Tests for User Monitoring

Diagnosing Issues Using Pack Diagnostics

Pack Diagnostics

Oracle Application Management Pack for Oracle E-Business Suite includes a diagnostics feature which can be used to troubleshoot issues by running diagnostic tests. The tests are grouped into the modules listed below.

- AMP: Cloning
- Patch Manager
- Customization Manager
- User Monitoring

To navigate to the diagnostics module, on the Oracle E-Business Suite Management page, select Pack Diagnostics from the Administer menu.

How to Run a Diagnostic Test

To execute a diagnostic test, click Create. This will take you the page where you must provide the details to do the diagnosis. You must enter the details described in the
following table:

**Diagnostic Test Details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name to identify this instance of execution. This name can be later used to search for this instance of execution.</td>
</tr>
<tr>
<td>Module</td>
<td>You can select a specific module or all modules from the drop-down list. When you select a module, all tests for that module will be run.</td>
</tr>
<tr>
<td>Show Details</td>
<td>You can select the extent of detail you want in the final report.</td>
</tr>
<tr>
<td></td>
<td>• All - This option logs all information regardless of whether the diagnostic test completes with success or error.</td>
</tr>
<tr>
<td></td>
<td>• Errors only - This option only logs details for those tests that error out.</td>
</tr>
<tr>
<td>Category</td>
<td>• Generic - Select this option to perform a health check of a specific module.</td>
</tr>
<tr>
<td></td>
<td>• User Specific - Select this option to diagnose issues faced by the current logged-in user in a specific module.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional description for this instance of the execution.</td>
</tr>
</tbody>
</table>

You must add the Oracle E-Business Suite instance against which the diagnostic test will be executed. You can add multiple Oracle E-Business Suite instances. Click on the **Add** button in the Targets section. A list of values will pop up with the list of all the Oracle E-Business Suite instances discovered, and you can select the needed Oracle E-Business Suite instances. Once you are done with the selection, click the **Submit** button.

A job to run the tests is submitted, and the status column in the Requests table will show the status of the execution. You can refresh the page to get the latest status. You can click on the **Status** column to drill down further to see a detailed report of the execution. Expand the hierarchical table by clicking **Expand All**. There will be **Tasks** and **Steps**. Click on the status column of each step to get the detailed report for that step.

**Search for a Test Execution**

The pack diagnostics page by default list the name and other details of recent executions. You can search for any execution by its name.
Executing a Test Again

You can rerun an instance of execution without entering the details again. Search for that instance. Select it and click on the **Retest** button.

Diagnostic Tests for AMP: Cloning

You should run diagnostic tests on your system in preparation for the cloning procedures to ensure your system is set up properly. For more information on running diagnostic tests, see: How to Run a Diagnostic Test, page 12-1.

The following table lists generic diagnostic tests related to cloning.

**Generic Diagnostics Tests for AMP: Cloning**

<table>
<thead>
<tr>
<th>Step</th>
<th>Severity</th>
<th>Test Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Check if EBS has Shared File System</td>
<td>Expected results: Yes/No. This is an informational message. If the shared file system is enabled and the result is No, please check ‘s_atname’ to find out if all the nodes are consistent. Name of Command: CheckIfSFS</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Check if AutoConfig is run on Database Tier</td>
<td>Verify if AutoConfig has been run on the database tier. For cloning to work, it is mandatory that AutoConfig was successfully run on the source database tier. Name of Command: CheckIfAutoConfigIsRun</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Check If AutoConfig Is Run on Applications Tier</td>
<td>Verify if AutoConfig has been run on the applications tier.</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get the Database Tier Operating System User Name</td>
<td>Get the O/S User Name for the database tier.</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test Description</td>
<td>Notes/Expected Results/Corrective Measures</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get Agent Perl Version</td>
<td>Verify Agent Perl utility version. Cloning using the management pack requires the agent Perl utilities to be at a certain version level for certain cloning flows to function properly. Please make sure that the Perl version inside the Agent is compatible with that in the Oracle E-Business Suite instance (see the related diagnostic test for the Oracle E-Business Suite Perl Version) Name of Command: GetAgentPerlVersion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Get key environment variables for Database Context</td>
<td>Obtain key environment variables for Database Context, including: PATH LD_LIBRARY_PATH LIBPATH SHLIB_PATH ORACLE_HOME ORACLE_SID PERL5LIB TNS_ADMIN Certain database context variables of the source Oracle E-Business Suite instance need to be definitively set with non-null values for the cloning job to proceed successfully. If this diagnostic test fails, run AutoConfig on the database tier so that the correct environment file is generated again. The values in the environment file are used in this command. Name of Command: GetEnvironmentVariableValues</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get the APPS tier Operating System User Name</td>
<td>Get the O/S User Name for the applications tier.</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get key information required for Apps Context Configvariables</td>
<td>Obtain key environment variables for the applications context, including: s_base, s_dbuser, s_dbgroup, s_appuser, s_appsgroup, s_dbport, s_port_pool, s_config_home, s_atName, s_hostname</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>CheckIOPatches for &lt;Oracle E-Business Suite Release Name&gt;</td>
<td>Verify that certain patches have been applied on the Oracle E-Business Suite target.</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Get EBS Perl Version</td>
<td>Check Oracle E-Business Suite Perl utility version.</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test Description</td>
<td>Notes/Expected Results/Corrective Measures</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td><strong>Check if AutoConfig is run on Applications Tier</strong></td>
<td>Verify if AutoConfig has been run on the applications tier. It is mandatory that AutoConfig completed successfully on the source applications tier for cloning to work. Name of Command: CheckIfAutoConfigIsRun</td>
</tr>
</tbody>
</table>
| EBS  | Warning  | **Get information for key Database Context Config variable** | Obtain key database context variables that are required for non-“Smart Clone” cloning procedures, including:  
- s_base  
- s_dbuser  
- s_dbgroup  
- s_appsuser  
- s_appsgroup  
- s_dbport  
- s_port_pool  
- s_hostname  
Certain database context variables of the source Oracle E-Business Suite instance need to be set with non-null values for the clone jobs to finish successfully. If this diagnostic test fails, rerun AutoConfig on the database tier. Name of Command: GetDBConfigVariables |
| EBS  | Warning  | **Get key environment variables for Application Context** | Obtain key environment variables for the applications context, including:  
- PATH  
- LD_LIBRARY_PATH  
- LIBPATH  
- SHLIB_PATH  
- ORACLE_HOME  
- ORACLE_SID  
- PERL5LIB  
- TNS_ADMIN  
If this diagnostic test fails, rerun AutoConfig on the applications tier. Name of Command: GetEnvironmentVariableValues |
<table>
<thead>
<tr>
<th>Step</th>
<th>Test Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Checks if Oracle E-Business Suite AD Snapshot is valid</td>
<td>In order to perform a &quot;scale-down clone&quot; process (that is, a multi-node source applications tier instance which has non-shared APPL_TOPs to a unified APPL_TOP in the target), AMP needs to ensure that the snapshots for the source APPL_TOPs have been updated properly. Make sure the &quot;Update Current View Snapshots&quot; option in adadmin is run at least once after Oracle E-Business Suite creation. Name of Command: CheckIfADSnapshotIsValid</td>
</tr>
</tbody>
</table>

EBS Summary

A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.

The following table lists user-specific diagnostic tests related to cloning.
### User-Specific Tests for AMP: Cloning

<table>
<thead>
<tr>
<th>Step</th>
<th>Severity</th>
<th>Test</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Check Host Credential for Smart Clone flows</td>
<td>Check if the EM User has required preferred credential set for &quot;Operating System Username&quot; and &quot;Operating System Password&quot; in &quot;Oracle E-Business Suite Node&quot; target type for the applications context for Smart Clone flows.</td>
<td>If this diagnostic test fails, set the applications context operating system credentials in the &quot;Oracle E-Business Suite Node&quot; target type in the preferred credential store. Name of Command: CheckAppsContextCredentialExistence</td>
</tr>
<tr>
<td>EBS</td>
<td></td>
<td>Check Database schema credentials for Smart clone flows</td>
<td>Check if the EM User has the required preferred credential set for the APPS schema users in &quot;Oracle E-Business Suite&quot; target type for Smart Clone flows.</td>
<td>The database APPS schema credentials must be entered manually with Smart Clone flows.</td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Diagnostic Tests for Patch Manager

You should run diagnostic tests on your system in preparation for running Patch Manager procedures to ensure your system is set up correctly. For more information on running diagnostic tests, see: How to Run a Diagnostic Test, page 12-1.

The following table lists generic tests related to Patch Manager:
<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMGC</td>
<td>Check permissions for OMS Stage directory</td>
<td>Determine if a stage directory is defined on the OMS. Determine if the owner has read/write permissions to that directory.</td>
<td>Expected results are: the OMS Stage Directory Location, with the OMS user with read/write permissions.</td>
</tr>
<tr>
<td>EMGC</td>
<td>Check Patch Manager Stage directories</td>
<td>Verify if the properties set in the Preferences page have proper definitions for Patch Manager Stage directories</td>
<td>Refer to the section Patch Manager Prerequisites, page 16-13 for instructions on completing this step.</td>
</tr>
<tr>
<td>EMGC</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>Check if EBS Snapshot in OMS Repository is valid</td>
<td>Verify if the Oracle E-Business Suite snapshot in OMS Repository is valid. A snapshot shows data about a system for a point in time. If the snapshot is invalid, navigate to the Targets menu &gt; Oracle E-Business Suite and click on the instance name. Then navigate to the Oracle E-Business Suite menu (in the top left corner) &gt; Configuration &gt; Last Collected &gt; Actions &gt; Refresh.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>Check for EBS CPU Count</td>
<td>Verify that the target Oracle E-Business Suite system's CPU Count is greater than zero (0).</td>
<td>If there is not a valid snapshot, contact Oracle Support.</td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists user-specific tests for Patch Manager.
## User-Specific Diagnostic Tests for Patch Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMGC</td>
<td>CheckMetalink</td>
<td>Verify if username/password credentials are entered for My Oracle Support.</td>
<td>Refer to the Oracle Enterprise Manager documentation for instructions on completing this step.</td>
</tr>
<tr>
<td></td>
<td>Credentials</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMGC</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>CheckPrivilege</td>
<td>Check if the user currently logged in has authority to patch any instances.</td>
<td>Assign privileges as appropriate.</td>
</tr>
<tr>
<td>EBS</td>
<td>CheckWLSCreds</td>
<td>Check if Oracle WebLogic Server Administration Credentials are set for an Oracle E-Business Suite Release 12.2 instance.</td>
<td>Set the credentials as appropriate.</td>
</tr>
<tr>
<td>EBS</td>
<td>Check if Preferred Credentials exist</td>
<td>Check if the EM User has the required Preferred Credential set for APPS and SYSTEM schema users in &quot;Oracle E-Business Suite&quot; target type. Check if that user has the required Preferred Credentials for &quot;Oracle E-Business Suite Node&quot; target type for Database Context and for APPL_TOP Context.</td>
<td>Set the preferred credentials as appropriate.</td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>
**Diagnostic Tests for Customization Manager**

You should run diagnostic tests on your system in preparation for using Customization Manager to ensure your system is set up correctly. For more information on running diagnostic tests, see: How to Run a Diagnostic Test, page 12-1.

The following table lists generic tests related to Customization Manager:

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMGC</td>
<td>CheckOMSStage</td>
<td>Determine if a stage directory is defined on the OMS. Determine if the owner of the directory has read/write permissions to that directory.</td>
<td>Expected results are: the OMS Stage Directory Location and the OMS user with read/write permissions.</td>
</tr>
<tr>
<td>EMGC</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>CheckEBSHome</td>
<td>Verify permissions for APPL_TOP.</td>
<td>Verify that the user running the diagnostic test has the correct permissions for the APPL_TOP directory structure.</td>
</tr>
</tbody>
</table>

If the test fails, provide the correct Preferred Credentials information in "E-Business Suite" or "E-Business Suite Node". See: Preferred Credentials, page 5-1.
<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>CheckAgentHome</td>
<td>Verify permissions within the Agent home directory.</td>
<td>Verify that the user running the Diagnostic test has the correct permissions for the $AGENT_HOME directory structure. If the test fails, provide the correct Preferred Credentials information in &quot;E-Business Suite&quot; or &quot;E-Business Suite Node&quot;. See: Preferred Credentials, page 5-1.</td>
</tr>
<tr>
<td>EBS</td>
<td>Check Customization Manager related AD Patches for Release 12</td>
<td>Verify that certain AD patches have been applied on the Oracle E-Business Suite target.</td>
<td>The set of required interoperability patches will vary for the different Oracle E-Business Suite releases. The list of patches is contained in an XML file that might be modified to include or exclude recommended patches. The file is located at: <code>&lt;OMS_HOME&gt;\sysman\admin\emdrep\ebs\testsuites\CMTestSuite.xml</code>.</td>
</tr>
<tr>
<td>EBS</td>
<td>Check Customization Manager Patches for Release 12</td>
<td>Verify that certain Customization Manager patches have been applied on the Oracle E-Business Suite target.</td>
<td>The set of required interoperability patches will vary for the different Oracle E-Business Suite releases. The list of patches is contained in an XML file that might be modified to include or exclude recommended patches. The file is located at: <code>&lt;OMS_HOME&gt;\sysman\admin\emdrep\ebs\testsuites\CMTestSuite.xml</code>.</td>
</tr>
<tr>
<td>Step</td>
<td>Test Group</td>
<td>Description</td>
<td>Notes/Expected Results/Corrective Measures</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>CheckAmpAcp</td>
<td>Verify that the Agent is patched with the latest Oracle E-Business Suite management pack release.</td>
<td>If the Agent is not at the appropriate release, then it will need to be installed or upgraded through Oracle Universal Installer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Application Management Pack and the Application Change Management Pack patches are required on both the OMS and Agents.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>GetAPPSConfigV</td>
<td>Check if the context property JDBC_URL is available.</td>
<td>The context variable JDBC_URL needs to be set with non-null values for the Customization Manager jobs to proceed successfully. If the test fails, wait until the metric collection occurs, or force evaluation of the metric collection explicitly</td>
</tr>
<tr>
<td></td>
<td>ariables</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EMGC</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in these groups:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists user-specific tests for Customization Manager.
### User-Specific Diagnostic Tests for Customization Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>CheckEBSGlobalCred</td>
<td>Check Oracle E-Business Suite Preferred Credentials. This test verifies if the &quot;Applsys Schema&quot;, &quot;Apps Schema&quot;, and &quot;System Schema&quot; username/password exist; and, if so, if they are valid for a particular instance.</td>
<td>Verify the validity of the credentials supplied for the &quot;Applsys Schema&quot;, &quot;Apps Schema&quot;, and &quot;System Schema&quot; username/password for the &quot;E-Business Suite&quot; target type in Preferred Credentials. If the test fails, provide the correct credentials for the user in question. See: Preferred Credentials, page 5-1.</td>
</tr>
<tr>
<td>EBS</td>
<td>CheckAgentHomeWritePermission</td>
<td>Check for write permission within the Agent home directory.</td>
<td>Verify that the user running the Diagnostic test has the correct permissions for the $AGENT_HOME directory structure. If the test fails, provide the correct Preferred Credentials information in &quot;E-Business Suite&quot; or &quot;E-Business Suite Node&quot;. See: Preferred Credentials, page 5-1.</td>
</tr>
<tr>
<td>EBS</td>
<td>CheckWLSCreds</td>
<td>Check if Weblogic Admin Credentials are set for an Oracle E-Business Suite Release 12.2 instance.</td>
<td>If the test fails, provide the correct Preferred Credentials information in &quot;Oracle WebLogic Server&quot;. See: Preferred Credentials, page 5-1.</td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in these groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>

### Diagnostic Tests for User Monitoring

The following table has details for generic tests for user monitoring.
### Generic Tests for User Monitoring

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckIOPatches</td>
<td>Checks whether the mandatory interoperability patches needed for user monitoring are applied in this Oracle E-Business Suite instance.</td>
<td>Apply the mandatory interoperability patches in the Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>CheckRESTHealth</td>
<td>User monitoring uses REST services deployed on the Oracle E-Business Suite instance. This test checks if the REST services are accessible or not.</td>
<td>Check the error message in the report. Refer to the emoms.log for additional information.</td>
</tr>
<tr>
<td>CheckEBSProfile</td>
<td>Checks if the site-level profile Sign-On:Audit Level is set to 'FORM' in this Oracle E-Business Suite instance.</td>
<td>Set the site-level profile Sign-On: Audit Level to 'FORM'.</td>
</tr>
</tbody>
</table>

The following table lists user-specific tests for user monitoring.

### User-Specific Tests for User Monitoring

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckEBSGlobalCred</td>
<td>Checks if the preferred credential is set for AppsUserCredsSet for this Oracle E-Business Suite instance.</td>
<td>Set the preferred credential.</td>
</tr>
<tr>
<td>CheckEBSRole</td>
<td>Checks if the Oracle E-Business Suite user, whose credential is set as the preferred credential for AppsUserCredsSet, has the LCM_EM_CLIENT responsibility in this Oracle E-Business Suite instance</td>
<td>Assign the LCM_EM_CLIENT responsibility to the Oracle E-Business Suite user.</td>
</tr>
</tbody>
</table>
Cloning an Oracle E-Business Suite System

This chapter covers the following topics:

- Overview of Cloning an Oracle E-Business Suite System
- Smart Clone for Releases 12 and 12.2.x: Requirements, Setup, Prerequisites
- Running a Smart Clone Procedure for Releases 12 and 12.2.x
- Adding Custom Steps to a Smart Clone Deployment Procedure
- Smart Clone for Release 12 - Application Tier Only: Requirements, Setup, Prerequisites
- Cloning Procedures for Oracle E-Business Suite Releases 12.1

Overview of Cloning an Oracle E-Business Suite System


In previous releases, Smart Clone only allowed for the cloning of the application tier of Oracle E-Business Suite. Release 12.1.0.4.0 introduced a new capability that facilitates the automation of both the database and the application tier cloning from a single user interface for Oracle E-Business Suite Releases 12 and 12.2.x.

Features of Smart Clone:

- Smart Clone allows for the cloning of Oracle E-Business Suite applications deployed on RAC systems.
- It allows for the inclusion of scripts to clone database and application tiers using a single interview process to enhance and streamline the user experience.
• The Smart Clone process leverages Oracle Enterprise Manager Cloud Control provisioning framework to create clones and execute application-specific actions.

There are two Smart Clone procedures available in Oracle Application Management Pack for Oracle E-Business Suite Release 13.1:

• Smart Clone for R12 - Application Tier Only

• Smart Clone for R12, 12.2.x

As stated in the name, "Smart Clone for 11i, R12 - Application Tier Only" is used to clone only the application tier. The "Smart Clone for R12, 12.2.x" procedure allows you to clone an Oracle E-Business Suite Release 12.x or 12.2.x application tier. It also facilitates both the application tier and database tier cloning procedures, all within the same user interface.

For more information, see the Usage and Support, page 13-3 section below for more details.

New Cloning Features in Oracle Application Management Pack Release 13.1.1.1.0

New features in Oracle Application Management Pack for Oracle E-Business Suite Release 13.1.1.1.0 include:

• Procedure variables can now be added as global parameters in a customized cloning procedure. See the Create a Copy of the Out-of-Box Smart Clone Deployment Procedure, page 13-22 section.

• The ability to save data entered in the "Smart Clone for R12, 12.2.x" procedure as a template. At any point in the Smart Clone for Oracle E-Business Suite Release 12 or Release 12.2.x procedure (detailed in Running a Smart Clone Procedure for Releases 12 and 12.2.x), page 13-8, you can click Save as Template at any point in the process to save the data entered up until that point. When performing another Smart Clone for R12, R12.2.x, you can load the saved template in the first step of the process (on "Source Instance" page).

About Smart Clone for Release 12 - Application Tier Only

The "Smart Clone for R12 - Application Tier Only" procedure supports the following scenarios:

• Configuring single instance databases

• Configuring Oracle RAC databases

  • Customizing the listener names is supported if you have the required Oracle E-Business Suite patches applied.
• Configuring listeners with SCAN IPs is supported if both the database version and the cluster version are later than 11.2.0.2.

**About Smart Clone for Releases 12 and 12.2.x**

The "Smart Clone for R12, 12.2.x" procedure allows you to automate the steps to clone the database tier along with the cloning of the application tier in a single procedure.

**Considerations for Cloning with Oracle E-Business Suite Release 12.2**

Oracle E-Business Suite Release 12.2 is deployed on Oracle WebLogic Server. As a result, most of the technology stack scripts used in cloning (such as adpreclone, adclone, adstrtall, adstpall, and so on) require the WebLogic admin password. Therefore, the WebLogic admin password is required in the cloning procedure interview for Release 12.2 systems.

Also, note the following regarding zipping of files during the cloning process:

- `<COMMON_TOP>/clone/FMW/FMW_Home.jar` will be very large (2.7 GB).
- The WebLogic Server home directory (FMW_Home) will NOT be zipped or transferred.

**Terms**

The following table lists some cloning terms used in this document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>The Oracle E-Business Suite system being cloned.</td>
</tr>
<tr>
<td>Target</td>
<td>The Oracle E-Business Suite system being created as a copy of the source system.</td>
</tr>
<tr>
<td>Smart Clone</td>
<td>The cloning utility in Oracle Application Management Pack for Oracle E-Business Suite. Smart Clone allows you to use a database target cloned using an external solution as an input to its cloning procedures.</td>
</tr>
</tbody>
</table>

**Usage and Support**

The following table lists the details of use cases and their supported releases of Oracle E-Business Suite:
## Use Case Details

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Source Oracle E-Business Suite Instance</th>
<th>Target Oracle E-Business Suite Instance</th>
<th>Releases Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>1A</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>12.2, 12.1</td>
</tr>
<tr>
<td>1B</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB</td>
<td>12.2, 12.1</td>
</tr>
<tr>
<td>2A</td>
<td>Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>12.2, 12.1</td>
</tr>
<tr>
<td>2B</td>
<td>Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB</td>
<td>Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB</td>
<td>12.2, 12.1</td>
</tr>
</tbody>
</table>

**Note:** If you are currently using Smart Clone for Oracle E-Business Suite Release 12, it is recommended that you use the Smart Clone for R12, 12.2.x procedure. Although, if you intend to create a copy of the out-of-box Smart Clone deployment with one or more directive properties of type 'Ask User During Procedure Interview,' then use the Smart Clone for Release 12 - Application Tier Only procedure. In Release 12.1.0.4.0, the ‘Ask User during Procedure Interview’ option is only supported in the Smart Clone for Release 12 (application tier only) procedure.

In addition to the above features, the following scenarios are supported:

- As soon as Oracle E-Business Suite announces the certification on any database version with Oracle E-Business Suite, plug-in customers using Release 12.1.0.4.0 should be able to use the Smart Clone deployment procedure immediately for Oracle E-Business Suite cloning.

- Any specific needs such as data masking, data compression, and so on can be performed before running Smart Clone.

- Smart Clone supports the cloning of systems with different operating system users...
for the database tier and the application tier.

For Option 2B above (Multi Apps Node to Multi Apps Node cloning) with Release 12.2, you should avoid using the same server between the source and target.

Also, for Options 2A and 2B (Multi Apps Node to Single/Multi Apps Node cloning) with Release 12.2, observe the following:

- You must not use the same port pool for the target Oracle E-Business Suite system as that for the source Oracle E-Business Suite system.

- You must not use any of the source Oracle E-Business Suite hosts for target hosts.

**Navigation to Smart Clone**

You can access the Smart Clone feature either through the Oracle E-Business Suite Management page or from the Procedure Library.

**From the Oracle E-Business Suite Management Page**

Navigate to **Targets menu > Oracle E-Business Suite**. Here on the Oracle E-Business Suite Management page, go to **Administer menu > Cloning**.

On the Clone Oracle Applications page, click on the **Cloning Procedures** tab. Select the desired cloning procedure by clicking on the radio button and click **Run**.

![Oracle E-Business Suite Management](image)

**From the Procedure Library**

To access the feature using the Procedure Library, navigate to **Enterprise menu > Provisioning and Patching > Procedure Library**.

Search for and select the desired cloning procedure radio button (either "Smart Clone for 11i, R12 - Application Tier Only" or "Smart Clone for R12, 12.2.x"). Then, ensure that "Launch" is selected in the drop-down list and click **Go**.
Smart Clone for Releases 12 and 12.2.x: Requirements, Setup, Prerequisites

Requirements and Setup Steps

- Cloning using Oracle Application Management Pack for Oracle E-Business suite requires Perl 5.005 or later on the Oracle Enterprise Manager agent. The user who starts the agent processes must set the PERL5LIB environment variable pointing to Perl 5.005 (or later) libraries. Also, the Perl executable 5.005 must be used.

- All the virtual internet protocol (VIP) addresses configured in the Oracle Cluster Ready Services (CRS) of the target nodes identified for the created RAC instance must be up and running.

- If for a cloning process the target is multi-node and the database node domain and the applications node domain are different, perform the following steps:

  1. Include the target database node server name in the /etc/hosts file of the target applications node so that the applications node will be able to resolve the database node without the domain name. The modification should be like the following (this entry is for Linux x86; change as appropriate for your platform):

     \[
     \text{<ip-address> <Machine name with domain name> <Machine Name>}
     \]

     For example:

     192.0.2.1 adc60002demo.us.example.com adc60002demo

  2. In addition to the above entry in the /etc/hosts file, the applications node context file needs to be changed.

     Change the \text{s_dbdomain} entry in the \text{<STAGE_LOC>/appsTier/context/apps/\text{/SID}_<SERVER_NAME>.xml} file to the correct domain name of the database tier.

     For example, if the database node domain name is idc.example.com and the applications node domain name is us.example.com, then the context file

     \text{/d1/QA/stage/PMS29/080522035852/PMS29_adc60010demo.xml}
should be changed to

<domain oa_var="s_dbdomain">idc.example.com</domain>

- The OS utilities **make, ld, cc, and ar** must be in the environment PATH variable in all the host targets. If not, please update the PATH variable accordingly and restart the agent in the same terminal.

**Prerequisites**

The following are prerequisites which must be met before starting a Smart Clone for R12, 12.2.x procedure:

1. The source Oracle E-Business Suite instance must:
   - Be up and healthy.
   - Have been discovered in Oracle Enterprise Manager and its status must not be pending.
   - Have its `/etc/oraInst.loc` pointing to the correct oraInventory at the time of running Smart Clone.

2. If you attempt to clone a database with Smart Clone, then custom scripts are required.
   - The user must prepare the list of scripts (which supports arguments and input parameters).
   - Place them in corresponding hosts.
   - Make sure the scripts have executable permissions.
   - Make sure the scripts exit with the proper exit code (0 for success).
   - By the end of execution of all scripts, the OMS and application tier nodes should be able to connect to the database.

3. If you can also use an already-cloned database, the target database must:
   - Have already been cloned from the database of the source Oracle E-Business Suite instance.
   - Must be up and running.
   - Have been discovered in Oracle Enterprise Manager and its status must be up.
Note: Do not use the same SID (system identifier) for the target database as the source database. Doing so will lead to the failure of the last step of the Smart Clone procedure (discovery of the cloned instance).

4. The Oracle E-Business Suite Plug-in must be deployed on all the target database hosts and application tier hosts before starting the Smart Clone for R12, 12.2.x process.

5. The same set of user privileges as required in Release 12.1.0.3.0 are applicable to this release as well.

Running a Smart Clone Procedure for Releases 12 and 12.2.x

This section describes the steps for cloning a database and application tier for Oracle E-Business Suite Release 12 and 12.2.x using the "Smart Clone for R12, 12.2.x" procedure.

To Submit a Clone Procedure:

   This will display the application and database node information.

2. Verify the source Oracle E-Business Suite instance details and select the appropriate credentials from the Database Apps Credential drop-down and WebLogic Credential drop-down.

   Note: The Source Instance page is where you can load saved entries from a user-created template.
Remember, you can click Save as Template at any point in the process to save the data entered up until that point. When performing another Smart Clone for R12, R12.2.x, you can load the saved template in the first step of the process (on "Source Instance" page).

Click Next.

3. Enter the target database details.

   If the database is not cloned, skip this step and continue to Step 4. If the database is already cloned and discovered, follow the below steps to enter the target database details.

   Select the target database from the LOV and update the following text fields:
   - Apps User: Target database Apps user
   - Apps Password: Target database Apps password
   - If target is RAC: Choose to Enable/Disable SCAN
   - If SCAN is enabled, enter the complete SCAN name and SCAN port.

   **Note:** It is important to enter a complete SCAN name along with the domain name.

   Verify the following auto-populated values and update accordingly:
• If target is RAC: Listener Name

• TNS Admin Directory

4. This step only applies if the database is not cloned. This step is skipped if you have already completed tasks outlined in Step 3.

If the database is not cloned, follow the below steps to define the target database details, add the target database host(s), and to add the list of scripts.

**Defining the Target Database Details**

Choose the "Let Oracle EBS Clone procedure to clone database" option and fill in the following details of the target database:

• **Database Type:** After the database clone is done, what will be the database type (single or RAC)

• **Apps User:** Target database Apps user

• **Apps password:** Target database Apps password

• **Oracle Global Name:** Database Global Name

• **DB Service:** Database Service Name with which a connection can be established after the database clone

• **If target is RAC:** Choose to Enable/Disable SCAN

• **If SCAN is enabled,** enter the complete SCAN name along with domain
Adding the Target Database Host(s)

Add target database hosts by clicking on the **Add** button in the Target Database Nodes table.

The following fields must be updated in the table:

- If target is RAC: Virtual Hostname
- If target is RAC: Listener Name
- TNS Admin Directory
Adding the List of Scripts

Click on the **Add** button in the List of Scripts for DB Cloning panel. This will add a new row to the table.

On each row, enter the following details:

- The absolute path of the script along with the arguments.
- If the script prompts for user inputs, then enter the values for these prompts in the same sequence.
- Add the hosts on which the scripts need to be executed.

For example, the first row in the screenshot shown below represents:

- The script `/u01/scripts/preclone.pl` will be executed with one argument "dbTier."
- This script will prompt for 2 input parameters and values for these prompts are "/u01/dbstage," "apps."
- This script will be executed on the host "rws32707117.us.example.com."

These scripts will be executed one after the other in the sequence provided.
5. Enter the target application details.

**Enter the Common Properties of the Application Tier**

- Base directory: In which the target application system will be cloned to.
- Instance directory
- If application is pre-Release 12.2.x: Portpool
- For Release 12.2.x applications: RunFS Portpool
- For Release 12.2.x applications: PatchFS Portpool

**Add the Application Node(s)**

In the Target Application Nodes panel, click the **Add** button to add a host.

- Update the following details:
  - Web Entry Point Service Group: To enable following Services in the current node
    - OHS, OPMN
  - Web Application Service Group: To enable following Services in the current node
    - oacore, forms, oafm, tns_app
  - For Release 12.2 only: forms-c4ws, oaea
  - Batch Processing Service Group: To enable following Services in the current node
node

- Concurrent Manager, ICSM, JTFF

- Other Services: To enable following Services in the current node
  - forms_server, met_cl, met_srv, mwa_srv

- For Release 12.2 only: Admin - To enable WebLogic Admin Server in the current node

- For Releases earlier than 12.2.x only: Root Service Group - To enable the node manager in the current node

  **Note:** For Release 12.2, node manager will be automatically enabled if Web Application Service Group is enabled.

---

**Enter Details Specific to Oracle E-Business Suite Release 12.2.x:**

Add the application node as a shared file system node.

- After adding a least one application node, the next node can be added as a non-shared application node/shared application node.

- In the Add Host pop-up, select the **Shared App Node** radio button and APPL_TOP drop-down.
Update managed servers.

When you select "Web Application Services," default managed servers will automatically be populated. A user can delete/add managed servers as shown below:
6. Enter the stage directory details.

Choose a copy option to clone the source node application file system to the target nodes:

- Manual copy: If you want to copy the files manually, the file system on the target application node is already present.

- Automatic copy: With the automatic copy option, Smart Clone will automatically copy files from the source to the target.

For the automatic copy option, you can choose a copy method type in the stage directory:

- Remote File Transfer can be chosen when the source and target Oracle E-Business Suite instance are on different hosts.

- Shared Storage or Common Storage Location can be chosen when the source admin host and target application host are same or when the source admin host and target application host(s) share a common mount point.

Enter the stage directory details for the source admin host and target application host(s).
Note: Make sure this directory has write permissions. The stage directory has sufficient space to hold complete source file system (Approximately 15GB - 20GB or more free space is required, depending on the source application file system).

7. Enter the host credential details.

The following host credential details must be defined:

- **Source Node Credentials**: This table will have the Admin Node of the Source EBS.

- **DB Node Credentials**: This table lists all the Target DB Nodes along with the Hosts on which custom scripts will be run.

- **Application Node Credentials**: This table contains all the Target Application Node hosts.

  **Note**: It is recommended that you verify your entries using the Test button before proceeding to the next step.
8. Review the details.

The last step displays the data that you have entered. Please review the data and click on the **Finish** button to submit the clone.

Source Oracle E-Business Suite instance details for review:

![Source EBS Details](image1)

Target database details for review:

![Target Database](image2)

Target application details for review:
Stage directories and credentials for review:

**Copy Options**
Select from one of the copy options below. This is the copy method used to copy Source node application file system on to Target nodes.
- Manual Copy
- Automatic Copy
- Use Remote File Transfer
- Use Shared Storage or Common Storage Location

**Stage Directories**
Stage directories are temporary directories to stage the files while copying Source node to Target nodes.

<table>
<thead>
<tr>
<th>Source Node Host</th>
<th>Source Node Stage Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>rws3270781.us.example.com</td>
<td>/tmp</td>
</tr>
</tbody>
</table>

**Stage Directories for Target nodes:**

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Host</th>
<th>Stage Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>tg22rc_rws3270780</td>
<td>rws3270780.us.example.com</td>
<td>/tmp</td>
</tr>
<tr>
<td>tg22rc_rws3270781</td>
<td>rws3270781.us.example.com</td>
<td>/tmp</td>
</tr>
</tbody>
</table>

**Source Node Credentials**

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Host</th>
<th>Named Credential</th>
</tr>
</thead>
<tbody>
<tr>
<td>ad0pp9_rws3270781</td>
<td>rws3270781.us.example.com</td>
<td>NC_HOST_2015-04-01-063526 (...</td>
</tr>
</tbody>
</table>

**Target Database Node Credentials**

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Host</th>
<th>Named Credential</th>
</tr>
</thead>
<tbody>
<tr>
<td>tg22rc_rws3270780</td>
<td>rws3270780.us.example.com</td>
<td>NC_HOST_2015-04-01-063526 (...</td>
</tr>
<tr>
<td>tg22rc_rws3270781</td>
<td>rws3270781.us.example.com</td>
<td>NC_HOST_2015-04-01-063526 (...</td>
</tr>
</tbody>
</table>

**Target Application Node Credentials**

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Host</th>
<th>Named Credential</th>
</tr>
</thead>
<tbody>
<tr>
<td>tg22rc_rws3270780</td>
<td>rws3270780.us.example.com</td>
<td>NC_HOST_2015-04-01-063526 (...</td>
</tr>
<tr>
<td>tg22rc_rws3270781</td>
<td>rws3270781.us.example.com</td>
<td>NC_HOST_2015-04-01-063526 (...</td>
</tr>
</tbody>
</table>

**Viewing the Status of a Submitted Smart Clone Procedure:**

1. Open the Procedure Activity page by navigating to the Enterprise menu > Provisioning and Patching > Procedure Activity.

2. Enter the Job Name that was provided when the procedure was submitted into the Search field and click Go.
3. Click the corresponding check box to select a procedure to view its details.

If any of the procedure step statuses are marked as failed, select the step to view it in the procedure view and choose one of the following options:

- Ignore - Ignore the current failed step and proceed to the next step.
- Retry - Retry the failed step.
- Update and Retry - Update the job parameters and retry the failed step.

Note on Manual Steps for a Smart Clone Procedure for Oracle E-Business Suite Release 12.2.x:

In the Smart Clone deployment procedure for Release 12.2.x, as AutoConfig on the database tier will update the sqlnet.ora there will be a manual step just before the target Oracle E-Business Suite discovery step to enable the OMS host(s) to
connect to the target Oracle E-Business Suite database. You need to verify and update the OMS host(s) entry for `tcp.invited_nodes` if `tcp.validnode_checking` is set to yes.

<table>
<thead>
<tr>
<th>Directive Step</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run AutoConfig on the all application nodes</td>
<td>Rolling</td>
</tr>
<tr>
<td>Register new topology for EBS release 12.2.x</td>
<td>Job</td>
</tr>
<tr>
<td>Run AutoConfig on application node</td>
<td>Job</td>
</tr>
<tr>
<td>Manually update sqlnet.ora on Database nodes</td>
<td>Parallel</td>
</tr>
<tr>
<td>Manually update sqlnet.ora on Database nodes to enable OMS Connectivity</td>
<td>Manual</td>
</tr>
<tr>
<td>Register Target Application System</td>
<td>Parallel</td>
</tr>
<tr>
<td>Discover Target Application System</td>
<td>Job</td>
</tr>
<tr>
<td>Target Application Nodes</td>
<td>Parallel</td>
</tr>
<tr>
<td>Stop EBS PatchFS Admin Server if its up and running</td>
<td>Job</td>
</tr>
</tbody>
</table>

**Note:** If "Custom Commands for Database Cloning" is used, then the target Oracle Application needs to be discovered manually.

### Adding Custom Steps to a Smart Clone Deployment Procedure

This section describes creating custom steps and adding them to a Smart Clone deployment procedure. For more information generic information on how to create a directive step and add it to a copy of an out-of-the-box deployment procedure, refer to the *Oracle Enterprise Manager Cloud Control Administrator’s Guide*.

**Create a directive step:**

1. From the **Enterprise** menu, select **Provisioning and Patching > Software Library**.
2. Create a new directive. From the **Actions** drop-down menu, select **Create Entity > Directives**.
3. Enter a name and other attributes for the directive.
4. Add parameters for the directive.
5. Select the "Software Library" location and the script to be executed. In the example below, a Perl script is used.
6. Click **Next** and **Save and Upload**.
Create a Copy of the Out-of-Box Smart Clone Deployment Procedure:

1. From the Enterprise menu, select Provisioning and Patching > Procedure Library.

2. Select "Smart Clone for 11i, R12 - Application Tier Only" and click Create Like.

3. Under the General Information tab, enter a name and other general information.

4. Select the Procedure Variables tab to add variables.

   Select "String" in the Type drop-down list. The Value Options which are supported are "Text," "Password," and "List of Values."

5. On the Procedure Steps tab, select the step before, inside, or after which you want to add the custom step, and click Insert.
6. Create: Give the new step a name and enter additional information for the step.

7. Select Directive: Search for the directive and click **Next**.

8. Map Properties: Map the parameters as required in the Map Properties step. In our example, a text box will be provisioned in the Smart Clone procedure interview to provide the value for "Parameter 2".

   **Note:** In Release 12.1.0.4.0, the option ‘Ask User during Procedure Interview’ is supported ONLY in the "Smart Clone for 11i, R12 - Application Tier" procedure.

9. Review: Review the information entered and save the custom step. Then, save the procedure.

10. You can now submit the newly-created deployment procedure.

**Smart Clone for Release 12 - Application Tier Only: Requirements, Setup, Prerequisites**

As a prerequisite, the Smart Clone feature of the application tier expects the target Oracle E-Business Suite database to be cloned and discovered in the Enterprise Manager. In doing so, customers can choose their own options in creating the target Oracle E-Business Suite database by cloning from the source Oracle E-Business Suite database using the Database Plug-in Provisioning Pack, RMAN, a storage system
solution, or so on; whichever suits their needs the best. Smart Clone starts with taking the discovered target database as an input to configure a database target and then clones the applications tier of the source instance. It then applies that to the target Oracle E-Business Suite system. Custom scripts to clone the database tier can be plugged-in, which enables database and application tier cloning in one flow.

Requirements and Setup Steps

- Cloning using Oracle Application Management Pack for Oracle E-Business suite requires Perl 5.005 or later on the Oracle Enterprise Manager agent. The user who starts the agent processes must set the PERL5LIB environment variable pointing to Perl 5.005 (or later) libraries. Also, the Perl executable 5.005 must be used.

- All the virtual internet protocol (VIP) addresses configured in the Oracle Cluster Ready Services (CRS) of the target nodes identified for the created RAC instance must be up and running.

- If for a cloning process the target is multi-node and the database node domain and the applications node domain are different, perform the following steps:
  1. Include the target database node server name in the /etc/hosts file of the target applications node so that the applications node will be able to resolve the database node without the domain name. The modification should be like the following (this entry is for Linux x86; change as appropriate for your platform):
     <ip-address> <Machine name with domain name> <Machine Name>
     For example:
     192.0.2.1 adc60002demo.us.example.com adc60002demo
  2. In addition to the above entry in the /etc/hosts file, the applications node context file needs to be changed.
     Change the s_dbdomain entry in the
     <STAGE_LOC>/appsTier/context/apps/<SID>_<SERVER_NAME>.xml file to the correct domain name of the database tier.
     For example, if the database node domain name is idc.example.com, and the applications node domain name is us.example.com, then the context file
     /d1/QA/stage/PMS29/080522035852/PMS29_adc60010demo.xml should be changed to
     <domain oa_var="s_dbdomain">idc.example.com</domain>

- The OS utilities make, ld, cc, and ar must be in the environment PATH variable in all the host targets. If not, please update the PATH variable accordingly and restart the agent in the same terminal.
Prerequisites

The following are prerequisites to running an individual Smart Clone procedure:

1. The source Oracle E-Business Suite instance must:
   - Be up and healthy.
   - Have had AutoConfig run successfully. It is mandatory that AutoConfig was successfully run on the source applications tier and source database tier.
   - Have been discovered in Oracle Enterprise Manager and its status must not be pending.
   - Have had AutoConfig run successfully. It is mandatory that AutoConfig was successfully run on the source applications tier and source database tier.
   - Have its `/etc/oraInst.loc` pointing to the correct oraInventory at the time of running Smart Clone.

   **Note:** On some platforms such as Solaris, the variable is `/var/opt/oracle/oraInst.loc`.

2. The target database must have already been cloned from the source Oracle E-Business Suite database.

   **Note:** Ensure that the Oracle home target property is set correctly for the discovered database target.

   To do this, you can:
   - Use the Enterprise Manager 12c Database Plug-in to perform the required database cloning procedures OR
   - Use any other technology which suits your database cloning needs.

3. After it is cloned, the target database must:
   - Be up and running.
   - Have been discovered in Enterprise Manager 12c. You must discover the target database before you run Smart Clone.

   **Note:** Do not use the same SID (system identifier) for the target database as the source database. Doing so will cause the last
step of the Smart Clone process (discovery of the cloned instance) to fail.

4. The Oracle E-Business Suite agent plug-in must be deployed on all the target database hosts and application tier hosts. After deploying the agent plug-in on the target database hosts, run the step `root.sh`; otherwise Smart Clone will fail.

5. The Oracle Enterprise Manager user running the Smart Clone procedure must have the appropriate privileges.

The following privilege setup instructions can be ignored if the user is a "Super Administrator".

In order to execute the Smart Clone deployment procedure, a non-Super Administrator user must have certain target-level privileges and the resource privileges.

The privileges listed below could be granted in many ways depending on the desired level of granularity of privileges to be granted to the user. For more details on granting privileges, please refer to the section "Configuring Security" in the manual *Oracle Enterprise Manager Cloud Control Administrator’s Guide 12c*.

The following outlines one of the ways of granting the required privileges for executing the Smart Clone procedure.

**Target Privileges**

- Add any Target
  - Privileges applicable to all targets
    - Name: Add any Target (Description: Add any target in Enterprise Manager)

- Operator any Target
  - Privileges applicable to all targets
    - Name: Operator any Target (Description - Ability to perform administrative operations on all managed targets)
    - Included Privileges - View any Target
    - Applicable Target Types - All Target Types

**Resource Privileges**

- Job System resource:
• Name - Job System
• Description - Job is a schedulable unit of work that administrator defines to automate the commonly run tasks
• Resource Type Privilege - Create

Deployment Procedure:
• Name - Deployment Procedure
• Description - Deployment procedures are customizable orchestration routines for various Provisioning and Patching tasks
• Resource Type Privilege - Create

6. The following named credentials must be defined:
• Host target type
  • Authentication Target Type: "Host"
  • Credential Type: "Host Credentials"
• Oracle E-Business Suite target type
  Please refer to the section Named Credentials, page 5-2 for instructions on creating the Oracle E-Business Suite Database credentials.
• The normal host preferred credentials where the WebLogic Administration Server is running must also be set.

**Cloning with RAC Instances**

With Smart Clone, if the target Oracle E-Business Suite instance database is of type "RAC" and if you want to configure Parallel Concurrent Processing after the clone is completed, then it is recommended that you follow instructions described in the following My Oracle Support Knowledge Documents, depending on your RDBMS version:

• Document 783188.1, *Certified RAC Scenarios for E-Business Suite Cloning* for more information on cloning of systems deployed on Oracle Real Application Clusters (RAC) is possible.

Preferences

For Oracle E-Business Release 12.1 and earlier, the following properties are set in the Preferences page. Navigate to the Preferences page by navigating to Targets > Oracle E-Business Suite > Administer menu > Preferences. These preferences are not applicable to cloning with Oracle E-Business Suite Release 12.2. For Release 12.2, default values are used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under APPL_TOP directory of the applications tier.
  • Minimum value: 1
  • Maximum value: 16
  • If the value is empty OR less than 1 OR greater than 16, then the default value of 8 is used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under Tools Oracle Home directory of the applications tier.
  • Minimum value: 1
  • Maximum value: 8
  • If the value is empty OR less than 1 OR greater than 8, then the default value of 4 is used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under Tools Oracle Home directory of the applications tier.
  • Minimum value: 1
  • Maximum value: 4
  • If the value is empty OR less than 1 OR greater than 4, then the default value of 2 is used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under COMMON_TOP directory of the applications tier.
  • Minimum value: 1
  • Maximum value: 4
  • If the value is empty OR less than 1 OR greater than 16, then the default value of 2 is used.
Diagnostic Tests

For information on diagnostic tests for this feature, see: Diagnostic Tests for Cloning, page 12-3.


This section describes running the single-node to single-node and multi-node to single-node Smart Clone procedure. This procedure can be used for Oracle E-Business Suite Release 12.1.x.

At a high level, a Smart Clone procedure performs the following:

• Configures the target database

• Clones and configures the applications tier from the source Oracle E-Business Suite system

These two steps result in creating a target Oracle E-Business Suite system which is ready to use.

Note: On an HP-UX Itanium platform, the plug-in will show the "Oracle Applications JVM Usage" target as down. The cause of this issue is that the target type .xml contains control M (^M) characters. To resolve this issue:

1. Go to <Agent Home>/plugins/oracle.apps.ebs.agent/plugin_12.1.0.4.0/metadata.

2. Remove ^M characters in oracle_apps_jvm.xml.

3. Restart the agent.

To Run a Single-Node Cloning Procedure:


2. Select "Smart Clone for 11i, R12 - Application Tier Only" from the Start a Clone drop-down list and click Go.
3. On the General page, enter general information for the cloning process. This step captures information related to the target database already cloned and discovered in Enterprise Manager.

Provide a transaction name for the Clone Name.

Choose the source Oracle E-Business Suite you would like to clone from the LOV.

Specify the target database which is to be cloned from the source Oracle E-Business Suite’s database.

Based on the type of database chosen (that is, a single instance database or a RAC database), the Target Database Details region is dynamically rendered.

For a single instance database, provide the following:

- Target Database
- Apps Schema Username
- Apps Schema Password
- System Schema Password
- TNS admin directory

You can either click on the Validate Database button or you can leave it to the Next button to perform the same action.

If the target database is a RAC database, the Target Database Details region is rendered differently, as shown in the following figure. Specify whether SCAN is configured in the target database.
4. Next on the RAC Target DB Details page, enter RAC Target database details, if applicable. This step only applies if the target database is a RAC database. This step is skipped if the target database has the type "Single Instance."

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring customized names for listeners, then this page will automatically render in such a way that you provide names for the target database listeners by providing the required names in the column "New Listener Name". If the source Oracle E-Business Suite technology stack does not have the required patches, then Smart Clone will provide default names for the listeners using the naming convention LISTENER_<hostname>.

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring the target database with "SCAN Listeners”, then the "Custom SCAN Details" section is rendered with the "SCAN Name" and "SCAN Port" fields populated automatically. It is highly recommended not to change these values if it automatically populated. If for some reason the SCAN Name and SCAN Port fields are not populated (for example, if the cluster target instance discovered in Enterprise Manager has not populated these values yet as properties), then you must enter the correct values for these fields.

Optionally, select the **Use Custom SCAN Name and Port** check box if you want the target database configured with the SCAN listener. If you do not select the **Use Custom SCAN Name and Port** check box, then Smart Clone will clone the target database with virtual host names.
If the source Oracle E-Business Suite technology stack does not have the required patches, then the "Custom SCAN Details" section will not be rendered and the target database will be configured with virtual host names.

If the target instance is already configured with scan listeners, then by default the **Use Custom SCAN Name and Port** check box will be selected.

5. On the Source/Target page, enter source and target information.

In this step, Smart Clone captures information related to the source and target.

- All application tier information of the source Oracle E-Business Suite system is displayed.
- You enter details for the target Oracle E-Business Suite system.

If the source Oracle E-Business Suite system is deployed on a single applications tier, the Source regions appear as shown in the following figure. Information is shown for the following services: Admin, CP (Concurrent Processing), Forms, and Web.

In the Available Target System Nodes region, choose the source host that can be used as a reference while cloning the target applications tier. Specify the target host from the LOV where Smart Clone should create the target applications tier.

If the source Oracle E-Business Suite system is deployed on a multi-node applications tier, complete the additional fields in the Source region which appear.

The Source System Nodes region shows the details of the source Oracle E-Business Suite applications tier in terms of:

- Number of nodes the applications tier is deployed on.
- Details of the services on the nodes.

Selecting the service in this section is unnecessary as the reference source host will be selected only from the "Available Target System Nodes" region.

6. In the Available Target System Nodes region, select the **Single-Node Target** radio button. This is the default option.

Then choose the source host that can be used as a reference while cloning the target applications tier. Specify the target host from the LOV where Smart Clone should create the target applications tier.

For the target system node, click the **Specify Details** icon to update its properties in the Target Node Summary page.

7. The Target Node Summary page is shown. Verify the details.

The port pool and individual port values are updated from the source instance.

If there is an invalid value in the port pool from the source instance, the following
error is shown: "NOTE: Source Apps portpool context variable (s_port_pool) is invalid: <value>. Setting to default value '0'. Please update as needed!"

8. On the Copy Parameters page, enter information on how the copying process should be done.

   If you are using the same host for both the source and target instance, ensure that the source stage directory is different from the target stage directory.

9. Enter Credentials.

   Smart Clone uses named credentials. You can select and test the named credentials on this page.

   Named credentials can be created by navigating to the Setup menu, then Security > Named Credentials. Once on the Named Credentials page, click click Create.
Smart Clone requires the following credentials to be created:

- Application Node OS Credentials and Database Node OS Credentials.
  - Authentication Target Type - Host
  - Credential Type - Host Credentials

- Database Schema Credentials
  Refer to the section Named Credentials, page 5-2 for information on creating the Oracle E-Business Suite Database credentials.

The Credentials page allows you to enter in and test all required credentials for the nodes.

The Credentials page for a Smart Clone procedure is where the source applications system is single node and the target database is RAC is shown in the figure below. On this page you can enter and test the required credentials for all the nodes.

10. On the Custom Properties page, enter values for custom parameters. These would be used in any directive steps you have created.

You can create directive steps to be integrated into a deployment procedure. For
more information on deployment procedures, see the Oracle Enterprise Manager Cloud Control Administrator's Guide. For a description on how to create a directive step and insert it into a procedure created using the "Create Like" feature and a shipped Smart Clone procedure, see: Adding Custom Steps to a Smart Clone Deployment Procedure, page 13-21.

11. Next on the Schedule page, schedule the deployment by specifying when you would like the cloning process to run: Immediately or Later.

12. On the Review page, review the details of your Smart Clone deployment procedure and click Finish.

Cloning Procedures for Oracle E-Business Suite Releases 12.1

This section describes the automated scale-out and scale-in procedure of Oracle E-Business Suite Release 12.1 managed servers.

The procedure is similar to the single-node Smart Clone procedure - the main difference is in specifying the source and target in the "Source/Target" step in the interview process.

At a high level, the Smart Clone procedure:

• Configures the target database.

• Clones and configures the applications tier from the source Oracle E-Business Suite system.

These steps result in creating a target Oracle E-Business Suite system which is ready to use.

To Run a Multi-Node Cloning Procedure:

1. Navigate to the Cloning home page by using the following path: Targets menu > Oracle E-Business Suite > Administer menu > Cloning. Choose "Smart Clone for R12, 12.2.x" from the Start a Clone drop-down list. Click Go.

2. Enter general information for the cloning process. This step captures information related to the target database already cloned and discovered in Oracle Enterprise Manager.

   Provide a transaction name for the Clone Name.

   Choose the source Oracle E-Business Suite you would like to clone from the LOV.

   Select the target database which is cloned from the source Oracle E-Business Suite's database.

   Based on the type of database (that is, a single instance database versus a RAC database), the rendering of the Target Database Details region will dynamically
The figure below shows the rendering of the region for a single instance database.

Provide the following for the target database:

- Apps Schema Username
- Apps Schema Password
- System Schema Password
- TNS admin directory

You can either click on Validate Database button or you can leave it to the Next button to perform the same action.

If the target database is a RAC database, the Target Database Details is rendered differently, as shown in the following figure.
Provide the following for the target database:

- Apps Schema Username
- Apps Schema Password
- System Schema Password

Specify whether SCAN is configured in the target database.

You can click on Validate Database button or you can leave it to the Next button to perform the same action.

3. Enter RAC Target database details, if applicable.

This step only applies if the target database is a RAC database. This step is skipped if the target database is a single instance database.

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring customized names for listeners, then this page would automatically render so that you provide names for the target database listeners in the required field "New Listener Name".
If the source Oracle E-Business Suite technology stack does not have the required patches, then Smart Clone will give default names to the listeners using the naming convention "LISTENER_<hostname>".

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring the target database with "SCAN Listeners", then the "Custom SCAN Details" region is rendered with the "SCAN Name" and "SCAN Port" fields populated automatically. It is highly recommended not to change these values if it automatically populated. If for some reason the SCAN Name and SCAN Port fields are not populated (for example, if the cluster target instance discovered in Enterprise Manager has not populated these values yet as properties), then you must enter correct values into these fields.

Optionally, check the box "Use Custom SCAN Name and Port" if you want to get the target database configured with the SCAN listener. If you do not check the box "Use Custom SCAN Name and Port", then Smart Clone will clone the target database with virtual host names.

If the source Oracle E-Business Suite technology stack does not have the required patches, then the "Custom SCAN Details" region will not be rendered and the target database will be configured with virtual host names.

If the target instance is already configured with SCAN listeners, then by default the "Use Custom SCAN Name and Port" check box will be selected.

4. Enter source information in the Source/Target step.

The "Source System Nodes" region shows the details of the source Oracle E-Business Suite applications tier including:

- Number of nodes on which the applications tier is deployed
- Details of the services on the nodes
5. Enter target information on the Source/Target step.
   Choose the type of target. For multi-node cloning, the options are:
   - Multi-node target with a non-shared file system
   - Multi-node target with a shared file system

   Note that when the target has a shared file system that:
   - The first node in the admin service list is considered the primary service.
   - The Target location has "Override Defaults" selected as a provision to update
     the shared directory location for APPL_TOP, COMN_TOP, and so on.

   If you choose either of the multi-node choices, a new set of options is shown:

6. Add a node to each service by clicking on the Add button for the service and
   choosing the node from the LOV.
If you want to delete a node from a service, select the node to be deleted and click the **Delete** button.

7. After you add the lists of nodes, you can navigate to the "Common Properties" page.

In this page you specify properties such as port data and the applications base directory location.

*Common Properties for Non-Shared APPL_TOP*
When you click the Check Availability button, the port availability check box on all selected nodes will be selected. This verification is also done when you click OK for the page itself.

The port pool and individual port values are updated from the source instance.

If there is an invalid value in the port pool from the source instance: following error will be shown: "NOTE: Source Apps portpool context variable (s_port_pool) is invalid: <value>. Setting to default value '0'. Please update as needed!"

Click Next to proceed to the next step. After you click Next, the system checks to confirm all the services are enabled on the target node.

Note: Dependent services are automatically added to the nodes.

8. In the Copy Parameters step, choose options for how your copying will be done.
9. Enter Credentials.

Smart Clone uses named credentials. You can select and test the named credentials on this page.

Named credentials can be created by navigating to the **Setup** menu, then **Security > Named Credentials**. Then click **Create**.
Smart Clone requires the following credentials to be created:

- Application Node OS Credentials and Database Node OS Credentials.
  - Authentication Target Type - Host
  - Credential Type - Host Credentials

- Database Schema Credentials

Refer to the section Named Credentials, page 5-2 for information on creating the Oracle E-Business Suite Database credentials.

The Credentials page for a Smart Clone procedure where the source applications system is multi-node and the target database is non-RAC is shown below. This page allows you to enter and test all required credentials.
The Credentials page for a Smart Clone procedure where the source applications system is single node and the target database is RAC is shown below. This page allows you to enter and test the required credentials.

10. Enter values for custom parameters.

You can create directive steps to be integrated into a deployment procedure. For more information on deployment procedures, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide. For a description on how to create a directive step and insert it into a procedure created using the "Create Like" feature and a shipped Smart Clone procedure, see: Adding Custom Steps to a Smart Clone Deployment Procedure, page 13-21.
11. Schedule the deployment.

12. Review your Smart Clone deployment procedure and click Finish.

**What’s Next**

When a multi-node to multi-node application tier cloning procedure is submitted, irrespective of whether it is a "scale-up" or "scale-down" procedure, the admin node is configured first with the given services enabled. Then each node will be configured one
after the other, depending on the node details specified in the cloning interview.

After all the nodes are configured, the URLs used in accessing Oracle E-Business Suite are redirected to the node on which AutoConfig was last run. Therefore, after all nodes are configured, you should run AutoConfig again on the node in which the web service is enabled.

**Note:** For more information, see My Oracle Support Knowledge Document 1349509.1, *All the URLs Accessing Oracle E-Business Suite Are Getting Redirected to the Web Node Where AutoConfig Last Ran.*
Managing Oracle E-Business Suite Instances on Oracle Cloud Infrastructure

This chapter covers the following topics:

• Recommended Procedure if Enterprise Manager is Deployed On-Premises
• Recommended Procedure if Enterprise Manager is Deployed on Oracle Cloud Infrastructure
• Common Tasks

Recommended Procedure if Enterprise Manager is Deployed On-Premises

Overview

This section describes the steps required for discovering Oracle E-Business Suite instances provisioned on Oracle Cloud Infrastructure (OCI) using Hybrid Cloud Agents. Refer to "Enabling Hybrid Cloud Management" in the Oracle Enterprise Manager Cloud Control Administrator’s Guide for more information.

Notes

• The database for an Oracle E-Business Suite instance in OCI is a pluggable database when:
  • The Oracle Database version is 19c.
  • The Oracle Database version is 12.1.0.2 and the database is on a VM DB System or an Exadata DB System.

At this time, Oracle Application Management Pack does not support Oracle E-Business Suite discovery using pluggable database targets. However, by using the "Database SID" as the pluggable database name, we can discover Oracle E-Business Suite instances for which the database is a pluggable database.
• If an Oracle E-Business Suite instance on OCI is using load balancer and is discovered in Oracle Enterprise Manager, the load balancer target is not monitored or discovered in Enterprise Manager.

• When installing Enterprise Manager agents on Oracle E-Business Suite nodes, the fully qualified domain name (FQDN) should be resolvable from the OMS host and the gateway agent host.

• All agents are installed using the oracle user.

Installing a Hybrid Cloud Gateway Agent

1. Install the Enterprise Manager Agent on the host which from which you intend to communicate with Oracle E-Business Suite nodes on OCI.

2. Register the agent created above as "Hybrid Cloud Gateway Agent" using a command like:

   `emcli register_hybridgateway_agent -hybridgateway_agent_list="<agent host>:<agent port>" -ignore_network_check`

Installing Hybrid Cloud Agents on All Oracle E-Business Suite Nodes

1. Ensure that the FQDN of each of the Oracle E-Business Suite nodes resolves to the Public IP of the Oracle E-Business Suite node from the OMS Host and Hybrid Cloud Gateway Agent host.

2. Create a Named Credential which will be used to connect to Oracle E-Business Suite Nodes, using steps described in Creating a Named Credential, page 14-20 with following properties:
   • Authenticating Target Type: Host
   • Credential type: SSH Key Credentials
   • Scope: Global
   • User Name: oracle
   • SSH Private Key: <Content of /u01/install/APPS/.ssh/id_rsa on Oracle E-Business Suite Cloud Manager VM or Oracle E-Business Suite Cloud Admin Tool VM from where the Oracle E-Business Suite instance is provisioned or any other private key with which we can connect to Oracle E-Business Suite Node>

3. Add ingress rules to the security lists associated with the subnets on which Oracle E-Business Suite App nodes and Oracle E-Business Suite database nodes are created (this information is provided while provisioning the Oracle E-Business Suite
instance on OCI), using steps described in: Adding an Ingress Rule, page 14-20, with the following property:

- Source Type: CIDR, Source CIDR: <CIDR that matches OMS Host IP and Hybrid Cloud Gateway Agent IP>, IP Protocol: TCP, Source Port Range: All, Destination Port Range: 22

4. Deploy the agent on all the Oracle E-Business Suite nodes, using the steps described in Deploying a Hybrid Cloud Agent, page 14-21.

### Adding an Oracle E-Business Suite Database Target

#### Adding a Database Target when the Database is on Compute VM

For Oracle Database 19c, follow the steps described in Adding a Database Instance Target, page 14-22, but while adding the target, use "Database SID" as the pluggable database name provided while provisioning the Oracle E-Business Suite instance.

*Note:* The "Database SID" must be specified as the pluggable database name for Oracle E-Business Suite discovery to work.

For Oracle Database 12.1.0.2 or 11.2.0.4, follow the steps described in Adding a Database Instance Target, page 14-22.

#### Adding A Database Target when the Database is on 1-Node VM DB System (Single Instance)

For Oracle Database 19c or 12.1.0.2, follow the steps as described in Adding a Database Instance Target, page 14-22, but while adding the target, use "Database SID" as the pluggable database name provided while provisioning the Oracle E-Business Suite instance.

*Note:* The "Database SID" must be specified as the pluggable database name for Oracle E-Business Suite discovery to work.

For Oracle Database 11.2.0.4, follow the steps described in Adding a Database Instance Target, page 14-22.

#### Adding a Database Target when the Database is on a 2-Node VM DB System (Oracle RAC)

For Oracle Database 19c or 12.1.0.2 (and the Oracle E-Business Suite database is a pluggable database)

1. Add a cluster target by performing steps in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:
1. From the Enterprise Manager Console, in the Targets menu, select All Targets.

2. Search for and select the cluster target added above.

3. From the Cluster menu, select Discover Databases.

4. Click the Next button.

5. In the Database Discovery: Results page, under the "Cluster Database" section, select the check box associated with target listed, click on Configure.

6. In the Configure Cluster Database dialog, on the General tab, note down values of all the fields.

7. Click on the Instances tab.

8. Note down all values of all fields displayed for the two instances. Exactly two instances will be displayed.

9. Click the Cancel button.

10. Observe that you are on the Add Targets Manually page. You can navigate to this page by using the Setup menu, selecting Add Target, and then selecting Add Targets Manually.

11. Click on the Add Target Manually button.

12. Select target type as the Cluster Database.

13. Select/Enter Host as the first node in the cluster (host name can be derived from the values noted down in Instances tab above).

14. Click on the Add ... button.

15. Specify all values as noted in General tab above, except for the Service Name field. For the "Service Name" field, provide the pluggable database name provided while provisioning Oracle E-Business Suite instance.

   Note: You must specify the pluggable database name for the Service Name for Oracle E-Business Suite Discovery to work.

16. Enter the dbsnmp user password.

   Note: Ensure that the dbsnmp user account is working. You might need to unlock the user and set the password on the
Oracle E-Business Suite database.

17. Add two instances with the properties as noted down in Instances tab above, except for the Database SID field. For the Database SID field, provide the pluggable database name provided while provisioning Oracle E-Business Suite instance.

18. Click on the Next button.

19. Click on the Submit button.

20. Click on the Close button in confirmation window.

For Oracle Database 11.2.0.4

1. Add a cluster target by performing the steps in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:
   1. From the Enterprise Manager console, in the Targets menu, select All Targets.
   2. Search for and select the cluster target added above.
   3. In the Cluster Target Home page, from the Cluster menu, select Discover Databases.
   4. Click the Next button.
   5. In the Database Discovery: Results page, under the "Cluster Database" section, select the check box associated with the target listed, specify the dbsnmp user password, and click Next.

   Note: Ensure the dbsnmp user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

6. Click the Save button.

7. Click the Close button in the confirmation window.
Adding a Database Target when the Database is on an Exadata DB System

For Oracle Database 19 or 12.1.0.2 (and the Oracle E-Business Suite database is a pluggable database)

1. Add the cluster target by performing the steps in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:
   1. From the Enterprise Manager Console, in the Targets menu, select All Targets.
   2. Search for and select the cluster target added above.
   3. From the Cluster menu, select Discover Databases.
   4. Click on the Next button.
   5. In the Database Discovery: Results page, under the Cluster Database section, select the check box associated with the database you intend to discover and click the Configure button. Note that there can be multiple cluster databases listed based on the number of databases installed on Exadata DB System. The database name would have been provided while provisioning the Oracle E-Business Suite instance.
   6. In the Configure Cluster Database dialog, on the General tab, note down values of all the fields.
   7. Click on the Instances tab.
   8. Note down all values of all fields displayed for the two instances. Exactly two instances will be displayed.
   9. Click on the Cancel button.
   10. Observe that you are on the Add Targets Manually page. You can navigate to this page by using the Setup menu, selecting Add Target, and then selecting Add Targets Manually.
   11. Click on the Add Target Manually button.
   12. Select target type as "Cluster Database".
   13. Select/Enter Host as the first node in the cluster (hostname can be derived from the values noted down in Instances tab above).
   14. Click on the Add ... button.
15. Specify all values as noted in the General tab above, except for the Service Name field. For the Service Name field, enter the pluggable database name provided while provisioning the Oracle E-Business Suite instance.

   **Note:** You must specify the pluggable database name as the Service Name for Oracle E-Business Suite Discovery to work.

16. Enter the `dbsnmp` user password.

   **Note:** Ensure that the `dbsnmp` user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

17. Add two instances with the properties as noted down in Instances tab above, except for the Database SID field. For the Database SID field, provide the pluggable database name provided while provisioning Oracle E-Business Suite instance.

18. Click on the **Next** button.

19. Click on the **Submit** button.

20. Click on the **Close** button in confirmation window.

**For Oracle Database 11.2.0.4**

1. Add the cluster target by performing the steps described in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:

   1. From the Enterprise Manager console, in the **Targets** menu, select **All Targets**.

   2. Search for and select the cluster target added above.

   3. In the cluster target home page, from the **Cluster** menu, select **Discover Databases**.

   4. Click the **Next** button.

   5. In the Database Discovery: Results page, under the Cluster Database section, select the check box associated with the database you intend to discover and click the **Configure** button. Note that there can be multiple cluster databases listed based on the number of databases installed on Exadata DB System. The database name would have been provided while provisioning the Oracle E-
Business Suite Instance.

Provide the \texttt{dbsnmp} user password, and click \textbf{Next}.

\textbf{Note:} Ensure that the \texttt{dbsnmp} user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

6. Click the \textbf{Save} button.

7. Click the \textbf{Close} button in the confirmation window.

\section*{Discovering an Oracle E-Business Suite Instance}

Follow the steps described in Discovering Oracle E-Business Suite, page 4-1.

\section*{Recommended Procedure if Enterprise Manager is Deployed on Oracle Cloud Infrastructure}

This section describes the steps required for manually discovering Oracle E-Business Suite environments provisioned in Oracle Cloud Infrastructure Compute.

\subsection*{Overview}

In order to manually discover Oracle E-Business Suite environments provisioned on Oracle Cloud Infrastructure, you must complete the following sequence of steps, which are described in further detail in this section:

1. Ensure prerequisites are fulfilled.

2. Take inventory of port numbers which will be opened from the Oracle E-Business Suite nodes, which will be used in later steps.

3. Create ingress rules in Oracle Cloud Infrastructure to open the "Enterprise Manager Upload Http SSL Port" from the Oracle E-Business Suite nodes to the OMS host and add corresponding firewall rules to the OMS host.

4. Create ingress rules in Oracle Cloud Infrastructure to open the required ports from OMS to the Oracle E-Business Suite nodes.

5. Add firewall rules on corresponding application, database nodes corresponding to the ingress rules that were created.

6. Ensure that fully qualified domain name of each of the Oracle E-Business Suite nodes is resolvable from the OMS host and the fully qualified domain name of the
OMS host is resolvable from each of the Oracle E-Business Suite nodes.

7. Create required named credentials to connect to the Oracle E-Business Suite nodes.

8. Manually install a management agent on all Oracle E-Business Suite node.


**Prerequisites**

Before you perform a manually discovery of Oracle E-Business Suite environments provisioned in Oracle Cloud Infrastructure Compute, verify that the following requirements are fulfilled:

- Ensure that the Oracle E-Business Suite instance was provisioned using the EBS Cloud Admin Tool or Oracle E-Business Suite Cloud Manager.

- From the OMS host, you should be able to connect using SSH to each of the Oracle E-Business Suite nodes. Adding the required ingress rule for this communication to work is covered in the following sections.

**Notes**

- The database for the Oracle E-Business Suite instance in Oracle Cloud Infrastructure is a pluggable database (PDB) when:
  - The Oracle Database is 19c.
  - The Oracle Database is 12.1.0.2 and the database is on a VM DB System or an Exadata DB System.

  At this time, Oracle Application Management Pack does not support Oracle E-Business Suite discovery using pluggable database targets. However, by using the "Database SID" as the pluggable database name, we can discover Oracle E-Business Suite instances for which the database is a pluggable database.

- If an Oracle E-Business Suite instance on Oracle Cloud Infrastructure is using a load balancer and is discovered in Oracle Enterprise Manager, the load balancer target is not monitored or discovered in Enterprise Manager.

- All agents are installed as the oracle user.

**Taking Inventory of Port Numbers**

In order for EM agents to be able to upload to OMS, an ingress rule must be created on
the subnet where the OMS is installed to allow communication on the "Enterprise Manager Upload Http SSL Port" (which is by default "4093") from all Oracle E-Business Suite nodes. Take note of the port number.

**Note:** You can find the port number used in `<Middleware home>/install/portlist.ini` on the OMS host.

Record the following port numbers for reference, which will be opened from the Oracle E-Business Suite nodes:

- The database listener port on the subnet where database nodes are created. For example: 1521.
- The WebLogic Admin port range (for both run and patch file systems) on the subnet where the Oracle E-Business Suite application nodes are created (Only for Oracle E-Business Suite Release 12.2 instances). For example: 7001-7003.
- The port number used by the management agent installation on all subnets where the Oracle E-Business Suite nodes are present. For example: 3872.

**Creating Ingress Rules in Oracle Cloud Infrastructure to Open Required Ports from Oracle E-Business Suite Nodes to OMS Host**

Add ingress rules to the security lists associated with the subnet on which the OMS host properties (multiple rules may have to be created to cover CIDRs of all Oracle E-Business Suite nodes):

- **Source Type**: CIDR, **Source CIDR**: `<CIDR for IPs of Oracle E-Business Suite nodes>`, **IP Protocol**: TCP, **Source Port Range**: All, **Destination Port Range**: "Enterprise Manager Upload Http SSL Port"

**Note:** If the OMS host and Oracle E-Business Suite instances are on the same Virtual Cloud Network (VCN), the communication will happen using private IPs. In this case, the CIDR should match the private IP of the Oracle E-Business Suite node. If the OMS host and the Oracle E-Business Suite instances are on different VCNs, the communication will happen on public IPs. In this case, the CIDR should match the public IP of Oracle E-Business Suite node.

**Creating Firewall Rules on the OMS Host to Allow Communication from Oracle E-Business Suite Nodes**

1. Log in to the OMS host as the root user.
2. For each ingress rule added, create a corresponding firewall rule using commands similar to following:

```bash
firewall-cmd --zone=public --add-rich-rule 'rule family=ipv4 source address=<CIDR for IPs of Oracle E-Business Suite nodes> port port=<port number> protocol=tcp accept' --permanent

firewall-cmd --zone=public --add-rich-rule 'rule family=ipv4 source address=<CIDR for IPs of Oracle E-Business Suite nodes> port port=<port number> protocol=tcp accept'
```

Creating Ingress Rules in Oracle Cloud Infrastructure to Open Required Ports from OMS to the Oracle E-Business Suite Nodes

**Note:** If the OMS host and Oracle E-Business Suite nodes are on the same VCN, use the private IP of the OMS host when creating ingress rules. If the OMS host and Oracle E-Business Suite nodes are on different VCNs, use the public IP of the OMS Host when creating Ingress rules.

1. Add ingress rules to the security lists associated with the subnets on which the Oracle E-Business Suite App nodes are created (this information is provided while provisioning the Oracle E-Business Suite instance on Oracle Cloud Infrastructure), using steps in Adding an Ingress Rule, page 14-20 with the following properties:
   - **Source Type**: CIDR, Source CIDR: <OMS host IP>/32, IP Protocol: TCP, Source Port Range: All, Destination Port Range: 22
   - **Source Type**: CIDR, Source CIDR: <OMS host IP>/32, IP Protocol: TCP, Source Port Range: All, Destination Port Range: <WebLogic admin server port range> for example: 7001-7003 (Required only for Oracle E-Business Suite Release 12.2 instances)
   - **Source Type**: CIDR, Source CIDR: <OMS host IP>/32, IP Protocol: TCP, Source Port Range: All, Destination Port Range: <agent install port> for example: 3872

2. Add ingress rules to the security lists associated with the subnets on which Oracle E-Business Suite database nodes are created (this information is provided while provisioning the Oracle E-Business Suite instance on Oracle Cloud Infrastructure), using steps in Adding an Ingress Rule, page 14-20 with the following properties:
   - **Source Type**: CIDR, Source CIDR: <OMS host IP>/32, IP Protocol: TCP, Source Port Range: All, Destination Port Range: 22
   - **Source Type**: CIDR, Source CIDR: <OMS host IP>/32, IP Protocol: TCP, Source Port Range: All, Destination Port Range: <database listener port> for example: 1521
• **Source Type:** CIDR, Source CIDR: <OMS host IP>/32, IP Protocol: TCP, Source Port Range: All, Destination Port Range: <agent install port> for example: 3872

### Adding Firewall Rules on Oracle E-Business Suite Nodes

#### Add Firewall Rules to Oracle E-Business Suite App Nodes
Add firewall rules using the steps in Adding Firewall Rule When Local Firewall Uses “firewalld”, page 14-20. Each rule should correspond to each of the ingress rules added previously for the Oracle E-Business Suite App nodes.

#### Add Firewall Rules to Oracle E-Business Suite Database Nodes, When Database is on Compute
Add firewall rules using the steps in Adding Firewall Rule When Local Firewall Uses “firewalld”, page 14-20. Each rule should correspond to each of the ingress rules added previously for each of the database nodes.

#### Add Firewall Rules to Oracle E-Business Suite Database Nodes, When Database is on 1- Node VM DB System or 2-Node VM DB System
Add firewall rules using the steps in Adding Firewall Rule When Local Firewall Uses “iptables”, page 14-21. Each rule should correspond to each of the ingress rules added previously for each of the database nodes.

#### Add Firewall Rules to Oracle E-Business Suite Database Nodes, When Database is on Exadata DB System
In this case, no firewall rules need to be added. Do not attempt to add any firewall rules.

### Ensuring the Fully Qualified Domain Name is Resolvable
You must ensure that the fully qualified domain name (FDQN) of each of the Oracle E-Business Suite node is resolvable from the OMS host and that the FQDN of the OMS host is resolvable from each Oracle E-Business Suite node.

If the OMS host and Oracle E-Business Suite nodes are on the same VCN, no additional settings are required.

Although, if the OMS host and Oracle E-Business Suite nodes are on different VCNs, an update to the `/etc/hosts` file on OMS host and each of the Oracle E-Business Suite nodes is required so that the host names are resolvable as required. Ensure that the entries are created with public IPs of the hosts to FQDN for the host.

For example:
```plaintext
129.213.29.20  em132amp1.ampssubnet.my1811vcn.example.com  em132amp1
```
Creating Required Named Credentials to Connect Oracle E-Business Suite Nodes

Create named credentials which will be used to connect to the Oracle E-Business Suite nodes. Using the steps in Creating a Named Credential, page 14-20, create named credentials with the following properties:

- **Authenticating Target Type**: Host
- **Credential Type**: “SSH Key Credentials”
- **Scope**: Global
- **User Name**: oracle
- **SSH Private Key**: <Content of /u01/install/APPs/.ssh/id_rsa on EBS Cloud Admin Tool VM / Oracle E-Business Suite Cloud Manager VM from where the Oracle E-Business Suite instance is provisioned or any other private key using which we can connect to the Oracle E-Business Suite node>

Manually Installing Management Agents on All Oracle E-Business Suite Nodes

Follow the steps in section "Installing Management Agents" of the Oracle Enterprise Manager Cloud Control Basic Installation Guide to manually deploy the management agent on all Oracle E-Business Suite nodes.

- To manually discover an Oracle E-Business Suite environment that was provisioned on Oracle Cloud Infrastructure, discovery can only be performed if the agent is installed by the oracle user.
- When installing the agent by selecting the option "Add Target Manually", make sure to use the fully qualified domain name.
- Deselect "Configure Hybrid Cloud Agent" when deploying the agent manually.
- If you are deploying the Oracle E-Business Suite instance node agent by the fully qualified domain name, there is an additional step necessary when the OMS host and Oracle E-Business Suite nodes are on different VCNs. You must log in to the OMS server and add the following entry to the local hosts file (/etc/hosts) for each Oracle E-Business Suite node:

  `<Public IP address><machine name with domain name><machine name>`

  For example: 192.0.2.1 myr63sdb.mydbsubnet.demo1811vcn.example.com myr63sdb
Adding an Oracle E-Business Suite Database Target

Adding a Database Target when Database is on Compute VM

For Oracle Database 19c

Follow the steps as described in Adding a Database Instance Target, page 14-22, although while adding the target, use "Database SID" as the pluggable database name provided while provisioning the Oracle E-Business Suite instance.

Note: The "Database SID" must be specified as the Pluggable database name for Oracle E-Business Suite discovery to work.

For Oracle Database 12.1.0.2 or 11.2.0.4

Follow the steps described in Adding a Database Instance Target, page 14-22.

Adding a Database Target when the Database is on 1-Node VM DB System (Single Instance)

For Oracle Database 19c or 12.1.0.2 (and the Oracle E-Business Suite database is a pluggable database)

Follow the steps as described in Adding a Database Instance Target, page 14-22, although while adding the target, use "Database SID" as the pluggable database name provided while provisioning the Oracle E-Business Suite instance.

Note: The "Database SID" must be specified as the Pluggable database name for Oracle E-Business Suite discovery to work.

For Oracle Database 11.2.0.4

Follow the steps described in Adding a Database Instance Target, page 14-22.

Adding a Database Target when Database is on 2-Node VM DB System (Oracle RAC)

For Oracle Database 19c or 12.1.0.2 (and the Oracle E-Business Suite database is a pluggable database)

1. Add the cluster target by performing the steps described in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:
   1. From the Enterprise Manager console, in the Targets menu, select All Targets.
   2. Search for and select the cluster target added above.
   3. From the Cluster menu, select Discover Databases.
4. Click the **Next** button.

5. In the Database Discovery: Results page, under the Cluster Database section, select the check box associated with target listed, and click on **Configure**.

6. In the Configure Cluster Database dialog, on the General tab, note down the values of all the fields.

7. Click on the Instances tab.

8. Note down all values of all fields displayed for the two instances. Exactly two instances will be displayed.

9. Click on the **Cancel** button.

10. Observe that you are on the Add Targets Manually page. You can navigate to this page by using the **Setup** menu, selecting **Add Target**, and then selecting **Add Targets Manually**.

11. Click on the **Add Target Manually** button.

12. Select target type as "Cluster Database".

13. Select/Enter Host as the first node in the cluster (host name can be derived from the values noted down in Instances tab above).

14. Click on the **Add ...** button.

15. Specify all values as noted in the General tab above, except for the Service Name field. For the Service Name field, provide the pluggable database name provided while provisioning Oracle E-Business Suite instance.

   **Note:** You must specify the Pluggable database name as the Service Name for Oracle E-Business Suite Discovery to work.

16. Enter the **dbsnmp** user password.

   **Note:** Ensure that the **dbsnmp** user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

17. Add two instances with the properties as noted down in the Instances tab above, except for:

    - Database SID - For the Database SID parameter, provide the pluggable
database name provided while provisioning Oracle E-Business Suite instance.

- **Listener Machine Name** - For this parameter, give the value of the corresponding host.

18. Click on the **Next** button.

19. Click on the **Submit** button.

20. Click on the **Close** button in confirmation window.

**For Oracle Database 11.2.0.4**

1. Add a cluster target by performing the steps in Adding a Cluster Target, page 14-22.

2. Add a cluster database target by using the following instructions:
   1. From the Enterprise Manager console, in the **Targets** menu, select **All Targets**.
   2. Search for and select the cluster target added above.
   3. In the Cluster Target Home page, from the **Cluster** menu, select **Discover Databases**.
   4. Click the **Next** button.
   5. In the Database Discovery: Results page, under the Cluster Database section, select the check box associated with the target listed, specify the **dbsnmp** user password, and click **Next**.

   **Note:** Make sure the **dbsnmp** user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

6. Click on **Configure**.

7. Click on the **Instances** section.

8. Change the value of "Listener Machine Name" to be the same as that of "Host" for that particular instance, for each of the two instances.

9. Click the **Save** button.

10. Click **Next**.
11. Click the **Save** button.

12. Click the **Close** button in the confirmation window.

**Adding a Database Target when the Database is on Exadata DB System**

**For Oracle Database 19c or 12.1.0.2 (and the Oracle E-Business Suite database is a pluggable database)**

1. Add a cluster target by performing the steps described in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:
   1. From Enterprise Manager console, in the **Targets** menu, select **All Targets**.
   2. Search for and select the cluster target added above.
   3. From the **Cluster** menu, select **Discover Databases**.
   4. Click on the **Next** button.
   5. In the Database Discovery: Results page, under the Cluster Database section, select the check box associated with the database you intend to discover and click the **Configure** button. Note that there can be multiple cluster databases listed based on the number of databases installed on Exadata DB System. The database name would have been provided while provisioning the Oracle E-Business Suite instance.
   6. In the Configure Cluster Database dialog, on the General tab, note down the values of all the fields.
   7. Click on the **Instances** tab.
   8. Note down all values of all fields displayed for the two instances. Exactly two instances will be displayed.
   9. Click on the **Cancel** button.
   10. Observe that you are on the Add Targets Manually page. You can navigate to this page by using the **Setup** menu, selecting **Add Target**, and then selecting **Add Targets Manually**.
   11. Click on the **Add Target Manually** button.
   12. Select target type as ‘Cluster Database’.
   13. Select/Enter Host as the first node in the cluster (hostname can be derived from
the values noted down in the Instances tab above).

14. Click on the Add ... button.

15. Specify all values as noted in the General tab above, except for the Service Name field. For the Service Name field, enter the pluggable database name provided while provisioning the Oracle E-Business Suite instance.

   **Note:** You must specify the pluggable database name as the Service Name for Oracle E-Business Suite discovery to work.

16. Enter the `dbsnmp` user password.

   **Note:** Ensure that the `dbsnmp` user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

17. Add two instances with the properties as noted down in the Instances tab above, except for:

   - Database SID - For the Database SID parameter, provide the pluggable database name provided while provisioning Oracle E-Business Suite instance.

   - Listener Machine Name - For this parameter, give the value of the corresponding host.

18. Click on the Next button.

19. Click on the Submit button.

20. Click on the Close button in confirmation window.

**For Oracle Database 11.2.0.4**

1. Add the cluster target by performing the steps in Adding a Cluster Target, page 14-22.

2. Add a cluster database target using the following instructions:

   1. From the Enterprise Manager console, in the Targets menu, select All Targets.

   2. Search for and select the cluster target added above.

   3. In the Cluster Target Home page, from the Cluster menu, select Discover
Databases.

4. Click the **Next** button.

5. In the Database Discovery: Results page, under the Cluster Database section, select the check box associated with the database you intend to discover and click the **Configure** button. Note that there can be multiple cluster databases listed based on the number of databases installed on an Exadata DB System. The database name would have been provided while provisioning the Oracle E-Business Suite instance.

6. Provide the **dbsnmp** user password, and click **Next**.

   **Note:** Make sure the **dbsnmp** user account is working. You might need to unlock the user and set the password on the Oracle E-Business Suite database.

7. Click on **Configure**.

8. Click on the Instances section.

9. Change the value of "Listener Machine Name" to be same as that of "Host" for that particular instance, for each of the two instances.

10. Click the **Save** button.

11. Click on **Next**.

12. Click the **Save** button.

13. Click the **Close** button in the confirmation window.

**Manually Discovering the Oracle E-Business Suite Instance**

At this point, manually discover the Oracle E-Business Suite instance by using the steps in the section Using the Discovery Wizard, page 4-2.

Make sure to adhere to the additional steps found in Additional Features for Discovery, page 4-7, especially:

- Discovering Oracle E-Business Suite as the EM_MONITOR user (Recommended), page 4-7
- Discovering Oracle E-Business Suite as any database user (such as DBSNMP), page 4-7
Common Tasks

Creating a Named Credential

2. Select Named Credentials.
3. Click on the Create button.
4. Specify a Credential Name (user defined).
5. Fill in other mandatory fields as required and click the Save button.

Adding an Ingress Rule

1. Log in to Oracle Cloud Infrastructure console.
2. Using the menu, navigate to Networking, select Virtual Cloud Networks, and then select your VCN.
3. Click Security Lists and then select the security list corresponding to the subnet to which you want to create an ingress rule.
4. Click Edit All Rules.
5. Click on the + Add Another Ingress Rule button. Specify Source Type, Source CIDR, IP Protocol, Source Port Range, and Destination Port Range:
6. Click on the Save Security List Rules button.

Adding a Firewall Rule When the Local Firewall Uses "firewalld"

1. Log in to the node on which the firewall rule is to be created as the root user.
2. Execute the following commands:
   1. `firewall-cmd --zone=public --add-rich-rule 'rule family=ipv4 source address=<source CIDR> port port=<port number> protocol=tcp accept' --permanent`
   2. `firewall-cmd --zone=public --add-rich-rule 'rule family=ipv4 source address==<source CIDR> port port=<port number> protocol=tcp accept'`

   If you want to specify a <port range>, use a format like <first port in range>-<last port in range>. For example, port=7001-7003; (both
Adding a Firewall Rule When Local Firewall Uses "iptables"

1. Log into the node on which the firewall rule is to be created as the root user.

2. Execute the following commands:
   1. `iptables -I INPUT 1 -s <source cidr> -p tcp -m state --state NEW -m tcp --dport <port number> -j ACCEPT`
      If you want to specify a <port range> use format like `--dport <first port in range> :<last port in range>`. For example, `--dport 1521:1523`; (both ports are inclusive).
   2. `service iptables save`
   3. `service iptables restart`

Deploying a Hybrid Cloud Agent

1. From the Enterprise Manager console, in the Setup menu, select Add Target, and then select Add Targets Manually.

2. On the Add Targets Manually page, click the Install Agent on Host button.

3. Click the + Add button.

4. Enter the FQDN of the host on which the agent is being installed. Select a platform.

5. Click the Next button.


7. Select the Configure Hybrid Cloud Agent check box.

8. Select the Hybrid Cloud Gateway Agent.

9. Select an appropriate Named Credential.

10. Leave the Privileged Delegation Setting field blank (blank value).

11. Click on Next.

12. Click on Deploy Agent.

13. After the agent is installed successfully, run "<Installation Base Directory>/agent_<em version>/root.sh" as the root user.
Adding a Database Instance Target

1. From the Enterprise Manager console, in the Setup menu, select Add Target, and then select Add Targets Manually.

2. On the Add Targets Manually page, select Add Target Manually.

3. In the Add Target Manually dialog box, select "Database Instance" as Target Type.

4. For Host, choose the host on which the database is running.

5. Click Add ....

6. Specify all required properties and add the target.

Adding a Cluster Target

1. From the Enterprise Manager console, in the Setup menu, select Add Target, and then select Add Targets Manually.

2. On the Add Targets Manually page, select Add Target Manually.

3. In the Add Target Manually dialog box, select "Cluster" as the Target Type.

4. For Host, choose or enter the first node in the cluster.

5. Click Add ....

6. Fill in all the values, using the steps described in My Oracle Support Knowledge Document 1908635.1, EM 13c, 12c: How to Discover the Cluster and Cluster Database (RAC) Target in EM Cloud Control, in section (c), "Discover the Cluster Target and Cluster Database Target manually," under "How to determine the values which need to be supplied."

   Note: To determine "CRS_HOME" on OCI, execute the command ps -ef | grep tns. The output of the command will have the grid infrastructure home.

7. In the "Cluster Host and High Availability Services Targets" section, add the second host in the cluster.

8. Click the Save button.

9. Click the Close button in the confirmation window.
10. Wait for the cluster target status to be "Up".
Introduction to Change Management

This chapter covers the following topics:

- Introduction
- Approval Process for Change Management
- Preferred Credentials for Change Management
- Notifications Setup
- Diagnostic Tests

Introduction

Change Management functionality allows customers to control and manage the changes to Oracle E-Business Suite systems. Without an approval from the authorized approver, changes through patches or customizations cannot be made to any Oracle E-Business Suite instance using the Oracle Application Management Pack for Oracle E-Business Suite.

Change Management functionality includes following components:

- Approval Management - Manage and control changes done to Oracle E-Business Suite through patches or customizations using approval management.

- Patch Management - Automates deployment of Oracle-delivered patches and customizations using Patch Manager.

- Customization Management - Discovers customizations and automates the customization package creation and deployment process using Customization Manager.

- Cloning - Automates the Oracle E-Business Suite cloning process.

Please see detailed description of each of these components in their respective sections of this document.
Major Benefits

- Simplifies the mechanism of orchestrating changes across multiple Oracle E-Business Suite systems.
- Improves user productivity by automating the deployment of changes.
- Reduces human errors by providing a standards-based change deployment framework.
- Provides notifications on pending approval requests and status of changes to specific users or user groups.

Approval Process for Change Management

The Change Approval process helps ensure that all changes done with Oracle-delivered patches or customizations in Change Management go through a change approval mechanism. Oracle Application Management Pack for Oracle E-Business Suite Release 12.1.0.4.0 introduces a Multilevel Hierarchical Approval Process for Change Management requests, such as requests to apply patch(es) on an Oracle E-Business Suite instance. In previous releases of the Oracle E-Business Suite plug-in, the approval process is single level; that is, if any Change Management request is submitted for approval, then any user with the Approval privilege can approve the request. With the Multilevel Hierarchical Approval Process, the change request will go through the Approval Hierarchy of users defined for the Oracle E-Business Suite target for which the change request is submitted.

The Oracle Application Management Pack for Oracle E-Business Suite supports three types of change requests which need an approval process: (1) Create Splice Request, (2) Release Package Request, and (3) Patch Manager Request. Each type of change request normally has one active Approval Hierarchy defined for it. If no approval hierarchy is defined for a request type, then the default single level approval will take place for all the requests of that type. An approval hierarchy is identified by Hierarchy Type, which is the change request type and the Oracle E-Business Suite target. The request will follow the hierarchy defined for it.

**Note:** The change request type "Release Package" is not specific to an Oracle E-Business Suite target, so an Oracle E-Business Suite target is not required while defining an approval hierarchy for this request type.

The Multilevel Hierarchical Approval process involves three major components.

1. Defining an Approval Hierarchy.
2. Following the Approval Hierarchy when a request is submitted.
3. Using the functions View/Approve/Reject "Change Requests".

   **Note:** See the section Change Management Privileges, page 7-5 for information on required privileges.

**Navigation**

To go to the Approval Hierarchy home page from the Oracle E-Business Suite Management home, navigate to **Administer > Change Management > Change Approvals > Approval Hierarchy**.

**Navigation Path for Approval Hierarchy**

**Approval Hierarchy Home**

The Approval Hierarchy Home page shows the summary of defined Approval Hierarchies. Each Approval Hierarchy is associated with a Request Type (Hierarchy Type). An Approval Hierarchy is uniquely identified by its Hierarchy ID, and one change request type can have multiple Approval Hierarchies but only one is enabled at a time.
Approval Hierarchy Page Accessibility

Any user can view any Approval Hierarchy, but only users who have a privilege with the "Create/edit approval hierarchy" privilege can create, modify, or delete an Approval Hierarchy. This privilege is a Resource Level Privilege of the Oracle E-Business Suite plug-in.

Searching for an Approval Hierarchy

By default all existing Approval Hierarchies are displayed in the Approval Hierarchy home page with a "Search" region at the top. Users can search Hierarchies by Target Name or Hierarchy ID.
Creating an Approval Hierarchy

You must have the "Create/edit approval hierarchy" privilege to create an Approval Hierarchy.

In the Approval Hierarchy home page, click on Create.

Select the Hierarchy Type and Oracle E-Business Suite Target for which the Hierarchy is to be created, and add users who have the approval privilege (The LOV displays users who have the privilege to approve the selected request type).

Important: The Approval Hierarchy Level is the order in which Approvals are required. If the request is rejected at any level, then the request will not continue to the next level.
Enabling or Disabling an Approval Hierarchy or a User in an Approval Hierarchy

There can be multiple Approval Hierarchies for a request type. For hierarchy types that require targets, such as "Patch Manager" or "Create Splice", more than one hierarchy can be enabled if the targets are different (Hierarchy Type plus Target Name should be unique.) However, for the "Release Package" hierarchy type there is no associated target, so only one approval hierarchy can be defined.

Change management requests will follow the Approval Hierarchy which is enabled. The users within an Approval Hierarchy can be enabled or disabled as well. Disabled users in an Approval Hierarchy will be skipped and approval process will go to the next level.

Updating an Approval Hierarchy

In the Approval Hierarchy Home page, select the Approval Hierarchy to be updated and click the Update button. Note: If any Change Request is pending (status is Pending for Approval) within an Approval Hierarchy, then update of that Approval Hierarchy is not allowed.
Deleting an Approval Hierarchy

In the Approval Hierarchy home page, select the Approval Hierarchy to be deleted, and click **Delete**.

**Note:** If any Change Request (Pending, Approved, or Rejected) exists for that Approval Hierarchy, then the Delete function is not allowed. A user can choose to disable that Approval Hierarchy, however.
Deleting an Approval Hierarchy Confirmation Window

Viewing an Approval Hierarchy

In the Approval Hierarchy Home page, click on Hierarchy ID link to view the Approval Hierarchy.

Note: All users have access to view the hierarchies in order to view the user(s) associated with the approval process.
View Approval Hierarchy Page

**View Approval Hierarchy : Patch Manager**

Oracle E-Business Suite Management > Approval Hierarchy > View Approval Hierarchy : sc126_Oracle E-Business Suite

<table>
<thead>
<tr>
<th>Hierarchy Type</th>
<th>Patch Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Name</td>
<td>sc126_Oracle E-Business Suite</td>
</tr>
<tr>
<td>Enabled</td>
<td>Y</td>
</tr>
<tr>
<td>Hierarchy ID</td>
<td>100</td>
</tr>
<tr>
<td>Created By</td>
<td>SYSMAN</td>
</tr>
<tr>
<td>Last Updated By</td>
<td>SYSMAN</td>
</tr>
<tr>
<td>Last Update Date</td>
<td>1/25/2016</td>
</tr>
</tbody>
</table>

**Hierarchy Users**

<table>
<thead>
<tr>
<th>User Name</th>
<th>Hierarchy Level</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMUSER</td>
<td>1</td>
<td>Y</td>
</tr>
<tr>
<td>SYSMAN</td>
<td>2</td>
<td>Y</td>
</tr>
</tbody>
</table>

**Associating an Approval Hierarchy to a Change Request**

The user creating the Change Request selects the Hierarchy Type which is the change request type and the Oracle E-Business Suite target for which the Change Request is to be applied. (Note that a Release Package request does not need an Oracle E-Business Suite Target).

If any Approval Hierarchy exists for that request type (or target, in the cases of hierarchies with the types 'Create Splice Request' and 'Patch Manager Request'), the request will go through that hierarchy for approval. **Note: If no approval hierarchy is defined for a request type and Target and then the default single level approval process will take place.**

**Handling Removal (from Enterprise Manager) of a User or Unavailability of Users during Approval Process**

Note: In this section, the "Approval Hierarchy Administrator" is the user who has the resource privilege **Create/Edit Approval Hierarchy**.

If a user in an Approval Hierarchy is removed when no request is Pending within that Approval Hierarchy, then the removed user needs to be disabled from the Approval through the "Update Hierarchy" page. If the user is not disabled, then new requests cannot be submitted to the associated request type.

If a user in an Approval Hierarchy is removed while a Change Request is Pending with him/her, then:
1. A Warning message is displayed for the request in the Change Requests page.

2. If the requestor sees a warning message about the non-existence of a user at a particular level of the Approval Hierarchy, he/she has the option to send a notification to the Approval Hierarchy Administrator.

3. Once the requestor notifies the Approval Hierarchy Administrator about the removed user, all Approval Hierarchy Administrator users including the Super Administrator (a Super Administrator has all privileges) receives the email, and the Super Administrator has to approve the request on behalf of the removed user.

4. Once the request is approved by the Super Administrator, an Approval Hierarchy Administrator can disable the removed user from the Approval Hierarchy to prevent the future requests from going to the removed user.

The Super Administrator can approve or reject a request at any stage of the Approval process. The Super Administrator can approve one level at a time and cannot approve for all levels at once. The Approval Hierarchy Administrator is designated to create or edit the Approval Hierarchy.

**Change Approval Requests Page**

The Change Approval page allows users with the proper privileges to perform the following:

- Users can view their own requests. A user who submitted a request or requests can view all the requests that he or she submitted.

- If the logged-in user is the next approver for a pending request, he/she can approve or reject that request. Other users with the specific approval privilege will be only
able to view the specific type of request.

- Users can track historical data with respect to change control requests for auditing purposes using "Related History".

- If a request is pending for a longer time than expected, then the requestor has the option to send a reminder to the next approver in the Approval Hierarchy.

The table of requests includes columns for Module, Status, Requestor, Last Updated By, Last Updated Date, and the user with whom the request is currently pending approval ("Pending With").

If a request is pending approval with a user who does not exist in Enterprise Manager anymore, then a warning is displayed stating that the Approval Hierarchy Administrator should be notified.

**Viewing a Request**

By clicking on a request name in the Change Approval Requests page, you can view information on that request, including its status, Approval Hierarchy ID, Targets, Notification Email recipients, and Related History.

If a request is pending approval with a user who no longer exists, then you can use the button **Notify Approval Administrator** to notify the Approval Hierarchy Administrator.

Note that if multiple Approval Administrators exist, then a notification will be sent to any 5 Approval Administrators. If no Approval Administrator exists, then an error message is displayed.

**Auto-Approval - Requestor is Part of the Approval Hierarchy**

A change request is auto-approved (approved without user intervention) and goes to the next steps in the following cases:

1. If an Approval Hierarchy exists:
   1. All change requests will go through the approval process before their execution. In some cases, the request will be auto-approved (without user interaction) as described in this section.
   2. Auto-approval at one level if the Requestor is part of the Approval Hierarchy (Example: Hierarchy is L1-->L2--L3--L4, if L3 creates request the request gets approved at L3 once L2 approves).
   3. A Super Administrator can approve a request at any level but only one level at a time.
   4. If a user does not exist, the requestor can notify all Approval Administrators
who have the Approval Hierarchy privilege. (Note: A Super Administrator has all privileges including the Approval Hierarchy privilege).

5. A user who has the Approval Hierarchy privilege can create/edit an Approval Hierarchy (Note: A Super Administrator has all privileges including the Approval Hierarchy privilege).

2. If an Approval Hierarchy does not exist:
   • A request is auto-approved if the requestor has the Approve privilege.

Preferred Credentials for Change Management

When using Change Management features, you will need to access Oracle E-Business Suite instances. You can set up credentials for these instances for every user as a one-time setup step instead of entering them every time you need to access an instance. Note that preferred credentials are not shared across users. See the Credentials chapter beginning with the section Overview of Credentials, page 5-1 for more information.

Notifications Setup

You have the option of sending e-mail notifications to users regarding updates to the Oracle E-Business Suite systems. To have these notifications sent successfully, you must have the system set up properly:

• Ensure that the agent on the Oracle Management Server is up and running.

• Ensure that the command parDeploy has been run as part of the setup of Oracle Enterprise Manager Cloud Control 13c.

• Enter the SMTP information as described below.

To set the SMTP information in Oracle Enterprise Manager:
The Outgoing SMTP Server information must be entered in Oracle Enterprise Manager.

Note: If the SMTP information is not set correctly, notifications will not be sent.

1. Within Oracle Enterprise Manager, navigate to Setup > Notifications > Mail Servers.

2. Enter "Identify Sender As", "Sender’s Email Address" in "Sender Identity" information.

3. Click on the Add button in the "Outgoing Mail (SMTP) Servers” table.
4. In the "Outgoing Mail (SMTP) Server" window, enter SMTP server details and click OK.

5. Select the "Outgoing Mail (SMTP) Server" you just added and click the Test Mail Servers button.

**Diagnostic Tests**

Oracle Application Management Pack for Oracle E-Business Suite includes diagnostic tests that should be run to ensure your system is set up correctly to use the pack's features. These tests are run using the Pack Diagnostics choice on the Administer menu in the Oracle E-Business Suite Management page. For more information on using the Pack Diagnostics link, see: Diagnosing Issues Using Pack Diagnostics, page 12-1.
Introduction

Patch Manager allows you to deploy Oracle-delivered patches or customizations across Oracle E-Business Suite instances. You can create a patch run definition and run it multiple times on multiple instances and you can copy a patch procedure and modify it to suit your business needs. Also, you can easily access details on patch runs, correct errors if necessary, and continue the patch runs.

Note: If you will use Patch Manager with Oracle E-Business Suite Release 12.2, you should be familiar with Online Patching concepts before using Patch Manager. Refer to Oracle E-Business Suite Concepts and Oracle E-Business Suite Maintenance Guide for information on Online Patching.

Key Features

Patch Manager has the following features:
• Delivers patch recommendations to Oracle E-Business Suite and Technology Stack.

• Automates the deployment of Oracle-delivered patches and custom packages across multiple Oracle E-Business Suite instances.

• Leverages common Oracle E-Business Suite utilities such as adpatch and adop.

• Automates the patching deployment process to reduce overall patching deployment time and efforts.

• Enforces patch promotion policies for applying patches to pre-production instances prior to applying them to production systems.

• Supports searching and downloading of patches from My Oracle Support. The patches are downloaded to a central location on Oracle Management Server (OMS).

  **Note:** If My Oracle Support is unavailable to OMS, then Patch Manager is also able to search for and apply patches from the central staging location.

• Supports National Language Support (NLS) patches.

• Provides a complete history of all patch deployments.

• Provides a customizable patch deployment procedure.

• Leverages Oracle Enterprise Manager infrastructure for distributed processing.

With Patch Manager, you can accomplish the following tasks:
• View the readme of a patch with just one click.

• Check for prerequisites for Oracle E-Business Suite application patches.

• View and apply un-applied patches based on Oracle patch recommendations that are specific to any given Oracle E-Business Suite instance.

• Schedule deployments based on the target’s time zone.

• Schedule deployments of patches immediately or in the future.

• Perform a complete series of pre/post health checks when deploying patches.

• Track and monitor all patching deployments "Running", "Scheduled", "Saved" and "Succeeded" from a centralized console.

• View patching worker logs directly from the Patch Manager UI.
- Send and receive notifications for patch failures and completion.
- Run diagnostic tests. Oracle recommends running pack diagnostics for Patch Manager to ensure that credentials and privileges are set properly. For more information on pack diagnostics for Patch Manager, refer to: Diagnostic Tests for Patch Manager, page 12-10.

Running Patching Procedures from Enterprise Manager Command Line (EM CLI)

Patching procedures can also be run from Enterprise Manager command line interface (EM CLI, or emcli). The command used for creating a patch run is:

```bash
$EMCLI_HOME/emcli patch_ebs -input_file=ebs_patch_file:"<fully qualified path of ebs_patch_file.xml>"
```

Limitations of `emcli` verb `patch_ebs`:

1. The patches need to be pre-downloaded at OMS patch stage directory location which is set in Preferences page.
2. Merge patches is currently not supported in the `emcli` verb.
3. Patch Run Description and Notification Email(s) cannot be set.
4. The Check Prerequisites feature is currently not available in the `emcli` verb.

The format of the `ebs_patch_file.xml` and descriptions of tags for input xml file are described below in relevant sections for the Oracle E-Business Suite releases.

Patch Manager Home

The Patch Manager home page provides an overview of the patch deployment procedures. You can use the Personalize Page icon to hide, show, or reorder the regions on the page. For example, if you are patching Release 12.2 targets primarily, you can personalize the page to display the Online Patching region first and also display the Abort Runs and Cutover Runs regions.

The default Patch Manager home page displays following regions:

- **Patch Promotions** - You can use this region to promote patches based on predefined patch promotion policies.
- **Patch Runs** - used for targets on releases 12.1 and earlier
- **Online Patching** - used for Release 12.2 targets
- **Patch Logs** - used to access patching log files

Two other regions are available, but are hidden by default. Customers running Oracle E-Business Suite Release 12.2 or higher should enable these two hidden regions.
• Abort Runs
• Cutover Runs

Patch Manager Home Page

Patch Promotion Policies

Patch Manager delivers the capability to enforce user-defined patch promotion policies to ensure changes are made sequentially to pre-production instances (such as test or QA), and then promoted to production systems. These policies can be used to specify that patches must be applied to pre-production systems before applying them to production systems. This feature provides Audit Trail visibility and enhanced internal controls for patch application.

By default, the patch promotion policy feature is not enabled out of the box. Administrators can enable the promotion policy by setting the preference “Enforce Patch Promotion Policy”. Once it is enabled, administrators can define various patch promotion policies including multiple Oracle E-Business Suite targets and enforce the sequence in which the patches are promoted. Approvals are required for each Oracle E-Business Suite target before patches can be applied. Requests for approval will be generated when a patch is submitted. A Super Administrator can decide not to use the patch promotion policy for emergency patching or can choose not to include a specific Oracle E-Business Suite target instance in any patch promotion policy. In the case of emergency patching, Patch Manager sends out a notification of the patch promotion violation as a warning. For example, the patch promotion policy for a customization could have the patch proceed from development to testing and user acceptance, then to quality assurance testing and finally to production.
Example of a Sequence of a Patch Promotion Policy

Setting up a Patch Promotion Policy

To create a new patch promotion policy, navigate to Patch Manager Home > Action (menu) > Configure Promotion Policies. Then follow these steps:

1. Select the Create icon. A new window appears.

2. Provide a name for your policy in the Create New Promotion Policy window.

3. Select the release of Oracle E-Business Suite instances for which the patch promotion policy is to be configured.

4. Select the targets for your policy from the "Available Targets" list and move them to the "Selected Targets" list.

   **Important:** A target may belong to only one active policy. Because a given production system generally has multiple supporting instances that are clones of the production system, it would not make sense to put a supporting environment in two different patch promotion policies.

5. Move the targets up and down in the "Selected Targets" list to set the promotion order.

6. Click Save to save your work.
Creating a New Promotion Policy

The Patch Promotion Policy region on the home page displays patches and their statuses on various targets. This table dynamically changes based upon the policy displayed. You can select multiple rows within the table in order to promote patches to the next target defined in the policy.

For example, several developers might submit patches to a development environment. During the promotion of these patches to the next environment, an administrator has the capability to bundle the multiple patches into a single deployment procedure.

You can select the patches they want to promote and click on **Promote** to apply the patches to the next Oracle E-Business Suite target instance in the patch promotion
policy. The Patch Manager interview is then pre-populated with the selected patches and the target information.

A check mark in each target column indicates that the patch has been applied to the specified Oracle E-Business Suite instance. An 'X' mark indicates that the patch has not been applied to that target Oracle E-Business Suite instance. You can also access the patch readme file and Deployment Details from this region.

**Patch Runs**

The Patch Runs region of the Patch Manager Home lists the patch runs and their statuses for Oracle E-Business Suite Release 12.1 and earlier.

**Patch Runs Region**

You can perform various actions on a patch run depending on its status:

- **Review** - Review details of the patch run.

- **Create Like** - Copy an existing patch run, in order to change any aspect of the patch run or to run an identical run due to changes in the patch or target.

- **Edit** - If a patch run is in Saved status, you can edit it.

- **Submit** - If a patch run has been approved through the approval management system, it can be submitted from here.

To start a new patch run for Oracle E-Business Suite Release 12.1 and earlier, select "New Deployment". If a user has duplicated a "Patch Oracle E-Business Suite" deployment procedure, then clicking "New Deployment" will prompt you for which deployment procedure you would like to use. Otherwise, clicking "New Deployment" will begin the patch run interview.

By default, all records are displayed in the table. To filter the records by status, use the "Show" list. You can also use the Search button to apply additional filters to control which records are displayed.

**Online Patching**

The Online Patching region displays patch deployments against Oracle E-Business Suite
Release 12.2 targets.

**Online Patching Region**

Note that with Release 12.2, the adop patching process in Patch Manager is separated into two deployment procedures. The first deployment procedure runs the prepare, apply, finalize, and optionally actualize_all phases. The second deployment procedure executes the cutover, cleanup, and optionally fs_clone phases.

You can click "New Deployment" to begin a new online patching interview. You can use the "Create Like" feature to create a copy of an existing deployment.

In this region you can filter by "Latest", "Hidden", and "All". These choices will show only the latest adop sessions, hidden adop sessions, or all of them, respectively.

The records in this region are displayed in a tree format with a parent - child - grandchild relationship. The parent is the target, the child is the adop session, and the grandchildren are the patch deployments. Patch Manager supports multiple patch deployments in a single adop session. If the deployment procedure has not started or has not run through the "prepare" phase then the deployment records will fall under "ADOP Pending Sessions".

Columns in the region are:

- **Phase** - The adop phase the deployment procedure is currently running or ran last.
- **Apply Status** - The status of the "Apply" deployment procedure.
- **Cutover Status** - The status of the "Cutover" deployment procedure.
- **Review** - Link to the review page displaying all interview information.
- **Create Like** - Allows for duplication of an interview.
- **Edit** - Allows for editing a saved interview.
- **Hide** - Allows for hiding a deployment record from the display. The "Apply Status" column value of the record must be "Saved" or "Stopped" for this icon to be enabled. The hide feature hides this deployment from the "Latest" filter so the user can limit the number of saved and stopped deployments in the view. Hidden deployments can still be accessed from the "Hidden" filter setting of the view.
• **Submit** - Allows for submission of a deployment procedure after the interview has been approved in the approval management system.

• **ADOP Details** - This icon opens a window showing the adop phases, applied patches, database editions, and file system details.

• **Abort** - Clicking this icon submits a deployment procedure that runs "adop phase=abort" on all nodes. Before the submission occurs there is a check to ensure the target Oracle E-Business Suite system is in a state that allows for abort (such as, the prepare phase has been run). The check also verifies that the session for which you are running abort is the latest adop session; this step is to ensure that the correct session is to be aborted.

• **Cutover** - This icon submits the cutover deployment procedure. It opens a window in which you can schedule the cutover. This feature also ensures the adop session for which you are running is actually the latest.

• **Requestor** - This is the user who requested the patch be applied.

• **Created By** - This is the user who created the interview.

• **Last Updated** - Timestamp indicating when the deployment procedure was last updated.
The Patch Logs region allows you to view and download patching log files across all hosts of an Oracle E-Business Suite system.

To access log files:

1. First select an Oracle E-Business Suite target to which you have been granted access in Enterprise Manager.

2. The Remote File Browser for one of the Oracle E-Business Suite nodes is displayed, showing the contents of the directory one level above $ADOP_LOG_HOME.

3. Browse through the directories to find the files you want. Select the files and add them to the Selected Files or Folders list. Click OK.

4. The selected files are then displayed in the Patch Manager Logs section, from which you can download or view the log files.
Prerequisites for viewing Patch Manager Logs

To access the Patch Manager Log Viewer, you must have your preferred credentials set for the Oracle E-Business Suite Node target(s) of all application tier hosts. To set these, the navigation in Enterprise Manager is Setup > Security > Preferred Credentials > Oracle E-Business Suite Node. These credentials are required in addition to the credentials needed to use Patch Manager.

In addition, you must have been granted the privilege to raise a Patch Manager request.

For more information, see: Overview of Credentials, page 5-1 and Change Management Privileges, page 7-5.
Abort Deployments

Abort Deployments Region

This section will show all the patch deployment runs that can be aborted.

You can submit a request to run an Abort operation against a specific target using the Submit Abort icon.

This region is hidden by default. Oracle E-Business Suite Release 12.2 customers can display this region on the Patch Manager home page by clicking on the Personalize Page icon on the Patch Manager home page.

Cutover Deployments

Cutover Deployments Region

This region displays all executions of the “Cutover Oracle E-Business Suite” deployment procedure. This region is hidden by default. Oracle E-Business Suite Release 12.2
customers can display this cutover region on the Patch Manager home page by clicking on the Personalize Page icon on the home page.

You can submit a request to perform the cutover operation using the Submit Cutover icon.

Records can be filtered by status using the “Show” list. Use the Pending Patches button to find out all the applied patches on a particular Oracle E-Business Suite target awaiting cutover.

**Patch Manager Prerequisites**

The following are prerequisites to running a patching procedure. Unless otherwise noted, these prerequisites apply to all releases of Oracle E-Business Suite.

1. To download an Oracle patch directly from My Oracle Support, the following property must be set in the Preferences page.
   - **Connect to My Oracle Support for Patches** - This box should be checked.

2. Patches are downloaded to the OMS when they are applied. Set the preference **OMS Patch Stage Directory Location** to the directory to which the patch should be downloaded.

   **Note**: If a patch has already been downloaded to the OMS (for example, in a prior patching procedure), then it will not be downloaded again. See: Key Features, page 16-1.

   After a patch is on the OMS, it will then be moved to the target Oracle E-Business Suite system. The exception to this step is the case in which the system detects that an Oracle patch is already on the target; the system will not move the patch from the OMS to the target again. Custom patches, described in the next chapter, will always be moved from the OMS to the target because a developer can change the patch.

3. The following preferences are set to directories under the APPL_TOP by default. In general, you should leave these set to the default locations. You can override the default locations, but ensure that the Target Patch Directory Location is not shared amongst multiple Oracle E-Business Suite instances. The Target Stage Directory Location can be shared if all users accessing it have read/write permissions for all files.
   - **Target Stage Directory Location** - The directory to which zipped patches are downloaded.
   - **Target Patch Directory Location** - The directory to which patches are unzipped and from where the patches are applied.
For more information, see: Setting Preferences, page 6-1.

4. **(Oracle E-Business Suite Release 12.1 and earlier only)** As part of a queueing mechanism for patch runs, set the property **Minutes Patch Manager should wait for a down target**.

This setup will make patch manager wait for specified amount of time before failing when Patch Manager detects the target is in blackout state. Patch Manager will check every minute to see if the target has come out of the blackout state; if it has, Patch Manager will continue with the patch run. This property specifies in minutes the maximum length of time Patch Manager will wait before the patch run fails.

5. Patch Manager uses Preferred Credentials. These must be set prior to running a patch procedure. Navigate to Setup > Security > Preferred Credentials to set these. For more information, see: Overview of Credentials, page 5-1. The Preferred Credentials that might be required are:

- Oracle E-Business Suite Node credentials must be set to the applmgr account for application tiers and Oracle account for database tiers.

- Oracle E-Business Suite must have the "AppsDBCredSet" (the APPS schema) and "AppsSysDBCredSet" (the SYSTEM schema) set.

- Oracle WebLogic Server preferred credentials must be set for Oracle E-Business Suite Release 12.2 targets.

  **Note:** Database credentials are not required for Oracle E-Business Suite Release 12.2 targets.

If the APPS schema, system schema, or WLS Admin credentials are changed during the execution of a patching deployment procedure, then these changes will not be reflected in the running deployment procedure. A new deployment procedure will need to be started by the user.

If the credentials for the infrastructure targets are changed during an executing deployment procedure, these will be reflected in the currently running deployment procedure. For these types of credentials, the system uses a credential reference.

  **Note:** In a RAC-based Oracle E-Business Suite Release 12.2 instance, using any Online Patching feature such as patch deployment, cutover, or abort, results in the following error: "Weblogic admin server credential test returned: DB SID passed to getWeblogicDomainName is null."

To work around the problem, follow these steps:

1. Navigate to **Targets** from the Enterprise Manager console.
2. From the list, choose "Oracle E-Business Suite."

3. Select the instance by clicking on it.

4. From the instance target menu, choose **Target Setup > Monitoring Configuration**.

5. Provide the SID value of the RAC database.

6. Click **OK**.

**Blackout Periods**

During the patching deployment process, the system will try to "black out" the targets associated with an Oracle E-Business Suite system. The user submitting the patch run must have the **Operator** or **Blackout Target** privilege to be able to black out the target. For more information on privileges, see: Privileges and Roles for Managing Oracle E-Business Suite, page 7-1 and the Oracle Enterprise Manager Cloud Control Security Guide.

The following components of the E-Business Suite system will be blacked out during the patch run:

- Concurrent Processing Service
- Forms Based Applications Service
- Internal Concurrent Manager
- Listener
- Oracle Applications Infrastructure Service
- Oracle Applications Service
- Oracle Applications System
- Oracle Concurrent Manager
- Oracle E-Business Suite Custom Objects
- Oracle E-Business Suite Infrastructure
- Oracle E-Business Suite Nodes System
- Oracle E-Business Suite Patch Information
- Oracle E-Business Suite System
• Oracle E-Business Suite Workflow
• Oracle Workflow Agent Listener
• Oracle Workflow Background Engine
• Oracle Workflow Notification Mailer
• Self Service Applications Service
• Workflow Service
• Database Instance
• Host

By default, the blackout time period is one hour. You can control the blackout duration setting the following properties in the Preferences page. Navigate to this page from the Preferences under Administer menu on the Oracle E-Business Suite Instances page.

• Default Blackout Hours in Patch Manager
• Default Blackout Minutes in Patch Manager

Creating a Patch Run for Oracle E-Business Suite Release 12.1 and Earlier

To create a patch run for Release 12.1 and earlier, ensure you have completed the prerequisite steps described earlier. Then navigate to Targets > Oracle E-Business Suite > Administer > Change Management > Patch Manager. From the Patch Manager home page, select "New Deployment" in the Patch Runs region.

Note that you can also copy an existing patch run. From the Patch Manager home page, select the patch run you wish to copy and click the Create Like icon.

**Note:** In the Patch Run interview you can use the Back button to go back to a previous step; however, entered values on the current page will be lost.

To create a Patch Deployment for Release 12.1 and earlier:
1. In the Deployment Details page, enter the details below.
• Patch Deployment Name - Enter a user-friendly name for the patch run. You can search on this name later on.

• Target System Name - Choose the target system. Click the Verify Credentials button to test the Preferred Credentials for the applications system.

Select Override Patch Nodes to choose the hosts on which adpatch will run. The default host name is pre-populated. This option provides support DMZ configurations where some nodes contain a shared APPL_TOP and some nodes do not.

**Note:** You can select only one Oracle E-Business Suite target.

• Workers - The number of workers available on the system. Note that you can change this value.

• Description

• Justification

• Requestor - The default value is the user name with which you are signed in. You can change this to another name.
• Notification Email(s) - Select the email addresses of users who should be notified of the patch run request.

2. In the Patch Details page, search for the patch(es) to be applied.

![Patch Oracle E-Business Suite: Patch Details Page](image)

You can search on the following criteria:

• Patch Number

• Language - "All installed languages" will return the base (Generic or platform-specific) patch plus any language patches (if they exist) for every language installed on the selected targets. Choosing a specific language from the drop-down list will return its language patch if such patch exists.

• Created By

• Platform - Select "Generic Platform" if patch is not port-specific.

   If you are searching for a patch for a specific platform, your search results will return a Generic-platform patch if no platform-specific patch exists.

From the Patch Search Results table, select patch(es) you wish to apply and click the Add button.

The search results will include the following for each patch found:

• Patch Number

• Platform

• Language

• Description
• Created By

• Replaced By

• Patch Name

• Product

• Release

**Note:** By default Patch Manager searches for patches on My Oracle Support. If connectivity to My Oracle Support is disabled through the "MOSEnabled" preference, then the system will search among the patches that are already downloaded at the OMS stage directory location.

The following appears for each patch in the Selected Patches table.

• Order - The order in which the patches should be applied. This will be displayed only when you have more than one patch selected and do not have the Merge Patches button selected. You can then reorder the patches.

• Already Applied - Indicates if the patch is already applied or not

• Patch Number - The patch number.

• Patch Name

• Platform - The platform for the patch.

• Language

• Description

• Product - The name of the owning product.

• README - Click on this icon to review the README file for the patch.

• Created By - The user who created the patch (for custom patches).

• Replaced By - The patch number that replaces this patch, if any.

• Release - The release to which the patch is valid.

• Files - The files to be downloaded for the patch.

• Remove - If you want to remove this patch from the list, select the check box
and click the **Remove** button.

**Note:** For a controlled-release patch, a password is necessary for downloading the patch. An icon appears, which you can click to enter a password. Passwords expire after a set duration, so for scheduled deployments further in the future, make sure you have already downloaded the patch and staged it.

Use the **Merge Patches** button if you wish to merge two or more patches.

**Note:** You should merge AD patches separately from non-AD patches.

Finally, you can check for prerequisites for your patches using the **Check Prerequisites** button.

3. Specify a schedule in the Options page.

**Patch Oracle E-Business Suite: Schedule Options**

Choose from the following options:

- **Start Immediately** - Patch application will be scheduled to start immediately.

- **Schedule** - Patch application will start at the time you specify. Provide the Date, Time, and Time Zone.

- **Indefinite Grace Period** - With Indefinite Grace Period enabled, if the patches cannot be applied at the scheduled time, the system will try to apply them as soon as possible, and will keep trying indefinitely. Alternatively, if you provide a defined Grace Period in hours and minutes, the system will only try to start the application of patch for that amount of time.

The Blackout Length indicates the amount of time the target system will have a
blackout status in Enterprise Manager. Set this length to a higher value for large patch runs.

4. In the same Options page, specify Patch Options.

For more information on many of these options, see: Oracle E-Business Suite Patching Procedures and Oracle E-Business Suite Maintenance Utilities.

**Patching Procedure Options and AutoPatch Options**

<table>
<thead>
<tr>
<th>Patching Procedure Options</th>
<th>AutoPatch Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Target Backup Before Patching</td>
<td>Disable JSP Compilation</td>
</tr>
<tr>
<td>Create Target Backup After Patching</td>
<td>Disable Invalid Objects Compilation</td>
</tr>
<tr>
<td>Disable Archive Mode</td>
<td>Enable Schema Validation</td>
</tr>
<tr>
<td>Pause Before AutoPatch Steps</td>
<td>Disable File Generation</td>
</tr>
<tr>
<td>Pause After AutoPatch Steps</td>
<td>Disable Checkfile Feature</td>
</tr>
<tr>
<td>Run AutoConfig</td>
<td></td>
</tr>
</tbody>
</table>

**Patching Procedure Options** include the following:

- Create Target Backup Before Patching - Adds a pause after system is prepared for backup allowing for a manual backup.

- Create Target Backup After Patching - Adds a pause after patch is applied and database is brought back down to allow for a manual backup.

- Disable Archive Mode - Issues an ‘alter database noarchivelog’ command.

- Pause Before AutoPatch Steps - Adds a pause before AutoPatch (adpatch) is run to allow for any necessary manual preparation.

  AutoPatch (adpatch) is the Oracle Applications DBA (AD) tool that applies patches to an Oracle E-Business Suite system.

- Pause After AutoPatch Steps - Adds a pause immediately after patch is applied to allow for any necessary manual activities.
• Run AutoConfig - Run AutoConfig, the AD tool that manages configuration changes in an Oracle E-Business Suite system.

**AutoPatch Options** include the following:

• Disable JSP Compilation - Tells adpatch not to automatically compile out-of-date JSP files (nocompilejsp command).

• Disable Invalid Objects Compilation - Tells adpatch not to compile invalid objects (nocompiledb command).

• Enable Schema Validation - Tells adpatch to connect to all registered Oracle E-Business Suite schemas at the start of the patching process.

• Disable File Generation - Tells adpatch not to run commands normally found in generate driver (nogenerateportion command).

• Disable checkfile feature - Tells adpatch to disable the checkfile feature while running database portion (noccheckfile command).

**AD Administration Options and Advanced Options**

<table>
<thead>
<tr>
<th>AD Administration Options</th>
<th>Advanced Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Message Files</td>
<td>Enable HotPatch Mode</td>
</tr>
<tr>
<td>Compile APPS Schema</td>
<td></td>
</tr>
<tr>
<td>Compile Menu Information</td>
<td></td>
</tr>
<tr>
<td>Compile Flexfields</td>
<td></td>
</tr>
<tr>
<td>Re-Create Grants and Synonyms for APPS Schema</td>
<td></td>
</tr>
<tr>
<td>Relink Applications Programs</td>
<td></td>
</tr>
<tr>
<td>Generate Product JAR files</td>
<td></td>
</tr>
<tr>
<td>Generate Reports Files</td>
<td></td>
</tr>
<tr>
<td>Generate Form Files</td>
<td></td>
</tr>
</tbody>
</table>

**AD Administration Options** are listed below. These tasks are done to manage database objects (database objects or data in the database related to Oracle E-Business Suite). For example, a patch might add new menu entries or change the setup of a flexfield.

• Generate Message Files - Creates new message files after the messages have been loaded into the database. The README should instruct you when this is necessary.
• Compile APPS Schema - Compiles the APPS schema.

• Compile Menu Information - Compiles menus.

• Compile Flexfields - Compiles flexfields.

• Recreate Grants and Synonyms for APPS Schema - Recreates grants and synonyms for the APPS schema.

• Relink Application Programs

• Generate Product JAR Files

• Generate Reports Files

• Generate Form Files

**Advanced Options** are visible only if you have the 'Use advanced options in Oracle E-Business Suite Patching' target privilege. Advanced Options include the following:

• Enable HotPatch Mode - Patch will be applied without shutting down the applications or database, disabling archive mode, or enabling maintenance mode.

In HotPatch mode, AutoPatch applies a patch regardless of whether the Oracle E-Business Suite system is in maintenance mode. Maintenance mode controls the system downtime period by managing user login sessions.

**Note:** In HotPatch mode, if the patch application fails, the process will still perform/execute the blackout steps in the "Patch Oracle E-Business Suite" procedure. The blackout notifies other Enterprise Manager administrators that a maintenance procedure is being performed on the environment.

For the **Notifications** region, specify the statuses for which you would like to be notified.

5. Review your patch deployment.
The Review Page lets you review your patch run details, target list, patch details, patching options, and schedule.

**To copy a Patch Run for Oracle E-Business Suite Release 12.1 and Earlier:**

You might want to copy an existing patch run to change some aspect of it or to rerun it due to changes in the patch or target. To do this, select the patch run in the Patch Manager Home page and click the **Create Like** icon.

The system will take you through the patch deployment creation pages as if you were creating a new patch run, but with most values copied from the original patch run. Please note the following:

- The Patch Deployment Name defaults to the original name prefixed with "Copy of" and appended with the date.

- The Requestor field shows the original requestor’s user name. This value cannot be changed.

- The new patch run would be scheduled to run immediately by default, because the original run may have been scheduled for a now past date and time.

**Creating a Patch Deployment Procedure for Oracle E-Business Suite Release 12.2**

Note the following when running procedures for Oracle E-Business Release 12.2
instances:

- Abort and cutover procedures cannot be run independently from patching procedures.
- Running the adop phase fs_clone before the prepare phase as a part of a patching procedure is not supported. The fs_clone phase can be run individually.

**To create a Patch Deployment:**

Ensure that you have completed the prerequisite steps described earlier.

Navigate to **Targets >Oracle E-Business Suite >Administer >Change Management > Patch Manager.** From the Patch Manager home page, select “New Deployment” in the Online Patching region.

1. On the Deployment Details page, enter the details below.
   - Patch Deployment Name - Enter a user-friendly name for the deployment procedure. You can search on this name later on.
   - Target System Name
   - Verify Credentials - Click this button to check your credentials. This feature ensures that valid preferred credentials are set for you. For information on credentials, see: Overview of Credentials, page 5-1.
     - Oracle E-Business Suite Node credentials (all application tiers; no database tier credentials are required)
     - System schema credentials
     - APPS schema credentials
     - WLS server credentials
   - Workers - Specify the number of workers. You can choose to let ADOP determine an appropriate number of workers or choose a number from the list. This field is available for Oracle Application Management Pack for Oracle E-Business Suite Release 13.1.1.0 Bundle Patch 1 onwards.
   - Description
   - Justification - Enter a justification that can be used by an approver deciding to approve or reject this request for patching.
   - Requestor - The default value is the user name with which you are signed in. You can change this to another name.
• Notification Email(s) - Any users listed here will be notified when the patching deployment request is sent to approval management.

  Note: These notifications are different from notifications sent regarding the status of a submitted deployment procedure.

---

**Patch Oracle E-Business Suite: Deployment Details Page**

2. In the Patch Details page, search for the patch to be applied.
You can search for a patch based on the following criteria:

- **Patch Number**
- **Language**
- **Created By**
- **Platform**

**Note:** You must retrieve the desired patch through the Search region even if you have already downloaded the patch to the stage location (the process will not re-download the patch, however).

The search works as follows:

- Custom patches if a patch number greater than 11 characters has been entered or no patch number has been entered.

- Oracle patches if the patch number is less than 12 characters and the "Connect to My Oracle Support for Patches" preference is checked in the Preferences page. Since the target has already been chosen at this point in the interview process, the search will examine the target and search for only patches that are relevant with respect to languages and platform.

- Downloaded patches if the patch number is less than 12 characters and the "Connect to My Oracle Support for Patches" preference is unchecked in the
Preferences page.

Selecting the **Merge Patches** option will merge the patches when running adop later.

Selecting the **Check Prerequisites** option will connect to My Oracle Support (MOS), check the prerequisites for all the patches, and then check the target system to see if those patches have been applied. You must have "Connect to My Oracle Support for Patches" enabled in the Preferences page to use this option. If you do not have "Connect to My Oracle Support for Patches" enabled, the Check Pre-requisites button will be disabled and prerequisites for patches cannot be checked.

The prerequisite patches can also be selected in the pop-up window and then searched and selected to be applied along with the already selected patches.

The patch application order can be modified by clicking the "Move Up" and "Move Down" arrows.

Note that this page does not require any patches be selected. With Release 12.2, an "empty" patching cycle is supported in Patch Manager where only prepare, finalize, cutover, and cleanup are run.

The following appears for each patch in the Patch Search Results Table:

- Check box for selection
- Patch Number - The patch number.
- Platform - The platform for the patch.
- Language
- Description
- Created By
- Replaced By
- Patch Name
- Product - The name of the owning product.
- Release

Select the relevant check box(es) and click on the **Add** button to add the selected patch(es) to your patch deployment. It will appear in the Selected Patches table.
The following appears for each patch in the Selected Patches table.

- **Remove** - Select the check box(es) and click on the **Remove** button to remove the patch(es) from the list.

- **Order** - The order the patches should be applied. Use the Up and Down icons to change the order of the patches.

- **Patch Number** - The patch number.

  **Note:** For a controlled-release patch, a lock icon appears next to the patch number. Click on the icon to enter a password. Passwords expire after a set duration, so for scheduled deployments further in the future, make sure you have already downloaded the patch and staged it.

- **Platform** - The platform for the patch.

- **Language**

- **Description**

- **Readme**

- **Created By**

- **Replaced By**

- **Patch Name**

- **Product** - The name of the owning product.

- **Release**

- **Files** - The files to be downloaded for the patch.

3. Specify **Options**.
The online patching cycle has five phases. Patch Manager uses two separate deployment procedures to automate these five phases. The first deployment procedure runs the prepare, apply, finalize, and optionally actualize_all phases. The second deployment procedure executes cutover, cleanup, and optionally fs_clone.

On the options page you determine when each of these deployment procedures are executed. The first deployment procedure (that runs adop prepare, apply, finalize, and optionally actualize_all) can be started immediately upon submission or scheduled. If the "Schedule" option is selected, a date field is dynamically displayed. The grace period is the amount of time Enterprise Manager should wait if the Enterprise Manager job system cannot start the deployment procedure at the intended time.

**Patch Application Deployment Procedure Options**

Specify the patch application schedule:

- **Start Immediately** - Patch application will be scheduled to start immediately.
- **Schedule** - Patch application will start at the time you specify. Provide the Date, Time, and Time Zone.
- **Indefinite Grace Period** - With Indefinite Grace Period enabled, if the patches cannot be applied at the scheduled time, the system will try to apply them as soon as possible, and will keep trying indefinitely. Alternatively, if you provide a defined Grace Period in hours and minutes, the system will only try to start the application of patch for that amount of time.

For the Prepare phase, specify **Run FSClone before prepare phase** if you want to run fs_clone before the adop prepare phase. Also for the Prepare phase, specify **Pause After Prepare** if you want to stop execution of the deployment procedure after the adop prepare phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue with the next step.
For the Apply phase, specify **Pause After Apply** if you want to stop execution of the deployment procedure after the adop apply phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue.

For the Apply phase, specify **Actualize All Objects** if you want to run the adop actualize_all phase. If this option is chosen then the cleanup mode is switched to "full".

For the Finalize phase, specify the **Finalize Mode**. This option runs adop finalize phase in either Quick or Full mode.

Also for the Finalize phase, specify **Pause After Finalize** if you want to stop the execution of the deployment procedure after the adop finalize phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue.

**Cutover Deployment Procedure Options**

Specify the cutover options.

The Cutover deployment procedure has three options for execution:

- **Start Immediately**
- **Schedule**
- **No Cutover**

It can start immediately or be scheduled as described above. In this case an immediate start means immediately after the Apply deployment procedure executes. If a user schedules this deployment procedure and the apply deployment procedure is still running after the schedule date, then the apply deployment procedure will fail when it attempts to submit cutover. The cutover deployment procedure can also be skipped entirely with the "No Cutover" option."No Cutover"
may be useful on a development environment where ten developers are patching a single target and they only want to bounce the instance at midnight. Another example may be when a prerequisite patch was missed. In this situation, a user could do a patch run through finalize with the missed prerequisite, and then restart the original failed deployment procedure. Starting with Release 13.1.1.1.0 Bundle Patch 1, "No Cutover" is the default behavior.

Check the **Indefinite Cutover Grace Period** box if you want Enterprise Manager to wait an indefinite amount of time if the Enterprise Manager job system cannot start the deployment procedure at the intended time.

For the Cutover phase, the **Restart Middle Tier** is selected by default. When cutover is run, this option controls whether the middle tier is restarted.

The parameter `cm_wait` is used when running cutover to specify how long to wait for existing concurrent processes to finish running before shutting down the Internal Concurrent Manager. This feature is available starting from Release 13.1.1.1.0 Bundle Patch 1 only.

The **Pause After Cutover** option stops the execution of the deployment procedure after the adop cutover phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue.

The **Error out if EBS has abandon node(s)** option is selected by default. This option controls whether to allow cutover to happen or error out if abandon nodes are detected in the Oracle E-Business Suite instance.

For the Cleanup phase, choose whether you want the **Cleanup Mode** be run as Quick or Full.

For **FS Clone**, specify if you want to run a full file system synchronization.

**Advanced Options**

If you have the "Use advanced options in Oracle E-Business Suite Patching" target privilege, then **Advanced Options** will be available to you. If you have these options, then for the Apply phase, specify Hotpatch. This option will disable all other adop phases and run adop in hotpatch mode. This option is not supported unless specifically stated in the patch readme. A warning message is also displayed in Patch Manager when this option is chosen.

**Notifications**

For the Notifications region, specify for which statuses you want notifications to be sent. Users will be notified of a given status if the box is checked and either of the "Apply" or "Cutover" deployment procedures fall into that status.

Statuses for notifications are:

- Action Required
• Problems
• Succeeded
• Running
• Suspended

4. Review your deployment procedure.

**Patch Oracle E-Business Suite: Review Page**

The Review Page lets you review your deployment procedure details.

**Extending Patch Manager Deployment**

You can extend Patch Manager procedures using the Deployment Procedure Manager using the steps below. In these steps you create a copy of an existing procedure and extend it in the Deployment Procedure Manager.

1. Navigate to Enterprise menu > Provisioning and Patching > Procedure Library.

2. Extensions are supported for the following two patching procedures for Oracle E-Business Suite:
   • "Patch Oracle E-Business Suite” (for Release 12.1 and earlier)
• "Patch Oracle E-Business Suite Online" (for Release 12.2)

   **Note:** Extensions are not supported in the deployment procedures for cutover and abort.

3. Click the **Create Like** button.

4. Rename the copy of the original procedure as desired. You can make other updates here as well.

5. Save your new procedure.

6. Upon saving, the Deployment Procedure Manager Procedures tab appears. Your new procedure is listed first. You can select this procedure and click **Edit** to add steps, choose notifications, or make other changes. For example, you might want to add steps to a copy of the shipped Patch Oracle E-Business Suite procedure to automate the following steps: Pre-Patch Application Tier Backup, Post-Patch Database Tier Backup, or Post-Patch Application Tier Backup.

For more information on the Deployment Procedure Manager and provisioning in Enterprise Manager, refer to the Enterprise Manager documentation, including:

• *Oracle Enterprise Manager Lifecycle Management Administrator’s Guide*

• Oracle Enterprise Manager online help

---

**Patching an Oracle E-Business Suite Release 12.2 Instance using EM CLI**

To validate that an Oracle E-Business Suite instance is ready for patching, provide the following ebs_patch_file.xml file with the appropriate parameter values:

```xml
<EBSPatch>
    <PatchRunInfo>
        <PatchRunName>Validate PROD_Oracle E-Business Suite1</PatchRunName>
        <EBSTargetName>PROD_Oracle E-Business Suite</EBSTargetName>
        <Justification>Validating</Justification>
        <ValidateOnly>true</ValidateOnly>
    </PatchRunInfo>
</EBSPatch>
```

To patch an Oracle E-Business Suite 12.2 or above instance, please provide the following ebs_patch_file.xml file after filling in all the required parameters.
<?xml version="1.0"?>
<EBSPatch>

<PatchRunInfo>

<PatchRunName>test110220164405P</PatchRunName> <!-- Should always be a unique name -->

<EBSTargetName>PROD_Oracle E-Business Suite</EBSTargetName> <!-- The EBS Target name to be patched-->

<NumWorkers>40</NumWorkers> <!-- Number of workers to adopt. Available from 13.1.1.0 BP1 onwards -->

<Justification>Urgently Needed</Justification> <!-- Patch justification -->

<PatchProcedureName>Patch Oracle E-Business Suite Online</PatchProcedureName> <!-- The name of patching procedure. If tag not provided then Oracle default patching procedure shall be used. -->

</PatchRunInfo>

<PatchInfo>

<Patch>

<FileName>p21314570_R12.AZ.C_R12_GENERIC.zip</FileName> <!-- The filenames of patch which are already downloaded on OMS patch stage directory location -->

</Patch>

<Patch>

<FileName>p21314571_R12.AZ.C_R12_GENERIC_1of2.zip</FileName>
<FileName>p21314571_R12.AZ.C_R12_GENERIC_2of2.zip</FileName>

</Patch>

</PatchInfo>

<OnlinePatchingOptions>

<PatchApplicationDeploymentProcedure>

<Schedule>Immediately</Schedule> <!-- Either 'Immediately' or date in YYYY-MM-DDTHH:mm:ss+TZ format e.g. 2016-02-11T17:40:22+00:00 -->

<IndefiniteGracePeriod>false</IndefiniteGracePeriod> <!-- Either 'true' or 'false' -->

<GracePeriodHours>2</GracePeriodHours> <!-- Provide if IndefiniteGracePeriod is false -->

<GracePeriodMinutes>3</GracePeriodMinutes> <!-- Provide if IndefiniteGracePeriod is false -->

<Prepare>

<PauseAfterPrepare>true</PauseAfterPrepare> <!-- Either 'true' or 'false' -->

</Prepare>

</PatchApplicationDeploymentProcedure>

<CutoverDeploymentProcedure>

<Schedule>NoCutover</Schedule> <!-- Possible values are 'Immediately' or 'NoCutover' or time in format YYYY-MM-DDTHH:mm:ss+TZ e.g. 2016-02-11T17:40:22+00:00 -->

<IndefiniteGracePeriod>false</IndefiniteGracePeriod> <!-- Either 'true' or 'false' -->

<GracePeriodHours>2</GracePeriodHours> <!-- Provide if IndefiniteGracePeriod is false -->

<GracePeriodMinutes>3</GracePeriodMinutes> <!-- Provide if IndefiniteGracePeriod is false -->

</CutoverDeploymentProcedure>

</OnlinePatchingOptions>

</PatchApplicationDeploymentProcedure>

</PatchApplicationDeploymentProcedure>

</CutoverDeploymentProcedure>

</PatchManager>
To apply a patch in hotpatch mode, provide the following ebs_patch_file.xml:
<?xml version="1.0"?>
<EBSPatch>
  <PatchRunInfo>
    <PatchRunName>test110220164405</PatchRunName> <!-- Should always be a unique name -->
    <EBSTargetName>PROD_Oracle E-Business Suite</EBSTargetName> <!-- The EBS Target name to be patched-->
    <Justification>Urgently Needed</Justification> <!-- Patch justification -->
    <PatchProcedureName>Patch Oracle E-Business Suite Online</PatchProcedureName> <!-- The name of patching procedure. If tag not provided then Oracle default patching procedure shall be used. -->
  </PatchRunInfo>
  <PatchInfo>
    <Patch>
      <FileName>p21314570_R12.A2.C_R12_GENERIC.zip</FileName> <!-- The filenames of patch which are already downloaded on OMS patch stage directory location -->
    </Patch>
    <Patch>
      <FileName>p21314571_R12.A2.C_R12 GENERIC_1of2.zip</FileName>
      <FileName>p21314571_R12.A2.C_R12 GENERIC_2of2.zip</FileName>
    </Patch>
  </PatchInfo>
  <OnlinePatchingOptions>
    <AdvancedOptions>
      <Hotpatch>true</Hotpatch>
    </AdvancedOptions>
    <PatchApplicationDeploymentProcedure>
      <Schedule>Immediately</Schedule> <!-- Either 'Immediately' or date in YYYY-MM-DDTHH:mm:ss+TZ format e.g. 2016-02-11T17:40:22+00:00 -->
    </PatchApplicationDeploymentProcedure>
  </OnlinePatchingOptions>
  <Notification>
    <ActionRequired>true</ActionRequired>
    <Problems>true</Problems>
    <Succeeded>true</Succeeded>
    <Running>false</Running>
    <Suspended>false</Suspended>
  </Notification>
</EBSPatch>

To run only fsclone, the input file should be:
<?xml version="1.0"?>
<EBSPatch>
  <PatchRunInfo>
    <PatchRunName>test110220164405P</PatchRunName> <!-- Should always be a unique name -->
    <EBSTargetName>PROD_Oracle E-Business Suite</EBSTargetName> <!-- The EBS Target name to be patched-->
    <Justification>Urgently Needed</Justification> <!-- Patch justification -->
    <PatchProcedureName>Patch Oracle E-Business Suite Online</PatchProcedureName> <!-- The name of patching procedure. If tag not provided then Oracle default patching procedure shall be used. -->
  </PatchRunInfo>
  <OnlinePatchingOptions>
    <PatchApplicationDeploymentProcedure>
      <Schedule>Immediately</Schedule> <!-- Either 'Immediately' or date in YYYY-MM-DDTHH:mm:ss+TZ format e.g. 2016-02-11T17:40:22+00:00 -->
      <IndefiniteGracePeriod>false</IndefiniteGracePeriod> <!-- Either 'true' or 'false' -->
      <GracePeriodHours>2</GracePeriodHours> <!-- Provide if IndefiniteGracePeriod is false -->
      <GracePeriodMinutes>3</GracePeriodMinutes> <!-- Provide if IndefiniteGracePeriod is false -->
      <Prepare>
        <runFSClone>true</runFSClone>
      </Prepare>
    </PatchApplicationDeploymentProcedure>
    <CutoverDeploymentProcedure>
      <Schedule>NoCutover</Schedule> <!-- Fixed value -->
      <IndefiniteGracePeriod>true</IndefiniteGracePeriod> <!-- Fixed value -->
    </CutoverDeploymentProcedure>
  </OnlinePatchingOptions>
  <Notification>
    <ActionRequired>true</ActionRequired>
    <Problems>true</Problems>
    <Succeeded>true</Succeeded>
    <Running>false</Running>
    <Suspended>false</Suspended>
  </Notification>
</EBSPatch>

Patching an Oracle E-Business Suite Release 12.1 or Earlier Instance using EM CLI

The emcli command is:

emcli patch_ebs -input_file=ebs_patch_file:"<fully qualifiedpath of ebs_patch_file.xml>"

To patch an Oracle E-Business Suite 12.1 or earlier instance, please provide the following ebs_patch_file.xml file after filling in all the required parameters:
<?xml version="1.0"?>
<EBSPatch>
  <PatchRunInfo>
    <PatchRunName>Test Patch run 2</PatchRunName>
    <EBSTargetName>xxxx-Oracle E-Business Suite</EBSTargetName>
    <Justification>Test Patch</Justification>
    <PatchProcedureName>Patch Oracle E-Business Suite</PatchProcedureName>
  </PatchRunInfo>
  <PatchInfo>
    <FileName>p22385471_R12.GL.B_R12_GENERIC.zip</FileName>
  </PatchInfo>
  <PatchingOptions>
    <Schedule>Immediately</Schedule>
    <!-- or time in format YYYY-MM-DDTHH:mm:ssTZ e.g. 2020-04-17T05:25:00-07:00 -->
    <IndefiniteGracePeriod>true</IndefiniteGracePeriod>
    <GracePeriodHours>2</GracePeriodHours> <!-- if IndefiniteGracePeriod is false -->
    <GracePeriodMinutes>3</GracePeriodMinutes> <!-- if IndefiniteGracePeriod is false -->
    <BlackoutHours>4</BlackoutHours>
    <BlackoutMinutes>20</BlackoutMinutes>
  </PatchingOptions>
  <AutoPatchOptions>
    <DisableInvalidComp>false</DisableInvalidComp>
    <EnableSchemaValidation>true</EnableSchemaValidation>
  </AutoPatchOptions>
  <ADAdminOptions>
    <GenMessages>false</GenMessages>
    <CompileAppsSchema>false</CompileAppsSchema>
    <CompileMenu>false</CompileMenu>
    <CompileFlex>false</CompileFlex>
    <GrntsSyn>false</GrntsSyn>
    <RelinkProg>false</RelinkProg>
    <GenJars>false</GenJars>
    <GenReports>false</GenReports>
    <GenForms>false</GenForms>
  </ADAdminOptions>
  <Notification>
    <ActionRequired>false</ActionRequired>
    <Problems>false</Problems>
    <Succeeded>false</Succeeded>
    <Running>false</Running>
    <Suspended>false</Suspended>
  </Notification>
</EBSPatch>
Patch Worker Logs, Health Checks, and Troubleshooting

This section describes logging, health checks, and troubleshooting features within Patch Manager.

How to Access Patch Logs

The primary way to access log files is using the log viewer in the Patch Logs region of the Patch Manager Home page. See: Patch Logs, page 16-9.

Alternatively, you can drill down into the steps within an online patching deployment procedure execution to see the logs.

Health Checks

Patch Manager validates these servers shutting down and starting up: Listener, Forms server, Apache web services, and Internal Concurrent Manager.

How to Restart Failed Workers

For Oracle E-Business Suite Release 12.1 and earlier targets, use the following steps:

1. Navigate to your patch run using any method in "View a Patch Run".
2. Click on the Patch Run Name.
3. Click on the adpatch step (Apply Patch).
4. Select the check box for the failed target.
5. Click Update and Retry.
6. Change the parameter "restart_workers" to YES and click Retry.

Note: These steps are also listed in the AD Patch Log when you have a failed worker.

For Oracle E-Business Suite Release 12.2 and later targets, use similar steps to those above except navigate to your deployment and go to the adop apply phase step. Select the check box for the failed target, click Update, change the parameter "restart" to Yes, and click Retry.

1. Navigate to your deployment and select it.
2. Click on the adop apply phase.
3. Select the check box for the failed target.

4. Click Update and Retry.

5. Change the parameter "restart" to YES and click Retry.

How to Change the Patch Run Purge Policy

Enterprise Manager periodically purges Patch Manager deployment procedure execution data. As a result, older patch runs may not be accessible in Patch Manager. To change the purging frequency, run the following PL/SQL block connected to the repository as SYSMAN:

```sql
BEGIN
    MGMT_JOBS.drop_purge_policy('SYSPURGE_POLICY');
    MGMT_JOBS.register_purge_policy('SYSPURGE_POLICY', <number of days>, null);
END;
```

Troubleshooting Patch Manager Deployment Failures

Access the log files is using the log viewer in the Patch Logs region of the Patch Manager Home page. See: Patch Logs, page 16-9.

To find errors using the Enterprise Manager Provisioning feature, do the following:

1. Find your patch run or deployment on the Patch Manager Home page.

2. Click on the status link for the patch run or deployment.

   The Procedure Activity tab of the Deployment Procedure Manager in Provisioning appears.

3. For a patch run or deployment that failed, click on its Status link.

4. A list of Procedure Steps in the patch run or deployment is shown. Use the dropdown list to filter on the steps shown; for example, choose "Failed Steps" to see the steps that failed. More information on these steps is shown.

   **Note:** After analyzing the log files, if you are confident that you can ignore any error and move forward, then in the Procedure Activity window, choose the menu item Actions > Ignore. This option allows you to ignore the error and move forward.

A Note on Applied Patches Metric Collection

The metric "applied_patches" of target type "Oracle E-Business Suite Patch Information" is modified to collect only 10,000 rows by default. If you want to collect
information on all the patches applied over that limit, perform the following steps:

1. From the target menu of "Oracle E-Business Suite Patch Information", click on Target Setup > Monitoring configuration. Change the value of the property "Restrict collection" to 'No' and save it.

2. Log in to the Oracle E-Business Suite database and find the count of rows returned:

   ```sql
   SELECT count(*) FROM ad_snapshot_bugfixes asb, ad_trackable_entities adte,ad_snapshots asn,ad_appl_tops aat,FND_PRODUCT_GROUPS fpg, ad_releases ar,ad_bugs ab,ad_patch_drivers apd,ad_patch_runs apr, ad_applied_patches aap, ad_patch_run_bugs aprb WHERE asb.bugfix_id = ab.bug_id AND asb.snapshot_id = asn.snapshot_id AND asn.snapshot_name = 'GLOBAL_VIEW' AND asn.snapshot_type = 'G' AND asn.appl_top_id=aat.appl_top_id AND ab.baseline_name=nvl(adte.baseline,'R12') AND aat.name='GLOBAL' AND aat.appl_top_type='G' AND aat.applications_system_name = fpg.applications_system_name AND upper(ad.trackable_entity_abbr) = Decode(upper(adte.abbreviation(+)),'SO', 'SQLSO','FA', 'OFA','AP', 'SQLAP','GL', 'SQLGL',UPPER(adte.abbreviation(+))) AND ar.release_id=asn.release_id AND fpg.release_name=ar.MAJOR_VERSION||'.'||ar.MINOR_VERSION||'.'||ar.TAPE_VERSION N AND apd.applied_patch_id=aap.applied_patch_id AND apd.patch_driver_id=apr.patch_driver_id AND apr.patch_run_id=aprb.patch_run_id AND aprb.bug_id=ab.bug_id;
   ```

3. Modify $AGENT_HOME/sysman/config/emd.properties and add the following property:

   ```properties
   CollectionResults.MaximumRowsFloodControlMax=<value>
   ```

   Provide a value which is greater than the number of rows obtained in the above query.

After completing the above steps, use EMCTL commands to reload the emd.properties file and restart the agent.
This chapter covers the following topics:

- Introduction
- Major Definitions
- Setup Steps
- Security
- Diagnosing Issues
- Overview of the User Interface
- Managing Custom Applications
- Managing Custom Packages
- Maintaining the File Metadata Repository
- Reporting
- Customization Discovery

**Introduction**

Customization Manager has following capabilities:

- Automated creation of customization packages that are deployable with Patch Manager or standard Oracle E-Business Suite Applications DBA (AD) Utilities.

- Discover and report customizations in the in Database, File System (under APPL_TOP and JAVA_TOP), and Configurations. This report can help customers understand the footprint of the customizations they have, which in turn can be used to plan for upgrading to Oracle E-Business Suite Release 12.2 or for promoting their customizations to other instances.

- Run readiness reports to ensure these customizations are ready for Oracle E-
Business Suite online patching.

- Support of over 175 different custom file types.
- Validate and register custom objects.
- Validate custom code to ensure adherence to Oracle standards or user-defined standards.
- Auto-correct existing custom applications to ensure custom applications are defined according to Oracle standards.
- Integrate with third part source control or version control software.
- Package and promote custom packages across Oracle E-Business suite instances; leverages Patch Manager to deploy custom packages similar to Oracle patches across Oracle E-Business Suite instances.
- Support for creation of National Language Support (NLS) patches.

**Major Definitions**

**Custom Application**
A custom application is a non-Oracle E-Business Suite application that is registered with Oracle Application Object Library and typically has (at least) its own directory structure and other components.

**Custom File**
Any file which is not shipped by Oracle but has been on deployed on an Oracle E-Business Suite instance for the purpose of customizing the Oracle E-Business Suite functionality. The file should be developed according to Customization Standards recommended by Oracle.

**Custom Standards**
Any proprietary standard followed by the customer, while developing the custom file, other than what is recommended by Oracle.

**Package**
A package is a bundle of custom files along with the metadata. It can be applied to any Oracle E-Business Suite instance using AD patching utilities.
File Source

The source control to which the custom files are checked in.

File Metadata Repository

The File Metadata Repository stores information of custom files used to create customization packages. This information can be used to manage and catalog customizations within the system.

File Manifest

The list of files included in a package.

Entity

One of the Oracle Application Object Library (FND) tables. Examples include: Profiles, Functions, Menus, and Responsibilities.

Seed Owner / Seed User

One of the below Oracle Seed Owners. The following is a list of Oracle predefined users used for uploading Oracle-shipped seed data.

- ORACLE12.X.X
- SYSADMIN
- SEED
- INITIAL SETUP
- OPERATIONS
- DATAMERGE
- AUTOINSTALL

Customization Types

- File System (Appl Top) - Custom files under $APPL_TOp
- File System (Java Top) - Custom files under $JAVA_TOp
- Database - Customized database objects
• Configuration - Customized FND data

Setup Steps

• Ensure that the Preferred Credentials are set for each user as described in the chapter Setting Credentials, page 5-1.

• Ensure that the Stage Directory is specified in the Preferences page. This property specifies the OMS stage directory for package creation. To set this, navigate to Targets > Oracle E-Business Suite > Administer > Preferences. For more information, see: Setting Preferences, page 6-1.

Security

Oracle Application Management Pack for Oracle E-Business Suite uses the native Enterprise Manager functionality of privileges and roles for security. All management activities require that the user has the appropriate privilege(s). Refer to the section Privileges and Roles for Managing Oracle E-Business Suite, page 7-1, to see the privileges needed for each management action in Customization Manager.

Diagnosing Issues

Oracle Application Management Pack for Oracle E-Business Suite includes a pack diagnostics feature that can be used to troubleshoot issues by running diagnostic tests. Refer to the section Diagnostic Tests for Customization Manager, page 12-13.

Overview of the User Interface

Navigate to the Customization Manager Home Page

To navigate to the home page of Customization Manager, go the Oracle E-Business Suite Management page and expand the Administer menu. Select Change Management > Customization Manager.
Home Page

The Customization Manager home page shows the list of packages created. You can select a package and perform management activities like deploy, create like, and so on. These features are explained later.

Related Links in the Home Page

You can navigate to all other pages from the Related Links section. All these features are explained in detail later.

Managing Custom Applications

By using the Custom Applications link you can perform the following operations on
your custom applications:

- View custom applications and instance associations.
- Hide and unhide the custom applications within Customization Manager.
- Register a new custom application.
- Validate an already-registered custom application.
- If a validation request fails, run the Auto-Correct feature for the application.

A custom application "definition" is de-coupled from registration. Once an application is defined, it can be registered on one or more instances.

A user must have the "Approve splice request" privilege to hide and unhide custom applications. By default, hidden custom applications will be invisible. A user can check the "show hidden custom applications" box to view the hidden custom applications.

To manage custom applications, go to the home page of Customization Manager and click on Custom Applications in the Related Links section.

**Custom Applications Page**

![Custom Applications Page](image)

**Define a new custom application**

1. Select "New Custom Application" from the Add list and click Go. The Define Custom Applications page appears.
2. Specify an Application Short Name for your application. Note that the short name must be a maximum of 8 characters. Only alphanumeric characters and underscore (_) are allowed, and letters must be lowercase. The application short name is recommended to be prefixed with "xx".

3. Specify an Application Name for your application.

4. Optionally provide a description.

5. Click **Submit** to save your work.

**Note:** A custom application definition is not associated with any specific Oracle E-Business Suite instance but can be used to register the given custom application on one or more Oracle E-Business Suite instances.

### Register a custom application for a specific Oracle E-Business Suite instance

Once you have defined a new custom application in Customization Manager, you can register it with Oracle E-Business Suite instances.

1. Navigate to the Custom Application Requests page using its link under Related Links on the Customization Manager home page and click the **Register** button. Alternatively, you can also click the **Register** button on the Custom Application details page.
2. Enter in the Application Short Name for the application. You can use the LOV provided. Note that the Application Name defaults in.

3. Enter in the Oracle E-Business Suite instance. You can use the LOV provided. Note that the required APPLSYS schema, APPS schema and system schema Preferred Credentials need to be set for this Oracle E-Business Suite instance.

4. Enter in an Application ID. Oracle recommends you use an application ID greater than 50000. Customization Manager automatically generates and defaults the
recommended application ID.

5. Enter the custom application’s schema password.

6. For an Oracle E-Business Suite Release 12.2 instance, specify whether to register the custom application on the Run file system or the Patch file system. If you choose the Patch file system, you have the option to defer the adop cutover.

**Register Custom Application Page (for Release 12.2)**

7. Select "Run AutoConfig" if desired. AutoConfig execution is necessary for the custom application to be available for patching. Please run AutoConfig manually if you do not chose to run it during the custom application registration.

8. Enter e-mail addresses to notify when the request is approved and completed.

9. Enter a justification and click **Submit**. A request to register the custom application will be submitted. You can later track the request. See: Track a custom application request, page 17-13.

10. The request must be approved by a user with the **Approve splice request** privilege. Until then the request will be Pending Approval status. Once approved, select the Approved request and click **Execute**.

**Note:** You have the option of registering a custom application on a patch edition in Oracle E-Business Suite Release 12.2. In this way, you do not need to wait until a full fs_clone operation is executed to synchronize the patch edition with the run edition to apply custom patches on the patch edition. The WebLogic Administrator credentials must be set before you register the custom application on the patch edition.
Discover an existing custom application

Navigate to the Custom Applications page. Select "Existing Custom Application" from the Add drop-down list and click Go. The Discover Custom Applications page appears.

Discover Custom Applications Page

Optionally, you can use the Search feature to narrow down the results the table. Select the custom application you wish to discover and click Submit.

Validate an existing custom application

If you have custom applications registered in your Oracle E-Business Suite instances, you can validate them to check if you can apply a patch using AD patching utilities (adpatch for Oracle E-Business Suite Release 12.1.3 and earlier; adop for Release 12.2 and later).
1. Navigate to the Custom Application Requests page using its link under Related Links. Click the **Validate** button. Alternatively, you can also select the Oracle E-Business Suite instance and click the **Validate** button on the Custom Application details page.
2. Enter in the Application Short Name for the application. You can use the LOV provided. Note that the Application Name defaults in.

3. Enter in the Oracle E-Business Suite instance. You can use the LOV provided. Note that the Preferred Credentials need to be set for this Oracle E-Business Suite instance.

4. Select "Generate Readiness Report for Online Patching" if desired for Release 12.2 instances. This option reports Edition-Based Redefinition (EBR) violations in the specified custom schema that include objects not complying with the EBR rules about non-editioned objects (data storage objects such as tables and materialized views), and referencing editioned objects (code objects such as: packages, triggers, object types, and so on). This report also lists several naming standard violations that must be fixed prior to applying the online patching enablement patch for Release 12.2.

5. Click Submit. A job to validate the custom application will be submitted. Validation is based on certain standards and is provided by Oracle Applications DBA (AD) utilities. For details about the validation, see: Validation of Custom Applications: Examples, page E-1.

**Auto-correct an existing custom application**

If your request to validate a custom application fails, you can use the Auto-Correct feature to help you make the custom application conform to Oracle E-Business Suite standards. Note: This feature can only be used on failed validation requests.
The user who submits the auto-correction request must have the **Splice Request** privilege. The request must be approved for execution using Change Approval.

1. Click the “Custom Application Requests” link under Related Links on the Customization Manager home page. The Custom Application Requests page appears. Select a request and click the **Auto-Correct** button. Note: If you choose a request that did not fail in the Validation step, you will receive the error "Only failed validation requests are allowed for auto-correction."

2. In the Auto-Correct Custom Application page, enter the following:
   - Custom Application’s Schema Password. If you do not enter a value, the application short name is used by default.
   - E-mail addresses for whom to notify when the request is approved and completed. (Optional)
   - Justification (Required)

3. Click **Submit**. A request to auto-correct this existing custom application will be submitted. You can later track the request. See: Track a custom application request, page 17-13.

4. The request must be approved by a user with "Approve splice request" privilege. Until then the request will be Pending Approval status. Once approved, select the Approved request and click **Execute**.

5. You can download the log if the corresponding job for your request has been purged and no longer exists in the Enterprise Manager system.

**Track a custom application request**

1. Navigate to the Custom Applications Requests page using its link under Related Links. Select a custom application request from the table and click **View**.
Custom Application Requests Page

2. Details for the request will be shown.

Register Custom Application Page: Example

Tip: To debug or view logs of a custom application request, click on the "Job Details" icon against the specific custom application request. This will show the EM job log associated with the custom application request. Click and view details on the "DO_JOB" step to view the detailed log of the given custom application request. In case of a failure of a custom application request, a new request should be submitted after rectifying the errors/failures listed in the job details log.
View the details of a custom application

View details of a custom application by navigating to Custom Applications, selecting the application name, and clicking its Details icon.

**View Custom Application Page: Example**

- **Application Name**
- **Description**
- **E-Business Suite Instance**
- **File Metadata**
- **Packages**

Details include:

- A list of instances where the custom application is present with the status validated/not validated. If the status is not validated, it is recommended to use the **Validate** button to launch a validation request. A valid status ensures that custom patches for the given custom application can be applied on that instance.

- Custom objects associated with the given custom application which are present on the given instance can be viewed by clicking on the "View Objects" icon. Customization Manager automatically discovers and relates the following objects associated with a custom application:
  - Custom Forms
  - Profile Options
  - Request Sets
  - Custom Database Objects
Managing Custom Packages

Developing Custom Code

Files and File Types
Customization Manager allows you to package custom files of a variety of file types, including the following:

- Oracle Application Object Library (FND) objects - menus, responsibility, concurrent programs, and so on
- Forms
- Reports
- Database objects - views, tables, triggers, packages, and so on
- Oracle Application Framework components

For more information on file types, see Supported File Types in Customization Manager, page C-1.

In creating a custom patch, Customization Manager will create a driver file. For NLS patches, the driver file uses a character set according to the mapping described in Customization Manager Character Set Mapping, page F-1. You should ensure that the character set of your files matches that of the custom patch driver.

Standards for developing custom code
Custom code must be developed as per the standards published by Oracle. Refer to the customization standards in the Oracle E-Business Suite Developer’s Guide. Also, for Oracle E-Business Suite Release 12.2, refer to My Oracle Support Knowledge Document 1577661.1, "Developing and Deploying Customizations in Oracle E-Business Suite Release 12.2."

Validations for custom code
Customization Manager has a standards checker to check if the files included in a
custom package meet certain Oracle coding standards. This checker tests all code for standards compliance and cannot be turned on or off. Some standards are mandatory and will result in failure when Customization Manager attempts to build the package. Other standards are recommended, and the standards checker will give a warning but the package will be built. For example, Customization Manager mandates that each file included within a customization package has an Oracle-compliant source header present within the file. If a file in a package is missing this header, the package cannot be built. In addition to out-of-box Oracle coding standards, you can define your own standards to validate your custom code.

For more information on the standards checker, see: Customization Manager Coding Standards Validation, page D-1.

**User-Defined Custom Standards**

You can add user-defined custom standards that meet your organizational IT standards and coding practices. These user-defined standards will be added to the standards checker to validate the files included in a custom package. You can skip this section if you do not wish to define your own development standards for custom code.

**Types of custom standards**

- File naming conventions - For example, use the regular expression `^xx` to enforce the rule that a filename should start with 'xx'.

- File path conventions - For example, use the regular expression `^patch/115/sql$` to enforce the rule that SQL files should be under the directory `$XXPROD_TOP/patch/115/sql`.

- File content restrictions - For example, use the regular expression `^((?!System.out.print).)*$` to enforce the rule that Java files should not contain `System.out.print` statements.

**Managing custom standards**

Navigate to the Customization Manager home page and click on Custom Standards in the Related Links section. You can perform the following actions here:

- View details of a custom standard
- Add new custom standard
- Edit a custom standard
- Release a custom standard
- Obsolete a custom standard
- Delete a custom standard
• Download custom standards

Custom Standards Page

You can view the following details of a custom standard:

• Name

• Type of the standard

• Releases of Oracle E-Business Suite for which this standard is applicable

• Status of the standard
  • Released - It is already in use
  • Obsolete - It is no longer in use
  • Saved - It is under development and is not ready for use

• File types for which this standard is applicable

• Severity if this standard is violated

• User who created it

• User who last updated it

• Time stamp when the standard was last updated

Add a new custom standard
You must have the Create release package request privilege to create a custom standard.
Click on the +Add button to create a new custom standard. Enter the following details:

- Name of the standard
- Description
- Release
  - All - For all supported releases
  - R12 - For Release 12.1 and 12.2
- File Type
- Severity
  - Error
  - Warning
• Standard Type
  • File Path
  • File Name
  • File Content

• Regular Expression to be used to validate the standard

Optionally you can test your standard. Provide the input based on the standard type and click Test.

Edit a custom standard
You can edit only the standards that you created. Released and obsolete standards cannot be edited. You can edit the following for a standard: Description, Release, File Type, Severity and Regular Expression. The Standard Name and Standard Type cannot be changed.

Delete a custom standard
You can delete a standard that is in the Saved status.

Release a custom standard
You must release a standard before it can be used in creating custom patches. After a standard is saved, a user can raise a request to release the standard. Only a user with the Approve release package request privilege can approve/reject the request. If the request is approved, then the standard will go to the Released state. Otherwise, it will go back to the Saved state. Meanwhile, the standard will be in the Pending Approval state. Once released, the standard cannot be edited or deleted.

Obsolete a custom standard
Released standards can be made obsolete. Once a standard is obsolete, it cannot be edited or deleted. A user can raise a request to obsolete the standard. Only a user with the Approve release package request privilege can approve/reject the request. If the request is approved, then the standard will go to the Obsolete state. Otherwise, it will go back to the Released state. Meanwhile, the standard will be in the Pending Approval state.

Download custom standards
You can download the details of released custom standards in HTML format and share it. The details include Standard Name, Standard Type, Description, Release, File Type, and Severity.

Creating Custom Packages

Registering the Source Control
To create a custom package you must first register your source control with Customization Manager. This registration is called File Source Mapping. This is a one-time activity. You can create more than one file source mapping if needed.
To create the File Source Mapping, go to the home page of Customization Manager and click on File Source Mapping in the Related Links section.

**File Source Mapping Page**

Here you can see a list of file source mappings already created.

**View the details of a file source mapping**

You can view the following details of a file source mapping:

- Name of the source control.
- Host from which the source control is accessible. The Oracle E-Business Suite plug-in must be deployed on this host.
- Source Type - The type of the source control system. Valid values are: SubVersion, CVS, File System, or Others.
- Owner - The user who created this file source mapping.
- Last Updated - The date and time the mapping was last updated.
- Enabled - Specifies if the mapping is enabled or disabled. You can enable/disable a mapping from the Update File Source Mapping page.
- Public - Whether the given mapping is public. If a mapping is public, all users can view it, but only the owner and Super Administrators can edit it.
Create a file source mapping

**Create File Source Mapping Page**

Click on the **Create** button and enter the details listed in the following table:

**File Source Mapping Details**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the file source mapping.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Host where the source control is installed. Preferred Credentials need to be set for this host.</td>
</tr>
<tr>
<td>Stage Path</td>
<td>A folder on the given host with read/write access which is used for temporary processing during checkout.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Source control type</td>
<td>Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• SubVersion</td>
</tr>
<tr>
<td></td>
<td>• CVS</td>
</tr>
<tr>
<td></td>
<td>• File System</td>
</tr>
<tr>
<td></td>
<td>• Others</td>
</tr>
</tbody>
</table>

The source control type is used to default the checkout command. However, the checkout command can be modified based on your source control or file system configuration. If your source control system is not among CVS, SubVersion or File System, then you may choose “Others” and enter your checkout command.

Command Enter the complete command, with required parameters, to be used to check out files. The parameters that can be used to construct the checkout command are mentioned under the “Checkout Command Syntax” box.

This provides an open interface with which a user can integrate any third-party source control system with Customization Manager within Oracle Application Management Pack for Oracle E-Business Suite. However the user should be able to check out files from the command line on any supported platforms to use this open interface.

Environment Script (Optional) The environment script to be run before files are checked out. This is used to set any environment parameters for preprocessing, if required.

Description A brief description of the source control.

Public Mark the file source mapping as Public if desired. If a file source mapping is marked as Public, any user can view it and use it to create a package. However, only the owner and Super Administrators can edit the file source mapping.

Enable Automatic Header Update Explained later in the section Automatic Header Update and Insertion, page 17-27.

**Test the file source mapping**

Oracle strongly recommends that you to test the checkout command by using the "Test Checkout Command" option. It is also important to ascertain that the user provided within the "host" credentials has the correct permissions on the given host selected for checkout.
In the Test Checkout Command section Enter the following details:

- **Product**
- **Source Path**
- **File Name**
- **Version**
- **Language**
- **Branch** - If your source control system requires it and if a `%branch%` token is included within the checkout command.
- **Tag** - If your source control system requires it and if a `%tag%` token is included within the checkout command.
- **User Name** - If your source control system requires it and if a `%user_name%` token is included within the checkout command.
- **Password** - If your source control system requires it and if a `%password%` token is included within the checkout command.

Use the **Preview** or **Test** button to preview or test the checkout command and version command. The results will be shown in the Command Preview or Test Results field.
Create a file source mapping using the "Create Like" button

**File Source Mapping Page**

Select the **Create Like** button on the File Source Mapping page to create a file source mapping by copying the details from an existing file source mapping. This procedure is used typically to create a mirror copy of the first file source mapping, or to create another file source mapping with minor modifications without having to enter all the relevant details about the file source mapping.

**Update a file source mapping**

You can update a file source mapping by clicking on its name listed in the main File Source Mapping page. You can only update the fields described below. It is not possible to update the host for a given file source mapping.

- Source control type
- Command
- Stage Path
- Environment Script
- Description
- Public (or not)

You can test the changes by following the steps mentioned in the previous section Test the file source mapping, page 17-23.

**Disable or Enable a file source mapping**

You can check or uncheck the Enabled box to enable or disable a file source mapping.

**Delete a file source mapping**

Use the icon provided to delete a mapping in the view list page. You can delete a
mapping only when no package is associated with it.

**Example of a file source mapping with parameters**

The following table provides information on the file source mapping parameters and sample values for each parameter.

### File Source Mapping Parameters and Sample Values

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Related User Interface Page</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>%product_code%</td>
<td>Substitution variable for the product code</td>
<td>Create/Update Package - File Listing</td>
<td>xxco</td>
</tr>
<tr>
<td>%file_path%</td>
<td>Substitution variable for source path</td>
<td>Create/Update Package - File Listing</td>
<td>patch/115/import</td>
</tr>
<tr>
<td>%file_name%</td>
<td>Substitution variable for file name</td>
<td>Create/Update Package - File Listing</td>
<td>Custom_Responsibilities.ldt</td>
</tr>
<tr>
<td>%version%</td>
<td>Substitution variable for version</td>
<td>Create/Update Package - File Listing</td>
<td>115.32</td>
</tr>
<tr>
<td>%lang_code%</td>
<td>Substitution variable for language</td>
<td>Create/Update Package - File Listing</td>
<td>US</td>
</tr>
<tr>
<td>%branch%</td>
<td>Substitution variable for branch</td>
<td>Create/Update Package - General</td>
<td>Prod13</td>
</tr>
<tr>
<td>%tag%</td>
<td>Substitution variable for tag</td>
<td>Create/Update Package - General</td>
<td>Release12c</td>
</tr>
<tr>
<td>%user_name%</td>
<td>Substitution variable for username</td>
<td>Create/Update Package - General</td>
<td>developer1</td>
</tr>
<tr>
<td>%password%</td>
<td>Substitution variable for password</td>
<td>Create/Update Package - General</td>
<td>password</td>
</tr>
</tbody>
</table>

Here is the syntax of a checkout command with the parameters:

```
svn cat file:///usr/local/svn/%product_code%/%file_path%/%lang_code%/%file_name% --username %user_name% --password %password% > %file_name%
```

Here is the above checkout command with values substituted for the parameters:
Source Headers Inside Custom Files

Each file included within a customization package should have an Oracle-compliant source header present within the file.

The following is an example of an Oracle-compliant header:

```
$Header: sample.txt 10.1 2012/04/06 09:38 jdoe ship $
```

The header contains the following elements:

- Filename
- Revision ID - This needs to be incremented every time a file is checked in
- Date and time of checkin
- Author
- Shipment state - ship/noship. For custom files, use the value ship

Automatic Header Update and Insertion

This option can be enabled while defining or updating the file source mapping used for package creation. When the "Automatic header update" option is selected, Customization Manager takes care of querying the source control repository to derive the revision number. It then updates the Oracle-compliant header present within the file with the same during the process of package creation. It is important to ascertain that the correct "Version command" is provided to lookup/query the revision number from the given source control repository, except when using the source control types 'File System' or 'CVS'. This feature is not supported when the source control type is File System. For CVS, there is no need to specify the version command because the header is always retrieved from the $Header string present within the file. Note that the checkout and version commands vary highly, based on the specific source control system.

- When using the automatic header update feature with CVS, you must have a $Header placeholder within each source file. The placeholder header must be embedded in the source file before the file is checked in into CVS. Also ensure that you change the file name with the correct case within the $Header before embedding the header in the file.

- When using Subversion, you must use Subversion client version 1.2 or above for automatic header update.

Automatic header update is supported for all file types. For binary files like forms,
reports, and so on, you must provide a dummy placeholder for the header with enough appropriate offset (space). It is recommended to leave at least 40% extra offset (space) to accommodate incrementing revision numbers. During the process of package creation, the system uses this as a placeholder and updates it with the correct header. Again, the automatic header update option should be enabled and the correct version command should be specified within the file source mapping. The header is calculated based on the release and the version in the source control. For example, if you are building a package for Release 12 and the version of the file in the subversion repository is 29, then the header version calculated would be 120.29.

**Automatic header insertion** is supported only for selected file types. In this case, Customization Manager inserts a valid Oracle-compliant header into the source file during the process of package creation, even when there is no $Header present in the file. Automatic header insertion is supported for the following file types in case the file does not contain a proper $Header:

- .css
- .drvx
- .htm
- .html
- .ildt
- .java
- .jlt
- .jsp
- .ldt
- .msg
- .odf
- .pdt
- .pkb
- .pkh
- .pks
- .pl
- .plb
Adding a Header to Custom RTF Files

You can add a header to a custom RTF file by adding it to the file's "Comments" property. For example, in Microsoft Word, navigate to the File menu, select Properties, and enter the header in the Comments field as shown in the figure below.
When creating custom patches, you will need an E-Business Suite instance to compile Java or PLD files. The E-Business Suite Mapping indicates the Oracle E-Business Suite instance which would be used for this compilation. This mapping is not necessary if the custom patches do not contain Java or PLD files. However, an E-Business Suite Mapping is needed if you want to generate BI Publisher reports.

Go to the home page of Customization Manager and click on E-Business Suite Mapping in the Related Links section. Here you can see the list of E-Business Suite Mappings already created.
You can perform the following actions here:

- Create a new E-Business Suite Mapping
- Create an E-Business Suite Mapping using "Create Like"
- Update an E-Business Suite Mapping

Create an E-Business Suite Mapping

Click on the Create button.

Create E-Business Suite Mapping Region

Enter the details listed in the following table:
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the mapping.</td>
</tr>
<tr>
<td>E-Business Suite</td>
<td>Select an E-Business Suite instance from the LOV.</td>
</tr>
<tr>
<td>Public</td>
<td>If an E-Business Suite Mapping is marked as Public, any user can view it and use it to create a package, but only the owner and Super Administrators can edit it. This feature is typically useful when you would want the system administrator to create one mapping and enable all developers to use them, without having them know the details of the source control or Oracle E-Business Suite system.</td>
</tr>
<tr>
<td>Stage path</td>
<td>The stage path is the location of the directory with write permissions used for temporary processing during compilation and build process.</td>
</tr>
<tr>
<td>Prepend Classpath</td>
<td>This field is valid only with Java files. This classpath is prepended to these files when a package is built. This can be used to specify any third party libraries if you custom java files have dependencies on them.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description.</td>
</tr>
</tbody>
</table>

Create an E-Business Suite Mapping using "Create Like"

Select the Create Like button to create an E-Business Suite Mapping by copying the details from an existing E-Business Suite Mapping. This procedure can be used typically to create a mirror copy of the E-Business Suite mapping or create another E-Business Suite Mapping with minor modifications without having to enter all the relevant details about the E-Business Suite Mapping.

Update an E-Business Suite Mapping

Click on the name of the E-Business Suite mapping. It will open up the details page where you can edit it. You can make the following updates:

- Enable or disable the mapping
- Check or uncheck the public check box
- Change the stage path, prepend classpath, and description
Packaging the Custom Code

Create a package

Once you have registered the source control and checked in your custom code, you can create the custom packages to be deployed in the Oracle E-Business Suite instance.

Go to the Customization Manager home page and click on Create.

Create Package: General Page

Enter values for the fields listed in the following table:

Package Fields

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package ID</td>
<td>An auto-generated unique number.</td>
</tr>
<tr>
<td>Package Name</td>
<td>Enter a user-friendly name for the package.</td>
</tr>
<tr>
<td>Release</td>
<td>Select R12 for Release 12.1 or Release 12.2.</td>
</tr>
<tr>
<td>Product</td>
<td>Enter the owning product application. This can be a seeded Oracle product or a custom product registered in Oracle E-Business Suite.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Package Type</td>
<td>Enter the package type. This value is for your own classification and convenience for searching and cataloging. No validation is performed on this field.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for your reference. This description becomes part of the package readme.</td>
</tr>
<tr>
<td>File Source Mapping</td>
<td>Select the File Source Mapping for this package from the list of previously-defined mappings.</td>
</tr>
<tr>
<td>Branch</td>
<td>Enter the branch for the source control system, if required. The branch will be substituted for the %branch% token within your checkout command.</td>
</tr>
<tr>
<td>Tag</td>
<td>Enter the tag for the source control system, if required. The tag will be substituted for the %tag% token within your checkout command.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name to connect to the source control system, if required. The User Name will be substituted in the &quot;%user_name%&quot; parameter of the checkout command.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password to connect to the source control system, if required. The password entered here would be substituted for the %password% token within your checkout command.</td>
</tr>
<tr>
<td>Upload Manifest</td>
<td>If you have a file manifest in a comma-separated value (CSV) format on your computer, you can upload it here. Refer to the section: Sample Manifest, page 17-38.</td>
</tr>
</tbody>
</table>

Click **Next** to provide the list of files to be included in the package. You may add or remove file entries manually from the File Listing page. Alternatively, you may also include file entries from the File Metadata Repository using the **Include Files** button. Each file included in a customization package should have an Oracle-compliant source header present within the file. See: Source Header inside Custom Files, page 17-27.
For each file, enter the details listed in the following table:

### File Details

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>The owning product application. This can be a seeded Oracle product or a custom product registered in Oracle E-Business Suite (not in Customization Manager). This would be substituted in the &quot;%product_code%&quot; parameter in the checkout command.</td>
</tr>
<tr>
<td>Source Path</td>
<td>The source directory for the file on the source control system. This would be substituted in the &quot;%file_path%&quot; parameter in the checkout command.</td>
</tr>
<tr>
<td>File Name</td>
<td>The name of the file. This would be substituted in the &quot;%file_name%&quot; parameter in the checkout command.</td>
</tr>
<tr>
<td>Version</td>
<td>The version of the file. The version is only needed if the checkout command will use the version information. This would be substituted to the &quot;%version%&quot; parameter in the checkout command.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File Type</td>
<td>The type of the file. Ensure that correct type is selected for the file entry. The Oracle Applications DBA (AD) patch driver instructions are based on the type selected. For details, please refer to the appendix Supported File Types in Customization Manager, page C-1.</td>
</tr>
</tbody>
</table>
| Destination Path | The destination path for the file in the Oracle E-Business Suite instance excluding the language subdirectory and relative path from the product top. For common file types, a default destination path is provided automatically but this default value can be overridden. The destination path must be an AD-compliant destination path according to Oracle E-Business Suite standards. The destination path in the patch driver is automatically suffixed with the language code chosen with exception to "Generic". Note: For "Generic" files, ensure that the destination path is entered correctly: For example,  
Product: XXCO  
Source Path: forms/US  
File Name: IDC.fmb  
Destination Path: forms  
Language: US  
The final destination path is "forms/US" but the values are entered separately. |
| Language (Optional) | The language code for the file. Select the language code as needed to generate the respective NLS patch.                                                                                                                                                                                                                       |
| Status       | The status can be one of the following:  
  • Valid - Indicates that the entry is valid.  
  • Review - Indicates that the entry needs to be reviewed.  
  • Duplicate - Indicates that the entry is duplicated.  
  • Blank - Indicates that one of the required fields is blank.                                                                                                                                                                                                                                         |

Click **Next**. Enter additional information for your package, as described in the following table:
## Additional Information for a Package

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Business Suite information (Conditionally required)</td>
<td>The E-Business Suite mapping information is required only when the package contains at least one Java or PLD file. You can select the Oracle E-Business Suite Mapping from the list of previously-defined mappings. See: E-Business Suite Mapping, page 17-30.</td>
</tr>
<tr>
<td>Package Metadata</td>
<td>Enter the instructions for package application here. These instructions will become part of the package readme.</td>
</tr>
<tr>
<td>Comments</td>
<td>These comments will be recorded as part of the package history for tracking changes made to the package.</td>
</tr>
</tbody>
</table>
| Prerequisite Information    | For Release 12 (and higher) packages, enter in the prerequisite patch numbers that will be used in validation only when the package is deployed through Patch Manager.  

*Note that this validation is done only if you use the Check Prerequisites button in the Patch Details page when creating a patch run in Patch Manager.*  |
| Mailing List                | You can enter e-mail addresses for people who should be sent notifications about the package's creation status on the event of success or failure. It is recommended to have e-mail notifications set so that the appropriate users can be notified about the package success or failure. |
Click **Submit** to complete the package creation.

**Sample Manifest**

```
#Product,SourcePath,FileName,Version,Type,DestPath,LangCode
xxco,java\r12\reporter\cpserver,XXCOCustomCp.java,115.1,java,java\r12\reporter\cpserver,Generic
xxco,patch\115\import,XXCOConcprog.ldt,115.9,software ldt,patch/115/import,US
xxco,patch\115\import,XXCOMenu.ldt,,software ldt,patch/115/import,US
xxco,patch\115\import,XXCOResp.ldt,115.7,software ldt,patch/115/import,US
xxco,patch\115\import,XXCOUser.ldt,115.6,software ldt,patch/115/import,US
xxco,forms,XXCOFRM.fmb,,fmb,forms,US
```

**Automatic File Driver File Generation and Update**

A file driver file is a master file for adpatch to identify valid Oracle E-Business Suite files for a given product (including a custom product). It is required to have an entry within the file driver file for selected file types like forms, reports, and so on. If not, then the following error is thrown during patching: "File in patch is not a known Oracle Applications file". Customization Manager takes care of this file driver file requirement automatically. Customization Manager implicitly generates a file driver file for the relevant files in a package. During deployment with Patch Manager, these entries are
automatically added to the custom product master file driver file. In case a user applies a patch manually with adpatch, he or she can run `updateFileDriver.pl` within the `<package>/meta-inf` folder before invoking adpatch.

Note that if you get the error "File in patch is not a known Oracle Applications file" while applying a custom patch built with Customization Manager, then it could be due to a missing entry in file driver file for the custom product for one or more custom files.

The file driver file for a custom product is located under:

`$<custom_product_top>/admin/driver/<custom_product_short_name>file.drv`

For example, if XXCO is the custom product, then you can find the file driver file under

`$XXCO_TOP/admin/driver/xxcofile.drv`

All custom files would require an entry in the respective file driver file depending on the custom product to which they belong, EXCEPT files which have destination path beginning with any of the following:

- admin
- mds
- lib
- patch
- help
- def

as well as any Java file under destination path beginning with "java".

The usual format for an entry into the file driver file is:

```
<product> <subdirectory> <filename>
```

Sample entries are as below:

```
xxco admin/sql XXCONLADD.sql
xxco forms/<LANG> XXCOFORM.fmb
```

**Create a package using the Create Like option**

Customization Manager allows you to create a package by copying the details from an existing package.

From the Customization Manager home page, select the package to copy and click **Create Like**.
This procedure is used typically to create a mirror copy of the package or create another package with minor modifications without having to enter all the relevant details about the package.

**Example of Copying a Package**

Create a package using the Upload option

If, before using Customization Manager, you created a custom patch which is on a desktop or any other location, or even another EM instance, you can use the Upload option to upload that custom patch. In case you have multiple Enterprise Manager instances, you can download the custom patch from one EM instance and upload it to another EM instance. To download the custom patch from an EM instance, navigate to the View Packages UI of Customization Manager and download the patch from the Patch Downloads section. You can stage these downloaded patches in a temporary location and upload them to another EM instance.
Upload Package Page

While uploading a custom patch, the following information is required:

- Package Name
- Release to which the custom patch belongs
- Custom product/application associated with the custom patch
- Package type: only for classification purposes
- Description for your reference
- Any specific instructions for applying the custom patch

You can upload one or more custom patches (NLS patches) to this customization package. However, it is important that all of them must be associated with the same unique patch number. Clicking the Submit button creates a customization package with the status "Succeeded". This customization package can now be deployed just like any other customization package and can be "Released" or "Obsoleted", when required.

**Note:** Reporting and update capabilities are not available for the uploaded packages.

Search for packages

You can perform an Advanced Search for packages with the following criteria:
• Name
• ID
• Product
• Instruction Contains
• Prerequisite Patch
• Description Contains
• Owner
• Release
• Package Type
• Standards Check Results
• Status
• Language
• Public (Choose whether you want results with only Public packages, no Public packages, or either)
• Contains File
• Contains File with Version (Used in conjunction with "Contains File")
• Updated within (Days)
• File Source Mapping Name
• Branch
• Tag
• E-Business Suite Mapping Name
• Last Updated By

View a package

View package details by selecting its name in the search results table on the main Customization Manager page.
**View Package Page**

**Oracle E-Business Suite Management**

**View Package**

**View Package: TestPack7**

**Package Details**

The Package Details region includes the following:

- **Package ID**
- **Release**
- **Product**
- **Package Type**
- **Owner**
- **Created** - The date and time the package was created.
- **Last Updated** - The date and time the package was last updated.
- **Last Updated By** - The user who last updated the package.
- **Status** - The status of the package. Possible values are: In Progress, Succeeded, Saved, Failed, Released, and Obsoleted.
- **Standard Checker Result** - If applicable. Click on the link for detailed results.
- **E-Business Suite Mapping Name** - If applicable.
• File Source Mapping Name

• Branch

• Tag

• Uploaded - Whether this package was created as a result of a patch upload.

• Public - Whether this package is shared across all users.

Description
Any description entered for the package is shown here.

Instructions
Instructions entered in the Package Metadata field are shown here.

Patch Downloads
For each patch generated, the following information is shown here:
• File Name - Click on the patch file name link to download the patch.
• Language - The language of the patch.
• Size - The size of the patch.
• Readme - Click on the icon to download the readme. The readme file is in HTML format and includes the package description and package metadata.

Typically, each customization package could be associated with one or more language patches.

Manifest
The file manifest is shown here. Details for each file include Product, Source Path, File Name, Destination Path, Version, File Type, Language, and Last Updated timestamp.

Use the Download Manifest button to download the manifest as a comma-separated values (CSV) file, viewable in Microsoft Excel.

You can search for a specific file by entering in the file name in the "Locate File" field and clicking Go. Wildcard characters "%" and "*" are supported here.

Technology Stack Details
The Technology Stack Details for a package provide a snapshot of the technology stack properties for the Oracle E-Business Suite instance where the package was compiled.
You can first check Technology Stack compatibility yourself by running "Instance Comparison" reports.

Attachments
You may add or remove any associated documentation like project plan, design documents, and so on. For each attachment, the following is listed:
• File Name
• Description

• Last Updated timestamp

You can remove an attachment from the package using the Delete icon. If the package is Released or Obsoleted, then the attachments cannot be deleted.

**Prerequisite Information**
Any prerequisite patches are listed here along with any comments.

**Mailing List**
View the e-mail addresses for people who should be sent notifications about the package, on the event of success or failure.

**Report**
Use the **Report** button to create a report on the package. See: Reporting, page 17-54.

**History Details (View Package History)**
The package history provides a chronological view of all the important events in the lifecycle of a package.

**View Package History Page**

![View Package History Page](image)

From the View Package Details page, click on the **History Details** button to go to the View Package History page. This page provides high-level history tracking of the package, including the timestamp and user-entered comments for the following events:

• Creation of package

• Update of package

• Release of package

You can also drill down to the Oracle Enterprise job details for the package creation and any updates.

**View Log**
Use the **View Log** button to view the most recent Oracle Enterprise Manager job details for the package.
**Download Log**

Use the **Download Log** button to download the consolidated log for the package creation. For Release 12.1.0.3.0 and later, this log is in HTML format. For the packages created with Release 12.1.0.2.0, this log is in .txt format.

**Update a package**

To update a package, find the package listing in the main Customization Manager page and select the icon in the Update column. Alternatively, use the **Update Package** button on the View Package page. For details of each field that can be updated, refer to Create a package, page 17-33.

**Update package metadata**

**Update Package Metadata Page**

![Update Package Metadata Page](image)

Package metadata can be updated to change the status of the package or to push the file entries metadata in the package to the File Metadata Repository. Using the Update Package Metadata page, you can make the updates described in the following table:
**Package Metadata Information**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>You can release or obsolete a package by changing its status to &quot;Released&quot; or &quot;Obsoleted&quot;. Once a package is updated to the &quot;Released&quot; status, it cannot be updated and it becomes accessible to other users. Once a package is moved to the &quot;Obsoleted&quot; status, it is no longer updatable or deployable.</td>
</tr>
<tr>
<td></td>
<td><em>Note: With the Change Approval Framework, once an approver approves a request from a user to release/obsolete a customization package, the package is released/obsoleted. The user does not need to release/obsolete the package explicitly after the approval.</em></td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> Add comments for future reference when you release or obsolete a package. For example, state the reason why you obsolete a package.</td>
</tr>
<tr>
<td>Add file metadata to file repository</td>
<td>Add file metadata entries to the File Metadata Repository.</td>
</tr>
<tr>
<td>Public</td>
<td>If you are the owner of the package or a super administrator, you can mark the package as &quot;Public&quot; which enables the package to be shared across all users to view or update.</td>
</tr>
<tr>
<td>Comments</td>
<td>Add comments which are recorded in the package history for the above changes.</td>
</tr>
</tbody>
</table>

**Save the package**

If, in the process of creating or updating a package definition, you want to save the package definition before submitting a request to have Enterprise Manager actually build the package, click the **Save** button on the File Listing page or the Submit page of the Create/Update process. Your package definition will be saved and it will appear on the main Customization Manager page with a status of Saved.

**Release the package**

Use the Update Package Metadata page to release a package. After a package is released, it is implicitly shared with other users to view and deploy. See: Update package metadata, page 17-46.

**Note:** *With the Change Approval Framework, if an approval hierarchy exists*
for "release package" and all the approvers at the different levels approve a request to release a customization package, then the package is released. The user does not need to release the package explicitly after the approval. If an approval hierarchy does not exist, the request will follow a single level of approval mechanism.

Before you deploy a custom package using Patch Manager, it is recommended to run the Instance Comparison Report to compare the technology stack properties of the package with those of the instance to which the package is being deployed. Patch Manager does not stop the deployment of a patch if the technology stack properties are not compatible, so you should make your best judgment based on the Instance Comparison Reports. See: Reporting, page 17-54.

**EM CLI Commands for Custom Package Creation**

You can create custom packages using the Enterprise Manager command-line interface (EM CLI).

The following command is used to create a package:

```
emcli ebs_cm_package -action=createPatch -input_file=properties_file: <path to the input properties file>
```

The command to get the status of the creation of a package is:

```
emcli ebs_cm_package -action=getStatus -patch=number
```

The command to download a patch is:

```
emcli ebs_cm_package -action=downloadPatch -patch=number -host=name -directory=path
```

The command to download the log file of the creation of a package is:

```
emcli ebs_cm_package -action=downloadLog -patch=number -host=name -directory=path
```

The following table describes values for the input properties file.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Sample Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>RELEASE</td>
<td>R12</td>
<td>Includes 12.2 Online Patches.</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>Like xxco/fnd</td>
<td>Any Oracle shipped standard product (or) custom product</td>
</tr>
<tr>
<td>FILE_MANIFEST_CSV</td>
<td>/home/userabc/manifest.csv</td>
<td>Manifest in csv format. Details below.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Sample Values</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FILE_SOURCE_ZIP</td>
<td>/home/userabc/source.zip</td>
<td>Details below.</td>
</tr>
<tr>
<td>FSM_HOST_NAME</td>
<td>dummy.example.com</td>
<td>A valid host where the files manifest. csv and source.zip are staged.</td>
</tr>
<tr>
<td>ESM_INSTANCE_NAME</td>
<td>ut121S-Oracle E-Business Suite</td>
<td>• A valid E-Business Suite instance name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Instance used only for source code compilation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Needed only when the patch includes java or pld files.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>Test Patch</td>
<td>Description for reference.</td>
</tr>
<tr>
<td>INSTRUCTION</td>
<td>For UAT</td>
<td>Any instruction for patch deployment</td>
</tr>
<tr>
<td></td>
<td>1000000000058;100000000060</td>
<td>List of semicolon separated prerequisite patches</td>
</tr>
<tr>
<td>MAILING_LIST</td>
<td><a href="mailto:abc@example.com">abc@example.com</a></td>
<td>List of semicolon separated email IDs</td>
</tr>
</tbody>
</table>

The value of command parameter `-host=name` and the value of input.properties parameter `FSM_HOST_NAME` and `ESM_INSTANCE_NAME` should all be a valid target which are already discovered in Enterprise Manager.

The following is a sample input properties file for package creation:

```bash
RELEASE=R12
PRODUCT=xxco
FILE_MANIFEST_CSV=/home/oracle/OPC/manifest.csv
FILE_SOURCE_ZIP=/home/oracle/OPC/source.zip
FSM_HOST_NAME=dummy.example.com
ESM_INSTANCE_NAME=ut121S-Oracle E-Business Suite
DESCRIPTION=Test Desc
INSTRUCTION=Test Instruction
PREREQ_PATCHES=100000000058;100000000060
EMAIL_LIST=abc@example.com
```

The following table describes the manifest file.
**Details of the Manifest File to be Uploaded**

<table>
<thead>
<tr>
<th>CSV Fields</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Any Oracle shipped standard product (or) custom product</td>
</tr>
</tbody>
</table>
| Path       | • Anyone of the recommended destination path for the given filetype  
|            | • Refer to: Recommended Locations for Common File Types, page C-13 |
| Language   | Generic/US/KO/AR etc |
| Filename   | Filename with extension |
| Filetype   | • Any one of the Customization Manager supported filetypes  
|            | • Refer to Supported File Types, page C-1 |

A sample manifest file for upload is:

```
xco,xxco/oracle/apps/fnd/demo,Generic,Hello.java,OAF Component  
fnd,java/demo,Generic,Hello.java,java  
fnd,patch/115/import,Generic,afsvcct.lct,lct  
fnd,patch/115/import,US,afsvcct.lct,lct  
fnd,patch/115/import,KO,afsvcct.lct,lct  
fnd,patch/115/import,xxco/oracle/apps/fnd/demo/Hello.java  
```

For each file entry in the manifest CSV, we expect <file> to be present under <prod>/<path>/<lang> within <source.zip>.

A sample structure of the source.zip file is:

```
fnd/patch/115/import/afsvcct.lct  
fnd/patch/115/import/US/afsvcct.lct  
fnd/patch/115/import/KO/afsvcct.lct  
fnd/java/demo/Hello.java  
xco/xxco/oracle/apps/fnd/demo/Hello.java  
```

**Sample Commands**

A sample command to submit a request for patch creation:

```
$EMCLI_HOME/emcli ebs_cm_package -action=createPatch -input_file=properties_file:/home/userabc/input.properties  
```

Patch ID: 100000000064  
Procedure Execution ID: 2BCD973D6186A475E050D20A7F16047E  
emcli execution completed.

A sample command to check the status of a patch creation request:
$EMCLI_HOME/emcli ebs_cm_package -action=getStatus -patch=100000000064
Status: Succeeded
emcli execution completed.

A sample command to download the patch zip file once a request completes:
$EMCLI_HOME/emcli ebs_cm_package -action=downloadPatch -host=dummy.example.com -directory=/home/userabc -patch=100000000064
Writing file:/home/userabc/p100000000064_Generic.zip on the host:dummy.example.com
Writing file:/home/userabc/p100000000064_KO.zip on the host:dummy.example.com
emcli execution completed.

A sample command to download the request log to analyze patch creation failure:
$EMCLI_HOME/emcli ebs_cm_package -action=downloadLog -host=dummy.example.com -directory=/home/userabc -patch=100000000064
Writing file:/home/userabc/2BCD973D6186A475E050D20A7F16047E.zip on the host:dummy.example.com
emcli execution completed.

Maintaining the File Metadata Repository

The File Metadata Repository stores metadata information on each file. It can be used as a cataloging repository for all custom files within your enterprise. The File Metadata Repository is also aware of the objects within the custom files. This capability typically applies to SQL scripts and PL/SQL packages where the objects are tables, indexes, sequences, views, and so on.

File Metadata Repository Page

The system can parse and discover objects within custom files when added to the File Metadata Repository. This can be initiated from the Update Package Metadata page by clicking the box “Add file metadata to file repository”. See also: Update Package Metadata, page 17-46.

Examples of custom objects include:

• Tables
• Views
• Mviews and Mview logs
• Triggers
• PL/SQL package names
• Indexes

You can view and updates objects populated for a given file. You can also search for files containing specified objects and include them during package creation or update.

Search capabilities are limited to:
• PL/SQL spec and body (all formats)
• SQL files
• Oracle Application Framework XML files
• XDF

Adding File Details to the File Metadata Repository

The information on a file can be uploaded to the repository in one of three ways:
• By uploading a package's file manifest in CSV format to the repository.
• By adding metadata for an individual file manually to the repository.
• By updating the metadata for a file already in the repository.

You can add metadata to the repository using the "Add file metadata to file repository" option in the Update Package Metadata page. See: Update Package Metadata, page 17-46.

The File Metadata Repository can be accessed from its link under Related Links.

You can search for a file by entering the filename in the Search field on the main File Metadata Repository page. Alternatively, use Advanced Search to search for its file using one or more of the following: Filename, Product, Language, Source Path, Destination Path, Version, File Type, or Object Name.

Also, during the package create/update flow, you can search for files or files referring to objects within the file metadata repository using the Include Files button.

Upload a file manifest

1. Select the Upload Manifest button from the main File Metadata Repository page.
2. Select your file manifest file using the **Browse** button for the File Manifest field.

3. Optionally add a description.

4. Click **Submit**.

**Add details for an individual file**
1. Click on the **Add** button from the main File Metadata Repository page.

2. Enter the name of the file.

3. Enter the product to which the file belongs.

4. Enter its source path.

5. Enter the version of the file.

6. Select the file type from the list provided.

7. Enter the destination path.

8. Enter the language for the file.

9. Optionally enter a description.

10. Click **Submit**.

**Updating the Metadata for a File Already in the File Metadata Repository**
1. Select the Update icon for the file in the Search results table in the main File Metadata Repository page.

2. Update the file name, file type, version, product, source path, destination path, language, and/or description as desired.

3. Click **Submit**.

You can associate one or more customization objects to a given file in the Related Objects region. For instance, a PLS file might be associated with a PL/SQL procedure name as one of the objects. You might update a given file entry to associate one or more customization objects to it. This capability allows you to catalog and later search for customization objects using the Advanced Search option within the File Metadata Repository. However, there are currently no validation checks built into the system that use this information during package creation or deployment.
Reporting

Customization Manager offers powerful reporting capabilities to help you document, compare and track your customizations. You can generate three types of reports on packages:

- A Standard report gives you details on a single package, including technology stack requirements and the file manifest. You might use this to document customizations.

- A Comparison report allows you to compare two packages. For example, you might want to compare their technology stack snapshots or the versions of the files included in the packages.

- An Instance Comparison report allows you to compare the details of the package with that of an actual Oracle E-Business Suite instance. The details which are compared include custom application, file driver file entries, file manifest and versions, and the technology stack snapshot of a package to the technology stack properties of a given instance. By doing this comparison you can determine possible compatibility issues of the package with the instance and assess the possible impact/possible issues before actually applying the patch.

  **Important:** Oracle strongly recommends that you generate an Instance Comparison report for each custom package and the instance where it is intended to be deployed to identify any technology stack incompatibilities before actually applying the patch. Reports can be accessed from the Package Report link under Related Links for Customization Manager.

Creating a Report

To create a report, use one of the following navigation paths:

- Select a package from the Package Search results page and click Report.

- Click the Report button on the View Package page.

- Click the Create button on the Package Report page.
Create a standard report

Create Report: Standard

A Standard report gives you details on a single package, including technology stack requirements and the file manifest.

1. Enter in a user-friendly name for your report.

2. Choose Standard for the Report Type.

3. Enter the package you want the report to be based on in the Package field. This package must have the status of Succeeded, Released, or Obsoleted.

4. Enter the Report Format. Options are:
   - PDF (Portable Document Format)
   - RTF (Rich Text Format)
   - XLS (Microsoft Excel format)

5. Enter the Oracle E-Business Suite Mapping to be used for the report generation.

6. Click Submit.
Create a comparison report

Create Report: Comparison

A Comparison report allows you to compare two packages. For example, you might want to compare technology stack requirements or versions of the files included in the packages.

1. Enter in a user-friendly name for your report.

2. Choose Comparison for the Report Type.

3. Enter the package name in the Primary Package field. This package must have the status of Succeeded, Released, or Obsoleted.

4. Enter the package name in the Secondary Package field. This package must have the status of Succeeded, Released, or Obsoleted.

5. Enter the Report Format. Options are:
   - PDF (Portable Document Format)
   - RTF (Rich Text Format)
   - XLS (Microsoft Excel format)

6. Enter the Oracle E-Business Suite Mapping to be used for the report generation. Please note that this instance would be only used to publish the report using BI Publisher.

7. Click Submit.
An Instance Comparison report allows you to compare the technology stack properties of a package to the technology stack properties of a given instance. By doing this comparison, you can tell if the package can be properly deployed on the instance. In addition, the report lists any missing entries in the file driver file, and compares files and versions within the package to those of the instance.

1. Enter in a user-friendly name for your report.

2. Choose Instance Comparison for the Report Type.

3. Enter the package you want the report to be based on in the Package field. This package must have the status of Succeeded, Released, or Obsoleted.

4. Enter the Report Format. Options are:
   - PDF (Portable Document Format)
   - RTF (Rich Text Format)
   - XLS (Microsoft Excel format)

5. Enter the Oracle E-Business Suite Mapping to be used for the report comparison. The Oracle E-Business Suite instance referred by this mapping would be the one which would be compared against the package. As a best practice, it is recommended to generate an instance comparison report for every instance where you intend to deploy the package, to identify any possible incompatibilities/issues before actually applying the package.

6. Click Submit.
Viewing a Report

Package Report Page

To access reports, navigate to the Customization Manager home page > Package Report (under Related Links).

In the Package Report search results table, the following is shown for each report:

- **Name** - The name of the report.
- **Type** - The type of the report; either Standard, Comparison, or Instance Comparison.
- **Primary Package** - The primary package on which the report is based.
- **Secondary Package (if any)** - For Comparison reports, the second package used in the comparison.
- **E-Business Suite Mapping** - The E-Business Suite Mapping used in the report generation or comparison.
- **Format** - The format of the report; either PDF, RTF, or XLS.
- **Status** - The status of the report.
- **Owner** - The user who created the report.
- **Last Updated** - The Last Updated timestamp for the report.
- **Download** - Click on the link provided to download a ZIP file containing the report.
• Details - Click on the Details icon to view details on the report submission job. This link takes you to the Oracle Enterprise Manager Deployments Status page for the report submission.

• Delete - Click on the Delete icon for the report to delete it.

**Standard report output file**

The Standard Report output file has three sections:

• Package Details - Information pertaining to the package’s definition.

• Technology Stack Information - Properties and values of the technology stack of the instance mapped through the Oracle E-Business Suite Mapping for the package.

• File Manifest - The listing of the files in the package. For each file, the following information is included: product, source path, name, version, language, and type.

**Comparison report output file**

The Comparison Report output file has three sections:

• Package Details - Information pertaining to the packages’ definitions.

• Technology Stack Information - This section shows a comparison of the values of the two packages’ technology stack details.

• File Manifest - This section shows a comparison of the versions of each given file in the two packages.

**Instance comparison report output file**

The Instance Comparison Report output file has six sections:

• Package Details - Information pertaining to the package’s definition.

• Oracle E-Business Suite Instance Information - Basic information for the instance used in the report comparison. Information includes name, patch level for Applications DBA (AD), patch level for Oracle Application Object Library (FND), and the database release information.

• Missing custom products/applications.

• Missing entries in file driver file.

• File comparison to report missing files or version differences.

• Technology Stack Details - For each given property, this table lists the value for the
package and the value for the Oracle E-Business Suite instance, and how they compare to each other.

Searching for a Report

You can search for a report by its name on the main Package Report page, or use the Advanced Search link to search based on additional criteria, including:

- E-Business Suite Mapping - The E-Business Suite mapping used for the report generation or comparison.
- Primary Package - The primary package for the report.
- Secondary Package - The secondary package, if any. The secondary package would be used in Comparison Reports.
- Type - The type of report; either Standard, Comparison, or Instance Comparison.
- Report Format - The format chosen for the report; either PDF, RTF, or XLS.

Customization Discovery

This feature is used to report the inventory of customizations present on a given Oracle E-Business Suite instance. Customization Discovery allows you to view inventory of customizations you have in a specific Oracle E-Business Suite environment. You can view the report by product, or all customizations; and you can export the report to a Microsoft Excel spreadsheet.

Customization Discovery currently allows you discover following customizations:

- Discover customizations under $APPL_TOP.
- Discover customizations under $JAVA_TOP.
- Discover customizations for the following 15 database object types:
  1. Regular Tables
  2. Partitioned Tables
  3. Index Organized Tables
  4. Global Temporary Tables
  5. Queued Tables
  6. Views
7. Indexes
8. Sequences
9. Materialized Views
10. Materialized View Logs
11. Advanced Queues
12. Packages
13. Triggers
14. Types
15. Security Objects

- Discover customized Oracle Application Object Library (FND) data for the following 18 entities:
  1. Alerts
  2. Concurrent Executables
  3. Concurrent Programs
  4. Descriptive Flexfields
  5. Flexfield Value Sets
  6. Forms
  7. Functions
  8. Grants
  9. Menus
  10. Messages
  11. Print Styles
  12. Printer Drivers
  13. Printers
  14. Profiles
15. Request Groups

16. Request Sets

17. Responsibilities

18. Users

- Create and manage the File System Exclusion Rule List.
- Create and manage the Database Exclusion Rule List.
- Create and manage the Configuration Exclusion Rule List.
- Discover customizations under $OA_HTML. (In this release you can view these customizations only in the CSV report.)
- Discover database custom schemas. (In this release you can view these customizations only as part of the CSV report.)

You can manage your customization discovery requests from the Customization Discovery page available under Related Links for Customization Manager. From the new Customization Discovery dashboard, you should be able to perform the operations described below.

### Submitting a Customization Discovery Request

Use the following steps to submit customization discovery request.

1. Navigate to Customization Discovery Request page. You can use one of the following navigation paths:
   - Select the Customization Discovery Requests link under Related Links on the Customization Manager home page.
   - Go to the Customization Discovery dashboard and select Customization Discovery Requests from the menu.
   - Go to the Customization Discovery dashboard and select Customization Discovery Requests from the menu.

2. Click the **New** button.
3. Select an Oracle E-Business Suite instance using the LOV. You should have the Raise Customization Discovery Request privilege to raise a customization discovery request on the selected Oracle E-Business Suite instance.

4. Enter a valid stage directory on the given Oracle E-Business Suite instance.

5. Select a Report Type.
   - Standard: With this option, the downloadable compressed output file will contain only the CSV report files.
   - Debug: With this option, the downloadable compressed output file will contain the final CSV report files and as well as all the intermediate temporary files to debug any issues.

6. Enter a description.

7. Enter a mailing list separated by commas; this is used to send notifications on the request completion.

**Tracking Request Status**

You can monitor only the requests submitted by you. The request will be in one of the following states:

- **Saved**
• In Progress
• Succeeded
• Failed

**Customization Discovery Requests Page**

Deleting a Request

You can delete only the requests that are in a Succeeded or Failed state. The Delete action will purge all the reports associated with that request.

Viewing a Request Log

Once the request is in the In Progress state, a user can monitor the request progress through the EM Procedure Activity UI.

Downloading a Request Log

For Succeeded and Failed requests, you can download a consolidated log in HTML format.

Viewing Customization Details Offline

On successful completion of the request, you can download the report's compressed file to view the customization details offline in CSV/HTML format. A summary section and details about the discovered customization for each customization type are generated. For a failed request, you can download the compressed file to analyze the issue with the intermediate debug log files.
Example of Downloaded Report

File System (ApplTop and JavaTop) Customization

The details listed below are included in the report:

- Node/Hostname
- Product
- Sub Directory
- File Name
- File Size
- File Last Modified Date

The Summary Report contains:

- Total number of custom files per product
- Total number of custom files per filetype

Database Customization

Baseline patches are needed for data model comparison. There is one patch for each release (12.1.3, 12.2.4, 12.2.5, 12.2.6, and 12.2.7) for the standard copy Oracle database object definition XMLs. These patches need to be manually downloaded to the `<OMSStageDir>/definition` directory:

- Patch 21387665 - PATCH FOR DATA MODEL COMPARISON (EBS RELEASE: 12.1.3)
- Patch 21387666 - PATCH FOR DATA MODEL COMPARISON (EBS RELEASE: 12.2.4)
- Patch 24308948 - PATCH FOR DATA MODEL COMPARISON (EBS RELEASE: 12.2.5)
- Patch 25056342 - PATCH FOR DATA MODEL COMPARISON (EBS RELEASE: 12.2.6)
- Patch 26871451 - PATCH FOR DATA MODEL COMPARISON (EBS RELEASE: 12.2.7)

The following table shows database object types, objects for each type, and types of database object definition changes that are discovered during recognized discovery process.

**Database Object Types**

<table>
<thead>
<tr>
<th>Discovered Object Type</th>
<th>Discovered Objects</th>
<th>Definition Changes Recognized During Discovery</th>
</tr>
</thead>
</table>
| Regular tables         | • Tables in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
<pre><code>                    | • Tables in its own product schema                                                      | • table: addition or removal, pct_free, pct_used, ini_trans, max_trans, initial_extent, next_extent, min_extents |
</code></pre>
<p>|                        | • The following types of tables are excluded:                                          | • column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id |
|                        | • Partitioned tables                                                                 |                                              |
|                        | • Global temporary tables                                                             |                                              |
|                        | • Index organized tables                                                              |                                              |
|                        | • Queued tables                                                                      |                                              |
|                        | • Advanced Queues                                                                    |                                              |
|                        | • Materialized Views                                                                  |                                              |
|                        | • Materialized views logs                                                             |                                              |</p>
<table>
<thead>
<tr>
<th>Discovered Object Type</th>
<th>Discovered Objects</th>
<th>Definition Changes Recognized During Discovery</th>
</tr>
</thead>
</table>
| **Partitioned tables** | • Partitioned tables in APPS/APPS_NE that start with a product short name and/or known product prefixes  

• Partitioned tables in its own product schema | • table: addition or removal, pct_free, pct_used, ini_trans, max_trans, initial_extent, next_extent, min_extents  

• column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id  

• partition: addition or removal, partition position, subpartition count, composite vs. non-composite partition, logging, high_value_length |
| **Index organized tables** | • Index organized tables in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  

• Index organized tables in its own product schema | • table: addition or removal, pct_free, pct_used, ini_trans, max_trans, initial_extent, next_extent, min_extents  

• column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id |
| **Global temporary tables** | • Global temporary tables in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  

• Global temporary tables in its own product schema | • table: addition or removal, pct_free, pct_used, ini_trans, max_trans, initial_extent, next_extent, min_extents  

• column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id |
<table>
<thead>
<tr>
<th>Discovered Object Type</th>
<th>Discovered Objects</th>
<th>Definition Changes Recognized During Discovery</th>
</tr>
</thead>
</table>
| **Queued tables**      | • Queued tables in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
                         • Queued tables in its own product schema | • table: addition or removal, type, object type, single or multiple recipients, transactional vs. non-transactional, pct_free, pct_used, ini_trans, max_trans, initial_extent, next_extent, min extents  
                         • column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id |
| **Views**              | • Views in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
                         • Views in its own product schema that start with a product short name and/or known product prefixes | • view: addition or removal, type_text_length, type_text, text, oid_text_length, oid_text, view_type_owner, view_type |
| **Indexes**            | • Indexes in APPS/APPS_NE schema starting with a product short name and/or known product prefixes  
                         • Indexes in its own product schema | • index: addition or removal, type of the index  
                         • indexed column: addition or removal, index_owner, table_owner, table_name, column_position, descend |
| **Sequences**          | • Sequences in APPS/APPS_NE schema start with a product short name and/or known product prefixes  
                         • Sequences in its product base schema | • sequence: addition or removal, min_value, max_value, increment_by, cycle_flag, order_flag, cache_size |
<table>
<thead>
<tr>
<th>Discovered Object Type</th>
<th>Discovered Objects</th>
<th>Definition Changes Recognized During Discovery</th>
</tr>
</thead>
</table>
| Materialized views     | • Materialized views in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
• Materialized views in its own product schema that start with a product short name and/or known product prefixes  
• Materialized views in its own product schema that start with a product short name and/or known product prefixes | • mview: addition or removal, container_name, pct_free, pct_used, .ini_trans, max_trans, initial_extent, next_extent, min_extents, query  
• column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id |
| Materialized view logs | • Materialized view logs in APPS/APPS_NE schema that start with ‘MLOG$’ followed by its product short name  
• Materialized view logs in its own product schema | • mview log: addition or removal  
• column: addition or removal, order, nullable vs. not nullable, data type, char_length, data_precision, data_scale, column_id |
| Advanced queues        | • Advanced queues in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
• Advanced queues in its own product schema | • queue: addition or removal, owner, name, queue_table, qid, queue_type, max_retries, retry_delay, enqueue_enabled, dequeue_enabled, retention |
| Packages               | • Packages in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
• Packages in its own product schema | • packages: addition or removal  
• procedure/function: addition or removal  
• arguments: addition or removal, data_type, in_out |
<table>
<thead>
<tr>
<th>Discovered Object Type</th>
<th>Discovered Objects</th>
<th>Definition Changes Recognized During Discovery</th>
</tr>
</thead>
</table>
| Triggers               | • Triggers in APPS/APPS_NE schema that start with a product short name and/or known product prefixes  
                        • Triggers in its own product schema | • trigger: addition or removal, owner, trigger_type, triggering_event, table_owner, base_object_type, table_name, when_clause, status, action_type  
                        • column: addition or removal, trigger_owner, table_owner, table_name, column_name, column_list, column_usage |
| Types                  | • Types and Collections in APPS/APPS_NE and SYSTEM schema that start with a product short name and/or known product prefixes  
                        • Types and Collections its own product schema | • types and collections: addition or removal, typecode, predefined, incomplete, final, instantiable  
                        • methods: addition or removal, method_type, final, instantiable, overriding, inherited  
                        • arguments: addition or removal, subprogram_id, sequence, data_type, in_out  
                        • attributes: addition or removal, attr_type_owner, attr_type_name, length, precision, scale, character_set_name, attr_no |
| Security objects       | • Security objects in FND_OBJECTS table | • security object: addition or removal  
                        • database_object_name |

**Note:** Generally, the product ownership of an object is identified by the prefix of the object name. However, some products may have objects that start with different prefixes. The following table shows products and object prefix relationships.
## Product Short Names and Additional Prefixes

<table>
<thead>
<tr>
<th>Product Short Name</th>
<th>Additional Prefixes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>HZ, OCM, RA, TAX</td>
</tr>
<tr>
<td>AP</td>
<td>OIE</td>
</tr>
<tr>
<td>AMS</td>
<td>AML</td>
</tr>
<tr>
<td>AMW</td>
<td>RCI</td>
</tr>
<tr>
<td>BOM</td>
<td>CST, CTO</td>
</tr>
<tr>
<td>CS</td>
<td>CSK, CSZ</td>
</tr>
<tr>
<td>EDW</td>
<td>EDW (from all product schema including the common schema, e.g. APPS)</td>
</tr>
<tr>
<td>FND</td>
<td>WF, UMX, FWK, OAM</td>
</tr>
<tr>
<td>INV</td>
<td>MTL</td>
</tr>
<tr>
<td>JTF</td>
<td>JTY, JTO, CAC, JTH, JTA</td>
</tr>
<tr>
<td>ONT</td>
<td>OE</td>
</tr>
<tr>
<td>OE</td>
<td>SO</td>
</tr>
<tr>
<td>PER</td>
<td>HR</td>
</tr>
<tr>
<td>PAY</td>
<td>PY</td>
</tr>
<tr>
<td>PO</td>
<td>RCV</td>
</tr>
</tbody>
</table>

### Configuration Customization

The details included are based on the entity.

**Common For All Entities**

- Last Update Date
• Owner

FND Entities

1. Alerts
   • Alert Name
   • Application Short Name
   • Description

2. Concurrent Executables
   • Application Short Name
   • Description
   • Executable Name
   • User Executable Name

3. Concurrent Programs
   • Application Short Name
   • Description
   • User Concurrent Program Name

4. Descriptive Flexfields
   • Application Short Name
   • Description
   • Descriptive Flexfield Name

5. Flexfield Value Sets
   • Description
   • Flexfield Value Set Name

6. Forms
   • Application Short Name
   • Description
7. Functions
   - Context Dependence
   - Description
   - Form References Form
   - Function Name
   - User Function Name

8. Grants
   - Ctx Resp App Short Name
   - Description
   - Grant Menu Name
   - Name

9. Menus
   - Description
   - User Menu Name

10. Messages
    - Application Short Name
    - Message Name
    - Message Text

11. Print Styles
    - Description
    - User Printer Style Name

12. Printer Drivers
    - Description
• Printer Driver Name

13. Printers
  • Description
  • FP Type
  • Printer Name

14. Profiles
  • Application Short Name
  • Description
  • User Profile Option Name

15. Request Groups
  • Application Short Name
  • Description
  • Request Group Name

16. Request Sets
  • Concurrent Programming Name
  • Description
  • User Request Set Name

17. Responsibilities
  • Application Short Name
  • Description
  • Responsibility Name

18. Users
  • Description
  • User Name
The Summary Report contains:

- Total number of customized data rows/entries per product
- Total number of customized data rows/entries per entity

**File System (OA_HTML) Customization**

The inventory of the custom files under $OA_HTML$ are included only as a part of offline CSV reports. For each file, the below details are included in the report:

- Node/Hostname
- Product
- Sub Directory
- File Name
- File Size
- File Last Modified Date

**Database Custom Schema**

The following five CSV files are included as offline reports in this release. Only records in which $\text{application\_id} \geq 20000$ are considered.

1. **Database Custom Schemas**
   - Application ID
   - Application Short Name
   - Oracle ID
   - Oracle Username

2. **Database Table FND Application**
   - Application ID
   - Application Short Name
   - Basepath
   - Product Code
   - Created By ID
• Created By Name
• Creation Date
• Last Updated By ID
• Last Updated By Name
• Last Update Date

3. **Database Table FND Product Installations**
   - Application ID
   - Oracle ID
   - Product Version
   - Status
   - Industry
   - Tablespace
   - Index Tablespace
   - Temporary Tablespace
   - Sizing Factor
   - Install Group Num
   - DB Status
   - Patch Level
   - Created By ID
   - Created By Name
   - Creation Date
   - Last Updated By ID
   - Last Updated By Name
   - Last Update Date
4. **Database Table FND Oracle User ID**
   - Oracle ID
   - Oracle Username
   - Description
   - Enabled Flag
   - Read Only Flag
   - Install Group Num
   - Created By ID
   - Created By Name
   - Creation Date
   - Last Updated By ID
   - Last Updated By Name
   - Last Update Date

5. **Database Table FND OAM Context Custom**
   - OA Var
   - Ctx Type
   - OA Type
   - Name
   - Default Value
   - Title
   - Description

**Viewing Customization Details Online**

In the Customization Discovery dashboard, you can view the list of Oracle E-Business Suite instances on which the customization discovery request was completed successfully. Also, you can view the last successful discovered customization details online for each Oracle E-Business Suite instance. The summary is shown in the graphical format and the details are shown in the tabular format. You can filter the
details based on the fields like customization type, node, product, file type, object type, and entity type. Optionally, you can choose to view only the Top-5 or Top-10 customizations for each customization type.

**Customization Discovery Page**

![Customization Discovery Page](image)

**File System (Appl Top) Customization**

1. Select the Oracle E-Business Suite instance in Discovered Customizations table.

2. Select Customization Type as "File System (Appl Top)".
File System (Java Top) Customization

1. Select the Oracle E-Business Suite instance in Discovered Customizations table.

2. Select Customization Type as "File System (Java Top)".
**Customization Discovery: "File System (Java Top)"**

1. Select the Oracle E-Business Suite instance in Discovered Customizations table.
2. Select Customization Type as "Database".

**Database Customization**

1. Select the Oracle E-Business Suite instance in Discovered Customizations table.
2. Select Customization Type as "Database".
Configuration Customization

1. Select the Oracle E-Business Suite instance in Discovered Customizations table.

2. Select Customization Type as "Configuration".
Customization Discovery: Configuration

Oracle E-Business Suite Management
Oracle E-Business Suite Management > Customization Manager > Customization Discovery

Customization Discovery

You can filter the details based on fields such as customization type, node, product, file type, and entity type.

Filtering Customization Details

You can define your own rules to ignore the specific set of files or directories or Oracle E-Business Suite module in customization discovery. This is a user-specific feature where the rules are visible only to their owner and applicable only for the customization discovery request submitted by their owner. Only enabled rules will be applied during customization discovery.

- You can edit, delete, enable, or disable a rule at any time.

Managing Exclusion Rule Lists

You can define your own rules to ignore the specific set of files or directories or Oracle E-Business Suite module in customization discovery. This is a user-specific feature where the rules are visible only to their owner and applicable only for the customization discovery request submitted by their owner. Only enabled rules will be applied during customization discovery.
All the user-specific rules that are in the Enabled state at the time of request submission will be applied for that customization discovery request.

Use the options on the menu on the Customization Discovery page to manage exclusion rules.

**Navigation for Managing Exclusion Rules**

Perform the following steps to add a new file system exclusion rule.
1. Enter a description.

2. Select Rule Type:
   - File System (JavaTop) - Rule applied only for the custom files under $JAVA_TOP
   - File System (ApplTop) - Rule applied only for the custom files under $APPL_TOP
   - All - Rule applied for the custom files under $APPL_TOP, $JAVA_TOP and $OA_HTML

3. Enter EBS Module Regular Expression.

4. Enter Sub Directory Regular Expression.

5. Enter File Name Regular Expression.

It is strongly recommended that you test the exclusion rule by using the Test option.
Add Database Exclusion Rule

Database Exclusion Rule List Page

Click **Add** to add a new database exclusion rule.
1. Enter a description.

2. Select Object Type

3. Enter Database schema Regular Expression.

It is strongly recommended that you test the exclusion rule by using the Test option.
Add Configuration Exclusion Rule

Configuration Exclusion Rule List Page

Click +Add to add a new configuration exclusion rule.

Add Configuration Exclusion Rule Page

1. Enter a description.
2. Select Entity Type.
Target Types

This appendix covers the following topics:

- Target Types

Target Types

The following table lists details of the individual target types shipped in the management pack.

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Applicable Oracle E-Business Suite Release</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle E-Business Suite</td>
<td>All releases</td>
<td>Target representing entire Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Oracle Applications Service</td>
<td>All releases</td>
<td>Target representing all the services provided by Oracle E-Business Suite.</td>
</tr>
<tr>
<td>Concurrent Processing Service</td>
<td>All releases</td>
<td>Target representing the services provided by the concurrent processing infrastructure.</td>
</tr>
<tr>
<td>Forms-Based Applications Service</td>
<td>All releases</td>
<td>Target representing the services provided by Oracle Forms.</td>
</tr>
<tr>
<td>Self-Service Applications Service</td>
<td>All releases</td>
<td>Target representing the services provided by self-service applications.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Applicable Oracle E-Business Suite Release</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>All releases</td>
<td>Target representing the service provided by the Oracle Workflow infrastructure.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Node</td>
<td>All releases</td>
<td>Target representing an individual Oracle E-Business Suite node.</td>
</tr>
<tr>
<td>Oracle Concurrent Manager</td>
<td>All releases</td>
<td>Target representing the concurrent manager.</td>
</tr>
<tr>
<td>Internal Concurrent Manager</td>
<td>All releases</td>
<td>Target representing the internal concurrent manager.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Workflow</td>
<td>All releases</td>
<td>Target representing all the members of the Oracle Workflow infrastructure.</td>
</tr>
<tr>
<td>Oracle Workflow Agent Listener</td>
<td>All releases</td>
<td>Target representing the Oracle Workflow agent listener.</td>
</tr>
<tr>
<td>Oracle Workflow Background Engine</td>
<td>All releases</td>
<td>Target representing the Oracle Workflow background engine.</td>
</tr>
<tr>
<td>Oracle Workflow Notification Mailer</td>
<td>All releases</td>
<td>Target representing the Oracle Workflow notification mailer.</td>
</tr>
<tr>
<td>Oracle Applications JVM Usage</td>
<td>12.1.x</td>
<td>Target representing the JVM that runs the oacore server. This is used to monitor parameters specific to Oracle E-Business Suite deployment.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Custom Objects</td>
<td>All releases</td>
<td>Target representing the customizations in an Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Patch Information</td>
<td>All releases</td>
<td>Target representing the patching activities in an Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Conflict Resolution Manager</td>
<td>All releases</td>
<td>Target representing Oracle E-Business Suite Conflict Resolution Manager.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Applicable Oracle E-Business Suite Release</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Oracle E-Business Suite Internal Monitor</td>
<td>All releases</td>
<td>Target representing Oracle E-Business Suite Internal Monitor.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Service Manager</td>
<td>All releases</td>
<td>Target representing Oracle E-Business Suite Service Manager.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Transaction Manager</td>
<td>All releases</td>
<td>Oracle E-Business Suite Transaction Manager.</td>
</tr>
<tr>
<td>Oracle MobileApps Telnet Listener</td>
<td>All releases</td>
<td>Target representing the Mobile Web Application (MWA) server and dispatcher.</td>
</tr>
</tbody>
</table>
Prevalidation for Discovery

This appendix covers the following topics:

- Prevalidation Checks for Discovery

Prevalidation Checks for Discovery

The following table lists the checks used in the prevalidation step of discovery.

<table>
<thead>
<tr>
<th>Category</th>
<th>Sub category</th>
<th>Description</th>
<th>Applicable Releases of Oracle E-Business Suite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apps Context File</td>
<td>Number of Context Files</td>
<td>A minimum of one (1) context file must be there.</td>
<td>For 12.1.x</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Number of Context Files</td>
<td>A minimum of two (2) context files must be there.</td>
<td>12.2 and later</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Context Name</td>
<td>Context name should not be empty.</td>
<td>All releases</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Context Name</td>
<td>Context name must be same for both run and patch editions.</td>
<td>12.2 and later</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Edition Name</td>
<td>Edition name must be same for all nodes under an edition.</td>
<td>12.2 and later</td>
</tr>
<tr>
<td>Category</td>
<td>Sub category</td>
<td>Description</td>
<td>Applicable Releases of Oracle E-Business Suite</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Duplicate Context Files</td>
<td>There should not be two context files for the same applications node.</td>
<td>12.1.x</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Duplicate Context Files</td>
<td>There should not be two context files for the same node under an edition.</td>
<td>12.2 and later</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Number of nodes</td>
<td>Only one applications node per host.</td>
<td>12.1.x</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Number of nodes</td>
<td>Only two applications nodes per host: One for the run edition and one for the patch edition.</td>
<td>12.2 and later</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>EBS System Name</td>
<td>Oracle E-Business Suite system name must be the same in all context files.</td>
<td>For all releases</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Context variables</td>
<td>Mandatory context variables must be there.</td>
<td>All releases</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>WLS Admin Server</td>
<td>Must be up for the run edition.</td>
<td>12.2 and later</td>
</tr>
<tr>
<td>DB Context File</td>
<td>Duplicate Context Files</td>
<td>There should not be two context files for the same database node.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB Context File</td>
<td>Context Name</td>
<td>Context name should not be empty.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB Context File</td>
<td>Number of nodes</td>
<td>Only one database node per host.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB Context File</td>
<td>EBS System Name</td>
<td>Oracle E-Business Suite system name must be same in all context files.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB Context File</td>
<td>Context variables</td>
<td>Mandatory context variables must be there.</td>
<td>All releases</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>Agent installation</td>
<td>EM Agents must be installed on all hosts.</td>
<td>All releases</td>
</tr>
<tr>
<td>Category</td>
<td>Sub category</td>
<td>Description</td>
<td>Applicable Releases of Oracle E-Business Suite</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>Agent Compatibility</td>
<td>Agent must be at the same release as OMS or one release lower (n-1).</td>
<td>All releases</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>OS User</td>
<td>Agent OS user and Oracle E-Business Suite OS user must be same or must be in the same OS user group.</td>
<td>All releases</td>
</tr>
</tbody>
</table>
Supported File Types in Customization Manager

This appendix covers the following topics:

- Supported File Types
- Recommended Locations for Common File Types
- Execution Sequence of SQL File Types

Supported File Types

The following table lists the supported file types in Customization Manager. You can include files of only these types in your custom packages. The Object Action column lists the action that AutoPatch performs on files of the given type.

<table>
<thead>
<tr>
<th>File Type Name</th>
<th>Source Extension</th>
<th>Description</th>
<th>Object Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>alter_sequence</td>
<td>.sql</td>
<td>Alter Sequence Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>alter_table</td>
<td>.sql</td>
<td>Alter Table Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>alter_table_owner</td>
<td>.sql</td>
<td>Alter Table Owner Script (run as schema owner)</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>amx</td>
<td>.amx</td>
<td>Standard XML file</td>
<td>copy</td>
</tr>
<tr>
<td>app</td>
<td>.app</td>
<td>Used to configure the apache single listener (modplsql)</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>BC4J XML</td>
<td>.xml</td>
<td>Oracle Application Framework - BC4J XML file customizations</td>
<td>compile and deploy under $JAVA_TOP</td>
</tr>
<tr>
<td>bmp</td>
<td>.bmp</td>
<td>Bitmap image file</td>
<td>copy</td>
</tr>
<tr>
<td>cfg</td>
<td>.cfg</td>
<td>Configuration file</td>
<td>copy</td>
</tr>
<tr>
<td>class</td>
<td>.class</td>
<td>Java class file</td>
<td>copy</td>
</tr>
<tr>
<td>clx</td>
<td>.clx</td>
<td>Spell-checking dictionary file in compressed lexicon format</td>
<td>copy</td>
</tr>
<tr>
<td>cmd</td>
<td>.cmd</td>
<td>NT Command File</td>
<td>copy</td>
</tr>
<tr>
<td>conf</td>
<td>.conf</td>
<td>Configuration file to be released along the product</td>
<td>copy</td>
</tr>
<tr>
<td>coremif</td>
<td>.coremif</td>
<td>XML file that contains schematic information about graphical representation of the structure (RMIM)</td>
<td>copy</td>
</tr>
<tr>
<td>create_index</td>
<td>.sql</td>
<td>Create Index Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_index_owner</td>
<td>.sql</td>
<td>Create Index Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>create_sequence</td>
<td>.sql</td>
<td>Create Sequence Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_synonym</td>
<td>.sql</td>
<td>Create View Synonym Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_synonym_owner</td>
<td>.sql</td>
<td>Create Synonym Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>create_table</td>
<td>.sql</td>
<td>Create Table Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_table_owner</td>
<td>.sql</td>
<td>Create Table Schema Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>create_trigger</td>
<td>.sql</td>
<td>Create or Replace Trigger Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_type</td>
<td>.sql</td>
<td>Create or Replace Type Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_view</td>
<td>.sql</td>
<td>Create or Replace View Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_view_owner</td>
<td>.sql</td>
<td>Create View Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>csh</td>
<td>.csh</td>
<td>Shell script file</td>
<td>copy</td>
</tr>
<tr>
<td>csv</td>
<td>.csv</td>
<td>File from which user-needed data is imported</td>
<td>copy</td>
</tr>
<tr>
<td>ctl</td>
<td>.ctl</td>
<td>SQL*Loader file</td>
<td>copy</td>
</tr>
<tr>
<td>dat</td>
<td>.dat</td>
<td>Data file</td>
<td>copy</td>
</tr>
<tr>
<td>dbc</td>
<td>.dbc</td>
<td>File used for database connection</td>
<td>copy</td>
</tr>
<tr>
<td>dbt</td>
<td>.dbt</td>
<td>Database text file</td>
<td>copy</td>
</tr>
<tr>
<td>def</td>
<td>.def</td>
<td>Definition file</td>
<td>copy</td>
</tr>
<tr>
<td>dis</td>
<td>.dis</td>
<td>Discoverer Export</td>
<td>copy</td>
</tr>
<tr>
<td>dll</td>
<td>.dll</td>
<td>Dynamic link library</td>
<td>copy</td>
</tr>
<tr>
<td>dmp</td>
<td>.dmp</td>
<td>Memory dump</td>
<td>copy</td>
</tr>
<tr>
<td>doc</td>
<td>.doc</td>
<td>Microsoft Word document file</td>
<td>copy</td>
</tr>
<tr>
<td>document css</td>
<td>.css</td>
<td>Used in document patches; cascading stylesheet file</td>
<td>copy and execute using FNDGFU</td>
</tr>
<tr>
<td>document gif</td>
<td>.gif</td>
<td>Used in document patches; image files</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>document htm</td>
<td>.htm</td>
<td>Used in document patches; HTML files</td>
<td>copy</td>
</tr>
<tr>
<td>document ldt</td>
<td>.ldt</td>
<td>Used in document patches; navigation library files</td>
<td>copy and upload using FNDLOAD</td>
</tr>
<tr>
<td>dot</td>
<td>.dot</td>
<td>Microsoft Word template file</td>
<td>copy</td>
</tr>
<tr>
<td>drv</td>
<td>.drv</td>
<td>Driver file</td>
<td>copy</td>
</tr>
<tr>
<td>drvx</td>
<td>.drvx</td>
<td>Database driver exception file</td>
<td>copy</td>
</tr>
<tr>
<td>dtd</td>
<td>.dtd</td>
<td>XML Document Type Definition</td>
<td>copy</td>
</tr>
<tr>
<td>ear</td>
<td>.ear</td>
<td>An EJB .jar archive with XML contents in the META-INF</td>
<td>copy</td>
</tr>
<tr>
<td>eex</td>
<td>.eex</td>
<td>Oracle Discoverer</td>
<td>copy</td>
</tr>
<tr>
<td>env</td>
<td>.env</td>
<td>Environment file</td>
<td>copy</td>
</tr>
<tr>
<td>exp</td>
<td>.exp</td>
<td>Drawing Express file format</td>
<td>copy</td>
</tr>
<tr>
<td>fdi</td>
<td>.fdi</td>
<td>Disk image file</td>
<td>copy</td>
</tr>
<tr>
<td>fdo</td>
<td>.fdo</td>
<td>Form definition operator script</td>
<td>copy</td>
</tr>
<tr>
<td>flt</td>
<td>.flt</td>
<td>Filter file</td>
<td>copy</td>
</tr>
<tr>
<td>fmb</td>
<td>.fmb</td>
<td>Oracle Forms</td>
<td>copy and genform</td>
</tr>
<tr>
<td>fmt</td>
<td>.fmt</td>
<td>Oracle Forms form source text file</td>
<td>copy</td>
</tr>
<tr>
<td>fmx</td>
<td>.fmx</td>
<td>Compiled form</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>force upload</td>
<td>.ldt</td>
<td>Used in software patches</td>
<td>copy and upload using FNDLOAD with CUSTOM_MODE=FORCE option</td>
</tr>
<tr>
<td>fpp</td>
<td>.fpp</td>
<td>Fortan source code file</td>
<td>copy</td>
</tr>
<tr>
<td>frm</td>
<td>.frm</td>
<td>Database format file</td>
<td>copy</td>
</tr>
<tr>
<td>ftg</td>
<td>.ftg</td>
<td>System help file</td>
<td>copy</td>
</tr>
<tr>
<td>fxp</td>
<td>.fxp</td>
<td>Fortan compiled code file</td>
<td>copy</td>
</tr>
<tr>
<td>hct</td>
<td>.hct</td>
<td>HRMS fast formula loader control file</td>
<td>copy</td>
</tr>
<tr>
<td>hdt</td>
<td>.hdt</td>
<td>HRMS fast formula loader data file</td>
<td>copy</td>
</tr>
<tr>
<td>hlp</td>
<td>.hlp</td>
<td>Help file</td>
<td>copy</td>
</tr>
<tr>
<td>html</td>
<td>.html</td>
<td>Hypertext Markup Language</td>
<td>copy</td>
</tr>
<tr>
<td>ico</td>
<td>.ico</td>
<td>Icon file</td>
<td>copy</td>
</tr>
<tr>
<td>imp</td>
<td>.imp</td>
<td>Spreadsheet file</td>
<td>copy</td>
</tr>
<tr>
<td>inc</td>
<td>.inc</td>
<td>Include file</td>
<td>copy</td>
</tr>
<tr>
<td>inf</td>
<td>.inf</td>
<td>Used for applying updates to windows registry</td>
<td>copy</td>
</tr>
<tr>
<td>ini</td>
<td>.ini</td>
<td>Java Parameter File</td>
<td>copy</td>
</tr>
<tr>
<td>inp</td>
<td>.inp</td>
<td>Input file</td>
<td>copy</td>
</tr>
<tr>
<td>interface ldt</td>
<td>.n</td>
<td>Interface Repository loader file</td>
<td>copy</td>
</tr>
<tr>
<td>jar</td>
<td>.jar</td>
<td>Java archive file</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>java</td>
<td>.java</td>
<td>Java file</td>
<td>compile and deploy under $JAVA_TOP</td>
</tr>
<tr>
<td>java_lib</td>
<td>.jar</td>
<td>Java library (for compilation only)</td>
<td>Use jar only for compiling; jar is not included into the patch</td>
</tr>
<tr>
<td>jlt</td>
<td>.jlt</td>
<td>Java Loader Text - used by AKLOAD.java</td>
<td>copy</td>
</tr>
<tr>
<td>jpg</td>
<td>.jpg</td>
<td>JPEG image file</td>
<td>copy</td>
</tr>
<tr>
<td>Jpx</td>
<td>.jpx</td>
<td>BC4J Substitution</td>
<td>copy</td>
</tr>
<tr>
<td>JRAD/MDS File</td>
<td>.xml</td>
<td>JRAD Files are xml extensions. These extensions should be used for Oracle Application Framework objects under the mds directory.</td>
<td>copy and load using XMLImporter</td>
</tr>
<tr>
<td>js</td>
<td>.js</td>
<td>Javascript file</td>
<td>copy</td>
</tr>
<tr>
<td>jsp</td>
<td>.jsp</td>
<td>Java server page</td>
<td>copy</td>
</tr>
<tr>
<td>jspx</td>
<td>.jspx</td>
<td>JSP document</td>
<td>copy</td>
</tr>
<tr>
<td>lct</td>
<td>.lct</td>
<td>Application Object Library Generic Loader control file</td>
<td>copy</td>
</tr>
<tr>
<td>llt</td>
<td>.llt</td>
<td>Digital chart file</td>
<td>copy</td>
</tr>
<tr>
<td>mac</td>
<td>.mac</td>
<td>Macro file</td>
<td>copy</td>
</tr>
<tr>
<td>mdl</td>
<td>.mdl</td>
<td>Text file created by Oracle Warehouse Builder (OWB) metadata loader file for data import</td>
<td>copy</td>
</tr>
<tr>
<td>mif</td>
<td>.mif</td>
<td>XML file that contains schematic information about graphical representation of the structure (RMIM)</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>mk</td>
<td>.mk</td>
<td>Make file</td>
<td>copy</td>
</tr>
<tr>
<td>mmb</td>
<td>.mmb</td>
<td>Menu file</td>
<td>copy</td>
</tr>
<tr>
<td>mmt</td>
<td>.mmt</td>
<td>Menu text file</td>
<td>copy</td>
</tr>
<tr>
<td>mmx</td>
<td>.mmx</td>
<td>A kind of menu file</td>
<td>copy</td>
</tr>
<tr>
<td>msb</td>
<td>.msb</td>
<td>Message Dictionary file</td>
<td>copy</td>
</tr>
<tr>
<td>msg</td>
<td>.msg</td>
<td>FND Message Loader Text</td>
<td>copy</td>
</tr>
<tr>
<td>MSI</td>
<td>.xml</td>
<td>Manual Step File</td>
<td>copy</td>
</tr>
<tr>
<td>OAF Component</td>
<td>.java</td>
<td>Oracle Application Framework customizations</td>
<td>compile and deploy under $JAVA_TOP</td>
</tr>
<tr>
<td>obd</td>
<td>.obd</td>
<td>Online help file</td>
<td>copy</td>
</tr>
<tr>
<td>odb</td>
<td>.odb</td>
<td>Oracle Lite database file required from Mobile Applications</td>
<td>copy</td>
</tr>
<tr>
<td>odf</td>
<td>.odf</td>
<td>Object definition file</td>
<td>copy</td>
</tr>
<tr>
<td>ogd</td>
<td>.ogd</td>
<td>Oracle Graphics</td>
<td>copy</td>
</tr>
<tr>
<td>ora</td>
<td>.ora</td>
<td>Net8 configuration files (listener.ora, tnsnames.ora)</td>
<td>copy</td>
</tr>
<tr>
<td>package_body</td>
<td>.sql</td>
<td>Package body</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>package_spec</td>
<td>.sql</td>
<td>Package specification</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>pc</td>
<td>.pc</td>
<td>Pro*C program</td>
<td>copy</td>
</tr>
<tr>
<td>pdf</td>
<td>.pdf</td>
<td>Document file (Portable Document Format (PDF))</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>pdf</td>
<td>.pdf</td>
<td>XMLP PDF notrans</td>
<td>copy and load using XDOLoader</td>
</tr>
<tr>
<td>pdt</td>
<td>.pdt</td>
<td>HRMS legislative loader data file</td>
<td>copy</td>
</tr>
<tr>
<td>pkb</td>
<td>.pkb</td>
<td>Package body</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>pkh</td>
<td>.pkh</td>
<td>Package header</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>pkh (no n)</td>
<td>.pkh</td>
<td>Package definition</td>
<td>copy</td>
</tr>
<tr>
<td>Pks</td>
<td>.pks</td>
<td>PL/SQL package specification</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>pl</td>
<td>.pl</td>
<td>Perl Scripts</td>
<td>copy</td>
</tr>
<tr>
<td>plb</td>
<td>.plb</td>
<td>Package body</td>
<td>copy</td>
</tr>
<tr>
<td>pld (Forms)</td>
<td>.pld</td>
<td>Forms Library</td>
<td>compile to p1l; copy and genfpl</td>
</tr>
<tr>
<td>pld (Reports)</td>
<td>.pld</td>
<td>Reports Library</td>
<td>compile to p1l; copy and genrpl</td>
</tr>
<tr>
<td>pll (Forms)</td>
<td>.pll</td>
<td>Compiled Forms library</td>
<td>copy and run genfpl</td>
</tr>
<tr>
<td>pll (Reports)</td>
<td>.pll</td>
<td>Compiled Reports library</td>
<td>copy and run genrpl</td>
</tr>
<tr>
<td>Pls</td>
<td>.pls</td>
<td>PL/SQL package specification</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>p1x</td>
<td>.p1x</td>
<td>Oracle Forms library file executable</td>
<td>copy</td>
</tr>
<tr>
<td>pm</td>
<td>.pm</td>
<td>Perl Modules</td>
<td>copy</td>
</tr>
<tr>
<td>ppp</td>
<td>.ppp</td>
<td>Page layout file</td>
<td>copy</td>
</tr>
<tr>
<td>prc</td>
<td>.prc</td>
<td>Palm Pilot application file</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>prog</td>
<td>.prog</td>
<td>Host concurrent program</td>
<td>copy create a symbolic link using $FND_TOP/patch/115/bin</td>
</tr>
<tr>
<td>properties</td>
<td>.properties</td>
<td>Java Property Class</td>
<td>copy</td>
</tr>
<tr>
<td>prt</td>
<td>.prt</td>
<td>Oracle Reports driver</td>
<td>copy</td>
</tr>
<tr>
<td>ps</td>
<td>.ps</td>
<td>Postscript Pages</td>
<td>copy</td>
</tr>
<tr>
<td>rdf</td>
<td>.rdf</td>
<td>Oracle Reports</td>
<td>copy and genrep</td>
</tr>
<tr>
<td>res</td>
<td>.res</td>
<td>Resource file to store WF messages and used by WF Resource Generator</td>
<td>copy</td>
</tr>
<tr>
<td>rlt</td>
<td>.rlt</td>
<td>Data analysis uncommon file</td>
<td>copy</td>
</tr>
<tr>
<td>rpt</td>
<td>.rpt</td>
<td>Oracle Reports file</td>
<td>copy</td>
</tr>
<tr>
<td>rsp</td>
<td>.rsp</td>
<td>Rapid Install response file</td>
<td>copy</td>
</tr>
<tr>
<td>RTF File</td>
<td>.rtf</td>
<td>Rich text format</td>
<td>copy</td>
</tr>
<tr>
<td>rts</td>
<td>.rts</td>
<td>Resource bundle file for java related tool is Tecate</td>
<td>copy</td>
</tr>
<tr>
<td>Scr</td>
<td>.scr</td>
<td>Script file generated by the Oracle Scripting Script Builder’ tool”</td>
<td>copy</td>
</tr>
<tr>
<td>seed_data</td>
<td>.sql</td>
<td>Custom Seeded Data SQL script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>sh</td>
<td>.sh</td>
<td>Bourne or Korn shell script</td>
<td>copy</td>
</tr>
<tr>
<td>so</td>
<td>.so</td>
<td>UNIX shared library</td>
<td>copy</td>
</tr>
<tr>
<td>software css</td>
<td>.css</td>
<td>Used in software patches</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>software gif</td>
<td>.gif</td>
<td>Image file (Graphics Interchange Format)</td>
<td>copy</td>
</tr>
<tr>
<td>software htm</td>
<td>.htm</td>
<td>Hypertext Markup Language</td>
<td>copy</td>
</tr>
<tr>
<td>software ldt</td>
<td>.ldt</td>
<td>Used in software patches</td>
<td>copy and upload using FNDLOAD</td>
</tr>
<tr>
<td>sql</td>
<td>.sql</td>
<td>SQL script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>sql_owner</td>
<td>.sql</td>
<td>Generic SQL Owner Script (copy only)</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>sqlj</td>
<td>.sqlj</td>
<td>SQLJ file</td>
<td>copy</td>
</tr>
<tr>
<td>sym</td>
<td>.sym</td>
<td>Always accompanies a dll</td>
<td>copy</td>
</tr>
<tr>
<td>tag</td>
<td>.tag</td>
<td>Query tag name</td>
<td>copy</td>
</tr>
<tr>
<td>tcl</td>
<td>.tcl</td>
<td>TCL scripts called by Oracle Enterprise Manager's Intelligent Agent for hosted Exchange products</td>
<td>copy</td>
</tr>
<tr>
<td>thtml</td>
<td>.thtml</td>
<td>Template toolkit for ISD</td>
<td>copy</td>
</tr>
<tr>
<td>tif</td>
<td>.tif</td>
<td>Image file (Tagged Image File Format)</td>
<td>copy</td>
</tr>
<tr>
<td>tld</td>
<td>.tld</td>
<td>Tag library definition file</td>
<td>copy</td>
</tr>
<tr>
<td>tlx</td>
<td>.tlx</td>
<td>Spell-checking dictionary file in text lexicon format</td>
<td>copy</td>
</tr>
<tr>
<td>tpl</td>
<td>.tpl</td>
<td>Template files</td>
<td>copy</td>
</tr>
<tr>
<td>ttf</td>
<td>.ttf</td>
<td>TrueType font definition file</td>
<td>copy</td>
</tr>
<tr>
<td>txt</td>
<td>.txt</td>
<td>Plain text file</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>uit</td>
<td>.uit</td>
<td>Custom renderer for the FWK header component</td>
<td>copy</td>
</tr>
<tr>
<td>uix</td>
<td>.uix</td>
<td>User interface XML</td>
<td>copy</td>
</tr>
<tr>
<td>vsd</td>
<td>.vsd</td>
<td>Source file for gif files used in translations</td>
<td>copy</td>
</tr>
<tr>
<td>wbmp</td>
<td>.wbmp</td>
<td>Bitmap file for wireless devices</td>
<td>copy</td>
</tr>
<tr>
<td>wft</td>
<td>.wft</td>
<td>Workflow Text</td>
<td>copy and upload using WFLOAD</td>
</tr>
<tr>
<td>wfx</td>
<td>.wfx</td>
<td>Workflow XML loader files</td>
<td>copy and load using WFXLoader</td>
</tr>
<tr>
<td>wsd1</td>
<td>.wsdl</td>
<td>Web Services Description Language File</td>
<td>copy</td>
</tr>
<tr>
<td>x2h</td>
<td>.x2h</td>
<td>X2h format file for ISD</td>
<td>copy</td>
</tr>
<tr>
<td>xcfg</td>
<td>.xcfg</td>
<td>ADF XML configuration file</td>
<td>copy</td>
</tr>
<tr>
<td>xdf</td>
<td>.xdf</td>
<td>XML files containing object definitions</td>
<td>copy and execute using FNDXDFCMP</td>
</tr>
<tr>
<td>xdf(AW) xlf</td>
<td>.xlf</td>
<td>Analytic Workspaces XML files containing object definitions</td>
<td>copy</td>
</tr>
<tr>
<td>xgd</td>
<td>.xgd</td>
<td>XML Gateway Data definition file</td>
<td>copy</td>
</tr>
<tr>
<td>xgm</td>
<td>.xgm</td>
<td>XML Gateway Mapping file</td>
<td>copy</td>
</tr>
<tr>
<td>xlf</td>
<td>.xlf</td>
<td>XLF files are generated from xml files</td>
<td>copy</td>
</tr>
<tr>
<td>xls</td>
<td>.xls</td>
<td>Microsoft Excel file</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>XML</td>
<td>.xml</td>
<td>Extensible Markup Language file</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP PDF</td>
<td>.pdf</td>
<td>XML Publisher (XDO) PDF templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP rtf</td>
<td>.rtf</td>
<td>XML Publisher (XDO) non-transferable RTF templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP rtf</td>
<td>.rtf</td>
<td>XML Publisher (XDO) non-translatable RTF templates (recommended)</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP rtf</td>
<td>.rtf</td>
<td>XML Publisher (XDO) translatable templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP xlf</td>
<td>.xlf</td>
<td>Xlf files generated from translatable XMLP templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP XML</td>
<td>.xml</td>
<td>XML Publisher (XDO) non-translatable XML templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP XSD</td>
<td>.xsd</td>
<td>XML Publisher (XDO) non-translatable XML templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP XSL</td>
<td>.xsl</td>
<td>XML Publisher (XDO) non-translatable XSL templates</td>
<td>copy</td>
</tr>
<tr>
<td>xsd</td>
<td>.xsd</td>
<td>XML Schema provides a means for defining the structure of XML documents</td>
<td>copy</td>
</tr>
<tr>
<td>xsl (non-dbdrv)</td>
<td>.xsl</td>
<td>XML Style Sheets (not used in database driver)</td>
<td>copy</td>
</tr>
<tr>
<td>xss</td>
<td>.xss</td>
<td>Extensible Style Sheet definition</td>
<td>copy</td>
</tr>
</tbody>
</table>
Supported File Types in Customization Manager

<table>
<thead>
<tr>
<th>File Type Name</th>
<th>Source Extension</th>
<th>Description</th>
<th>Object Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>zip</td>
<td>.zip</td>
<td>Zipped file</td>
<td>copy</td>
</tr>
</tbody>
</table>

Recommended Locations for Common File Types

The following table lists recommended locations for some commonly-used file types.

Recommended Locations for Commonly-Used File Types

<table>
<thead>
<tr>
<th>File Types Description</th>
<th>Recommended Destination Path (Relative to Product Top)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL, PL/SQL files</td>
<td>patch/115/sql</td>
</tr>
<tr>
<td>All Generic Loader (FNDLOAD) files</td>
<td>patch/115/import/&lt;LANG&gt;; for example, 'patch/115/import/US'</td>
</tr>
<tr>
<td>Shell script</td>
<td>bin</td>
</tr>
<tr>
<td>Perl script</td>
<td>bin</td>
</tr>
<tr>
<td>Host concurrent program</td>
<td>bin</td>
</tr>
<tr>
<td>XDF file</td>
<td>patch/115/xdf</td>
</tr>
<tr>
<td>Forms</td>
<td>forms/&lt;LANG&gt;; for example, forms/US</td>
</tr>
<tr>
<td>File Types</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>rdf</td>
<td>Report</td>
</tr>
<tr>
<td>html,xsl,xss,css</td>
<td>HTML and style sheets</td>
</tr>
<tr>
<td>jsp</td>
<td>JSP</td>
</tr>
<tr>
<td>XML Publisher templates</td>
<td>XML Publisher templates</td>
</tr>
<tr>
<td>java</td>
<td>Java files</td>
</tr>
<tr>
<td>JRAD/MDS file</td>
<td>Oracle Application Framework-related XML files</td>
</tr>
<tr>
<td>gif</td>
<td>Image files</td>
</tr>
<tr>
<td>pm</td>
<td>Perl module</td>
</tr>
<tr>
<td>wfx</td>
<td>wfx file</td>
</tr>
</tbody>
</table>

### Execution Sequence of SQL File Types

The following table lists the execution sequence of SQL file types.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
<th>Order Of Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>create_sequence</td>
<td>Create sequence script</td>
<td>1</td>
</tr>
<tr>
<td>create_table</td>
<td>Create table script</td>
<td>2</td>
</tr>
<tr>
<td>File Type</td>
<td>Description</td>
<td>Order Of Execution</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>create_table_owner</td>
<td>Create table in custom schema</td>
<td>2</td>
</tr>
<tr>
<td>alter_table</td>
<td>Alter table script</td>
<td>3</td>
</tr>
<tr>
<td>alter_sequence</td>
<td>Alter sequence script</td>
<td>3</td>
</tr>
<tr>
<td>alter_table_owner</td>
<td>Alter table in custom schema</td>
<td>3</td>
</tr>
<tr>
<td>create_type</td>
<td>Create or replace type script</td>
<td>4</td>
</tr>
<tr>
<td>package_spec</td>
<td>Package specification</td>
<td>5</td>
</tr>
<tr>
<td>create_view</td>
<td>Create or replace view script</td>
<td>6</td>
</tr>
<tr>
<td>create_synonym</td>
<td>Create view synonym script</td>
<td>6</td>
</tr>
<tr>
<td>create_view_owner</td>
<td>Create view in custom schema</td>
<td>6</td>
</tr>
<tr>
<td>create_synonym_owner</td>
<td>Create synonym in custom schema</td>
<td>6</td>
</tr>
<tr>
<td>package_body</td>
<td>Package body</td>
<td>7</td>
</tr>
<tr>
<td>seed_data</td>
<td>Custom seeded data SQL script</td>
<td>8</td>
</tr>
<tr>
<td>create_index</td>
<td>Create index script</td>
<td>9</td>
</tr>
<tr>
<td>create_index_owner</td>
<td>Create index in custom schema</td>
<td>9</td>
</tr>
<tr>
<td>create_trigger</td>
<td>Create or replace trigger script</td>
<td>10</td>
</tr>
<tr>
<td>sql</td>
<td>Generic</td>
<td>11</td>
</tr>
<tr>
<td>sql_owner</td>
<td>Run SQL in custom schema</td>
<td>11</td>
</tr>
</tbody>
</table>

For example, the type create_sequence will execute before the type create_table or create_table_owner. The types create_table/create_table_owner will execute in parallel before the types alter_table/alter_sequence/alter_table_owner.
Customization Manager Coding Standards Validation

This appendix covers the following topics:

- Customization Manager Coding Standards Validation for Files
- Customization Manager Coding Standards Validation for Database Objects

Customization Manager Coding Standards Validation for Files

Customization Manager has a standards checker to check that the files included in a custom package meet certain coding standards. This checker tests all code for standards compliance.

Some standards are mandatory and will result in failure when Customization Manager attempts to build the package. Other standards are recommended, and the standards checker will give a warning but the package will be built.

Mandatory File Standards

The standards in the following table must be met. If a file does not meet these standards then Customization Manager will not build the package containing it.

<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Check</td>
<td>Each file must have an Oracle-compliant source header present.</td>
</tr>
</tbody>
</table>
### Other File Standards

The following table lists standards that if not met, will result in a Warning, but the package will still be built.

#### Other Customization Manager File Standards

<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java SOP Check</td>
<td>Java files must not use System.out.print</td>
</tr>
<tr>
<td>Java System.gc() Check</td>
<td>Java files must not use System.gc</td>
</tr>
<tr>
<td>SQL dual reference check</td>
<td>SQL files must not use System.dual, instead use dual</td>
</tr>
<tr>
<td>PERL module location</td>
<td>Perl module must be located anywhere under perl directory</td>
</tr>
</tbody>
</table>
| PERL file location     | Perl files must be located under one of following directories: bin, patch/[release]/bin,admin/template,admin/template/*.
<p>| SQL comment standard  | SQL file should not have -- as comment           |
| SQL file (!) check    | SQL file should not have ! character             |</p>
<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLS (!) check</td>
<td>PLS file should not have ! character</td>
</tr>
<tr>
<td>JRAD halign check</td>
<td>JRAD XML files should not contain hAlign</td>
</tr>
<tr>
<td>Java package name check</td>
<td>Standards differ depending on the type of file.</td>
</tr>
<tr>
<td></td>
<td>Use case 1 - Customizing Oracle shipped files: If the Java file is $JAVA_TOP/oracle/apps/fnd/demo/Hello.java then the file entry should be:</td>
</tr>
<tr>
<td></td>
<td>• Product: fnd</td>
</tr>
<tr>
<td></td>
<td>• File Name: Hello.java</td>
</tr>
<tr>
<td></td>
<td>• File Type: java</td>
</tr>
<tr>
<td></td>
<td>• Destination Path: java/demo</td>
</tr>
<tr>
<td></td>
<td>Use case 2 - Customizing Oracle Application Framework (OAF) files according to Oracle recommended standards: If the Java file is $JAVA_TOP/xxtop/oracle/apps/fnd/demo/Hello.java then the file entry should be:</td>
</tr>
<tr>
<td></td>
<td>• Product: xxtop</td>
</tr>
<tr>
<td></td>
<td>• File Name: Hello.java</td>
</tr>
<tr>
<td></td>
<td>• File Type: OAF Component</td>
</tr>
<tr>
<td></td>
<td>• Destination Path: xxtop/oracle/apps/fnd/demo</td>
</tr>
<tr>
<td>Java System.err Check</td>
<td>Java files must not use System.err</td>
</tr>
<tr>
<td>SQL file location check</td>
<td>SQL files must be located under one of following directories:</td>
</tr>
<tr>
<td></td>
<td>admin/sql, admin/template, admin/template/*, patch/[some dir]/sql, sql</td>
</tr>
<tr>
<td>Drvx file location check</td>
<td>Drvx files must be located under one of following directories:</td>
</tr>
<tr>
<td></td>
<td>patch/[some dir]/driver, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Driver File Location Standard</td>
<td>Driver files must be located under one of following directories:</td>
</tr>
<tr>
<td></td>
<td>admin/driver, patch/[some dir]/driver, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LCT File Location</td>
<td>LCT files must be located under one of following directories: admin/import, patch/[some dir]/import, upgrade/[some dir]/import, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>LDT File Location</td>
<td>LDT files must be located under one of following directories: admin/import, patch/[some dir]/import, help, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>PKG File Location</td>
<td>Package files must be located under one of following directories: admin/sql, patch/[some dir]/sql, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>RTF File Location</td>
<td>RTF files must be located under : patch/115/publisher/templates</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>XSS Location Standard</td>
<td>XSS files must be located under one of following directories: html, admin/template, admin/template/*</td>
</tr>
<tr>
<td>HCT Location Standard</td>
<td>HCT files must be located under one of following directories: patch/[some dir]/import, admin/template, admin/template/*</td>
</tr>
<tr>
<td>HDT Location Standard</td>
<td>HDT files must be located under one of following directories: patch/[some dir]/import, admin/template, admin/template/*</td>
</tr>
<tr>
<td>PDT Location Standard</td>
<td>PDT files must be located under one of following directories: patch/[some dir]/import, admin/template, admin/template/*</td>
</tr>
<tr>
<td>JavaScript Location Standard</td>
<td>JavaScript files must be located under one of following directories: html, patch/[some dir]/html, upgrade/[some dir]/html, admin/template, admin/template/*</td>
</tr>
<tr>
<td>PrintStackTrace Check</td>
<td>Using printStackTrace is not recommended</td>
</tr>
<tr>
<td>Workflow Location</td>
<td>Workflow files must be located under one of following directories: admin/import, patch/[some dir]/import, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>XDF Location Standard</td>
<td>XDF files must be located under one of following directories: admin/xdf, patch/[some dir]/xdf, patch/[some dir]/xdf/aw/US</td>
</tr>
<tr>
<td>Absolute URL Check</td>
<td>Check for absolute URLs</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Report Printer Def File</td>
<td>Report printer files must be located under one of following directories: reports,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Form Location Standard</td>
<td>Form files must be located under one of following directories: forms,admin/template,admin/template/*</td>
</tr>
<tr>
<td>JAR Location Standard</td>
<td>Jar files must be located under one of following directories: java/3rdparty,java/3rdparty/standalone,admin/template,admin/template/,patch/115/jar/bpel</td>
</tr>
<tr>
<td>JSP Location Standard</td>
<td>JSP files must be located under one of following directories: html,html/jsp/[PROD],html/jsp/[MOD],html/jsp/[PROD]/[MOD],html/jsp/[PROD]/[MOD]/[sub MOD],admin/template,admin/template/*</td>
</tr>
<tr>
<td>Dependency Files Location Standard</td>
<td>Dependency files must be located under one of following directories: java/make,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Cmd file Location Standard</td>
<td>CMD files must be located under one of following directories: admin/template,admin/template/*,bin</td>
</tr>
<tr>
<td>XML Location Standard</td>
<td>XML files must be located under one of following directories: html,java,mds,patch/115/publisher/defs,admin/template,admin/template/*,patch/115/manualsteps.</td>
</tr>
<tr>
<td>XGM Location Standard</td>
<td>XGM files must be located under one of following directories: patch/[some dir]/xml/US,admin/template,admin/template/*</td>
</tr>
<tr>
<td>XSL Location Standard</td>
<td>XSL files must be located under one of following directories: html,admin/xdf/xsl,patch/[some dir]/xdf/xsl,patch/[some dir]</td>
</tr>
<tr>
<td>ForceViewCheck</td>
<td>One must use FORCE in CREATE statements in view creation scripts</td>
</tr>
<tr>
<td>Show Error Check</td>
<td>SQL scripts must not contain the Show errors command</td>
</tr>
<tr>
<td>Absolute URL Check</td>
<td>Having absolute URLs is not recommended</td>
</tr>
<tr>
<td>Pkg Replace Check</td>
<td>Use CREATE OR REPLACE PACKAGE for package creation. Do not omit OR REPLACE</td>
</tr>
<tr>
<td>Pkg Create IS Check</td>
<td>Package creation must not use IS. Instead should always use AS</td>
</tr>
<tr>
<td><strong>Standard Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Xml Parse Standard</td>
<td>XML files should be well-formed</td>
</tr>
<tr>
<td>Control M Standard</td>
<td>Text files should not have control M[^M] character</td>
</tr>
<tr>
<td>SQL NoLogging Check</td>
<td>Using NOLogging in SQL scripts is not recommended</td>
</tr>
<tr>
<td>SQL Serveroutput Check</td>
<td>Using set serveroutput on in SQL scripts is not recommended</td>
</tr>
<tr>
<td>Wfx File Naming Standard</td>
<td>WFX filename must end in s, e, or a, ie. [s</td>
</tr>
<tr>
<td>16.3 File Naming Standard</td>
<td>Filename should adhere to the 16.3 naming standard</td>
</tr>
<tr>
<td>Set Scan Off Standard</td>
<td>Package creation scripts containing ampersand must have SET SCAN OFF</td>
</tr>
<tr>
<td>Drop Table check</td>
<td>Drop table should not be used in SQL/PLSQL files as it can result in loss of data</td>
</tr>
<tr>
<td>SQL Max Line Length Standard</td>
<td>No line in a SQL file should be longer than 255 characters</td>
</tr>
<tr>
<td>FNDSLOAD Check Standard</td>
<td>FNDSLOAD is obsolete. No dbdrv: hints should refer to FNDSLOAD</td>
</tr>
<tr>
<td>Drop Column check</td>
<td>Drop Column should not be used in SQL/PLSQL files</td>
</tr>
<tr>
<td>Long Raw check</td>
<td>LONG or LONG RAW columns should not be used</td>
</tr>
<tr>
<td>Insert Column check</td>
<td>INSERT SQL statements, should explicitly list the columns about to insert</td>
</tr>
<tr>
<td>FNDLOAD/FNDLOADS O syntax check</td>
<td>FNDLOAD/FNDLOADSO must have correct syntax</td>
</tr>
<tr>
<td>Admin Dbdrv none check</td>
<td>All files under [PROD_TOP]/admin must have only dbdrv: none</td>
</tr>
<tr>
<td>NLADD Sql Check</td>
<td>There should be no [PROD]NLADD.sql files in R12 patches</td>
</tr>
<tr>
<td><strong>Standard Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FNDLOAD ldt phase</td>
<td>dbdrv: FNDLOAD ldt files must have correct phase</td>
</tr>
<tr>
<td>Menu file location</td>
<td>Menu files must be located under one of following directories: resource,admin/template,admin/template/*</td>
</tr>
<tr>
<td>WFX file location check</td>
<td>WFX files must be located under one of following directories: patch/[some dir]/xml,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Create single line check</td>
<td>In SQL files, CREATE command must occur on one line only.</td>
</tr>
<tr>
<td>SQL exit check</td>
<td>SQL files must end with exit</td>
</tr>
<tr>
<td>Package SpecBody Same file</td>
<td>The package specification and body should be in different files</td>
</tr>
<tr>
<td>SQL Absolute path Check</td>
<td>SQL files should not have absolute path in a @ or @@ statements</td>
</tr>
<tr>
<td>Calling SQL script check</td>
<td>Use start or @ when calling a SQL script within a SQL script. Do not use @@.</td>
</tr>
<tr>
<td>Applsyspub Schema Check</td>
<td>Custom scripts are not allowed to modify APPLSYS PUB schema</td>
</tr>
<tr>
<td>Custom File Naming Standard</td>
<td>All files involved in the package must be for a product prefixed with xx””</td>
</tr>
<tr>
<td>Pkg body creation Standard</td>
<td>Package body creation scripts should not be in pkh files</td>
</tr>
<tr>
<td>Pkg spec creation Standard</td>
<td>Package Spec creation scripts should not be in pkb and plb files</td>
</tr>
<tr>
<td>Mview Build deferred Standard</td>
<td>Materialized Views must be created with BUILD DEFERRED option</td>
</tr>
<tr>
<td>Mview Parallel Standard</td>
<td>Materialized Views should not be created with parallel command</td>
</tr>
<tr>
<td>Mview prebuilt Standard</td>
<td>Materialized Views must not be created with ON PREBUILT TABLE option</td>
</tr>
<tr>
<td><strong>Standard Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Report Location Standard</td>
<td>Report files must be located under one of following directories: reports,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Import stmt Check</td>
<td>Java import statements must reference fully qualified Class names</td>
</tr>
<tr>
<td>Language check in destination path</td>
<td>The destination path for a file entry in the package creation process should not have the language code as a suffix. The language should be specified separately.</td>
</tr>
<tr>
<td>JRAD XML file type</td>
<td>During the package creation process, if an XML file is included with the file type as 'JRAD XML' (File type ID is 1005), then the destination path should start with 'mds'.</td>
</tr>
<tr>
<td>Control-M characters in PLD files</td>
<td>If a PLD file contains a control-M character, then some issues may arise while applying a patch containing this PLD file.</td>
</tr>
<tr>
<td>SQL whenever sqleerror exit failure rollback</td>
<td>A SQL Script should contain &quot;WHENEVER SQLERROR EXIT FAILURE ROLLBACK;&quot;.</td>
</tr>
<tr>
<td>Java file empty catch block</td>
<td>An empty catch Block finds instances where an exception is caught, but nothing is done.</td>
</tr>
<tr>
<td>Avoid returning from a finally block</td>
<td>In Java code, one should avoid returning from a finally block - this can discard exceptions. There should be no return statement from a finally block.</td>
</tr>
<tr>
<td>Avoid catching null pointer exception</td>
<td>Java code should never catch a null pointer exception. A catch block may hide the original error, resulting in other more subtle errors.</td>
</tr>
<tr>
<td>Java throwing exception in finally block</td>
<td>In Java, throwing exception in a finally block is confusing. It may mask an exception or a defect in the code, and it can also make code cleanup unstable.</td>
</tr>
<tr>
<td>Java catching throwable</td>
<td>In Java, one should avoid catching throwable. This action is dangerous because such a catch can catch other things like OutOfMemoryError.</td>
</tr>
<tr>
<td>Java class should not extend error</td>
<td>Errors are system exceptions. Classes should not extend them.</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Java files must have rcs_id</td>
<td>All Java files must have the following for source control ID: public static final String RCS_ID = $Header$</td>
</tr>
<tr>
<td>Java class name check</td>
<td>All Java files should have a class with a name that is the same as that of the file name.</td>
</tr>
<tr>
<td>Java empty if check</td>
<td>There should be no empty if statements in Java code. An empty if statement finds instances where a condition is checked but nothing is done about it.</td>
</tr>
<tr>
<td>Java empty while check</td>
<td>There should be no empty while statements in Java code.</td>
</tr>
<tr>
<td>Java empty finally block</td>
<td>There should be no empty finally blocks in Java code. Avoid empty finally blocks; these can be deleted.</td>
</tr>
<tr>
<td>Java if without braces</td>
<td>In Java, if statements must use curly braces. Avoid using if statements without curly braces.</td>
</tr>
<tr>
<td>Java while without braces</td>
<td>In Java, while statements must use curly braces. Avoid using while statements without using curly braces. Formats without curly braces are error-prone.</td>
</tr>
<tr>
<td>Java switch must have default label</td>
<td>In Java files, switch statements should have a default label.</td>
</tr>
<tr>
<td>Java empty synchronized</td>
<td>There should be no empty synchronized blocks.</td>
</tr>
<tr>
<td>Java empty static initializer</td>
<td>There should be no empty static initializer blocks.</td>
</tr>
<tr>
<td>JRAD files language must be US English</td>
<td>In a JRAD XML file, the language of the XML file should be US English and specified as &quot;xml:lang = 'en-US'&quot;</td>
</tr>
</tbody>
</table>
| Java Parameter (INI) extension and location standard | Java Parameter files should follow these standards:  
- Identified by file extension: .ini  
- Location standard:  
  1. $<PROD_TOP>/admin/template  
  2. $<PROD_TOP>/admin/template/* |
<p>| JDBC TimeStamp Compliance            | The proper column bind type should be used when sending/fetching DATE columns. Do not use Types.TIMESTAMP or OracleTypes.TIMESTAMP. |</p>
<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not use ~FILE or ~PATH in .drvx files</td>
<td>~FILE and ~PATH cannot be used in a dbdrv: command in a .drvx file, even within checkfile. A .drvx file is not loaded into the database.</td>
</tr>
<tr>
<td>dbdrv: fdfcmp should not be called</td>
<td>The database driver should not call fdfcmp.</td>
</tr>
<tr>
<td>Files with .drvx extension must contain</td>
<td>For each driver exception (.drvx) file the line dbdrv: command must exist. The command must be in all lowercase. The line dbdrv: none commands fail also.</td>
</tr>
<tr>
<td>'dbdrv: command'</td>
<td></td>
</tr>
<tr>
<td>No drvx files should contain XDOLoader</td>
<td>For all new patches containing Oracle XML Publisher files, the dbdrv command should be added to the file directly instead of using a separate drvx file.</td>
</tr>
<tr>
<td>No drvx files should contain dbdrv: PYLOAD</td>
<td>PYLOAD should not be in any automatically generated database driver.</td>
</tr>
<tr>
<td>dbdrv: FFXBCP must have correct syntax</td>
<td>dbdrv: FFXBCP must have correct syntax:&lt;br&gt;exec ff bin FFXBCP bin &amp;phase=last(+##) &amp;ui_apps 0 Y(-S</td>
</tr>
<tr>
<td>dbdrv: FFXMLC must have correct syntax</td>
<td>FFXMLC command must contain the following syntax:&lt;br&gt;exec ff bin FFXMLC bin (&amp;phase=dat(+##)) &amp;ui_apps 0 [yY]</td>
</tr>
<tr>
<td>dbdrv: FNDLIBR must have correct syntax</td>
<td>FNDLIBR command must contain the following syntax:&lt;br&gt;exec fnd bin FNDLIBR bin &lt;phase&gt; FND FNDCPBWV &amp;ui_apps SYSADMIN 'System Administrator' SYSADMIN</td>
</tr>
<tr>
<td>dbdrv: java htmlLoad.class must have correct syntax</td>
<td>Java htmlLoad.class command must contain the following syntax:&lt;br&gt;exec java oracle/apps/per htmlLoad.class java -username &amp;un_apps -password &amp;pw_apps -database &amp;jdbc_db_addr -file &lt;.html file&gt;</td>
</tr>
<tr>
<td>dbdrv: java UnzipFile.class must have correct syntax</td>
<td>Java UnzipFile.class command must contain the following syntax:&lt;br&gt;exec java oracle/apps/ad/jri UnzipFile.class java&lt;br&gt;The file must also have the .zip extension.</td>
</tr>
</tbody>
</table>
The syntax for LoadMap.class must be as follows:

```
exec java oracle/apps/ecx/loader LoadMap.class
java &phase=dat &un_apps &pw_apps &jdbc_db_addr &fullpath_prod_path_file
```

JRAD XML files must have file-version attribute

JRAD XML files must have a file-version attribute to indicate the version of the file. Following is a sample definition of file-version.

```
AkTestAttachLinkPG.xml 115.0 2003/02/10 18:18:10
tmak noship $'
xmlns='http://xmlns.example.com/jrad'>
```

Note that the file-version attribute must have the correct filename and a version.

Translation standard for JRAD files

In JRAD xml files the encoding should be UTF-8 and specified as: "encoding = 'UTF-8"

Do not end comments with the '-' character

Do not end comments with the '-' character, as this is the default Sql*Plus line continuation character. For lines with a series of '-', end the line with a '+' sign.

R12 file version standard

File version should start with '12'

---

**Customization Manager Coding Standards Validation for Database Objects**

The following table lists the standards which are applicable only for Oracle E-Business Suite Release 12.2 Online Patching.

**Standards for Oracle E-Business Suite Release 12.2 Online Patching**

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
<th>File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>A column type should not be ROWID.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A column type must not be LONG.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>File Types</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Table</td>
<td>A column type must be a built-in type or a user-defined type owned by a non-editioned user.</td>
<td>.xdf</td>
</tr>
<tr>
<td>Table</td>
<td>A base column name should be unique within the table within the first 27 bytes.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A base column name may use the '#' character only to distinguish the column versions; for example, <code>&lt;col_name&gt;#{version}&gt;</code>.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A table must be owned by an Oracle E-Business Suite product schema, not APPS.</td>
<td>.xdf</td>
</tr>
<tr>
<td>Table</td>
<td>A table name must not use the '#' character.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Materialized View (MV)</td>
<td>Create/alter Materialized View definition using XDF</td>
<td>.sql, .pkb, .pkh</td>
</tr>
<tr>
<td>Constraint</td>
<td>Create/alter constraint definition using XDF or ODF</td>
<td>.sql, .pkb, .pkh, .pls</td>
</tr>
<tr>
<td>Index</td>
<td>Create/alter the index definition using ODF or XDF.</td>
<td>.sql, .pkb, .pkh, .pls</td>
</tr>
<tr>
<td>Table</td>
<td>Create/alter the table definition using ODF or XDF.</td>
<td>.sql, .pkb, .pkh, .pls</td>
</tr>
<tr>
<td>Table</td>
<td>Do not modify application-managed tables in an online patch.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Constraint</td>
<td>A constraint name must contain an underscore (&quot;_&quot;).</td>
<td>.xdf</td>
</tr>
<tr>
<td>Index</td>
<td>An index name must contain an underscore (&quot;_&quot;).</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Trigger</td>
<td>A table trigger must be created on editioning view, not on the table.</td>
<td>.sql, .pkb, .pls</td>
</tr>
<tr>
<td>Table</td>
<td>DML statements must access tables via a table synonym or the editioning view.</td>
<td>All code</td>
</tr>
<tr>
<td>VPD</td>
<td>A VPD policy must be created on the editioning view or table synonym, not on the table.</td>
<td>.sql</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>File Types</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Synonym</td>
<td>A table synonym must point to the editioning view, not to the table.</td>
<td>.sql, .pkb, .pls</td>
</tr>
<tr>
<td>Synonym</td>
<td>Do not install synonyms in non-editioned schemas</td>
<td>.xdf, .odf</td>
</tr>
</tbody>
</table>
Validation of Custom Applications: Examples

This appendix covers the following topics:

• Validation of Custom Applications: Examples

Validation of Custom Applications: Examples

The following table lists examples of issues that might be discovered in validating a custom application. Recommended solutions are also provided. These examples apply only to Oracle E-Business Suite Release 12.2.

Because the list of issues and its corresponding recommendations will vary for one instance to another, please run requests to validate existing custom applications to generate release-specific and instance-specific recommendations. See: Managing Custom Applications, page 17-5.

The example custom application 'xxcust' used in this table corresponds to a case-sensitive custom application shortname.

The example custom application ID ‘50001’ used in this table corresponds to the custom application ID.
### Example Issues Discovered During Validation

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 12.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>The file $APPL_TOP/admin/xxcustprod.txt does not exist.</td>
<td>Create or replace file $APPL_TOP/admin/xxcustprod.txt. The contents should be:</td>
</tr>
<tr>
<td></td>
<td>xxcust 50001 END_OF_PRODUCT_ABBREVIATIONS -999 50001 xxcust XXCUST APP No No No No Yes Yes 50001 XXCUST DEFAULT 0 1.0.0 1.0.0 none none none none END_OF_PRODUCTS Release 12.0.0 R120 R120_ additional-this-mpl # list of products and versions XXCUST 12.0.0 END_OF_Release 0.0.0</td>
</tr>
<tr>
<td>The file $APPL_TOP/admin/xxcustterr.txt does not exist.</td>
<td>Create or replace file $APPL_TOP/admin/xxcustterr.txt with file:</td>
</tr>
<tr>
<td></td>
<td>%%% Single-product territory data file format 12.0.A</td>
</tr>
<tr>
<td></td>
<td># Release abbreviation # 10.7 - R1107, 11.0 = R11.0.28, 11.5 = R115 R120 0 usaeng US AMERICAN EN US American_English appltape.txt appltape.txt WE8ISO8859P1 Yes Standard Data_Group none none none none none c xxcust xxcust END_OF_PRODUCT_NAMES # # You may specify info for other languages here, but usually you will # not need to do this. #</td>
</tr>
</tbody>
</table>
The entry for xxcust is missing in FND_APPLICATION_TL.

**Recommendation for Release 12.2**

Update FND_APPLICATION_TL with the following SQL:

```
INSERT INTO FND_APPLICATION_TL (APPLICATION_ID, LANGUAGE, APPLICATION_NAME, CREATED_BY, CREATION_DATE, LAST_UPDATED_BY, LAST_UPDATE_DATE, LAST_UPDATE_LOGIN, DESCRIPTION, SOURCE_LANG)
VALUES (50001, 'US', 'xxcust', 1000, sysdate, 1000, sysdate, 1000, 'xxcust', 'US');
```

The entry for product xxcust is missing from FND_PRODUCT_INSTALLATIONS.

Insert the information about product xxcust in FND_PRODUCT_INSTALLATIONS using the following SQL:

```
INSERT INTO FND_PRODUCT_INSTALLATIONS
(APPLICATION_ID, ORACLE_ID, LAST_UPDATE_DATE, LAST_UPDATED_BY, CREATION_DATE, CREATED_BY, LAST_UPDATE_LOGIN, PRODUCT_VERSION, STATUS, INDUSTRY, TABLESPACE, INDEX_TABLESPACE, TEMPORARY_TABLESPACE, SIZING_FACTOR, INSTALL_GROUP_NUM, DB_STATUS, PATCH_LEVEL)
VALUES (50001, 50001, sysdate, 1000, sysdate, 1000, 1000, '12.0.0', 'I', 'C', <tablespace>, <index tablespace>, <temporary tablespace>, 100, 0, 'I', NULL);
```

Please replace <tablespace>, <index tablespace>, and <temporary tablespace> with appropriate values.
<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 12.2</th>
</tr>
</thead>
</table>
| The database is missing user xxcust. | Create database user xxcust. Give appropriate grants to the user by running the necessary SQL statements:  
- grant create session, alter session to xxcust  
- grant create type to xxcust  
- grant create database link to xxcust  
- grant create any outline, alter any outline, drop any outline to xxcust  
- grant analyze any to xxcust  
- grant create sequence, create table to xxcust  
- grant create cluster to xxcust  
- grant create trigger to xxcust  
- grant create materialized view, query rewrite to xxcust  
- grant unlimited quota on all tablespaces with which user xxcust is associated.  
Please use APPS_TS_TX_DATA as the main tablespace for user xxcust.  
Please use APPS_TS_TX_IDX as the index tablespace for user xxcust. |
| The entry for product xxcust is missing from FND_ORACLE_USERID. | Insert entry for the product xxcust in FND_ORACLE_USERID with the following SQL:  
```
INSERT INTO FND_ORACLE_USERID (ORACLE_ID, ORACLE_USERNAME, LAST_UPDATE_DATE, LAST_UPDATED_BY, CREATION_DATE, CREATED_BY, LAST_UPDATE_LOGIN, DESCRIPTION, ENABLED_FLAG, READ_ONLY_FLAG, ENCRYPTED_ORACLE_PASSWORD, CONCURRENT_BATCH_QUEUE_ID, INSTALL_GROUP_NUM) VALUES (50001, 'XXCUST', sysdate, 1000, sysdate, 1000, 1000, 'XXCUST Account', 'N', 'A', NULL, NULL, 0 );
``` |
<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 12.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>The entry for the product xxcust in $APPL_TOP/admin/topfile.txt does not exist.</td>
<td>Edit $APPL_TOP/admin/topfile.txt to insert the given below entry at the end: xxcust &lt;XXCUST_TOP&gt;</td>
</tr>
<tr>
<td></td>
<td>Please replace &lt;XXCUST_TOP&gt; with the appropriate value.</td>
</tr>
<tr>
<td>The environment variable XXCUST_TOP not defined</td>
<td>Run AutoConfig to generate the environment variable XXCUST_TOP.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0 does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/log does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/log.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/out does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/out.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/mesg does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/mesg.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/sql does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/sql.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/admin does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/admin.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/admin/driver does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/admin/driver.</td>
</tr>
<tr>
<td>The directory $APPL_TOP/xxcust/12.0.0/admin/sql does not exist.</td>
<td>Create directory $APPL_TOP/xxcust/12.0.0/admin/sql.</td>
</tr>
<tr>
<td>Issue</td>
<td>Recommendation for Release 12.2</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>The file $APPL_TOP/xxcust/12.0.0/admin/driver/xxcustfile.drv does not exist.</td>
<td>Create file $APPL_TOP/xxcust/12.0.0/admin/driver/xxcustfile.drv with the following contents: # # Dummy xxcustfile.drv # xxcustlogdirectory xxcustoutdirectory xxcustmesgdirectory xxcustsqlXXCUSTNLINS.sql xxcustadmin/sqlXXCUSTNLADD.sql # # End of dummy xxcustfile.drv #</td>
</tr>
<tr>
<td>The file $APPL_TOP/xxcust/12.0.0/sql/XXCUSTNLINS.sql does not exist.</td>
<td>Create file $APPL_TOP/xxcust/12.0.0/sql/XXCUSTNLINS.sql with the following contents: rem rem Dummy XXCUSTNLINS.sql rem rem Exit;</td>
</tr>
<tr>
<td>The file $APPL_TOP/xxcust/12.0.0/admin/sql/XXCUSTNLADD.sql does not exist.</td>
<td>Create file $APPL_TOP/xxcust/12.0.0/admin/sql/XXCUSTNLADD.sql with the following contents: rem rem Dummy XXCUSTNLADD.sql rem rem Exit;</td>
</tr>
</tbody>
</table>
This appendix covers the following topics:

- Character Set Mapping for Custom Patches

### Character Set Mapping for Custom Patches

Customization Manager creates patch drivers using the following character set mapping for NLS patches. The table below lists the mapping of character sets to NLS_LANG values. If you create a custom NLS patch, you must ensure that the character set of the custom files match that of the u-driver file of the custom patch.

#### Character Set Mapping for Drivers

<table>
<thead>
<tr>
<th>NLS_LANG Setting of Driver</th>
<th>Language Code</th>
<th>Character Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic</td>
<td>Generic</td>
<td>US7ASCII</td>
</tr>
<tr>
<td>Arabic</td>
<td>AR</td>
<td>AR8ISO8859P6</td>
</tr>
<tr>
<td>Bulgarian</td>
<td>BG</td>
<td>CL8ISO8859P5</td>
</tr>
<tr>
<td>Catalan</td>
<td>CA</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Czech</td>
<td>CS</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>German</td>
<td>D</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Danish</td>
<td>DK</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>NLS_LANG Setting of Driver</td>
<td>Language Code</td>
<td>Character Set</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Spanish</td>
<td>E</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Egyptian</td>
<td>EG</td>
<td>AR8ISO8859P6</td>
</tr>
<tr>
<td>Greek</td>
<td>EL</td>
<td>EL8ISO8859P7</td>
</tr>
<tr>
<td>Latin American Spanish</td>
<td>ESA</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>French</td>
<td>F</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Canadian French</td>
<td>FRC</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Croatian</td>
<td>HR</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>Hungarian</td>
<td>HU</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>Italian</td>
<td>I</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Icelandic</td>
<td>IS</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Hebrew</td>
<td>IW</td>
<td>IW8ISO8859P8</td>
</tr>
<tr>
<td>Japanese</td>
<td>JA</td>
<td>JA16EUC</td>
</tr>
<tr>
<td>Korean</td>
<td>KO</td>
<td>KO16KSC5601</td>
</tr>
<tr>
<td>Lithuanian</td>
<td>LT</td>
<td>NEE8ISO8859P4</td>
</tr>
<tr>
<td>Norwegian</td>
<td>N</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Dutch</td>
<td>NL</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Polish</td>
<td>PL</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>Portuguese</td>
<td>PT</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Brazilian Portuguese</td>
<td>PTB</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Romanian</td>
<td>RO</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>NLS_LANG Setting of Driver</td>
<td>Language Code</td>
<td>Character Set</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Russian</td>
<td>RU</td>
<td>CL8ISO8859P5</td>
</tr>
<tr>
<td>Swedish</td>
<td>S</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Finnish</td>
<td>SF</td>
<td>WE8ISO8859P1</td>
</tr>
<tr>
<td>Slovak</td>
<td>SK</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>Slovenian</td>
<td>SL</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>Thai</td>
<td>TH</td>
<td>TH8TISA5CII</td>
</tr>
<tr>
<td>Turkish</td>
<td>TR</td>
<td>WE8ISO8859P9</td>
</tr>
<tr>
<td>American English</td>
<td>US</td>
<td>US7ASCII</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>ZHS</td>
<td>ZHS16CGB231280</td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td>ZHT</td>
<td>ZHT16BIG5</td>
</tr>
<tr>
<td>Vietnamese</td>
<td>VN</td>
<td>VN8MSWIN1258</td>
</tr>
<tr>
<td>Cyrillic Serbian</td>
<td>CSR</td>
<td>CL8ISO8859P5</td>
</tr>
<tr>
<td>Albanian</td>
<td>SQ</td>
<td>EE8ISO8859P2</td>
</tr>
<tr>
<td>Ukrainian</td>
<td>UK</td>
<td>CL8ISO8859P5</td>
</tr>
</tbody>
</table>
This appendix covers the following topics:

- XML Schema Definition to Discover Oracle E-Business Suite Using EM CLI
- Sample XML Input File to Discover Oracle E-Business Suite Instances Using EM CLI
- Sample XML Schema to Start and Stop Oracle E-Business Suite Using EM CLI
- Sample Input XML File to Start or Stop Using EM CLI
- Sample XML Schema to Start and Stop Component/Node Using EM CLI
- Sample Input XML File to Start and Stop Component/Node Using EM CLI
XML Schema Definition to Discover Oracle E-Business Suite Using EM CLI

```xml
<xs:schema attributeFormDefault="unqualified" elementFormDefault="qualified" xmlns:xs="http://www.w3.org/2001/XMLSchema">
  <xs:element name="EBSDiscovery">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="DefaultDiscParams" minOccurs="0" maxOccurs="1">
          <xs:complexType>
            <xs:sequence>
              <xs:element name="NamedCreds" minOccurs="0" maxOccurs="1">
                <xs:complexType>
                  <xs:sequence>
                    <xs:element type="xs:string" name="AppsNamedCreds" minOccurs="0" maxOccurs="1"/>
                    <xs:element type="xs:string" name="WlsAdminNamedCreds" minOccurs="0" maxOccurs="1"/>
                    <xs:element type="xs:string" name="WlsMonitoringNamedCreds" minOccurs="0" maxOccurs="1"/>
                    <xs:element type="xs:string" name="NormalHostNamedCreds" minOccurs="0" maxOccurs="1"/>
                  </xs:sequence>
                </xs:complexType>
              </xs:element>
              <xs:element name="CustomerGroupDetails" minOccurs="0" maxOccurs="1">
                <xs:complexType>
                  <xs:sequence>
                    <xs:element type="xs:string" name="GroupName" minOccurs="0" maxOccurs="1"/>
                    <xs:element type="xs:string" name="InstanceGroupName" minOccurs="0" maxOccurs="1"/>
                  </xs:sequence>
                </xs:complexType>
              </xs:element>
              <xs:element name="DiscCustomization" minOccurs="0" maxOccurs="1">
                <xs:complexType>
                  <xs:all>
                    <xs:element name="DiscoverWorkflow" minOccurs="0" maxOccurs="1">
                      <xs:simpleType>
                        <xs:restriction base="xs:string">
                          <xs:pattern value="Y|N"/>
                        </xs:restriction>
                      </xs:simpleType>
                    </xs:element>
                    <xs:element name="DiscoverSSA" minOccurs="0" maxOccurs="1">
                      <xs:simpleType>
                        <xs:restriction base="xs:string">
                          <xs:pattern value="Y|N"/>
                        </xs:restriction>
                      </xs:simpleType>
                    </xs:element>
                    <xs:element name="DiscoverCustomObjects" minOccurs="0" maxOccurs="1">
                      <xs:simpleType>
                        <xs:restriction base="xs:string">
                          <xs:pattern value="Y|N"/>
                        </xs:restriction>
                      </xs:simpleType>
                    </xs:element>
                  </xs:all>
                </xs:complexType>
              </xs:element>
            </xs:sequence>
          </xs:complexType>
        </xs:element>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
```
<xs:element name="DiscoverPatching" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverJFF" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverFormsService" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverWorkflowService" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverConcurrentManagers" minOccurs="0" maxOccurs="1">
  <xs:complexType>
    <xs:all>
      <xs:element name="DiscoverAll" minOccurs="0" maxOccurs="1">
        <xs:simpleType>
          <xs:restriction base="xs:string">
            <xs:pattern value="Y|N"/>
          </xs:restriction>
        </xs:simpleType>
      </xs:element>

      <xs:element name="ExcludeConcurrentManagers" minOccurs="0" maxOccurs="1">
        <xs:complexType>
          <xs:sequence>
            <xs:element name="ConcurrentManager" minOccurs="0" maxOccurs="unbounded"/>
          </xs:sequence>
        </xs:complexType>
      </xs:element>
    </xs:all>
  </xs:complexType>
</xs:element>

<xs:element name="DeleteRemovedTargets" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="AppNodeCustomization" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>
<xs:element name="DiscoverWorkflow" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y\|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverSSA" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y\|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverCustomObjects" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y\|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverPatching" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y\|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverJFF" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y\|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverFormsService" minOccurs="0" maxOccurs="1">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:pattern value="Y\|N"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>

<xs:element name="DiscoverConcurrentManagers" minOccurs="0" maxOccurs="1">
  <xs:complexType>
    <xs:all>
      <xs:element name="DiscoverAll" minOccurs="0" maxOccurs="1">
        <xs:simpleType>
          <xs:restriction base="xs:string">
            <xs:pattern value="Y\|N"/>
          </xs:restriction>
        </xs:simpleType>
      </xs:element>
    </xs:all>
  </xs:complexType>
</xs:element>

<xs:element name="InstanceGroupName" minOccurs="0" maxOccurs="1"/>
<xs:element name="ExcludeConcurrentManagers" minOccurs="0" maxOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element name="ConcurrentManager" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="DiscoverWorkflowService" minOccurs="0" maxOccurs="1">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:pattern value="Y|N"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="DeleteRemovedTargets" minOccurs="0" maxOccurs="1">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:pattern value="Y|N"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="Hosts" minOccurs="0" maxOccurs="1">
<xs:complexType>
<xs:sequence>
<xs:element name="Host" minOccurs="1" maxOccurs="unbounded">
<xs:complexType>
<xs:sequence>
<xs:element type="xs:string" name="HostName" minOccurs="1" maxOccurs="1"/>
<xs:element type="xs:string" name="AliasedHost" minOccurs="0" maxOccurs="1"/>
<xs:element name="ExcludeContext" minOccurs="0" maxOccurs="1">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:pattern value="Y|N"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="DiscoverForms" minOccurs="0" maxOccurs="1">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:pattern value="Y|N"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
DiscoverMWA minOccurs="0" maxOccurs="1">
    <xs:restriction base="xs:string">
        <xs:pattern value="Y|N"/>
    </xs:restriction>
</xs:simpleType>
</xs:element>

DiscoverJVMUsage minOccurs="0" maxOccurs="1">
    <xs:restriction base="xs:string">
        <xs:pattern value="Y|N"/>
    </xs:restriction>
</xs:simpleType>
</xs:element>
</xs:all>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:all>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:sequence>

</xs:schema>
Sample XML Input File to Discover Oracle E-Business Suite Instances Using EM CLI

<!--Required elements are marked with Required. All other elements are optional.-->
<!--Required. Root element-->
<EBSDiscovery>
  <!--Default discovery parameters. These parameters will be applied to all instances if not overridden. Predefined discovery parameters will be used if default discovery parameters are not provided-->
  <DefaultDiscParams>
    <!--Monitoring and Weblogic Admin named credential-->
    <NamedCreds>
      <!--Monitoring named credential for database-->
      <AppsNamedCreds/>
      <!--Weblogic Admin named credential. Required for EBS Release 12.2 and above-->
      <WlsAdminNamedCreds/>
      <!--Weblogic Monitoring named credential. Useful for weblogic domain discovery. Required for EBS Release 12.2 and above-->
      <WlsMonitoringNamedCreds/>
      <!--Normal Host Credential. Required for EBS Release 12.2 and above only if preferred host credential is already not set and WLS Admin patch edition target is not up-->
      <NormalHostNamedCreds/>
    </NamedCreds>
    <!--Customer Group Details-->
    <CustomerGroupDetails>
      <!--All targets discovered for this instance will be grouped under this group. This group will be added to Group: Customer Group Name.-->
      <GroupName/>
      <!--If the Customer Instance Group Name is provided, then all the targets discovered for this instance and the Customer Instance Group Name will be added to this group.-->
      <InstanceGroupName/>
    </CustomerGroupDetails>
    <!--Discovery Customization. Elements can occur in any order-->
    <DiscCustomization>
      <!--Disable/Enable discovery of the Oracle Workflow components. Possible values: {Y, N}, Default Value: Y-->
      <DiscoverWorkflow/>
      <!--Disable/Enable creation of the Self-Service Applications (SSA) Service. Possible values: {Y, N}, Default Value: Y-->
      <DiscoverSSA/>
      <!--Disable/Enable discovery of custom objects configuration. Possible values: {Y, N}, Default Value: Y-->
      <DiscoverCustomeObjects/>
      <!--Disable/Enable discovery of the Patching Information Object. This target is essential for any Oracle E-Business Suite patching application and should be enabled if any patching applications are used with this instance. Applicable for EBS Release 12 and above. Possible values: {Y, N}, Default Value: Y-->
      <DiscoverPatching/>
      <!--Disable/Enable discovery of the Java fulfillment. Possible values: {Y, N}, Default Value: Y-->
      <DiscoverJFF/>
      <!--Disable/Enable creation of the Oracle Forms service.-->
Applicable for EBS Release 12 and above. Possible values: \{Y, N\}, Default Value: Y

\[<DiscoverFormsService>\]<DiscoverFormsService>

\[!---Disable/Enable creation of the Oracle Workflow service. If you do not discover workflow targets, then the workflow service will not be discovered. Possible values: \{Y, N\}, Default Value: Y\]

\[<DiscoverWorkflowService>\]<DiscoverWorkflowService>

\[!---Discovery customization of concurrent managers-->

\[<DiscoverConcurrentManagers>\]<DiscoverConcurrentManagers>

\[!---To Discover All concurrent managers. Possible values: \{Y, N\}, Default Value: N, If set to N, only core concurrent managers will be discovered-->

\[<DiscoverAll>\]<DiscoverAll>

\[!--- Provision to exclude a few concurrent managers from discovery even if DiscoverAll set to Y-->

\[<ExcludeConcurrentManagers>\]<ExcludeConcurrentManagers>

\[!---List of concurrent managers to exclude from discovery-->

\[<ConcurrentManager>\]<ConcurrentManager>

\[</ExcludeConcurrentManagers>\]<ExcludeConcurrentManagers>

\[!---Whether to delete an Oracle E-Business Suite member target from OMS which was originally discovered and later detached from the Oracle E-Business Suite target hierarchy with a rediscovery. For example, say you have discovered an Oracle E-Business Suite instance with five nodes. Later you customize the discovery and exclude two nodes. When you perform rediscovery, the two excluded nodes become orphan nodes. If this option is set to Yes, then the orphan targets will be deleted during rediscovery. Possible values: \{Y, N\}, Default Value: N-->

\[<DeleteRemovedTargets>\]<DeleteRemovedTargets>

\[!---Context level customization for application node. Applied to all the application context targets of an EBS-->

\[<AppNodeCustomization>\]<AppNodeCustomization>

\[!---Discovery of Forms. Possible values: \{Y, N\}, Default Value: Y-->

\[<DiscoverForms>\]<DiscoverForms>

\[!---Discovery of Mobile Web Applications. Possible values: \{Y, N\}, Default Value: Y-->

\[<DiscoverMWA>\]<DiscoverMWA>

\[!---Discovery of JVM Usage. Possible values: \{Y, N\}, Default Value: Y-->

\[<DiscoverJVMUsage>\]<DiscoverJVMUsage>

\[</AppNodeCustomization>\]<AppNodeCustomization>

\[</DiscCustomization>\]<DiscCustomization>

\[</DefaultDiscParams>\]<DefaultDiscParams>

\[!--- Required. List of database targets to be used for EBS discovery-->

\[<Databases>\]<Databases>

\[!---Required, can repeat 1 to N times. Database target details. At least one occurrence is required-->

\[<Database>\]<Database>

\[!--- Required. Name of database target. This database does not have any customization-->

\[<Name>\]<Name>

\[</Database>\]<Database>

\[!---Another database. This database has customization-->

\[<Database>\]<Database>

\[<Name>\]<Name>
<!--Required if default credentials are not set. This will override default credential for given database target if provided-->
<NamedCreds>
  <!--Monitoring named credential for database-->
  <AppsNamedCreds></AppsNamedCreds>
  <!-- Weblogic Admin named credential. Required for EBS Release 12.2 and above-->
  <WlsAdminNamedCreds></WlsAdminNamedCreds>
  <!-- Weblogic Monitoring named credential. Useful for weblogic domain discovery. Required for EBS Release 12.2 and above-->
  <WlsMonitoringNamedCreds></WlsMonitoringNamedCreds>
  <!--Normal Host Credential. Required for EBS Release 12.2 and above only if preferred host credential is already not set and WLS Admin patch edition target is not up-->
  <NormalHostNamedCreds></NormalHostNamedCreds>
</NamedCreds>

<!--Customer Group Details-->
<CustomerGroupDetails>
  <!--All targets discovered for this instance will be grouped under this group. This group will be added to Group: Customer Group Name.-->
  <GroupName></GroupName>
  <!--If the Customer Instance Group Name is provided, then all the targets discovered for this instance and the Customer Instance Group Name will be added to this group.-->
  <InstanceGroupName></InstanceGroupName>
</CustomerGroupDetails>

<!--Customization of specific EBS. Any combination of customizations can occur here-->
<DiscCustomization>
  <!--Disable/Enable creation of the Self-Service Applications (SSA) Service. Possible values: {Y, N}, Default Value: Y-->
  <DiscoverSSA></DiscoverSSA>
  <!--To list all the hosts of an EBS-->
  <Hosts>
    <!-- Host details. It can have more than one occurrence in case of multinode EBS. If a host is not customized, default customizations will be applied-->
    <Host>
      <!--Name of the host-->
      <HostName></HostName>
      <!--Aliased hostname, needed only if the host name is aliased-->
      <AliasedHost></AliasedHost>
      <!--Context level customization for application node-->
      <AppNodeCustomization>
        <!--Discovery of Forms. Possible values: {Y, N}, Default Value: Y.-->
        <DiscoverForms></DiscoverForms>
        <!--Discovery of JVM Usage. Possible values: {Y, N}, Default Value: Y.-->
        <DiscoverJVMUsage></DiscoverJVMUsage>
        <!--Exclude a node from being discovered . Possible values: {Y, N}, Default Value: N. This element is not supported in default customization-->
        <ExcludeNode></ExcludeNode>
        <!--At least one application node must be selected for successful discovery. Discovery can happen even if you do not select any database node. For Oracle E-Business Suite Release 12.2, you cannot exclude a node if the WebLogic Administration Server is running on that node.-->
      </AppNodeCustomization>
    </Host>
  </Hosts>
</DiscCustomization>
<?xml version="1.0" encoding="UTF-8"?>
<ExcludeContext></ExcludeContext>
</AppNodeCustomization>
</Host>
</Hosts>
</DiscCustomization>
</Database>
</Databases>
</EBSDiscovery>

Sample XML Schema to Start and Stop Oracle E-Business Suite Using EM CLI

<!--Required elements are marked with Required. All other elements are optional.-->
<!--Required. Root element-->
<EBSInstancesList>
<!-- The following global credentials will be applied to all EBS instances if not overridden -->
<GlobalCreds>
<NamedCreds>
<!-- Apps database and weblogic monitoring credentials -->

<!-- "E-Business Suite Database credentials " type for Oracle E-Business Suite target type set for apps schema. -->
<AppsNamedCreds>APPS</AppsNamedCreds>
<!-- "Oracle Weblogic credentials" type for Oracle web logic server target type -->
<WlsAdminNamedCreds>WLS</WlsAdminNamedCreds>
</NamedCreds>
</GlobalCreds>
</EBSInstances>

<!-- Name of EBS instance as discovered in EM -->
<EBSInstance>
<Name>pm121S-Oracle-E Business Suite</Name>
<NamedCreds>
<!-- Overridden apps and weblogic monitoring credentials -->
<AppsNamedCreds>APPS_CREDS</AppsNamedCreds>
</NamedCreds>
</EBSInstance>

<!-- Named credentials not mandatory, in this case, global credentials will be picked -->
<EBSInstance>
<Name>cm122-Oracle-E Business Suite</Name>
</EBSInstance>
</EBSInstancesList>
Sample Input XML File to Start or Stop Using EM CLI

<!--Required elements are marked with Required. All other elements are optional.-->
<!--Required. Root element-->
<EBSInstancesList>

<!-- The following global credentials will be applied to all EBS
instances if not overridden -->
<GlobalCreds>

<!-- Apps database and weblogic monitoring credentials -->
<!-- "E-Business Suite Database credentials " type for
Oracle E-Business Suite target type set for apps schema. -->
<AppsNamedCreds>APPS</AppsNamedCreds>

<!-- "Oracle Weblogic credentials" type for Oracle web logic
server target type -->
<WlsAdminNamedCreds>WLS</WlsAdminNamedCreds>

</NamedCreds>
</GlobalCreds>

<EBSInstances>

<!-- Name of EBS instance as discovered in EM -->
<Name>pm121S-Oracle-E Business Suite</Name>

<!-- Overridden apps and weblogic monitoring credentials -->
<AppsNamedCreds>APPS_CREDS</AppsNamedCreds>
<WlsAdminNamedCreds>ORAC13_CREDS</WlsAdminNamedCreds>

</NamedCreds>
</EBSInstance>

<EBSInstance>
<Name>cm122-Oracle-E Business Suite</Name>

<!-- Named credentials not mandatory, in this case, global
credentials will be picked -->
</EBSInstance>

</EBSInstances>
</EBSInstancesList>
Sample XML Schema to Start and Stop Component/Node Using EM CLI

```xml
<?xml version="1.0"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema"
    elementFormDefault="qualified" attributeFormDefault="unqualified">

  <xs:element name="EBSInstancesList" type="EBSInstancesListType"></xs:element>

  <xs:complexType name="EBSInstancesListType">
    <xs:sequence>
      <xs:element name="GlobalSettings" type="GlobalSettingsType" minOccurs="1"></xs:element>
      <xs:element name="GlobalCreds" type="GlobalCredsType" minOccurs="0"></xs:element>
      <xs:element name="EBSInstances" type="EBSInstancesType" minOccurs="1" maxOccurs="unbounded"></xs:element>
    </xs:sequence>
  </xs:complexType>

  <!-- Selection of component and application/db nodes is done by GlobalSettings tag -->
  <xs:complexType name="GlobalSettingsType">
    <xs:sequence>
      <xs:element name="DBTier" type="DBTierType" minOccurs="0" maxOccurs="1"></xs:element>
      <xs:element name="AppsTier" type="AppsTierType" minOccurs="0" maxOccurs="1"></xs:element>
    </xs:sequence>
  </xs:complexType>

  <!-- DB component details -->
  <xs:complexType name="DBTierType">
    <xs:sequence>
      <xs:element name="Component" minOccurs="1" maxOccurs="1">
        <xs:simpleType>
          <xs:restriction base="xs:string">
            <xs:enumeration value="ALL"></xs:enumeration>
            <xs:enumeration value="LISTENER"></xs:enumeration>
            <xs:enumeration value="DATABASE"></xs:enumeration>
          </xs:restriction>
        </xs:simpleType>
      </xs:element>
    </xs:sequence>
    <xs:attribute name="StartAndStopOnAllNodes" type="xs:boolean" default="false"></xs:attribute>
  </xs:complexType>

  <!-- App component details -->
  <xs:complexType name="AppsTierType">
    <xs:sequence>
      <xs:element name="Component">
        <xs:simpleType>
          <xs:restriction base="xs:string">
            <xs:enumeration value="ALL"></xs:enumeration>
            <xs:enumeration value="ICM"></xs:enumeration>
            <xs:enumeration value="MWA"></xs:enumeration>
            <xs:enumeration value="APPS_LISTENER"></xs:enumeration>
            <xs:enumeration value="HTTP_SERVER"></xs:enumeration>
          </xs:restriction>
        </xs:simpleType>
      </xs:element>
    </xs:sequence>
  </xs:complexType>
</xs:schema>
```
Sample Input XML File to Start and Stop Component/Node Using EM CLI

```xml
<EBSInstancesList>
  <GlobalSettings>
    <!-- If you set StartAndStopOnAllNodes as false then the list of node will be picked from individual instance using EBSInstance/DBNodes -->
    <DBTier StartAndStopOnAllNodes='true|false'>
      <Component>ALL | LISTENER | DATABASE</Component>
    </DBTier>
    <!-- If you set StartAndStopOnAllNodes as false then the list of node will be picked from individual instance using EBSInstance/AppNodes -->
    <AppsTier StartAndStopOnAllNodes='true|false'>
      <Component>ALL | ICM | APPS_LISTENER | HTTP_SERVER | OAFM_OC4J | OACORE_OC4J | FORMS_OC4J | ADMIN_SERVER_WEBLOGIC | FORMS_WEBLOGIC | OACORE_WEBLOGIC | FORMS_LISTENER
    </Component>
  </GlobalSettings>
  <!-- Global named credential names of EBS database and weblogic credentials -->
  <GlobalCreds>
    <NamedCreds>
      <AppsNamedCreds>APPS</AppsNamedCreds>
      <WlsAdminNamedCreds>WLS</WlsAdminNamedCreds>
    </NamedCreds>
  </GlobalCreds>
  <EBSInstances>
    <EBSInstance>
      <Name>pm121S-Oracle-E Business Suite</Name>
      <!-- NamedCreds at EBS Instance level would override credentials mentioned in Global credentials tag -->
      <NamedCreds>
        <AppsNamedCreds>APPS_CREDS</AppsNamedCreds>
        <WlsAdminNamedCreds>ORAC13_CREDS</WlsAdminNamedCreds>
      </NamedCreds>
      <!-- List of DB contexts on which DB component (mentioned in GlobalSettings/DBTier tag) has to be started/stopped -->
      <DBNodes>
        <ContextName>xxxx.example.com</ContextName>
        <ContextName>xxxx.example.com</ContextName>
      </DBNodes>
      <!-- List of App contexts on which app component (mentioned in GlobalSettings/AppTier tag) has to be started/stopped -->
      <AppNodes>
        <ContextName>xxxx.example.com</ContextName>
        <ContextName>xxxx.example.com</ContextName>
      </AppNodes>
    </EBSInstance>
    <EBSInstance>
      <Name>cm122-Oracle-E Business Suite</Name>
    </EBSInstance>
  </EBSInstances>
</EBSInstancesList>
```
Known Product Limitations

This appendix covers the following topics:

- Known Product Limitations

Known Product Limitations

1. Start and Stop features present in some of the Enterprise Manager console pages should NOT be used against individual Oracle E-Business Suite sub-targets. One example is starting and stopping the Oracle E-Business Suite database. While Oracle Enterprise Manager has no problems starting and stopping individual standalone product services, doing the same with Oracle E-Business Suite components will produce unexpected and inconsistent results. The one exception to this rule is that the Oracle Application Management Pack for Oracle E-Business Suite’s administration feature can be used to start and stop the application tier service from the Enterprise Manager console.

2. The only mechanisms for cloning an Oracle E-Business Suite system from within the Oracle Enterprise Manager Cloud Control console are those provided in the cloning chapter of this guide. Alternatively, for more information on cloning, refer to My Oracle Support Knowledge Document 406982.1, Cloning Oracle Applications Release 12 with Rapid Clone.

3. Altering the out-of-box cloning procedures is not supported. The "Create Like" feature is provided for customers to extend the cloning functionalities based on their own specific business needs.

4. In discovery and monitoring, Oracle Application Management Pack for Oracle E-Business Suite does not support multiple Oracle E-Business Suite instances with the same name across different hosts on a given Oracle Management Server; that is, instances are differentiated only by the Oracle System Identifier (SID) and not the CONTEXT_NAME values.
5. Metric collection errors will be reported for the target type oracle_apps_jvm if the setup needed to monitor Applications JVM Usage is not done after discovery. To fix the issue, you can either set up the metric collection or disable the metric collection; see: Monitoring JVM Usage, page 8-27.

6. If you have changed your APPS password, you should change it for the plug-in in two places: for the named credentials and target monitoring properties (if the Monitoring Configuration has the password). After changing the password, wait at least 15 minutes for it to propagate to the targets.

7. While discovering customization, custom alerts will not get discovered if you have any alert defined with SQL_STATEMENT_TEXT of a length greater than 32K on the given Oracle E-Business Suite instance.

8. In a RAC-based Oracle E-Business Suite Release 12.2 instance, using any Online Patching feature such as patch deployment, cutover, or abort, results in the following error: "Weblogic admin server credential test returned: DB SID passed to getWeblogicDomainName is null."

To work around the problem, follow the below steps:

1. Navigate to Targets from the Enterprise Manager console.

2. From the list, choose "Oracle E-Business Suite."

3. Select the instance by clicking on it.

4. From the instance target menu, choose Target Setup > Monitoring Configuration.

5. Provide the SID value of the RAC database.

6. Click OK.

9. Currently, the Patch Recommendation feature for Oracle Database is not available for in-memory databases.

10. In monitoring concurrent processing, the "Monitoring the Number of Blocked Requests" metric is disabled in the plug-in for Release 13.1.1.1.0. Enabling this metric will result in a collection error.
Index

A
Administration groups, 10-10
Administration of Oracle E-Business Suite, 10-1
AD Patch Log, 16-40
Aliased host
  mapping, 4-11
Approvals
  in Change Management, 15-2
APPS password
  changing, H-2
AutoConfig, 4-1
Availability Status charts, 8-4

C
Change approval, 15-2
Change approval framework, 7-5
Change Management
  approvals, 15-2
Changing the APPS password, H-2
Cloning, 13-1
  application tier, 13-23
  custom steps in deployment, 13-21
  database and application tier, 13-6
  database and application tier, 13-8
diagnostic tests, 12-3
  multi-node to single-node, 13-29
  scale-out and scale-in, 13-35
  single-node to single-node, 13-29
  smart clone, 13-6
  upgrade considerations, 2-3
Coding standards validation, D-1
Command-line discovery, 4-13
Comparison templates, 9-2
Compliance
  summary, 3-2
Compliance standards, 8-19
Concurrent processing
  dashboard, 8-41
Configuration, 9-1
  comparing configurations, 9-1
  of all members, 9-1
Configuration Topology Viewer, 8-2
Credentials
  named, 5-2
  preferred, 5-1, 15-12
Custom applications, 17-5
  validation, E-1
Custom compliance rules, 8-67
Customization Manager
  coding standards validation, D-1, D-11
  custom applications
    validating, E-1
diagnostic tests, 12-13
  file types
    recommended locations, C-13
    supported, C-1
standards checker, D-1
Custom metrics, 8-66
Cutover
  in online patching, 8-23

D
Deleting an Oracle E-Business Suite instance, 4-
Deploying the plug-in, 2-2
Deployment Procedure Manager (Oracle Enterprise Manager), 16-33
Diagnostic tests, 12-1, 15-13
  cloning, 12-3
  Customization Manager, 12-13
  Patch Manager, 12-10
  user monitoring, 12-16
Discovery, 4-7
  customizing, 4-8
  Discovery Wizard, 4-2
  log for troubleshooting, 4-7
  preparatory steps, 4-1
  prevalidation, B-1
  rediscovery, 4-14
  restrictions, 4-7
Discovery Wizard, 4-2
Downloading the plug-in, 2-2

EM CLI
  custom packages, 17-48
  patching Oracle E-Business Suite Release 12.1 or earlier, 16-38
  patching Oracle E-Business Suite Release 12.2, 16-34
Exalogic dashboard, 8-53

HTTPS/SSL targets
  monitoring, 11-4

Incidents, 8-7
In Place
  patching, 8-18

JVM usage
  monitoring, 8-27

Known product limitations, H-1

Management Agent
  installing, 2-3
Map Aliased Host, 4-11
Metrics, 2-3, 8-2
  current activity, 8-24
  custom, 8-66
  incidents, 8-7, 8-40
  performance, 8-38
  purging, 8-67
  thresholds, 8-2
  usage, 8-39
Monitoring, 8-2
  current activity, 8-24
  HTTPS/SSL targets
    configuration, 11-4
  JVM usage, 8-27
  metrics, 8-2
  online patching, 8-23
  settings, 11-1
  topology, 8-2
  user sessions, 8-25
Monitoring templates, 8-29

Named credentials, 5-2
Notifications
  setup, 15-12

Online Patching
  cutover, 8-23
Oracle Application Management Pack for Oracle E-Business Suite
  overview, 1-1
Oracle Applications Manager, 8-37
Oracle Cloud Infrastructure, 14-1
Oracle E-Business Suite Management page, 3-1
Oracle E-Business Suite Release 12.2
  coding standards validation, D-11
  Patch Manager deployment procedure, 16-24
Oracle E-Business Suite system home page, 8-3
Out of Place
  patching, 8-18
P
Patch Manager, 16-3
  deployment procedure, 16-24
  diagnostic tests, 12-10
  extending deployment, 16-33
  features, 16-1
  patch run, 16-16
  prerequisites, 16-11
  promotion policy, 16-4
  restarting failed workers, 16-40
  troubleshooting, 16-41
Patch promotion policy, 16-4
Patch recommendations, 8-9
Patch run, 16-16
  copying, 16-24
Preferences, 6-1
Preferred credentials, 5-1, 15-12
Prerequisites, 2-2
Prevalidation in discovery, B-1
Privilege propagation, 10-10
Privileges, 7-1, 7-6
  Change Management, 7-5, 15-2
Provisioning Manager (Oracle Enterprise Manager), 16-33

R
Real User Experience Insight, 8-55
Roles, 7-1, 7-6

S
Services, 8-41
  starting and stopping, 10-1
Smart Clone, 13-1
  custom steps in deployment, 13-21
  multi-node to single-node, 13-29
  scale-out and scale-in cloning, 13-35
  single-node to single-node, 13-29
  view status, 13-19
SQL file types
  execution sequence, C-14
Standards checker, D-1
Supported versions, 2-2
System requirements, 2-2

T
Target types, A-1
Topology, 8-2

U
Undeploying the plug-in, 2-4
Upgrading
  cloning considerations, 2-3
Upgrading the plug-in, 2-3
User monitoring, 8-25
  diagnostic tests, 12-16
User session monitoring, 8-25